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Sage Accpac International, Inc. License Agreement for 
Simply Accounting by Sage Products 

IMPORTANT – PLEASE READ CAREFULLY THE FOLLOWING 
TERMS AND CONDITIONS: 

This Sage Accpac License Agreement for Simply Accounting by Sage Accpac Products (this 
“Agreement”) is a legal agreement between you or the company that you are authorized to 
represent (“You”) and Sage Accpac International, Inc. (“Sage Accpac ”).  This Agreement 
governs your use of the accompanying Simply Accounting computer software programs and all 
documentation (printed and electronic manuals, guides, bulletins and online help) and any 
modifications, updates, revisions or enhancements received by You from Sage Accpac  or its 
dealers (the “Program”).  You acknowledge and accept the terms and conditions of this 
Agreement by installing this computer software. 

IF YOU DO NOT AGREE WITH THESE TERMS, YOU SHOULD IMMEDIATELY CANCEL 
THE INSTALLATION PROCESS AND RETURN THE PACKAGE AND ITS CONTENTS TO 
SAGE ACCPAC IN ACCORDANCE WITH SAGE ACCPAC’S RETURN POLICY. 

Registration and activation of your license for the Program with Sage Accpac is required.  Student 
and Evaluation versions must be registered upon your first use of the Program, otherwise, You 
have thirty (30) days after your first use of the Program to register and activate your product or the 
Program will stop functioning until You register and activate your product. 

1. GRANT OF LICENSE. 

Subject to your compliance with all terms of this Agreement, Sage Accpac hereby grants to You a 
limited, nontransferable, non-exclusive license to use the Program under the terms stated in this 
Agreement for use in your business or profession.  The grant of rights hereunder to the Program is 
not a sale of the Program or any portion thereof and does not convey any rights of ownership in 
the Program.  Sage Accpac reserves all rights not expressly granted by this Agreement and You 
hereby acknowledge that all title and ownership of the Program and all associated intellectual 
property rights are and shall remain with Sage Accpac. 

2. LICENSE RESTRICTIONS. 

You agree to the following restrictions: 

(a) You may not make copies, translations or modifications of or to the Program or any portion 
thereof, except You may install one (1) copy of the Program for backup purposes in support of 
your use of the Program.  You may install a second copy of the Program for use on either (i) your 
home computer; or (ii) a portable computer that You own or use in your business or profession, to 
the extent that such computer is used by You as a secondary computer.  You must reproduce all 
copyright, trademark, trade secret and other proprietary notices on any such copies of the Program.  
All copies of the Program are subject to the terms and conditions of this Agreement. 
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(b) You may not install more than one (1) Program on any Client Device (as defined below). 

(c) If You have licensed a single-user version of the Program, the Program shall be used and 
accessed solely in accordance with a single-user arrangement, which means that the Program and 
any data stored on a local area network is accessed by one user at a time on a total of one 
computer or workstation, or personal digital assistant, pager, “smart phone” or one such other 
electronic device (a “Client Device”), which You own or use in your business or profession and 
for which the Program is designed to operate.  The component parts of the Program may not be 
used individually or jointly in full or in part on more than one Client Device, unless otherwise set 
forth herein. 

(d) If You have licensed a multi-user version of the Program, the Program shall be used and 
accessed solely in accordance with a multi-user arrangement, which means that the Program and 
any data stored on a local area network may be accessed by multiple licensed users concurrently.  
If You have licensed a Multi-user License Pack (the right to install the Program on more than one 
Client Device and the right to access the same data concurrently from more than one Client 
Device, up to a pre-defined limit), You may install the Program on separate Client Devices up to 
the number of licenses that You have purchased, but not more than the pre-defined limit and You 
may access the same data concurrently up to that same number of licenses or predefined limit  
You also have the right to use the multi-user version of the Program on a local area network 
provided the number of Client Devices permitted to access the Program concurrently corresponds 
to the number of licenses You have purchased up to a pre-defined limit.   

 Use of software, hardware or services that bypass any Program license restrictions and/or 
reduce the number of Client Devices, concurrent users and/or seats, as may be applicable, 
accessing or utilizing the Program (e.g., “multiplexing,” “pooling,” or third party add on software 
or hardware) expressly does not reduce the number of licenses required (i.e., the required number 
of licenses would equal the number of distinct inputs to the multiplexing or pooling software or 
hardware “front end”).  If the number of Client Devices, concurrent users and/or seats that can 
potentially connect to the Program exceeds or has the potential to exceed the number of licenses 
You have obtained, then You must have a reasonable self-enforcing automatic mechanism in place 
to ensure that Your use of the Program does not exceed the use limits specified for the license You 
have obtained. 

 Notwithstanding the foregoing, if the Program is hosted under the auspices of an authorized 
Sage Accpac  Hosting Partner, it may be installed on server hardware located at premises under 
the exclusive or primary control of such Hosting Partner or its agent.  You may not use or permit 
any parent, affiliate, subsidiary or any other third parties to benefit from the use or functionality of 
the Program, either directly or via a facility management, timesharing, service bureau or any other 
arrangement; provided, however, that You may use the Program, as provided herein, to process the 
data of an affiliate or subsidiary of which You own more than fifty percent (50%); provided, 
however, You may not exceed the number of datasets specified on the applicable product 
packaging or accompanying documentation. 
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(e) If the Program You have licensed is a Not for Resale version (an “NFR Version”), your 
license is for your individual use and for demonstration, marketing, promotional, end user support, 
training and/or development purposes, each to the extent permitted, and/or required under the 
applicable Sage Accpac Premier Advisor (formerly Solution Provider), Authorized Consultant 
(formerly Certified Consultant) or other applicable agreements between You and Sage Accpac  
(the “Other Sage Accpac Agreements”).  Use of the NFR Version is limited to not more than the 
number of licenses You have acquired.   

(f) If the Program You have licensed is a student version (a “Student Version”), your license 
is solely for your individual use for educational purposes.  Use of the Student Version is limited to 
fourteen (14) months from date of registration. 

(g) If the Program You have licensed is an educational version (an “Educational Version”), 
your license is solely for your use for educational purposes.  Use of the Educational Version is 
limited to the number of licenses that you have acquired pursuant to you Educational Site License 
Agreement. 

(h) If the Program You have licensed is an evaluation version (an “Evaluation Version”), your 
license is solely for your individual use for evaluation purposes.  The Evaluation Version may be 
used for sixty (60) days. 

(i) If the Program You have licensed is the Monthly Service Plan, You agree that Your license 
rights are contingent on Your timely monthly payments of the license fee for the eleven months 
following product registration.  You must provide a valid credit card upon registration to which 
Your eleven monthly payments will be charged.  If Your credit card expires during Your eleven-
month payment period, it is Your responsibility to provide an updated valid credit card.  In the 
event You miss a payment, make a late payment, stop payment or dispute the charge on Your 
credit card before all eleven payments have been made, Your rights under this license agreement 
will terminate and You will be required to immediately stop using the Program.  In addition, Sage 
Accpac  will initiate collections action against you for the balance owed at the time the payments 
stop. Please note that your credit card will continue to be charged after your 11months of 
payments until you cancel your Monthly Service Plan.  

3. LIMITED WARRANTY. 

(a) The following limited warranty applies to You only if You are the original licensee of the 
Program.  Sage Accpac warrants that the Program substantially conforms to the specifications 
contained in the User Guide that was included in the original packaging or is found in the Help 
menu of, your Simply Accounting software (the “Documentation”) for a period of sixty (60) days 
from your purchase, as evidenced by your receipt (the “Limited Warranty Period”), provided 
that the Program is used on the Client Device for which it was designed.  Sage Accpac further 
warrants that the media on which the Program is furnished will be free from defects in material or 
workmanship for the Limited Warranty Period.  Receipt of revisions or upgrades to the Program 
shall not restart or otherwise affect the warranty period for previously delivered copies.  Sage 
Accpac does not represent or warrant that your use of the Program will be uninterrupted or error 
free. 
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(b) Provided You notify Sage Accpac in writing during the Limited Warranty Period of a 
substantial non-conformity between the Documentation and the Program, and if Sage Accpac is 
able to replicate and verify that such substantial non-conformity exists, Sage Accpac shall replace 
or correct the Program, at Sage Accpac’s sole option, so that the Program substantially conforms 
to the specifications or replace the defective media, as the case may be, or You may return all 
copies of the Program and Sage Accpac  shall remit to You the license fee You paid, up to the 
amount of Sage Accpac’s suggested list price for the Program.  This Section 3(b) states your 
SOLE AND EXCLUSIVE REMEDY for any breach of warranty hereunder. 

(c) No employee, agent or representative of Sage Accpac, nor any reseller (including the 
person or company who sold You the Program) or any other third party, is authorized to make any 
warranty with respect to the Program, except those expressly stated in Sections 3(a) and 3(b) of 
this Agreement, and You may not rely on any such unauthorized warranty. 

4. DISCLAIMER OF WARRANTIES. 

(a) The foregoing warranties and remedies are exclusive.  EXCEPT FOR THE EXPRESS 
WARRANTIES PROVIDED IN SECTIONS 3(a) AND 3(b) OF THIS AGREEMENT, THE 
PROGRAM IS PROVIDED ON AN “AS IS” BASIS AND SAGE ACCPAC  DISCLAIMS ALL 
OTHER WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE PROGRAM 
AND ANY SERVICES FURNISHED IN CONNECTION WITH THIS AGREEMENT.  SAGE 
ACCPAC DOES NOT WARRANT THAT THIS SOFTWARE IS FREE OF BUGS, VIRUSES, 
IMPERFECTIONS, ERRORS, OR OMISSIONS.  SAGE ACCPAC SPECIFICALLY 
DISCLAIMS AND EXCLUDES ANY IMPLIED WARRANTIES, INCLUDING WITHOUT 
LIMITATION: (I) OF MERCHANTABILITY; (II) FITNESS FOR A PARTICULAR PURPOSE; 
(III) OF NON-INFRINGEMENT; OR (IV) ARISING FROM COURSE OF PERFORMANCE, 
COURSE OF DEALING OR USAGE OF TRADE.  IF YOU ARE ACTING AS A CONSUMER, 
SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE 
FOREGOING MAY NOT APPLY TO YOU. 

(b) SAGE ACCPAC SHALL NOT BE LIABLE FOR ANY CLAIMS OR DAMAGES 
CAUSED BY THE OPERATION OF THE PROGRAM ON OTHER THAN THE COMPUTER 
AND OPERATING SYSTEM IDENTIFIED IN THE DOCUMENTATION, ACTS OF ABUSE 
OR MISUSE BY YOU OR MODIFICATIONS OR UNAUTHORIZED REPAIRS.  SAGE 
ACCPAC SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE IN CONNECTION 
WITH OR ARISING OUT OF THE INTERRUPTION OR LOSS OF USE OF THE PROGRAM 
OR ANY OTHER ITEMS OR SERVICES PROVIDED BY SAGE ACCPAC. 

(c) YOU ACKNOWLEDGE THAT ANY DATA ENTRY, CONVERSION OR STORAGE IS 
SUBJECT TO THE LIKELIHOOD OF HUMAN AND MACHINE ERRORS, MALICIOUS 
MANIPULATION, OMISSIONS, DELAYS, AND LOSSES, INCLUDING, BUT NOT 
LIMITED TO, INADVERTENT LOSS OF DATA OR DAMAGE TO MEDIA THAT MAY 
RESULT IN LOSS OR DAMAGE TO YOU AND/OR YOUR PROPERTY, AND/OR YOUR 
DETRIMENTAL RELIANCE ON MALICIOUSLY MANIPULATED DATA.  SAGE ACCPAC 
SHALL NOT BE LIABLE FOR ANY SUCH ERRORS, OMISSIONS, DELAYS, OR LOSSES.  
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YOU ARE RESPONSIBLE FOR ADOPTING REASONABLE MEASURES TO LIMIT THE 
IMPACT OF SUCH PROBLEMS, INCLUDING BACKING UP DATA, ADOPTING 
PROCEDURES TO ENSURE THE ACCURACY OF INPUT DATA, EXAMINING AND 
CONFIRMING RESULTS PRIOR TO USE, ADOPTING PROCEDURES TO IDENTIFY AND 
CORRECT ERRORS AND OMISSIONS, REPLACING LOST OR DAMAGED MEDIA, AND 
RECONSTRUCTING DATA.  IF YOU LICENSED A STUDENT VERSION, YOU 
ACKNOWLEDGE AND UNDERSTAND THAT:  (I) THE STUDENT VERSION MAY BE 
USED FOR EDUCATIONAL PURPOSES ONLY; (II) THAT THE STUDENT VERSION 
SHALL BE OPERABLE ONLY FOR 14 MONTHS; AND (III) THAT DATA OR OTHER 
INFORMATION USED WITH, PROCESSED BY AND/OR STORED IN CONJUNCTION 
WITH THE STUDENT VERSION MAY BE CONVERTED IF YOU UPGRADE TO THE PRO, 
PREMIUM, OR ACCOUNTANTS’ EDITION OF THE FULL RETAIL PRODUCT UPON 
TERMINATION OF THIS AGREEMENT.  IF YOU LICENSED AN EVALUATION 
VERSION, YOU ACKNOWLEDGE AND UNDERSTAND THAT:  (IV) THE EVALUATION 
VERSION MAY BE USED FOR EVALUATION PURPOSES ONLY; (IX) THE 
EVALUATION VERSION SHALL BE OPERABLE ONLY FOR SIXTY (60) DAYS; AND (X) 
UPON EXPIRATION OF THE EVALUATION PERIOD, ANY DATA OR OTHER 
INFORMATION USED WITH, PROCESSED BY AND/OR STORED IN CONJUNCTION 
WITH THE EVALUATION VERSION MAY BE CONVERTED IF YOU UPGRADE TO THE 
STUDENT VERSION OR THE BASIC, PRO, PREMIUM, OR ACCOUNTANTS’ EDITION OF 
THE FULL RETAIL PRODUCT. 

(d) ANY SAGE ACCPAC PREMIER ADVISOR OR AUTHORIZED CONSULTANT OR 
ANYRESELLER, INSTALLER OR CONSULTANT IS NOT AFFILIATED WITH SAGE 
ACCPAC IN ANY CAPACITY OTHER THAN AS A RESELLER, INSTALLER OR 
CONSULTANT OF SAGE ACCPAC’S PRODUCTS AND HAS NO AUTHORITY TO BIND 
SAGE ACCPAC OR MODIFY ANY LICENSE OR WARRANTY.  SAGE ACCPAC MAKES 
NO REPRESENTATIONS, WARRANTY, ENDORSEMENT OR GUARANTEE WITH 
RESPECT TO THE SKILLS OR QUALIFICATIONS OF ANY SAGE ACCPAC PREMIER 
ADVISOR OR AUTHORIZED CONSULTANT OR ANY RESELLER, INSTALLER OR 
CONSULTANT AND YOU ARE ENCOURAGED TO INDEPENDENTLY INVESTIGATE 
THEIR SKILLS AND QUALIFICATIONS. 

5. DISCLAIMER REGARDING LINKS TO EXTERNAL SITES. 

The Program includes links to other Web sites on the Internet that are owned and operated by third 
parties not under the control of Sage Accpac.  Sage Accpac provides the links for your 
convenience only and does not provide a warranty of any type regarding the actions of such third 
parties or the security of information sent to such third parties while You are using their Web sites.  
Under no circumstances shall Sage Accpac, or its subsidiaries or affiliates, be responsible or liable 
in any way for the availability of services or products offered, or the content located on or through, 
any such third party’s Web site. 

6. EXPORT RESTRICTIONS. 



 

6 

 

2006 ENG Simply EULA2.doc, printed on 9/12/2005, at 5:48:19 PM. Last saved on 9/12/2005 
5:38:00 PM. 

ACCPAC INTERNATIONAL, INC. Confidential 

You shall abide by all foreign and United States federal, state and local laws, ordinances, rules and 
regulations applicable to the transactions contemplated hereunder.  You agree to comply to the 
extent applicable with the United States Export Administration regulations, the International 
Traffic in Arms regulations and any regulations or licenses administered by the Department of the 
Treasury's Office of Foreign Assets Control 

7. SUPPORT. 

Sage Accpac disclaims any responsibility to provide any customer support except as may be 
agreed under a separate agreement to render support services.  Upon registration of the Program 
You will receive thirty (30) days of free customer support, provided that the Program is registered 
within thirty (30) days of your payment of the license fee, as evidenced by your receipt.  All other 
support requires purchase of a support option, as outlined in any special offers that Sage Accpac 
may from time to time send You, or may be found on the Simply Accounting Web site at 
www.simplyaccounting.com.  Sage Accpac does not provide free customer support for the 
Evaluation Version, NFR Version, Student Version, or versions for Educational Purposes.. 

8. TERMINATION OF SUPPORT AND OTHER SERVICES. 

Software has a limited useful life for various reasons including changes in technology.  You are 
free to decide and responsible for deciding when to upgrade the Program.  Sage Accpac reserves 
the right to terminate Customer Support and all other services applicable to the Program in the 
event that the Program has become inoperable or incompatible with current operating systems, 
hardware, add-on products, product updates and services or other technologies.  To obtain up-to-
date information regarding which products, releases and related services are currently supported, 
contact a customer service representative.  If you are not operating a supported release or service, 
it may be necessary to license an upgrade or replacement product or service in order to continue to 
receive Customer Support and/or other updates.  Any updates licensed by You are considered part 
of the Program and subject to the terms and conditions of this Agreement, except to the extent a 
separate license agreement is provided in connection with such update.  Any replacement products 
or upgrades will be governed by a separate agreement. 

9. OWNERSHIP RIGHTS. 

(a) The Program is protected by United States patent, copyright laws and other intellectual 
property laws, and international treaty provisions.  Sage Accpac and its third party licensors, if 
any, retain all title to and, except as expressly and unambiguously licensed herein, all rights and 
interest in:  (i) the Program, including, but not limited to, all copies, versions, customizations, 
compilations and derivative works thereof (by whomever produced) and all related 
Documentation; (ii) the Sage Accpac trademarks, service marks, trade names, icons and logos; and 
(iii) any and all copyright rights, patent rights, trade secret rights and other intellectual property 
and proprietary rights throughout the world in the foregoing.  You acknowledge that your 
possession, installation, or use of the Program does not transfer to You any ownership, title, or 
registrable interest of any kind to the intellectual property in the Program, and that You will not 
acquire any rights to the Program except as expressly set forth in this Agreement.  You agree that 
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all backup, archival, or any other type of copies of the Program will contain the same proprietary 
notices that appear on and in the Program. 

(b) Should You decide to submit any materials to Sage Accpac via electronic mail, through or 
to Sage Accpac Web site(s), or otherwise, whether as feedback, data, questions, comments, ideas, 
concepts, techniques, survey responses, suggestions or the like, You agree that such submissions 
are unrestricted and shall be deemed non-confidential upon submission.  You grant to Sage 
Accpac and its assigns a non-exclusive, royalty-free, worldwide, perpetual, irrevocable license, 
with the right to sublicense, to use, copy, transmit, distribute, create derivative works of, 
commercialize, display and perform such submissions. 

10. RECOMMENDED ENVIRONMENT. 

This Program has been designed to work optimally in the environment documented within the 
Documentation.  Any defects, inconsistencies or issues arising out of operating outside the 
parameters set forth therein may not be supported by Sage Accpac and may require You to pay 
additional maintenance/upgrade costs to Sage Accpac to rectify. 

11. HIGH RISK ACTIVITIES. 

The Program is not fault-tolerant and is not designed or intended for use in hazardous 
environments requiring fail-safe performance, including without limitation, in the operation of 
nuclear facilities, aircraft navigation or communication systems, air traffic control, weapons 
systems, direct life-support machines, or any other application in which the failure of the Program 
could lead directly to death, personal injury, or severe physical or property damage (collectively, 
“High Risk Activities”).  Sage Accpac expressly disclaims any express or implied warranty of 
fitness for High Risk Activities. 

12. LIMITATION OF LIABILITY. 

BECAUSE SOFTWARE IS INHERENTLY COMPLEX AND MAY NOT BE FREE FROM 
ERRORS, YOU ARE ADVISED TO VERIFY THE WORK PRODUCED BY THE PROGRAM.  
TO THE FULLEST EXTENT PERMITTED BY LAW, SAGE ACCPAC'S LIABILITY TO YOU 
FOR ANY DAMAGES OR LOSSES ARISING HEREUNDER, WHETHER BASED IN 
CONTRACT, TORT OR OTHERWISE, SHALL BE LIMITED TO AND NOT EXCEED THE 
GREATER OF THE AMOUNT OF LICENSE AND SUPPORT FEES PAID BY YOU TO SAGE 
ACCPAC, OR SAGE ACCPAC’S SUGGESTED LIST PRICE FOR USE OF THE PROGRAM.  
TO THE FULLEST EXTENT PERMITTED BY LAW, SAGE ACCPAC SHALL NOT BE 
LIABLE FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL OR INDIRECT 
DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF TIME, LOSS OF GOODWILL, 
LOSS OF CONFIDENTIAL OR OTHER BUSINESS INFORMATION, LOSS OF 
ANTICIPATED PROFITS, REVENUE OR DATA, OR COSTS INCURRED IN CONNECTION 
WITH OBTAINING SUBSTITUTE SOFTWARE, FOR BUSINESS INTERRUPTION, WORK 
STOPPAGE OR COMPUTER FAILURE OR MALFUNCTION EVEN IF SAGE ACCPAC HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.  Sage Accpac will 
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have no responsibility for the Program if any portion of the Program has been modified, lost, 
stolen or damaged by accident, abuse or misapplication. 

13. UNITED STATES GOVERNMENT. 

If the Program is to be provided under a U.S. Government contract, the U.S. government’s right to 
use, modify, reproduce, release or disclose the Program is subject to restrictions set forth in 
subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs(c)(1) and (2) of the Commercial Computer Software - Restricted 
Rights at 48 CFR 52-227-19, as applicable. 

14. TERM AND TERMINATION. 

(a) This Agreement shall commence on the date You install the Program and shall continue 
until the earlier of:  (i) the date it is terminated in accordance with the terms herein; (ii) your 
acceptance of a superseding license agreement; or (iii) the expiration of the trial period, if 
applicable. 

(b) This license, and all of Sage Accpac's obligations hereunder, automatically terminate if You 
fail to comply with any provision of this Agreement.  Upon the termination or expiration of this 
Agreement for any reason whatsoever:  (i) the license granted hereunder shall immediately cease; 
and (ii) You shall immediately stop using the Program in any way and, within ten (10) days after 
the effective date of expiration or termination deliver to Sage Accpac, or certify that You have 
destroyed all copies of the Program. 

(c) If You licensed an NFR Version or Educational Version, this Agreement is effective unless 
and until You or Sage Accpac terminates the Agreement in accordance with the terms set forth 
herein or the terms set forth in your Other Sage Accpac Agreements or upon the earlier 
termination or expiration of your Other Sage Accpac Agreements. 

(d) If you licensed a Student Version, this Agreement is effective for a term of fourteen (14) 
months, unless sooner terminated by You or Sage Accpac in accordance with the terms set forth 
herein. 

(e) If You licensed an Evaluation Version, this Agreement is effective for a period 
commencing on the first date the Program is downloaded, installed or first run for a term of sixty 
(60) days, unless sooner terminated by You or Sage Accpac in accordance with the terms set forth 
herein.   

15. MISCELLANEOUS. 

(a) As a user of the Program, You assume the responsibility for the selection of the Program as 
being appropriate for your purposes.  You understand and agree that:  (i) You are solely 
responsible for the content and accuracy of all reports and documents prepared with the Program; 
(ii) using the Program does not relieve You of any professional obligation concerning the 
preparation and review of such reports and documents; (iii) You do not rely upon Sage Accpac or 
the Program for any advice or guidance regarding the appropriate tax treatment of items reflected 
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on such reports or documents; (iv) You will review any calculations made by using the Program 
and satisfy yourself that those calculations are correct; and (v) Sage Accpac's support service is 
designed to offer technical support for issues regarding the features and functionality of this 
Program in the recommended operating environments only.  

(b) To the fullest extent permitted by law and consistent with valid entry into a binding 
agreement, the controlling language of this Agreement is English and any translation you have 
received has been provided solely for your convenience.  In the event You have entered into this 
Agreement by means of the display of a translated version of this Agreement in a language other 
than U.S. English, you may request a U.S. English language version of this Agreement by notice 
to Sage Accpac.  To the fullest extent permitted by law, all correspondence and communication 
between You and Sage Accpac under this Agreement must be in English language.  The exclusive 
judicial forum for any action that You bring to enforce this Agreement shall be an appropriate 
federal or state court located in Georgia.  The exclusive forum for any action that Sage Accpac 
brings to enforce this Agreement shall be an appropriate federal, state or provincial court in the 
state or province, as applicable, in which You have your principal place of business.  In either 
case, this Agreement shall be governed by the internal laws of the forum state without regard to 
the conflict of laws provisions thereof. 

(c) This Agreement allocates risk between You and Sage Accpac as authorized by applicable 
law, and pricing of Sage Accpac’s products reflects this allocation of risk and the limitation of 
liability contained in this Agreement.  In the event that any provision of this Agreement is found 
invalid or unenforceable pursuant to judicial decree, the remainder of this Agreement shall be 
valid and enforceable according to its terms.  

(d) The Sage Accpac logo, Simply Accounting and the Simply Accounting logo are registered 
trademarks or trademarks of Sage Accpac SB, Inc. or its affiliated entities.  For an up-to-date list 
of copyright and trademark statements, refer either to the copyright page of the Program User 
Guide or the Help About Simply Accounting window within the Program.  Other product names 
mentioned may be service marks, trademarks, or registered trademarks of their respective owners 
and are hereby acknowledged. 

(e) No failure or delay of either party to exercise any rights or remedies under this Agreement 
shall operate as a waiver thereof, nor shall any single or partial exercise of the same or other rights 
or remedies preclude any further or other exercise of the same or other rights or remedies, nor 
shall any waiver of any rights or remedies with respect to any circumstances be constructed as a 
waiver thereof with respect to any other circumstances. 

(f) Quebec.  With regard to Quebec, the parties declare that they have required that this 
Agreement and all documents related hereto, either present or future, be drawn up in the English 
language only.  Les parties déclarent par les présentes qu'elles exigent que cette entente et tous les 
documents y afférents, soit pour le présent ou l'avenir, soient rédigés en langue anglaise 
seulement. 

(g) Sections 12 (Limitation of Liability), 14(b) (Term & Termination), 15(b) (Governing Law) 
and this Section 15(g) shall survive the expiration or termination of this Agreement. 
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(h) This Agreement constitutes the entire agreement between You and Sage Accpac with 
respect to the subject matter hereof, and supersedes all proposals, oral or written, and all other 
communications between the parties with respect to such subject matter.  This Agreement shall not 
be modified, except by written agreement signed by the parties hereto.  Sage Accpac shall not be 
bound by or liable to You for any pre-existing or contemporaneous written or oral representations 
or warranties, made by anyone, with respect to the Software Product, including any Sage Accpac 
Premier Advisor or Authorized Consultant or distributor or reseller or their respective agents, 
employees, or representatives. 

(i) Sage Accpac shall not be liable for and shall be excused from any failure to deliver or 
perform or for delay in delivery or performance due to causes beyond its reasonable control, 
including but not limited to, work stoppages, shortages, civil disturbances, terrorist actions, 
transportation problems, interruptions or power or communications, failure or suppliers or 
subcontractors, natural disasters or other acts of God. 

(j) All notices given hereunder shall be in writing and sent by overnight courier or delivered in 
person: (i) if to Sage Accpac, to Sage Accpac, Legal Department, 1505 Pavilion Place, Norcross, 
Georgia  30093; and (ii) if to You, to the address You indicated upon your registration of the 
Program. 

(k) You authorize Sage Accpac to send You information, including but not limited to 
marketing and promotional material, via facsimile, email, telephone, and other reasonable means. 
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Part 1 

Before you start using Simply Accounting to keep track of your 
day-to-day business, you’ll want to tailor it to suit your company. If 
you need more information than the Quick Start provides, use Part 1 
of this manual to guide you through the setup process. 

Chapter 1 — Introduction 

Chapter 2 — Setting Up Accounts 

Chapter 3 — Entering Basic Settings and Options 

Chapter 4 — Making and Accepting Credit Card Payments 

Chapter 5 — Setting Up Projects 
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Chapter 1 
Introduction 
 

Setting up Simply Accounting to suit your company is a detailed but simple 
process. This chapter gives you an overview of the steps you’ll take and the 
options you need to consider, whether you’re just starting your company or have 
been in business for a while.   

 

What You Need to Do ...................................................................................................................... 1–1 
International Coverage..................................................................................................................... 1–1 
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What You Need to Do 
Are you upgrading 
from an earlier 
version?  

 If you’re upgrading from an earlier version of Simply 
Accounting, you can probably skip Part 1. Use the Quick 
Start Guide to install Simply Accounting, then read the 
What’s New in Simply Accounting manual to find out about 
the new and changed features in this version.  

Are you new to Simply 
Accounting? 

 If you’re just starting out with Simply Accounting, gather 
your existing accounting records so that you have everything 
handy when you need to enter setup information. 

 If you’re unfamiliar with accounting, read the Accounting 
Manual to learn the basic concepts. (On the Help menu, choose 
Simply Accounting Manuals, then Accounting Manual).  

 Install Simply Accounting and, if you wish, practice using it 
with the sample data provided. (See the Quick Start Guide for 
instructions.)  

 Read or browse through Part 1 of this manual and be sure 
you understand the decisions you need to make and the 
options you can choose. The table on the next page will help 
you decide which chapters you need to read.  

 Once you’re familiar with the options available, either:  

■ Run the Setup wizard as described in the Quick Start 
Guide, and refer to this manual for more detail. Or,  

■ Work through the rest of Part 1 in this manual, setting 
up options and adding information at your own pace.  

International Coverage 
  Simply Accounting is available in both Canadian and U.S. 

versions, and this manual describes both. Watch for the flags 
that mark information that is unique to each country. 

■ The manual uses Canadian spelling (for example, 
“paycheque” for “paycheck”). 
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Where To Now? 
Check the list below to see which chapters you need to read. 

If you answer Yes to this question:  Read this chapter:  

Do you need to add or change any 
accounts?  

Chapter 2, “Setting Up Accounts.” 

Do you need to enter or change basic 
background information, such as company 
address, names of taxes and payroll 
deductions, and printing options? 

Chapter 3, “Entering Basic Settings and 
Options.”  

Do you plan to make or accept credit-card 
payments? 

Chapter 4, “Making and Accepting Credit-
Card Payments.”  

Do you want to keep track of revenues and 
expenses you allocate to projects or 
departments? 

Chapter 5, “Setting Up Projects.”  

Do you plan to use a budget to keep your 
business on track? 

Chapter 6, “Setting Up a Budget.”  

Will more than one person be using your 
company’s data? 

Chapter 7, “Using Simply Accounting on a 
Network.”  

Do you plan to print reports, cheques, or 
forms with Simply Accounting? 

Chapter 8, “Setting Up Printers.”  

Do you need to make a list of the items and 
services you buy and sell? 

Chapter 9, “Setting Up a List of Inventory 
and Services.”  

Do you plan to do business outside the 
country? 

Chapter 10, “Doing Business outside the 
Country.”  

Do you have year-to-date account 
balances, payroll information, remittance 
information, inventory on hand, or 
outstanding purchase and sales invoices?  

Chapter 11, “Adding Historical 
Information.”  

Do you plan to use Simply Accounting on 
a handheld device? 

Chapter 28, “Working Away from the 
Office.” 
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Chapter 2 
Setting Up Accounts 
 

Your account records are at the heart of your business. Organized into logical 
categories, they automatically calculate and update the value of your assets, 
liabilities, revenues, expenses, and equity. It’s important to set up these records 
carefully before you start doing business. 

 

Choose a Typical Set of Accounts for Your Business................................... 2–1 
Add or Change Accounts........................................................... 2–3 

Account Types ................................................................ 2–3 
Account Numbering ........................................................... 2–4 

Expanded Numbering...................................................... 2–5 
Accounting by Departments .................................................... 2–6 

Turn on the Option to Use Departmental Accounting.......................... 2–6 
Set Up Departments ........................................................ 2–7 
Assign Departments to Vendors, Customers, and Employees................... 2–8 
Changing or Removing the Department for a Specific Account ................. 2–9 

Adding Accounts ............................................................. 2–10 
Add GIFI Codes .............................................................. 2–11 
Assign Account Classes ....................................................... 2–12 

Set Up Bank Accounts ............................................................ 2–13 
Set Up Linked Accounts........................................................... 2–14 
Consolidating Data from Several Companies ........................................ 2–16 
Keeping and Comparing Additional Years of Financial History ....................... 2–17 

Keeping Track of Changes in Account Names or Numbers........................ 2–17 
Deleting Accounts ........................................................ 2–18 

Set Up Accounts for Reconciliation ................................................. 2–19 
Before You Start .............................................................. 2–19 
Two Steps to Setting Up ....................................................... 2–19 

Add and Link the Accounts You Need ...................................... 2–19 
Reconciling an Account for the First Time ................................... 2–20 

Tips for Reconciling Credit Cards .............................................. 2–22 
Check Your Chart of Accounts ..................................................... 2–22 
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What You Need to Do 
 Determine whether you need to create a consolidated parent 

company. 

 From the templates that come with Simply Accounting, 
choose a typical set of accounts for your business.  

 Add, change, or remove accounts.  

 Set up bank accounts. 

 Set up linked accounts to update all related records 
automatically when you process a transaction.  

 Set up accounts for reconciliation so you can quickly 
compare your bank and credit-card statements to your 
Simply Accounting records.  

 Check your chart of accounts. 

Choose a Typical Set of Accounts for Your Business 
Simply Accounting comes with predefined sets of accounts for 
many different types of companies. Adapting one of these 
“company templates” is much easier and faster than starting 
from scratch and typing in all your accounts one at a time.  

If you have completed the Setup wizard as described in the 
Quick Start manual, you may already have chosen a set of 
accounts. If not, follow the steps in this section. 

To choose a company template:  

1. Close all Simply Accounting windows except for the Home 
window. 

2. In the Home window on the File menu, choose New 
Company. 
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3. Use the Setup wizard to guide you through the process. 

 

Once you have entered your fiscal-
year dates, you can either complete 
the Setup wizard, or click Next, then 
Finish and come back to it later. (To 
start the Setup wizard later, in the 
Home window choose Setup, then 
Wizards, then Settings.) 

Choose Copy a 
Template Containing 
Typical Accounts 

 

You’ll probably need to rename or change some of the accounts 
to suit your own business, as described in the next section.  
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Add or Change Accounts 

You may need to add some new accounts, change or rename 
others, or remove the ones you don’t need. You can add 
accounts at any time, and can usually change or remove them 
unless the program prevents it. (For example, you can’t remove 
an account unless it has a zero balance.)  

To find out more about changing or removing accounts, see 
“Maintaining Records” in Chapter 20. 

Tip:  If you are making a lot of changes, or need more help, you 
can use the Modify Accounts wizard to add, change, or remove 
accounts. (In the Home window on the Setup menu, choose 
Wizards, then Modify Accounts, and follow the steps on the 
screen.) You can also drag-and-drop accounts and use the Insert 
and Delete keys in the Accounts icon window to make changes 
quickly.  

Account Types 

Simply Accounting uses the following account types to format 
your financial statements.  

Type of 
Account 

Function on the Financial  
Statement 

Relationship to Other Types of 
Accounts 

Section 
Heading 

Divides the financial statement into 
sections (Assets, Liabilities, Equity, 
Revenue, and Expense). 

The program assigns the section 
name; you cannot change it. Accounts 
within a section are further classified 
into groups. 

Group 
Heading 

Classifies groups of accounts within a 
section. 

Introduces two or more group or 
subgroup accounts.  

Subgroup  Stores amounts processed in the 
transaction windows. Balances are 
shown in the left column of the 
financial statement. 

Used for accounts whose balances 
will be subtotalled rather than 
included directly in the group total. 
Subgroup accounts must be followed 
by a group total before the next 
heading. 
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Type of 
Account 

Function on the Financial  
Statement 

Relationship to Other Types of 
Accounts 

Group  Stores amounts processed in the 
transaction windows. Balances are 
shown in the right (total) column of the 
financial statement. 

Used for amounts included directly 
in the group total. 

Subgroup 
Total  

Contains the subtotal of all the 
consecutive subgroup accounts above 
it. The program displays the amount in 
the right column of the financial 
statement. 

Must follow a subgroup account. The 
balance is included in the group total.

Current 
Earnings 

Shows the difference between revenue 
and expense account totals. The 
program calculates the balance every 
time you make an entry that affects a 
revenue or expense account, and 
displays it in the Equity section of the 
balance sheet.  

You cannot process transactions to 
this account. 

Group 
Total 

Gives the sum of all group and 
subgroup totals above it, up to the 
preceding group heading. The 
program displays the amount in the 
right column of the financial 
statement. 

You cannot process transactions to 
this account. 

Section 
Total 

Gives the sum of all accounts within 
the same section of the financial 
statement. It includes all the group 
totals. 

You cannot change the section name; 
the program assigns it. 

Account Numbering 

To ensure that related accounts are grouped together, and that 
the program prints the accounts in the right order on financial 
statements, Simply Accounting uses the following account 
numbering system. You cannot enter an account number outside 
this range, unless you are using Simply Accounting Premium or 
higher. 
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Asset accounts  1000 to 1999 
Liability accounts 2000 to 2999 
Equity accounts  3000 to 3999 
Revenue accounts 4000 to 4999 
Expense accounts  5000 to 5999 

When you assign account numbers, leave gaps between them. 
(For example, leave a gap of 10 or 20 numbers.) If you later need 
to add an account in the same section, you can insert it between 
two related numbers. 

Expanded Numbering 

 Simply 
Accounting 
Premium or 
higher 

If you use Simply Accounting Premium or higher you can 
expand the account numbering system. You can add or remove 
digits from your account numbering system or change the start 
and end numbers used by any of the account groups. An 
expanded numbering system must follow the same order as 
listed earlier in the “Account Numbering” section; however, you 
can leave spaces in the numbering system for later use. 

  Note:  Any changes you make to your account numbers will 
automatically update your linked accounts. And, if you have 
converted your data from another version of Simply Accounting, 
you will probably find it easiest to add extra digits to your 
accounts and leave the structure similar to the way it is currently. 

To set up an expanded numbering system: 

1. In the Home window from the Setup Menu, choose System 
Settings, and then Settings. 

2. Under General, choose Numbering, and select a number of 
digits from the drop-down list. 

3. If you would like to change the numbering of any account 
group, enter the new numbers in the Starting Account 
Number and Ending Account Number fields. 

4. Click OK when you have finished. 
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Accounting by Departments 

Simply Accounting 
Pro or higher  

If you use Simply Accounting Pro or higher, you can add a 
four-digit department code to your account numbers to allow 
accounting by department. This lets you:  

■ Define a greater range of account numbers.  

■ Prepare reports that group and compare the departments of 
your business.   

For example, you can divide account 5300 (Wages) into 
departments 0100 (Administration), 0200 (Marketing), and 
0300 (Operations). As you pay wages, you can print financial 
reports to compare the wage expense of each department. 

To use departments with your accounts, you need to: 

■ Turn on the Use Departmental Accounting option. 

■ Set up departments and specify which accounts should or 
should not use them. 

■ Assign departments to your vendors, customers, and 
employees. 

These topics are described in the sections that follow. 

Turn on the Option to Use Departmental Accounting  

When you first install Simply Accounting, the Use Departmental 
Accounting option is turned off. To be able to do accounting by 
departments, you need to turn on the option (only once) by 
following these steps. 

Note:  Consolidated companies do not recognize departments. 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

2. Under General, choose Departments, and check the Use 
Departmental Accounting box. 

3. Click OK. 
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Set Up Departments 

After you have turned on the option to use departmental 
accounting, you add a list of the departments you want to use. 
You can change the names of departments, or delete them if you 
no longer need them, as described later in this section. 

To add departments: 

1. In the Home window on the Setup menu, choose System 
Settings, Settings, General, and then Departments. 

2. Fill in the information. 

 

Enter a unique, 4-digit 
code. 

Enter a description of 
the department, up to 
25 characters. 

Click or press the 
Spacebar to switch 
between Active and 
Inactive. 

 

3. Click OK. 

When you add a department, the department is automatically 
added to all group and subgroup accounts. This means that the 
account and department numbers will appear when you select 
an account from a list, such as the list of accounts in a transaction 
window.  

If you don’t plan to use departments with all of your accounts, 
you can “turn off” departments for specific accounts. If you want 
to use a different department with a particular account, you can 
change it. For instructions on both of these tasks, see “Changing 
or Removing the Department for a Specific Account,” later in 
this section. 
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To change the name of a department: 

1. In the Home window on the Setup menu, choose System 
Settings, Settings, General, and then Departments.  

2. Select a department and enter a new name or department 
code. 

Click or press the 
Spacebar to switch 
between Active and 
Inactive. 

Select a department 
to rename or 
renumber it. 

 

3. Click OK. 

To delete departments: 

1. In the Home window on the Setup menu, choose System 
Settings, Settings, General, and then Departments.  

2. Select a department code and press the Delete key. 

3. Click OK. 

Assign Departments to Vendors, Customers, and Employees 

After you have set up departments as described in the previous 
section, you should assign departments to your vendors, 
customers, and employees. Simply Accounting will then 
automatically use the appropriate departments whenever you 
process transactions, such as purchases, payments, sales, 
receipts, or paycheques.  
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To find out how to assign departments to your vendors, 
customers, and employees, refer to Chapters 12, 13, and 15 
respectively.  

You can also select an account that uses a department when you 
link an account in the inventory records. However, this is very 
restrictive and should be done only in special cases. This is 
discussed later in “Set Up Linked Accounts” in this chapter, and 
in “Add Accounts to Keep Track of Inventory and Service Items” 
in Chapter 9. 

Changing or Removing the Department for a Specific Account 

If you want to use a different department with an account, 
follow these steps. 

1. In the Home window on the Setup menu, choose System 
Settings, Settings, General, and then Departments. 

2. Click Assign Accounts and select a department. To remove 
an account from a department, select the account from the 
Accounts That Use This Department list and click Remove. 

If an account in this 
area should use the 
department, select the 
account, and click 
Select. 

Select the department. 

If an account should not
use the department, 
select the account, and 
click Remove. 

 

Tip:  To choose several random accounts at once, press the 
Ctrl key while selecting (clicking) each account. To select a 
sequential range of accounts, click (highlight) the first 
account, then press the Shift key and simultaneously click 
the last account of the range. 
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You can also use the Chart of Accounts Records window to 
remove the department from an account, as described later in 
“Adding Accounts.” 

Note:  If you remove a department from the Accounts Payable 
group or subgroup, you will be unable to assign that department 
to vendors. Similarly, if you remove a department from the 
Accounts Receivable group or subgroup or from the Regular 
Wage Expense account, you will be unable to assign that 
department to customers or employees respectively. 

Adding Accounts 

 

1. In the Home window, on the General tab, choose the 
Accounts icon.  

2. On the File menu or toolbar, choose Create, then fill in the 
fields on the Account tab.  

 

This field appears in the 
Canadian version. It’s 
described under “Add GIFI 
Codes” later in this 
chapter. 

Account classes are 
discussed under “Assign 
Account Classes,” later in 
this chapter. 

If you haven’t finished 
entering history, enter the 
account’s opening 
balance. History is 
discussed in Chapter 11. 

 

3. If you want to use this account to keep track of project 
revenues and expenses, see Chapter 5, “Setting Up Projects.”  

4. If you want to store additional information about this 
account, fill in the Additional Info tab.   
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Fill in the additional 
information about the 
account.  

If you need to change the 
name of a field, in the 
Home window, choose 
Setup, System Settings, 
Names and Terminology. 
Then enter the new name 
on the Accounts tab.   

Simply Accounting 
Pro or higher 

5. If you use Simply Accounting Pro or higher and have set up 
departments, use the Departments tab to specify which 
departments should be used with the account: 

 

If the account should use 
the department, choose 
the department here, 
and click Select. 

If the account should not 
use the department, 
choose the department 
here, and click Remove. 

 

 
Save 6. On the File menu, choose Save.  

 Add GIFI Codes  

If you file your corporate tax returns (T2s) electronically, you are 
required to assign a GIFI (General Index of Financial 
Information) code to each account. Your accountant or the 
Canada Revenue Agency can tell you more about GIFI codes.  

■ If you’re using one of the company templates that comes 
with Simply Accounting, the codes are already assigned. 
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However, if you add or change any accounts, you may need 
to add or change GIFI codes.  

■ If you typed in your accounts one at a time, you need to add 
a GIFI code to each account.  

We recommend that you ask your accountant to review your 
chart of accounts to be sure the codes are correct.  

To add or change a GIFI code: 

1. In the Home window, choose the Accounts icon, select an 
account, and enter the GIFI code. 

 

Type the GIFI code here. 

 

 
Save 2. On the File menu, choose Save.  

Assign Account Classes 

Account classes let you organize your accounts into categories. 
For example, when you select cheque or cash as the payment 
method on an invoice, the program provides a list of the 
accounts that are set up as bank and cash accounts so you can 
choose one to make or receive the payment.  

Account classes also provide a more informative Statement of 
Cash Flows, which shows you where your money is coming 
from and where it’s going. If you are familiar with Crystal 
Reports or Microsoft Excel, you can also use this information to 
create custom reports.  

It’s important to set up your account classes correctly. For 
example, be sure to classify your current and long-term assets 
and liabilities properly, and to assign an expense account for 
amortization (depreciation).  
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To assign account classes: 

1. In the Home window on the General tab, choose the 
Accounts icon, then select a group or subgroup account. 

2. In the account record, click the Class Options tab and fill in 
the information.  

 

Select an account class.  

Depending on the class 
you selected, other fields 
may appear, allowing you 
to store additional 
information about the 
account.  

 

 
Save 3. On the File menu, choose Save.  

Set Up Bank Accounts  
 

If you set up an account as a Bank account, you can store 
additional information that makes it easy to use online banking. 
For example, you can keep a record of the bank’s transit number 
and Web site address.  

1. In the Home window on the General tab, choose the 
Accounts icon, then select the account. 

2. Click the Class Options tab and fill in the information. 

Select Bank. 

Select your bank from 
the list, then fill in the 
other information.  

If you have numbered 
deposit slips, enter the next 
number, if not, leave this 
field blank.  
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 If you don’t see a list of banks in the Institution field, you can 
type the name of the bank. To specify cheque numbers, go to 
Setup, Reports and Forms, then Cheques. 

 
Save 3. On the File menu choose Save.  

Set Up Linked Accounts  
 

Simply Accounting uses linked accounts to update all related 
accounts automatically when you process a transaction. For 
example, if you make a payment to a vendor, the program 
decreases the balance in your bank account and decreases the 
balance you owe that vendor.  

If you used a template to create your chart of accounts in Simply 
Accounting, many of the linked accounts are already set up. 
However, you may need to add or change accounts to suit your 
business, or to remove or unlink an account you don’t need. For 
example, if you are never charged for freight, you can unlink 
and remove the Freight Expense account.  

Tip:  If you are making a lot of changes, or need more help, you 
can use the Linked Accounts wizard. In the Home window on 
the Setup menu, choose Wizards, then Linked Accounts, and 
follow the steps on the screen. 

To set up a linked account: 

1. In the Accounts window, add the account you want to link, 
if it is not already there. (For instructions, see “Adding 
Accounts,” earlier in this chapter.)  

2. In the Home window on the Setup menu, choose System 
Settings, then Linked Accounts.  

3. Select the module that contains the account you want to link.  
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If you plan to keep track of 
transactions in more than 
one currency, fill in the 
linked accounts to use for 
foreign currencies.  

This linked account is used 
for prepaid orders and 
deposits. 

 

Simply Accounting 
Pro or higher 

Note:  If you select an account and department number (in 
Simply Accounting Pro or higher), then all transactions for 
the account will be recorded to that one department. For 
example, if you specify account 2200-0100 for Accounts 
Payable when you link accounts, then all purchase  
transactions for every vendor will use that account, 
regardless of the vendor’s department. You would not be 
able to record purchases to Accounts Payable to different 
vendor departments. 

4. Click OK.  

To remove a linked account:  

1. In the Home window on the Setup menu, choose System 
Settings, then Linked Accounts. 

2. Select the module in which you want to unlink and remove 
the account.  
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Select the account 
you want to unlink, 
then press the 
Backspace key. 

 

3. Click OK. 

4. In the Accounts window, remove the account. (For more 
information on removing accounts, see “Maintaining 
Records” in Chapter 20.) 

Consolidating Data from Several Companies 
 Simply 

Accounting 
Premium or 
higher 

If you are using Simply Accounting Premium or higher, you can 
consolidate multiple companies. This is very helpful for 
companies owned by one “parent” company with many 
“subsidiary” companies scattered throughout the state/province 
or country, or even internationally, which are required to 
provide consolidated company reports. 

Before you consolidate, you should review the chart of accounts 
for each subsidiary company to determine how it will relate to 
the chart of accounts in the parent company. 

Note:  Departmental accounting is ignored by the consolidated 
parent company. 

For more information on creating a consolidated company, see 
Chapter 24, “Maintaining a Healthy Business.” 
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Keeping and Comparing Additional Years of 
Financial History 
Simply Accounting 
Pro or higher 

If you are using Simply Accounting Pro or higher, you can keep 
monthly account balances and include them on comparative 
financial statements for up to 100 years. This lets you: 

■ Compare your current year’s transactions to those of 
previous years, to have a better idea of how your business is 
doing.  

■ Print historical financial statements easily, without having to 
restore a backup file.  

The program adds to your financial history when you start a 
new fiscal year.  

Clearing financial 
history 

You can clear the data at any time by using the Clear Financial 
History command. In the Home window on the Maintenance 
menu, choose Clear Data, then Clear Financial History, and select 
the dates to clear. 

Keeping Track of Changes in Account Names or Numbers 

When you start a new fiscal year, Simply Accounting (Pro or 
higher) records the chart of accounts (account names and 
numbers), opening balances, and transaction details for the year 
that is ending, and retains any financial history from previous 
years. 

If you change any account number or name during the new 
fiscal year, the program stores information about the account’s 
relationship to accounts in the previous year, on the Related 
Historical Accounts tab in the account record.  

Note the following:  

■ You can set up related accounts for any group or subgroup 
account. You cannot relate group headings, group totals, 
subgroup totals, or current earnings accounts.  

■ The related accounts must be in the same section of the chart 
of accounts (assets, liabilities, and so on).  
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■ You can select more than one account from the previous 
year to relate to the account, although you cannot relate the 
same account from the previous year to more than one 
account in the current year.  

■ If you rename an account in the current year, Simply 
Accounting renames it in the previous year also. 

You can print a list of accounts used in earlier fiscal years when 
you print the chart of accounts. In the Home window on the 
Reports menu, select Lists, then Chart of Accounts. Select the 
years you want to include, then click OK. 

You can also print a list of unrelated accounts, to see which of 
your accounts should be related to accounts in the current year. 
On the Reports menu choose Management Reports, then 
General, then Unrelated Historical Accounts. The report lists 
accounts that are not related to any accounts in the current chart 
of accounts.  

To record the relationship of current and historical 
accounts:  

1. In the Accounts window, open the account you want to 
relate to other, older accounts. 

2. On the Related Historical Accounts tab, select a fiscal year, 
then enter an account.  

3. Close the Chart of Accounts Records window.  

Deleting Accounts 

If you delete an account, the relationship between accounts from 
the previous year and accounts in the current year is lost. The 
balances from related accounts in earlier years will not appear 
on multi-period reports, so the reports may be out of balance. To 
maintain the relationship between current and past accounts, 
and thus ensure that you can print meaningful comparative 
reports, be sure to set up a new relationship on the Related 
Historical Accounts tab.  

If you need to delete an account, we recommend that you 
renumber it, rename it “Deleted Account,” and check the Omit 
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From Financial Statements If Balance Is Zero box in the account 
record. This will maintain the relationship between past and 
current charts of accounts and ensure that the multi-period 
reports balance.  

Set Up Accounts for Reconciliation 
 

Reconciliation lets you identify errors or unexpected differences 
between your accounting records and the statements sent to you 
by your bank or credit-card merchant. Such differences include 
service charges, fees, and bank interest earned, which you may 
not have entered in your Simply Accounting records.  

Before You Start 

Before you set up an account for reconciliation, you should:  

 Finish entering your company’s historical records, as 
described in Chapter 11.  

 Set up credit cards, if you plan to reconcile statements from 
your credit-card merchants. Refer to Chapter 4, “Making and 
Accepting Credit-Card Payments,” for more information.  

 Set up accounts to use online banking, if you want to use this 
feature. Online banking can eliminate much of the work of 
reconciling, by letting you download your bank statement 
and check the entries automatically. Refer to “Set Up Bank 
Accounts,” earlier in this chapter, for more information.  

Two Steps to Setting Up 

Add and Link the Accounts You Need 

 

1. In the Accounts window, add the accounts you plan to 
reconcile, if you have not already done so. Refer to “Adding 
Accounts,” earlier in this chapter, for more information.  
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2. In the Accounts window, add the income, expense, and 
adjustment accounts you will need to keep track of interest 
earned, service charges, and adjustments.  

3. In the Accounts window, select the account you want to set 
up for reconciliation, then click the Reconciliation and 
Deposits tab.  

4. Check the Save Transactions For Account Reconciliation box, 
then click the Set Up button.  

You can enter more 
meaningful names for the 
accounts, if you wish. 

 
 
 

 

Select income accounts 
to track the amounts 
your bank deposits in 
your account, such as 
interest earned.  

Select expense accounts to 
track amounts such as service 
charges and loan interest.  

Select an account for 
errors and occasional 
small adjustments.  

 

5. Click OK.  

Reconciling an Account for the First Time 

 

1. In the Home window on the General tab, choose the Account 
Reconciliation or the Reconciliation and Deposits icon. 

2. Select the account you want to reconcile for the first time.  

3. Enter the start and end dates from the statement you are 
reconciling, then enter the reconciliation date. If you have 
more than one unreconciled statement for this account, you 
can reconcile them either together or separately. If you 
reconcile them separately (which might be easier if you have 
a lot of them), reconcile the oldest statement first. 
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On the Transactions tab, read the instructions for reconciling 
an account for the first time, and then click the Add Prior 
Outstanding button. 

4. Enter a date in the Show Resolved Transactions On Or After 
field. This date determines which transactions are displayed. 
If you know the date of your oldest outstanding transaction 
for this account, choose that date; otherwise, accept the 
displayed date. Simply Accounting will display transactions 
that were entered after the earliest transaction date of the 
current or last year. 

5. If you want to sort the transactions, choose a method from 
the Sort Transactions By field. This will change the order in 
which the transactions appear when you create reports from 
the Report menu. The Order of Entry option allows you to 
sort transactions by the order in which they were originally 
entered.  

6. Select all the transactions that were still outstanding as of the 
start date of your bank or credit card statement, and click 
Add. You can then change the Show Resolved Transactions 
date to find other transactions.  

7. If you have performed any transactions that you have not 
recorded in Simply Accounting, click the Insert Outstanding 
button to add these amounts manually.  

8. Print the Resolved Transactions or the Outstanding 
Transactions report (or both) to save in your account 
reconciliation files. They are both available from the Report 
menu in the Add Outstanding Transactions window.  

9. Click OK. 

The account is now ready to reconcile. To find out how to 
perform a regular monthly reconciliation, read “Reconciling 
Statements from a Bank or Credit-Card Company” in 
Chapter 20. 
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Tips for Reconciling Credit Cards 

Track credit-card 
transactions 
separately 

To keep track of credit-card transactions, create a separate asset 
account for each credit card you use or accept, and then set up 
the credit-card accounts for reconciliation. 

Reconcile credit-card 
accounts first 

You will not find deposits for individual credit-card sales on 
your bank statement. The credit-card company normally  
transfers the amounts it owes you in lump sums to your bank, 
based on each day’s credit-card sales. Therefore, it is a good idea 
to reconcile your credit-card accounts before reconciling your 
Bank account.  

For more information about reconciling credit-card merchant 
statements, refer to “Reconciling Statements from a Bank or 
Credit-Card Company” in Chapter 20.  

Check Your Chart of Accounts 
 

After you have set up your accounts, print a copy of your chart 
of accounts and make sure you have entered everything 
correctly. Keep a copy for your records.  

Where To Now? 
 If you have been in business for a while before starting to 

use Simply Accounting, you should enter your historical 
records (the transactions that occurred before the earliest 
transaction date, normally the first day of your fiscal year). 
This ensures that your business records are accurate and up 
to date. Refer to Chapter 11 for more information about 
adding history.  

 If you have finished setting up accounts for reconciliation 
and are ready for regular monthly reconciliation, refer to 
“Reconciling Statements from a Bank or Credit-Card 
Company” in Chapter 20  
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Chapter 3 
Entering Basic Settings and Options 
 

You’ll need to enter some basic information before you start doing business, such 
as tax names and rates, payment terms, and printing options. 
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What You Need to Do 
You can use the Setup wizard, described in the Quick Start 
manual, to enter a lot of this information. However, if you need 
more detail, follow the steps in this manual to set up the options 
you need.  

 Enter your company name, address, fiscal year, and other 
background information.  

 Set up sales taxes.  

 Set up payroll options, taxes, and deductions.  

 Enter payment options for vendors and customers. 

 Enter payroll authorities as vendors, so that you can track 
amounts you owe for payroll liabilities. 

 Set up shippers so you can track incoming and outgoing 
shipments.  

 Set up printing and e-mail options in Simply Accounting.  

 If needed, set up fields to store additional information about 
your accounts, vendors, customers, employees, inventory, 
and projects.  

 Customize colours and fonts for reports.  

 Set your preferences for screen colour, terminology, and 
other display options.  

 Set up users and passwords to protect your data.  

Enter Background Information about Your 
Company 

Simply Accounting records your company name, address, and 
Canadian business number or American federal and state ID 
number and prints them on many reports and forms, so you 
need to include this information in your records. 
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You also need to specify a fiscal year for your company. We 
recommend that you ask your accountant to help you select a 
fiscal year suitable for your company and type of business. 

Dates Simply Accounting uses certain significant dates to help protect 
your data, save time, and prevent errors. Some of these dates 
set limits on the entries you can add and delete. 

Earliest Transaction Date.  The earliest date on which you can 
process transactions for the current fiscal year. If you’re setting 
up Simply Accounting for the first time, this is usually the day on 
which you convert from your former accounting system, the 
date for which you have a complete, balanced set of data.  

Latest Transaction Date.  The latest date on which you have 
processed transactions for the current fiscal year.  

Session Date.  The date associated with the current work 
session, usually today’s date. You enter this date when you start 
Simply Accounting, and the program uses it as the transaction 
date unless you change it when you make an entry. 

Transaction Date.  You can process transactions in the past or 
the future if needed. In the Home window on the Setup menu, 
choose System Settings, then Settings. Under Company select 
System. Check the Do Not Allow Transactions Dated Before box 
and enter a date in the field, or the Allow Transactions in The 
Future box. (You need to do this only once.)  

 
 Company 

Type 
If you use Simply Accounting Premium or higher and specify a 
Company Type, features on the My Business tab are customized 
to work more closely with your industry: 

■ A compilation of industry-specific reports appears in the 
My Reports window. 

■ Industry-specific accounts are added. For example, if you 
run a motel and choose Accommodation as your company 
type, Simply Accounting will add inventory expense and 
asset accounts for Linen, Rugs, and Glassware, and Revenue 
accounts for Dining, Conventions, and Banquets. 

■ Business tips for your industry are added to the How Do I 
list. 
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To enter background information about your company:  

1. In the Home window on the Setup menu, choose System 
Settings, then Company Information.  

 

The program prints this name on reports, 
and on invoices and other forms if you wish.  

The Business Number 
appears on invoices, 
purchase orders, and T4 
slips.  

Some of the date fields are 
available only if you have 
not finished entering history 
(described in Chapter 11). 

Type a date, or click the 
button and select a date 
from the calendar. 

The program fills in these dates 
after you close the books at 
the end of each fiscal year 
(Pro or higher).  

Choose a Company Type to 
customize the program to 
work best with your industry. 
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The program prints this name 
on reports, and on invoices 
and other forms if you wish.  

The Federal ID Number is 
printed on W-2 forms. 

Some of the date fields are 
available only if you have 
not finished entering history 
(described in Chapter 11). 

The program fills in these dates 
after you close the books at 
the end of each fiscal year.  

 

2. Fill in the information then click OK. 

Set Up Sales Taxes 
You can set up customized sales taxes, naming and defining 
rates and combining taxes to suit the needs of your company 
and the area in which you do business.  

Pre-set sales taxes If you are using the Canadian or U.S. version of Simply 
Accounting, the program sets up the sales taxes for you when  
you run the Setup wizard to set up a new company, or when you 
upgrade from an earlier version. However, you should check 
that you have all the codes and rates you need, and set up 
additional ones if necessary. For example, if you sell goods or 
services in a neighboring province or state that uses different 
sales taxes, you should set up taxes for those jurisdictions as 
well.  

To set up taxes, you need to:  

■ List the taxes you use. 
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■ Set up tax codes that group the different taxes and rates 
together. 

■ Enter tax codes for vendors and customers. 

■ Enter tax information for inventory items. 

List the Sales Taxes You Use  

1. In the Home window on the Setup menu, choose System 
Settings, then Sales Taxes. 

2. Fill in the information on the Taxes tab.  

 

Tax:  Type the name of the tax, up to 20 characters.  

Tax ID Included on Forms:  Type a tax ID, such as a 
Canadian Business Number or U.S. state tax ID, that you are 
required to include on invoices and other forms that use this 
tax.  

Exempt from This Tax:  Choose Yes if your company is not 
required to pay this tax. 

Is This Tax Taxable:  Select Yes if this tax is subject to 
another tax. In the Taxable Tax List that appears, click to add 
a check mark beside each tax that is to be charged on the tax. 

 Account to Track Tax Paid on Purchases:  If you do 
business in Canada, select an account to record the tax you  
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pay on purchases. Normally, this would be a liability 
account. If you do not enter an account, the tax will be 
included in the cost of the items purchased and will not 
appear separately on financial reports.  

Account to Track Tax Charged on Sales:  Select an 
account. Normally, this would be a liability account. If you 
do not enter an account, you will not be able to charge 
customers this tax.  

Report on Taxes:  Select Yes to include this tax on the Tax 
report.  

3. Follow the steps in the next section to set up tax codes.  

Set Up Tax Codes  

Tax codes let you combine different taxes and rates into groups, 
so you can quickly apply all the required taxes at once. The 
codes appear when you select a vendor or customer in the 
Purchases or Sales window, and Simply Accounting fills in the 
taxes associated with that code. This lets you quickly enter the 
taxes for a vendor or customer who is subject to several different 
taxes, without having to look up the rates.  

Simply Accounting prints the codes on invoices so customers 
can tell what they have been charged.  

1. Fill in the information on the Tax Codes tab.  

Type a one- or two-
character code to identify 
each combination of taxes 
you have set up.  

Type a description of the 
tax.   
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Type a one- or two-
character code to identify 
each combination of taxes 
you have set up. 

Type a description of the 
tax.   

2. For each code, double-click the code or description to 
display the Tax Code Details screen.  

 

Fill in the details about the 
tax code.  

 

 

Fill in the details about the 
tax code. 

 

3. Click OK to save the details, then click OK again to save the 
rest of the sales tax information.  
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Set up codes for 
tax-exempt status 

If some of your customers are exempt from one or more of the 
taxes that you normally charge, you should set up tax codes that 
do not include the tax, and use these codes for the tax-exempt 
customers. Similarly, if you are exempt from paying tax to some 
of your vendors, set up tax codes for vendors to whom you do 
not pay tax. If you do sometimes charge or pay the tax to these 
customers or vendors, set up tax-exempt codes, and remember 
to set the Tax Exempt setting to No on the Taxes tab in the 
customer and vendor records.  

Enter Tax Codes for Vendors and Customers 

Vendors and existing 
customers 

After you have set up tax codes as described in the previous 
section, you should enter a tax code for each vendor and each 
current customer.  

To enter tax codes for new vendors, or existing vendors and 
customers:  

1. In the vendor record, enter a tax ID on the Address tab.  

2. In the customer record, enter a tax ID on the Taxes tab.  

3. On the Taxes tab, specify whether the vendor or customer is 
exempt from each tax. If the customer is exempt, Simply 
Accounting will print their tax ID on the invoice and will not 
charge the tax. 

4. Select the tax code that is normally associated with the 
vendor or customer. 

5. Close the vendor or customer record to save your entries. 

New customers Once you  have added tax codes to your existing customer 
and vendor records, you can set up Simply Accounting to 
automatically assign a default tax code to each new customer 
record that you create. 

6. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

7. Under Customers and Sales, choose Options, and select a tax 
code from the Tax Code For New Customers field. 
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8. Click OK. 

Enter Tax Information for Inventory Items 

In inventory records, use the Taxes tab to record taxes and duty 
rates.  

1. In the inventory record, fill in the Taxes tab.  

Specify whether the item is 
exempt from any taxes.  

This appears only if you 
chose to track duty in 
System Settings. 

 

2. Close the inventory record to save your entries.  

Tax Exemptions for Vendors, Customers, and Items 

Note that tax-exempt status always takes precedence. If you are 
buying or selling an item that is exempt from tax, Simply 
Accounting does not calculate tax, even if the vendor or 
customer normally charges or pays it. Similarly, if you are 
selling a taxable item to a customer who has tax-exempt status, 
Simply Accounting does not calculate tax.  
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Set Up Payroll Options 
Simply Accounting comes with several pre-defined names for 
different types of employee income, payroll taxes, deductions, 
entitlements, and additional expenses. You can change these 
names to suit your company. For example, if your company 
offers a dental plan, you can change the name of one of the 
miscellaneous deductions to Dental. 

If you need to change these names, follow the steps in this 
section. 

Change Income and Deduction Names  

1. In the Home window on the Setup menu, choose System 
Settings, then Names and Terminology.  

2. On the Payroll tab, rename any of the payroll income and 
deduction fields to suit your company.  

 

If you rename any of the 
deduction fields, 
remember to rename the 
linked accounts 
(described in Chapter 2). 

Pre-defined income types 
are displayed on a shaded 
background. They cannot 
be renamed. 

 

3. Click OK. 
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 Enter Canadian Payroll Tax Information  

1. In the Home window on the Setup menu, choose System 
Settings, then Settings.  

2. Under Payroll, choose Income, and fill in the information.  

 
 

 
Enter the EI (Employment Insurance) factor, and the EHT 
(Employer Health Tax for Ontario and Newfoundland), 
and QHSF (Quebec Health Services Fund) rates. 

This can be an hourly rate, 
or a differential rate. These 
terms are defined on the 
next page. 

This can be an income, 
benefit, reimbursement, 
hourly rate, differential rate, 
or piece rate.  

Check the Vacation box 
to calculate vacation pay.

Indicate the taxes that apply 
to each type of income. 

 
System-defined 
income types 

Advance, Benefits, Benefits (Quebec), Vacation, Vacation 
Paid, Regular, Overtime 1, and Overtime 2 are system-
defined incomes. For Advance, Benefit, and Benefits 
(Quebec), you cannot modify the Unit of Measure or the tax 
calculation options. For Regular, Overtime 1 and Overtime 2, 
you can select either hourly rate or differential rate as the 
income type, and you can modify the tax calculation options. 

Insurable hours The Calculate Insurable Hours option lets you specify 
whether the hours worked for the income should be reported 
on paycheques as EI insurable hours. The Calculate Ins. Hrs. 
option differs from the EI option, which indicates that the 
income is subject to EI deductions. 

You may or may not be able to select the Calculate Insurable 
Hours option, depending on the income type: 
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If type of income is: Then Ins. Hrs. option: 

Income Can be selected or not. 

Hourly Rate Is selected automatically, 
and cannot be edited. 

Differential Rate (and 
remaining income types) 

Is not selected, and cannot 
be edited. 

 
The Calculate Insurable Hours option may determine 
whether the Hours Per Period field appears on the Income 
tab of the Employee Records window and the Paycheques 
window. 

Hourly and differential 
rates 

An hourly rate represents a base rate paid for standard work 
or hours, whereas a differential rate represents a rate beyond 
the standard or base rate. For example, you might pay a 
differential rate for night shift hours, or for different types of 
work. 

3. Under Payroll, choose Deductions and fill in the 
information.  

Indicate whether 
deductions should be 
taken off before or after 
tax is calculated. 

 
4. Click OK.  
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 Enter U.S. Payroll Tax Information  

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

2. Click Payroll and then Income, and fill in the information.  

 
Indicate whether each 
type of income is taxable. 

Enter the SDI (State 
Disability Insurance), SUTA 
(State Unemployment Tax 
Act), and FUTA (Federal 
Unemployment Tax Act) 
rates. 

Can be an hourly rate or 
differential rate. 

Can be an hourly rate, 
differential rate, income, 
benefit, or reimbursement. 

 
Hourly and differential 
rates 

An hourly rate represents a base rate paid for standard work 
or hours, whereas a differential rate represents a rate beyond 
the standard or base rate. For example, you might pay a 
differential rate for night shift hours, or for different types of 
work. 

3. Click Deductions and fill in the required information.  

 

Indicate whether 
deductions should be 
taken off before or after 
tax is calculated. 

 
 
Select whether to deduct 
a flat amount or a 
percentage of the gross for 
each deduction. 
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4. Click OK.  

Set Up Linked Accounts for Payroll  

You can set up a linked account for each of the income fields in 
your payroll records, to keep track of different types of 
employee income in separate wage expense accounts. You can 
also link individual employees to a single wage expense account. 
Linked accounts can provide additional detail and flexibility in 
your payroll records. 

To set up linked accounts for different types of employee 
income: 

1. In the Accounts window, add the account you want to link, 
if it is not already there. (For instructions, see “Adding 
Accounts” in Chapter 2.)  

2. From the Setup menu, choose System Settings, then Linked 
Accounts.  

3. Select the Payroll Income tab.  

 

For each type of income, 
select a wage expense 
account. 

 

4. Click OK. 
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To link an employee’s income to a single wage expense 
account: 

1. In the Accounts window, add the account you want to link, 
if it is not already there. (For instructions, see “Adding 
Accounts” in Chapter 2.)  

2. Open the employee’s record, and then, on the Income tab, 
select the account to link:  

 

Click the second button, 
then select a wage 
expense account for the 
employee.  

 

3. Click the Save button on the toolbar or close the record.  

 Simply 
Accounting 
Premium or 
higher 

A payroll expense group is a group of linked accounts that 
allows you to process payroll expenses for different groups of 
employees to different accounts. Payroll expenses such as EI or 
CPP can also be assigned to the same group. 

This feature is always on for new companies, and the existing set 
of payroll linked accounts becomes the default payroll expense 
group.  

If you have upgraded your company from a version of Simply 
Accounting that doesn't have payroll expense groups and have 
set any employee's wage expenses to be recorded in an account 
other than the payroll linked accounts (on the Income tab of the 
employee's record), Simply Accounting creates a new payroll 
expense group. 

Setting up payroll expense groups is a three-step process: 

■ Add the accounts you want to link. To add an account, see 
“To Set Up Linked Accounts For Different Types of 
Employee Income” later in this section. 
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■ Set up a payroll expense group. See “Setting Up a Payroll 
Expense Group” later in this section to create a payroll 
expense group. 

■ Assign a payroll expense group to the employees you want 
to include in this group. To assign a payroll expense group 
to an employee, see “Adding Basic Employee Information” 
in Chapter 15. 

Setting Up a Payroll Expense Group 

1. From the Setup menu, choose System Settings, then Linked 
Accounts. 

2. Click Payroll Expense Groups. 

3. Select the My Company Uses Payroll Expense Groups box. 

4. Click Add and enter the name of the expense group in the 
Expense Group Description field. 

  5. Click the button in the Expense Group Description field. 

 

For each type of income, 
select a wage expense 
account. 

When you are 
finished, click OK. 

 

6. Click OK to close the Linked Accounts window. 

To turn payroll expense group on or off: 

1. In the Home window on the Setup menu, choose System 
Settings, and Linked Accounts. 

2. Click the Payroll Expense Groups tab. 

3. Clear the My Company Uses Payroll Expense Groups box. 



Chapter 3:  Entering Basic Settings and Options 

User Guide    3–17 

 

SIM2006 ENGL UG Part 1 (3) PRINT.doc, printed on 1/16/2006, at 11:36:56 AM. Last saved on 
1/16/2006 11:36:00 AM. 

ACCPAC INTERNATIONAL, INC. Confidential 

4. Click OK. 

If you turn off this feature, all employees will use the expense 
accounts on the Payroll Income, Payroll Taxes, and Payroll User-
Defined Expenses tabs in the Linked Accounts window. 

Enter Payment Options for Vendors and Customers 
You can classify your outstanding bills and customer payments 
according to when they are due. This helps you take advantage 
of discounts on items you buy, and alerts you to contact 
customers who have not paid on time. 

You can also keep a record of the payment terms (discounts) you 
receive from your vendors and offer to your customers, and can 
have the program calculate interest on overdue sales invoices. 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

2. Under Vendors and Purchases, choose Options and fill in the 
information. 

 

Check the box if you want 
to calculate and deduct 
discounts from the pre-tax 
amount on an invoice. 

Enter the number of days 
you use to classify amounts 
you owe your vendors 
(suppliers). 

 

3. Under Customers and Sales, choose Options and fill in the 
information.  
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If you want to print interest 
charges on overdue 
invoices and statements, fill 
in these fields. Refer to 
“Charging Interest on 
Overdue Invoices” in 
Chapter 13 for details. 

Enter the number of days 
you use to classify the 
amounts your customers 
owe you. 

Enter the payment terms 
you give most customers. 
(You can change this for 
individual customers.) 

 
4. Click OK. 

Turning off orders and 
quotes 

If your company does not use vendor or customer orders or 
quotes, you can prevent associated fields and toolbar icons from 
appearing on sales and vendor invoices. 

1. In the Home window on the Setup menu, choose Systems 
Settings, then Settings. 

2. Under Company, click Features. 

 

 
Uncheck these boxes.  

 
 3. Click OK. 
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Set Up Shippers 
If you have Internet access, you can track shipments on your 
shippers’ Web sites, as described in “Tracking Shipments” in 
Chapter 22. First enter the following information. 

1. In the Home window on the Setup menu, choose System 
Settings, then Shippers.  

2. Check the Track Shipments box, then fill in the information. 

 

Check this box to be able 
to track shipments. 

Enter the name and Web 
site for each shipper. 

 

3. Click OK.  

Set Up Printing and E-mail Options in Simply 
Accounting 

You can specify where Simply Accounting will start the 
automatic numbering of invoices, orders, and other forms you 
use.  

The program can warn you if you are about to process a 
transaction without printing or e-mailing it first, and can record 
standard comments to include on the printed form or forms sent 
by email. 
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Enter Options for Orders, Invoices, and Other Forms 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

2. Under Company, choose Forms and fill in the information. 

 

If you use preprinted forms 
that include your company 
name and address, leave 
these boxes unchecked. 

Check these boxes to 
have the program warn 
you if you enter a number 
that is out of sequence. 

Check these boxes to 
have the program warn 
you if you try to process an 
entry without printing or 
e-mailing it first. 

Check these boxes if you want to print in 
batches (more than one at a time), as 
described in the section“Print Forms in 
Batches” in Chapter 22. 

Check these boxes to display 
a warning if another invoice 
or receipt uses the same 
number. 

 

3. Click OK. 

4. If you want to set the next number for deposit slips, open the 
Bank account record in the Accounts window and set the 
number on the Class Options tab. (See “Set Up Bank 
Accounts” in Chapter 2.)  

5. To set the next number for cheques, choose Reports and 
Forms on the Setup menu, and then Cheques. Select the 
account the cheque is drawn from. Enter the cheque number 
in the Next Cheque Number field.  
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Add Standard Comments to Invoices and Other Forms 

Add Comments to Printed Forms 

You can include comments on printed sales order confirmations, 
invoices, and sales quotes. For example, you could mention an 
upcoming sale or a new product. 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings.  

2. Under Customers and Sales, choose Comments and fill in 
the information. 

 

Type a comment to 
appear on printed forms. 
You can change it on 
individual transactions. 

 

3. Click OK. 

Include a Message with Forms You Send by E-mail 

If you have a MAPI-compatible e-mail program (such as 

QUALCOMM® Eudora® or Microsoft® Outlook® Express), you 
can send purchase orders and purchase invoice confirmations to 
vendors, and sales quotes, sales order confirmations, invoices, 
receipts, and statements to your customers. 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings.  

2. Under Company, choose E-mail and fill in the information.  
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Type a message to send 
with each type of form you 
plan to e-mail. You can 
change it on individual 
forms. 

 

You can use one of the forms that come with Simply 
Accounting, or customize your own as described in 
“Customizing Forms and Management Reports” in the 
Advanced Topics file. (In the Home window on the Help 
menu, choose Simply Accounting Manuals, then Advanced 
Topics.)  

3. Click OK.  

Set Up Fields to Store Additional Information 
You can store additional information in records (vendors, 
customers, employees, and so on) or in transactions (purchases, 
sales, and so on). 

In Records 

You can store information in up to five extra fields for each type 
of record you keep (vendors, customers, employees, and so on). 
First you name the fields you want to use, then you enter the 
information in the individual records. For example, you could 
store information about an alternative vendor or the name of an 
employee’s spouse. 
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To change the names of the fields: 

1. In the Home window on the Setup menu, choose System 
Settings, then Names and Terminology. 

 
Set Field 
Names 

Or, within a specific record, click Set Field Names on the 
toolbar or File menu. 

 

On each tab, enter the 
new field names you want 
to use. If you leave a name 
blank, the field will not 
appear in the record 
window.  

 

To store additional information in the fields:  

1. Open the record in which you want to store the additional 
information.  

 

On the Additional Info tab, 
fill in the additional 
information. 

 

2. If you want Additional Information text to appear in a pop-
up window when you process a paycheque for this 
employee, select the box under Display This Information 
When The Employee Is Selected In A Transaction.  
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In Transactions 

When entering transactions, such as purchases, sales, or 
paycheques, you can store an additional date and an additional 
field. You can define these two fields to store any date or 
information you like, such as a voucher date and voucher 
number. The fields will appear in the transaction detail reports. 

To change the names of the fields:  

1. In the Home window on the Setup menu, choose System 
Settings, and then Names and Terminology. 

2. On the Transactions tab, enter the new field names. 

 

Enter the new field names 
you want to use.  

 

To enter additional information in the fields: 

 
Enter 
Additional 
Information 

1. When you use one of the transaction windows (such as 
purchases, sales, payments, receipts, paycheques, and so on), 
click Enter Additional Information on the toolbar, or choose 
Enter Additional Information from the transaction menu, 
such as the Purchase menu or Sales menu. 

2. Enter the information in the fields.  
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3. Click OK. 

Create Job Categories 
Simply Accounting 
Pro or higher  

If you use Simply Accounting Pro or higher, you can use job 
categories to track which of your salespeople is responsible for a 
specific order, and easily identify the employees who are 
authorized to enter time slips. 

Job categories can also save you time when entering invoices and 
time slips: 

■ Only employee names that are assigned to a salesperson 
category appear in the Sales, Orders and Quotes window (in 
the Sold By field). 

■ Only employee names that are assigned to a job category 
that is required to submit time slips appears in the Time Slip 
window (in the Employee field drop-down list). 

■ You can group employees into job categories for payroll 
reporting purposes. 

To set up job categories: 

1. In the Home window on the Setup menu, select System 
Settings, and choose Settings, Payroll, and then Job 
Categories. 
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2. Enter a category name and indicate whether an employee 
assigned to this category must submit time slips and/or is a 
salesperson 

■ If an employee is assigned to a job category that must 
enter time slips, their name can be selected from a 
drop-down list on the time slip entry window. 

■ If an employee is assigned to a job category identified as 
a salesperson, the employee name can be selected from a 
drop-down list on sales invoices, orders, and quotes. 

3. Click the Assign Job Categories button to assign employees 
to the new categories. You can also assign individual 
employees to a job category on the Personal tab of an 
employee record. 
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Choose None from the Job Category list to view unassigned 
employees.  

4. Click OK. 

Customize Colours and Fonts for Reports 
You may want to change the font you use for printing (for 
example, a smaller font lets you print more information on a 
page).  

You may also want to use different colours to emphasize 
different parts of your reports. Follow the instructions below to 
change colours for the reports you display and print in Simply 
Accounting.  

1. In the Home window on the Setup menu, select Reports and 
Forms, then Reports and fill in the information.  

 

Select the font, type size, 
and colour you want to use 
for different sections of 
reports.  

Click the box, then select a 
colour. 

  

2. For each report or form you plan to print, select the settings 
you need.  
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You can select a 
different printer for each 
form you use.  

You can customize the 
form, as described in 
“Customizing Forms and 
Management Reports” 
in the Advanced Topics 
manual.  

 

3. Click OK. 

Set Display Preferences  
You can customize the colours and other display options in 
Simply Accounting. If you are using Simply Accounting Pro or 
higher with multiple users, each user can set display preferences, 
and the program will use those settings when the user logs in.  

1. In the Home window on the Setup menu, choose User 
Preferences, then the Colour Scheme tab.  
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Select the colours and 
backgrounds you want to 
use in different parts of 
Simply Accounting.  

 

2. Select the Options tab.  

 

Select accounting or 
non-accounting terms. 
The Simply Accounting 
manuals use non-
accounting terms. 

Select a language for 
Excel spreadsheets. 

 

3. Choose from the following options: 

■ Automatically Save Changes to Vendor, Customer 
and Other Records.  Check this box if you do not need 
to be reminded to save whenever you close a record. 

■ Show List Buttons Throughout Simply Accounting for 
Easier Data Entry.  Check this box to display a button 
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that pops up a list of possible entries in a field. The list 
makes data entry easier, since you can select from it 
rather than having to remember the exact name or 
spelling of the entry you want. 

■ Automatically Refresh Lists.  If you’re using Simply 
Accounting Pro or higher, with multiple users, check 
here to have records updated automatically when other 
users make changes. 

■ Show A List Of Inventory Items When An Unknown 
Inventory Item Number Is Entered.  Check this box to 
display a list of all inventory items if an item number is 
entered incorrectly. 

■ Always Apply Allocation To Entire Transaction.  
Check this box if you want to automatically allocate all 
items in a transaction to the same project (this option can 
be changed on individual transaction records). 

4. Click OK.  

Modify Transaction Windows 

 Simply 
Accounting 
Premium or 
higher 

If you use Simply Accounting Premium or higher, and have full 
accounting rights, you can modify transaction window names, 
making your accounting environment more suited to your 
company terminology. 

For example, if your business is part of the catering industry, 
you may wish to identify vendors as suppliers, customers as 
clients. 

Note:  If you entered a Company Type during setup, transaction 
windows automatically display industry-specific names. You 
can modify these names manually, as described next. 

To modify transaction window names: 

1. Switch to single-user mode, if required. 

2. In the Home window on the Setup menu, select System 
Settings, and then choose Names and Terminology. 
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■ On the Vendors tab, in the Terminology section, choose 
the module name and select terms for Vendors, 
Purchases, Invoices, and Payments, if required.  

■ On the Customers tab, in the Terminology section, 
choose the module name and select terms for 
Customers, Sales, Invoices, and Receipts, if required. 

3. Click OK to save your changes. 

Date Format 
To avoid confusion over transaction dates (such as 11-12-10) you 
can define how dates will display, both on your screen and on 
reports. 

To modify the date format: 

1. In the Home window on the Setup menu, select System 
Settings, and then Settings. Under Company, select Dates 
and complete the following:  

 

Specify short date and long 
date formats. 

Specify a format to display 
on the screen and on 
reports. 

 

■ If you plan to use short dates, specify the format and 
separator and then indicate when you want to view 
short dates, for on-screen use or in reports. 

■ If you plan to use the long date format, specify the 
format and when you want to use long dates. 

2. Click OK to save your changes. 
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Switch between Different Languages 
 In the Canadian version of Simply Accounting, you can switch 

from the English version to the French version and back again  
instantly. If you run your business in both languages, or if you 
keep books for several companies and want to be able to use 
either language easily, this feature will save you time and 
money, since you don’t need to buy, install, and set up two 
versions of the program. 

All the Simply Accounting features, including all on-screen 
displays, printed reports, and the online help and manuals, are 
instantly available in the other language. However, note that a 
few fields that contain information specified by the user (such as 
the name of the Project module, or names of some tax codes or 
employee income fields) may remain in the original language 
after switching. 

To switch to French: 

1. Choose View on the Home window menu bar, and select 
Passer au français or Switch to French.  

To set up a preferred language for vendors, customers, 
employees, or users: 

1. Open the Vendors window and select a vendor. 

For each vendor for whom you want to specify a language 
preference, go to the Options tab and specify the language in 
the Conduct Business In field. 

2. Open the Customers window and select a customer.  

For each customer for whom you wish to specify a language 
preference, go to the Options tab and specify the language in 
the Conduct Business In field. 
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Choose a customer 
language. You can 
change this setting at any 
time.  

 

3. To specify a language preference for an employee, open the 
Employees window and choose a language preference on 
the Personal tab. 

4. To specify a language for Simply Accounting users, choose 
the Setup menu in the Home window, then choose Set Up 
Users. Select a user and click Modify. Choose a language 
preference. Click OK. 

Set Up Users  
If more than one person uses your data, it’s a good idea to set up 
user security, including passwords. User security can control 
whether a user can display or change certain data, identify who 
created a transaction, prevent unauthorized use of certain parts 
of the program, or exclude users altogether. You can also control 
the way non-Simply Accounting products such as Crystal 

Reports® or Microsoft Access use your data.  

Once you set up a password for a user, the user must always 
enter the password when starting Simply Accounting, unless 
you later choose to clear passwords, as described later in this 
section. 

Simply Accounting 
Pro or higher 

Note that, if you are using Simply Accounting Pro or higher and 
multiple users are sharing a company file simultaneously on a 
network, you must add a unique name for each user of your 
data. However, the users do not need passwords. 
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What Type of Security Do You Need? 

Think about who will be using your data and how you want to 
track or restrict its use. For example, you might allow only one 
or two people to see or make changes to the payroll. Or you 
might allow a user to change accounts, but not display or print 
financial reports.  

For security reasons, passwords are displayed only as asterisks. 
Because you need the sysadmin password to make changes to 
other users and their passwords, you should keep a record of it 
in a secure place. 

The following table shows the different types of access rights on 
the Set Up Users window that you can assign to different users.   

Simply Accounting 
Pro or higher  

If you use Simply Accounting Pro or higher, you can add users 
to Simply Accounting who are authorized to enter time slips for 
only one employee (either themselves or an assigned employee) 
or all employees.  

A Time Slip Entry user can view only the Time Slips entry 
window. The rest of the Home window is hidden. The user can 
select and record time slips only for the employee(s) they have 
rights for. And they can lookup time slips only for those 
employees.  

Type of User (Simply Accounting Pro or higher only) 

Accounting User An accounting user is granted access and rights to 
specified records and transactions. 

Time Slip Entry User A time slip entry user can only enter time slips for all 
employees or a specified employee. 

Access Rights 

System Administrator The primary user of your data is called the system 
administrator, or sysadmin. This person is allowed 
rights to all of your company’s data. Only the system 
administrator can add users and assign rights to them. 
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Full Accounting Rights Unrestricted access to all modules. A user who is 
assigned the Full Accounting Rights option has the 
same rights as the sysadmin user, except for the right to 
add, remove or modify users. 

Allow Access If you select this option for a module, then its related 
edit, view, and report options are also automatically 
selected. You can then select or de-select the options. 

For Records (such as accounts, customers, vendors, and so on) 

This type of access: Enables user to: 

Modify Add, change, or delete the module’s records. 

The right to view is also automatically assigned. 

View View the module’s records, but not edit them (unless 
the right to modify is also assigned). 

Reports Display, print, and export the module’s reports, graphs, 
list reports, mailing labels, and management reports. 

For Transactions (such as purchases, payments, sales, and so on) 

This type of access: Enables user to: 

Enter Add, change, or delete the module’s transactions and 
adjustments to be processed. 

Import purchase and sales orders. 

(The right to look up is also automatically assigned.) 

Lookup Look up and view the module’s transactions, but not 
edit them (unless the right to enter is also assigned). 

Reports Display, print, and export the module’s transaction 
reports and graphs, but not list reports, mailing labels, 
and management reports. 
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Note:  Only the sysadmin user, or a user who is granted full accounting rights, has 
access to: the Restore command on the File menu; Settings on the Setup, Wizards menu; 
Company Information, Names, Settings, and Credit Cards on the Setup, System 
Settings menu; and to some Clear commands. Only the sysadmin user has access to Set 
Up Users on the Setup menu. 

 

No Access (all options 
cleared) 

If, for a user, you clear all options on the Set Up User window, 
then the user will not have access to any module. The 
module’s icons will not appear, except the Accounts, 
Miscellaneous Transactions, and Reconciliation and Deposits 
icons, which appear with a no-entry symbol . The user can 
display some items, such as Checklists, and Company 
Information, but not the Daily Business Manager. 

Access to other 
features, such as the 
Daily Business 
Manager 

Depending on a user’s access rights, information may be 
restricted in some Simply Accounting features, such as the 
Checklists or Daily Business Manager. For example, a user 
may see only certain types of transactions or only certain tabs 
in the Daily Business Manager.  

The user’s setup will also affect importing and exporting data. 

Symbols Note the following symbols that appear in Simply Accounting 
to indicate whether a user can gain access to a particular 
module: 

 

Symbol in the 
Home window is: 

 
Means: 

 
No Access. Cannot use the module 
but may have access to view or print 
reports if set up for it. 

 

View (or Lookup) only. Cannot add, 
change, or delete information in the 
records of the module. 

No symbol Allow Access. Access permitted to the 
module, except for reports if user is 
denied access to reports. 
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Preventing Users from Viewing or Changing Simply Accounting Data in Other 
Programs 

You can use other products, known as third-party products, with 
Simply Accounting. For example, you can use Crystal Reports or 
Microsoft Access to customize reports or analyze your data in 
different ways.  

Warning! If you allow users any rights to read data with third-party 
products, note that they may be able to use those products to  
read more of your company’s data than you want them to, no 
matter what rights they have within Simply Accounting. Be 
careful about allowing users rights to use third-party products.  

Changes in your data We strongly recommend that you do not alter data using 
programs other than Simply Accounting, because you could 
cause unexpected changes in your data, leading to data integrity 
problems. 
 
To allow or deny users the right to gain access to Simply 
Accounting data through other products, refer to “Adding or 
Changing a User,” later in this section.  

Setting Up or Changing a Password for the System Administrator 

To add or remove users, the system administrator must have a 
password. 

Do not forget the system administrator’s password. Without it, 
you may not be able to use all parts of the program or control 
other users’ security rights. 

To set up or change a password for the system 
administrator: 

1. Open your Simply Accounting data using the sysadmin 
name and password. If you are setting up a sysadmin 
password for the first time, when you open the company, 
you will already be logged on as the system administrator. 

2. In the Home window on the Setup menu, choose Set Up 
Users.  

3. Select sysadmin, then click Modify.  
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Enter a password (letters, 
numbers, or both). You can
include both upper- and 
lower-case letters. The 
password is case-sensitive; 
that is, if you enter a 
password and type the 
correct letter in the wrong 
case, the password will not 
work.  

 In the Canadian 
version of Simply 
Accounting, you can 
select the user’s language 
preference. 

 

4. Click OK.  

Note:  Once you have created a password for the system 
administrator, you must always enter a user name and password 
to open the company. You can delete the sysadmin password, as 
described under “Deleting a User’s Password,” or by using the 
Clear button, as described under “Removing Security,” later in 
this chapter. 

Adding or Changing a User 

Only the system administrator can add a new user, or change the 
rights of an existing user. To add a user, the system 
administrator must have a password. 

Each user must have a unique name, but more than one user can 
use the same password.  

To add a user:  

1. Open your Simply Accounting data using the sysadmin 
name and password. 
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2. In the Home window on the Setup menu, choose Set Up 
Users, then click Add User and fill in the information.  

 

  In the Canadian version of Simply 
Accounting, you can select the user’s 
language preference. 

Type a password for the 
user, up to seven 
characters, then re-type it 
to confirm. 

Type the user’s name, up to 
14 characters, and if you 
use Simply Accounting Pro 
or higher, indicate whether 
this user is restricted to time 
slip entry. 

Click one of these options to 
define the user’s rights to 
access to third-party products. 

Check or clear the boxes to 
allow edit, view, reports, all, 
or no rights to this user. 

 

Simply Accounting 
Pro or higher 

If you use Simply Accounting Pro or higher, you can restrict 
this user to time slip entry only. Refer to the section “What 
Type of Security Do You Need?” earlier in this chapter for 
more information about time slip entry users. 

3. In the User’s Rights With Third-Party Products area, select 
the rights you want to allow this user from non-Simply 
Accounting products. Note that some third-party products 
require exclusive access to be able to modify the database. 

Note:  If you allow the user any rights to read data with 
third-party products, they may be able to use those products 
to read more of your company’s data than you want them to, 
no matter what rights they have within Simply Accounting. 
Be careful about allowing users rights to use third-party 
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products. We recommend that you set this option to allow 
no access to your data.  

4. Click OK. 

Changing a Password for a User 

Either the system administrator or the user can change a user’s 
password. However, only the system administrator can change 
the user’s access rights. 

To change a user’s password: 

1. Open your Simply Accounting data, using either the user’s 
or the sysadmin name and password. 

2. In the Home window on the Setup menu, choose Set Up 
Users. 

3. If you opened the data using the sysadmin name and 
password, select the user’s name, then choose Modify.  

4. Type the new password. 

 

Type a password for the 
user, then re-type it to 
confirm.  

 In the Canadian version 
of Simply Accounting, you can 
select the user’s language 
preference. 
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5. Click OK. 

Changing a User’s Rights to Use Data 

Only the system administrator can change a user’s rights.  

To change a user’s rights:  

1. Open your Simply Accounting data, using the sysadmin’s 
name and password. 

2. In the Home window on the Setup menu, choose Set Up 
Users. 

3. Select the user’s name, then choose Modify and fill in the 
information.  

 

Check or clear the boxes 
to allow all, some, or no 
rights to this user. 

 In the Canadian version 
of Simply Accounting, you can 
select the user’s language 
preference. 

Choose whether this user 
is restricted to time slip 
entry. 

 

4. Click OK.  
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Deleting a User’s Password 

Either the system administrator or the user can delete a user’s 
password. The user will still be restricted to the parts of the 
program allowed by the system administrator, but will not need 
a password to open the data.  

Note:  You can delete a system administrator’s password only if 
no other user records exist. To delete a system administrator’s 
password, see “Removing Security” later in this chapter. 

To delete a user’s password: 

1. Open your Simply Accounting data, using either the user’s 
or the sysadmin’s name and password. 

2. In the Home window on the Setup menu: 

■ If you opened the data using the sysadmin name and 
password, choose Set Up Users. 

■ If you opened the data as a user, choose Change 
Password. 

3. If you opened the data using the sysadmin password, select 
the user’s name, then choose Modify. 

If you opened the data as a user, enter the user password.  

4. Delete the password, as follows.  
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Press the Backspace key 
on the keyboard to 
remove the password, 
then repeat in the 
Re-enter Password field.  

 In the Canadian version 
of Simply Accounting, you can 
select the user’s language 
preference. 

 

5. Click OK. 

Deleting a User 

Only the system administrator can delete a user.  

To delete a user: 

1. Open your Simply Accounting data using the sysadmin’s 
name and password. 

2. In the Home window on the Setup menu, choose Set Up Users. 

3. Select the user that you want to delete, and click Remove 
User. You cannot delete the system administrator 
(sysadmin). 

4. Click OK.  

Removing Security 

If you decide that you do not want to use any passwords at all, 
and prefer to allow free access to your data to everyone, you can 
clear all the passwords and users you have set up.  
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Note that if you are using Simply Accounting Pro or higher on a 
network, you must have users set up if you want more than one 
person to use your company data at the same time.  

To remove security: 

1. Open your Simply Accounting data using the sysadmin’s 
name and password. 

2. In the Home window on the Setup menu, choose Set Up 
Users, then click Clear.  

 

Click Clear to remove all 
security and passwords.  

 

Note that you cannot remove the system administrator 
(sysadmin) from the list of users. However, the sysadmin 
password will be set to blank, so you will not be asked to 
enter a password the next time you start Simply Accounting.  

3. Click OK.  

Restoring a Damaged Security File  

In the unlikely event that you see a message warning you that 
your security file has been damaged or deleted, you can restore 
your sysadmin password and list of users. You can use either the 
Restore Security From Backup wizard, or the Repair Security 
command on the Maintenance menu, as described in this section.  

Do not use the Repair Security command unless your security file has 
been damaged. It removes all user passwords from your security 
settings.  
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To repair a damaged security file using the Restore Security 
From Backup wizard:  

1. Start Simply Accounting. If the security file is damaged, the 
Restore Security From Backup wizard appears. 

2. Follow the steps on the screen to restore your most recent 
backup for this company.  

3. Re-enter all your user passwords. (On the Setup menu, 
choose Set Up Users, then enter a password for each user.)  

To repair a damaged security file from the Maintenance 
menu: 

1. Start Simply Accounting.  

2. In the Select Company window, choose Restore From 
Backup to restore the most recent backup of your Simply 
Accounting data to a temporary folder. 

3. Copy the .SDW file from the temporary folder to the folder 
where you store your current Simply Accounting data. 

4. Open your data using the sysadmin name and the password 
that was in effect on the date you made the backup. 

5. In the Home window, on the Maintenance menu, choose 
Database Utilities, then Repair Security. 

6. On the Setup menu, choose Set Up Users, then enter 
passwords for the users.  

To repair a file that was damaged while using Simply 
Accounting data in another program:  

1. Start Simply Accounting.  

2. If the Restore Security From Backup wizard appears, follow 
the steps above under “To repair a damaged security file 
using the Restore Security From Backup wizard.” 

If the wizard does not appear, follow the steps above under “To 
repair a damaged security file from the Maintenance menu.”  
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Chapter 4 
Making and Accepting Credit-Card 
Payments 
 

You can pay for your purchases with a credit card and accept credit-card 
payments from your customers. Simply Accounting calculates and tracks any 
fees you owe the credit-card company. 

 

Add Credit-Card Accounts ......................................................... 4–1 
Enter Information about Credit Cards ............................................... 4–2 
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What You Need to Do 
 Add credit-card accounts.  

 Enter information about the credit cards you use and accept.  

Add Credit-Card Accounts 
 

You can accept credit-card payments from your customers, and 
use credit cards to pay for purchases you make from your 
vendors. When you accept a credit-card payment from a 
customer, Simply Accounting automatically calculates any fee 
you owe the credit-card company and keeps track of it in a 
separate account. Later, you can use the Account Reconciliation 
feature to verify the credit-card merchant statements against 
your records.  

Tip:  You’ll find it much easier to keep track of your credit-card 
sales and purchases if you set up an account for each credit card 
you accept or use, rather than having a single account for all 
credit cards. Having separate accounts also makes it easier when 
you reconcile the statements you receive from the credit-card 
merchants whose cards you accept.  

To set up credit-card accounts: 

 

 

1. In the Home window on the General tab, choose the 
Accounts icon. 

2. For each type of credit card you accept from customers, add:  

■ An asset account for the amounts you will collect from 
the credit-card issuer for customer payments.  

■ An expense account for the fees you pay to the 
credit-card issuer.  

3. For each type of credit card you use to make payments, add: 

■ A payable or liability account for the amounts you will 
pay to the credit-card issuer when they send you a 
statement of the purchases you have made with their 
card.  
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■ An expense account for any fees or interest charges you 
pay to the credit-card issuer.  

 
Save 4. On the File menu, choose Save.  

5. Go to the next section to add information about the credit 
cards you use.  

Enter Information about Credit Cards  
 

Make a list of the credit cards you use and accept, and their 
associated accounts. 

1. In the Home window on the Setup menu, choose System 
Settings, then Credit Cards. 

2. Click the Credit Cards Accepted tab and fill in the 
information.  

 

Enter the percentage the 
card company charges on 
each transaction.  

Type the names of the 
credit cards you accept 
from customers. 

Select the account where 
you want to record the 
amount the credit-card 
company will pay you (this 
can be a bank account or 
an asset account). 

Enter an account to keep 
track of the fees you pay to 
the credit-card company.  

 

3. Click the Credit Cards Used tab and fill in the information.  
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Enter the account that 
tracks the amount you 
owe the credit-card 
company. 

Enter the names of the 
credit cards you use for 
company purchases. 

Enter the account that 
keeps track of the fees you 
owe, such as interest 
charges on overdue 
amounts. 

 

4. Click OK.  

Where To Now? 
 You can use Simply Accounting to save time and trouble in 

reconciliation, the process of matching your bank and 
credit-card statements against your own records and 
accounting for any differences. For more information, refer 
to “Set Up Accounts for Reconciliation,” in Chapter 2.  

 For more information about using credit cards for purchases 
and sales, see Chapter 12, “Buying,” and Chapter 13, 
“Selling.”  

 For more information about merchant statements of credit 
card transactions, see the section “Receiving Money from 
Credit-Card Sales,” in Chapter 20.

http://www.simplyaccounting.com/
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Chapter 5 
Setting Up Projects 
 

You can use Simply Accounting to keep closer track of the revenues and 
expenses associated with a particular activity, by allocating them to various jobs, 
projects, or departments. 

 

Why Would I Use Projects?......................................................... 5–1 
Turn On the Project Allocation Option............................................... 5–2 
Rename the Project Module......................................................... 5–2 
Decide How to Allocate ............................................................ 5–3 
Add a List of Projects .............................................................. 5–4 
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What You Need to Do 
 Turn on the project allocation option.  

 If you want to, rename the Project module. 

 Decide how you want to allocate to projects. 

 Add a list of projects.  

Why Would I Use Projects? 
If you allocate (distribute) all or part of a transaction to one or 
more projects, revenue centres, or cost centres, you can produce 
detailed or summary reports on specific parts of your business. 
For example, if an employee works for one day a week on 
Project A and four days on Project B, you can allocate 20 percent 
of the payroll expense for that employee to Project A and 
80 percent to Project B.  

The Project module does not have its own transaction window. 
You use the following types of transactions to allocate amounts 
to projects: 

■ Purchases. 

■ Sales. 

■ Paycheques, including payroll cheque runs. 

■ Miscellaneous transactions. 

■ Inventory adjustments. 

■ Time slips. 

For more information, see Chapter 17, “Allocating Revenues and 
Expenses to Projects.”  
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Turn On the Project Allocation Option 
 

The revenue and expense accounts that come with the Simply 
Accounting templates are already set to allow project allocation. 
However, if you add new accounts, or if you want to allocate 
from other types of accounts, you must turn on the option for 
each account. 

If you plan to allocate from asset, liability, or equity accounts, we 
recommend that you check with your accountant.  

1. In the Home window on the General tab, choose the 
Accounts icon, open the account you want to use for 
allocation, then check the Allow Project Allocations box.  

This field appears only in 
the Canadian version. 

Check this box to allocate 
amounts to projects from 
this account. 

 

 
Save 2. On the File menu, choose Save.  

Rename the Project Module 
 

You can use the project features in Simply Accounting to keep 
track of jobs, cost centres, profit centres, departments, branches, 
or any other type of division. If you prefer not to call these 
“projects,” you can rename the module. 

1. In the Home window on the Setup menu, choose System 
Settings, then Names and Terminology.  
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On the Project tab, enter a 
new name. This will rename 
the Project tab and icons 
in the Home window, and 
change the name on 
screens and reports that 
relate to projects. 

 

2. Click OK.  

Decide How to Allocate  
 

You can allocate amounts to projects by either percentage or 
amount. On paycheques, you can also allocate by hours.  

1. In the Home window on the Setup menu, choose System 
Settings, then Settings.  

2. Under Project, choose Allocation, and fill in the information.  

Select the allocation 
method you want to use. 

Check this box if you want 
access to the Allocate field in 
transactions by using the Tab 
key. If you generally don’t 
allocate, turn off to skip. 

If you normally allocate the 
full amount of revenues or 
expenses to projects, check 
this box. The program will 
warn you if you try to process 
an entry with less than the full 
amount allocated. 
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3. Click OK. 

 
Add a List of Projects 

 

1.  In the Home window on the Project tab, choose Add Project 
or the Project icon. 

2. On the File menu or toolbar, choose Create, then fill in the 
information on the Project tab.  

See “Set Up Project 
Budgets” in Chapter 6 for 
information about this tab. 

You can enter additional 
information about the 
project. To change field 
names, go to Setup, 
System Settings, Names 
and Terminology. 

Fill in information about the 
project. 

 

 
Save 3. On the File menu, choose Save.  

Where To Now? 
 To find out more about project allocation, refer to 

Chapter 17, “Allocating Revenues and Expenses to Projects.”  

 If you want to set up project budgets, refer to “Set Up Project 
Budgets” in Chapter 6.  

 For more information about cost allocation in general, read 
Chapter 20, “Cost Accounting,” in the Accounting Manual.  
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Chapter 6 
Setting Up a Budget 
 

A budget helps keep your business on track by setting out a detailed plan that 
predicts where your money is coming from and where it’s going. Use it to spot 
problem areas quickly and run your business more effectively. 

 

Turn on the Budgeting Option ...................................................... 6–1 
Add Budget Information to the Accounts ............................................ 6–2 
Set Up Project Budgets ............................................................. 6–4 
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What You Need to Do 
 Turn on the budgeting option.  

 Add budget information.  

 If you use projects, set up project budgets. 

Turn on the Budgeting Option 

 

To be able to set up budgets in Simply Accounting, you need to 
turn on the budgeting option. You will then be able to compare 
your company’s actual performance to the budget estimates. 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. 

2. Under General, choose Budget, and fill in the information.  

Check this box to set up a 
budget.  

 

Select a budget period 
frequency. Monthly is the 
most common choice. 

 

3. Click OK. 

If you later decide not to use budgets, you can turn off the 
option by unchecking the box.  

 Turn on budget option 
 Add budget info 
 Set  project budgets 
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Add Budget Information to the Accounts 

 

For each account you want to include in your budget, use the 
Accounts window to enter an estimated amount for each budget 
period. Or, if you receive budget information from your 
company’s head office or other authority, you can import a 
budget in .CSV format. For more information about importing 
budgets, refer to Chapter 3 in Advanced Topics. (In the Home 
window on the Help menu, choose Simply Accounting Manuals, 
then Advanced Topics). 

Later, if you want to modify your budget expectations quickly 
for all revenue or expense accounts, use one of these two 
methods: 

■ Update Budget Amounts on the Maintenance menu.  

■ Export your current budget information to a spreadsheet 
where you can update one or more accounts by an amount, 
calculation, or percentage. 

For more information on modifying budgets, refer to “Quickly 
Updating Your Budget,” in Chapter 20. 

Tip:  Budget accurately. Don’t feel that you have to fill in the 
same amount for each period. Consider seasonal sales, one-time 
or annual expenses, and so on. 

Enter budget amounts: 

1. In the Home window, open the Accounts window. 

2. Select the revenue or expense account you want to include in 
your budget. (Revenue accounts are usually numbered 4000 
to 4999, and expense accounts are usually 5000 to 5999.)  

3. On the Budget tab, check the Budget This Account box. 

4. If you are not using departments for your accounts, fill in the 
information as follows: 

 Turn on budget option 

 Add budget info 
 Set project budgets 
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If the budget period is 
Annual, a single budget 
amount field appears 
here. 

 

Click this button to 
distribute the Total 
Budgeted Amount in equal 
amounts to each period. 

 

Simply Accounting 
Pro or higher 

If you are using departments for your accounts (available if 
you use Simply Accounting Pro or higher), the Budget tab 
looks like this: 

 

Fill in the information as follows: 

a) Enter the Total Budgeted Amount. 

b) To distribute the Total Budgeted Amount in equal 
amounts to each period, click the Allocate To Period 
button. The distributed amounts appear on the first line, 
Budget Amount. 

c) Adjust the Budget Amount values if necessary. 

d) To automatically distribute each period’s Budget 
Amount value, in equal amounts, to each department, 
click the Allocate To Dept. button. For example, in the 
previous illustration, the Budget Amount for July ($500) 
is distributed to departments 0100 and 0200 for July, in 
equal amounts of $250 each. 

e) Adjust the department amounts if necessary. 

 
Save 5. Repeat steps 2 to 4 for each account you want to budget, then 

on the File menu, choose Save.  
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Set Up Project Budgets 

 

You can set up a budget for any project. When you allocate 
amounts to projects as you record revenues and expenses, 
Simply Accounting keeps track of the amounts, so that you can 
compare the actual cost of the project to a budget estimate and 
spot potential cost overruns early. 

To set up a project budget: 

1. In the Home window, on the Setup menu, choose System 
Settings, then Settings.  

2. Under Project, choose Budget, and fill in the information. 

Check this box to budget 
projects.  

Select a budget period for 
your projects. This can be 
different from the regular 
company budget periods 
you set up on the General 
tab. 

 

3. Click OK. 

4. In the Home window, open the Project window, select the 
project you want to budget, and fill in the information. 

 

Keep an eye on the 
budgeted profit. If you’re 
doing better than 
expected, you can be 
more flexible when 
negotiating prices with 
suppliers and customers. 

Fill in the expected 
revenues and expenses for 
each period. 

 

 Turn on budget option 
 Add budget info 

 Set project budgets 
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Simply Accounting 
Pro or higher 

5. If you are using Simply Accounting Pro or higher, click the 
Details button to enter budget information for revenues and 
expenses in specific accounts.  

 
Save 6. Repeat steps 4 and 5 for each project you want to budget, 

then on the File menu, choose Save.  

Where To Now? 
 To find how to allocate revenues and expenses to projects, 

refer to Chapter 17, “Allocating Revenues and Expenses to 
Projects.”  

 To find out about the budget reports you can use in Simply 
Accounting, refer to “Checking Your Budget” in Chapter 20.
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Chapter 7 
Using Simply Accounting on a 
Network 
 

With Simply Accounting Pro or higher, up to six people can use the same set of 
company data at the same time. 

 

Set Up Your Network .............................................................. 7–1 
Install Simply Accounting on the Network ........................................... 7–2 
Set Up Users and Passwords........................................................ 7–2 
Multi-User vs Single-User Mode .................................................... 7–3 





Chapter 7:  Using Simply Accounting on a Network 

User Guide    7−1 

 
  

SIM2006 ENGL UG Part 1 (6-11) PRINT.doc, printed on 1/17/2006, at 10:36:02 AM. Last saved 
on 1/17/2006 10:35:00 AM. 

ACCPAC International, Inc. Confidential 

What You Need to Do 
 Set up your network.  

 Install Simply Accounting on the network. 

 Set up security levels and passwords.  

Set Up Your Network  

 

With Simply Accounting Pro or higher, you can allow more than 
one user to use the same Simply Accounting data at the same 
time. 

The steps you need to take to set up your network may vary, 
depending on your network operating system and on the version 
of Windows you are using.  

 Install the latest network drivers for your network operating 
system, and the latest service packs and patches for your 
version of Windows. 

 Check that the network hardware and software are up to 
date and running correctly. Network problems could 
damage your Simply Accounting data.  

 Consult your network provider or system administrator if 
you need help with questions about your network.  

 Set up the folder where you store your Simply Accounting 
data so it can be shared with other users. Assign 
read/write/create access rights to this folder (usually 
\Program Files\Winsim2006\Data).  

 Under some operating systems, you may need to assign full 
control to the user’s Simply.ini file.  

 Set up your network 
 Install Simply 
Accounting 

 Set up user passwords 
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Install Simply Accounting on the Network 

 

You can either install a full version of the program on each user’s 
computer, or install a full version on a single computer or server 
and install components on individual workstations that allow 
them to use the full version.  

Installing the full software on every computer allows it to run 
faster; however, each time you receive a new version of the 
software (such as a payroll tax update), you must install the 
update on every workstation. By installing a full version of 
Simply Accounting on a single computer or server, and smaller 
components on individual workstations, you significantly 
reduce the amount of time it takes to install the most current 
version of the software throughout your company. 

To install Simply Accounting on every computer: 

1. Follow the instructions on the Simply Accounting CD case. 

To install Simply Accounting Pro or higher on a single 
computer or server: 

1. Install the full version of Simply Accounting Pro or higher 
on one computer or server, following the steps for regular 
installation, as described on the Simply Accounting CD case. 

2. At each workstation, install Simply Accounting components. 
When the program asks you to select an installation type, 
choose Simply Accounting Workstation Components, and 
then follow the instructions on the screen. You must also 
specify a folder where data will be stored and shared by all 
users. 

Set Up Users and Passwords 

 

You must set up users if you plan to run Simply Accounting on a 
network. You can set their passwords to blank, or assign them all 
the same password, but each user must have a different name.  

 Set up your network 

 Install Simply 
Accounting  

 Set up user passwords 

 Set up your network 
 Install Simply 
Accounting  

 Set up user passwords 
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It’s a good idea to set up passwords to prevent unauthorized 
access to your data. For instructions, refer to “Set Up Users” in 
Chapter 3. 

Multi-User vs Single-User Mode 
After you have set up users, you can open the company in multi-
user mode to allow additional users to log on. However, you can 
lock other users out of the data by starting Simply Accounting in 
single-user mode. 

If you open your data in multi-user mode, some menus and 
options are not available, even if you log on as sysadmin. This 
feature protects your data by preventing other users from using 
the data while it is being updated. 

Opening the company data in single-user mode as the sysadmin 
gives you full access to all menus and options. 

After you open Simply Accounting, you can switch between 
multi-user and single-user mode. In the Home window on the 
File menu, choose Switch To Single-user Mode or Switch To 
Multi-user Mode. 
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Chapter 8 
Setting Up Printers 
 

Before you print reports and forms, check that your printer works properly with 
Simply Accounting. 

 

Before You Start ................................................................... 8–1 
Test Your Printer .................................................................. 8–1 

Test Reports................................................................... 8–1 
Test Other Forms .............................................................. 8–2 

Helpful Hints ..................................................................... 8–3 
Troubleshooting ............................................................... 8–3 
Setting Negative Margins....................................................... 8–4 
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What You Need to Do 
 Test your printer. 

 If your printer doesn’t work properly with Simply 
Accounting, troubleshoot the problems. 

Before You Start 
 Install at least one printer to work with Microsoft Windows.  

 Select a printer and specify printer settings for each type of 
form in Simply Accounting.  

 The program remembers both the printer and the settings 
you selected every time it prints that type of form. To select 
a printer and settings, see “Set Up Printing and E-mail 
Options in Simply Accounting” in Chapter 3. 

 Make sure your printer is correctly connected to your 
computer with the paper loaded and the power on. 

Test Your Printer 

 

You should test all types of forms to see if your printer prints 
them properly. 

Test Reports 

As a test, print a two-page report such as the chart of accounts. 

To print the chart of accounts:  

1. In the Home window on the Reports menu, choose Lists, 
then Chart Of Accounts. Click OK.  

2. On the File menu, choose Print. 

3. Check the printed report. 

 Test your printer 
 Troubleshoot 
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Test Other Forms 

After you print a report, as described in the previous section, test 
each type of form you plan to print. 

You can print payroll cheques, payment cheques, invoices, 
purchase orders, sales order confirmations, quotes, receipts, and 
customer statements on 8½-by-11-inch or 8½-by-7-inch forms, or 
on custom forms. (Custom forms are explained in the Advanced 
Topics file “Customizing Forms and Management Reports.” In 
the Home window, on the Help menu, select Simply Accounting 
manuals, then Advanced Topics.)  

  The paper size for Canadian T4 and Relevé 1 slips and American 
W-2 forms may vary. Check the latest Simply Accounting Tax 
Update for more information about printing these forms. 

If the form does not print properly, use the steps that follow to 
adjust your printer settings. Follow the same steps for all forms. 

These steps use customer statements as an example. You can test them 
using blank 8½-by-11-inch paper or preprinted 8½-by-11-inch or 
8½-by-7-inch customer statement forms. 

To print a customer statement:  

1. In the Home window on the Setup menu, choose Reports 
And Forms, then click Statements, and confirm that the 
form-size setting matches the size of your statement forms. 
Click OK. 

2. In the Home window on the Reports menu, choose 
Customers And Sales, and then Customer Statements. 

3. Select at least two customers from the list, and click OK. 

You must print statements for at least two customers, to see 
where the second statement starts printing and to see 
whether your printer knows how long a statement should 
be. 

4. Check the printed statements. They are printed properly if: 

■ The print lines up properly on the page. 
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■ The second statement starts in the correct place. This 
depends on the page size of your forms: 

8½ by 11 inches:  The second statement starts printing 
at the top of the next 8½-by-11-inch page. 

8½ by 7 inches:  The second statement starts printing 
seven inches below the start of the first (except when 
printing on laser printers). You would only use this page 
size for dot-matrix printers. 

Helpful Hints 

Troubleshooting 

If the samples you printed in the previous section did not print 
correctly, follow the steps in this section to try to fix the problem. 

If this happens: Do this: 

Report is too wide to 
fit on the page 

Choose a smaller type size or a different font. On the Setup menu, 
choose Reports And Forms, select the form, then select another 
font size or font. 

Printing does not line 
up properly  
(tractor-feed printer) 

Shift the paper left, right, up, or down. Refer to the printer’s 
manual. 
Reset your margins. On the Setup menu, choose Reports And 
Forms, select a form type, then change the margin settings. Also, 
see the next section, “Setting Negative Margins.” 

Last two lines of the 
page do not print 

Reduce the top margin. On the Setup menu, choose Reports And 
Forms, select a form type, then enter a smaller top margin. Also, 
see the next section, “Setting Negative Margins.” 
If you are using an HP LaserJet printer, you may have selected a 
PostScript printer driver. This causes the program to print too 
many lines per page. Try selecting a non-PostScript printer driver.
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If this happens: Do this: 

Nothing prints Check that your printer is connected and switched on.  
Try installing the latest version of the driver for your printer 
(contact the printer manufacturer about these drivers). 

Setting Negative Margins 

If the printing does not line up properly on a form, you can reset 
the margins. You can even set negative margins to shift the 
printing slightly to the left, or up: 

1. From the Setup menu, choose Reports And Forms. Select the 
form you want to change. 

2. Experiment with different margin settings until you get the 
result you want. 

 
Moves print down

0.05 inch.
Moves print left

0.1 inch.  

When you type a positive number in the margin field, the first 
line of printing moves down or to the right. But if you type a 
negative number in the margin field, the first line of printing will 
move up or to the left. The maximum negative margin setting 
depends on the printer and form, but you cannot exceed –1.00. 

If the program displays a message telling you the printer offsets 
(that is, the negative numbers) are too big when you attempt to 
print, click No and adjust the margins in the Reports And Forms 
window. Or, continue with the printing to see how well the form 
is aligned, then adjust the margin. 
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Chapter 9 
Setting Up a List of Inventory and 
Service Items  
 

If you buy or sell goods or services, it’s a good idea to keep a list of them. It 
makes invoice entry much faster, helps you to analyze your revenues and 
expenses in more detail, and keeps track of things that may need your attention. 

 

Why You Need a List of Inventory and Service Items ................................. 9–1 
Select Inventory Options ........................................................... 9–2 
Add Accounts to Keep Track of Inventory and Service Items........................... 9–3 
Make a List of the Items and Services You Buy and Sell ............................... 9–4 

Working with Different Units of Measure ........................................ 9–8 
Create and Maintain Price Lists ..................................................... 9–9 

Naming Price Lists............................................................. 9–9 
Adding or Changing Prices on Your Price Lists .................................. 9–10 

Assemble Items from Components ................................................. 9–12 
Recording the Assembly of Items............................................... 9–13 
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What You Need to Do 
 Select inventory options. 

 Add accounts to keep track of inventory and service items.  

 Make a list of the items and services you buy and sell. 

 Organize your inventory and service item prices on Price 
Lists. 

 If you assemble items from components, enter item assembly 
records. 

 Identify items and services to sell online (optional) 

Why You Need a List of Inventory and Service Items 
Entering your inventory and service items into Simply 
Accounting offers many advantages. Primarily, it saves time 
when buying or selling. Instead of typing the details of each 
item, you can select the item from a list so that Simply 
Accounting enters the related information automatically. 

A well-organized list of inventory and service items also makes 
it easy to keep track of the things you’re buying and selling, and 
to focus on areas that may need your attention. Although you 
can manage without a list, you’ll find that you have more useful 
information and better control if you let Simply Accounting keep 
track of inventory for you. 

Finally, keeping track of your inventory and service items allows 
you maintain one or more price lists. Price lists are used to 
control prices, by automatically suggesting the price of your 
inventory or service items when you create invoices. This also 
provides an easy and quick way of discounting your regular 
prices for special customers. 

If you would like to know more about the principles of 
inventory accounting, read Chapter 19 in the Accounting Manual.  
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Select Inventory Options 
 

You can evaluate profit (the difference between the average cost 
and the selling price) on goods and services using either markup 
or margin. If you’re not sure which to use, you can ask your 
accountant which profit-evaluation method is most common in 
your type of business. 

Markup and margin are evaluated using the following formulas: 

Selling price – cost 
   Markup =

Cost 
 x 100 

 
Selling price – cost 

   Margin = Selling price  x 100 

The program uses the weighted-moving-average method to 
calculate the cost of the items you sell. 

To select inventory options: 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings.  

2. Under Inventory and Services, choose Options, and fill in the 
information. 

 

Choose the order in which 
items appear on your 
inventory and services list. 

Select one of the profit-
evaluation methods 
described above. 

These options appear if 
you have set up a foreign 
currency. See Chapter 10 
for more information. 

Check this box if you may 
need to record a sale 
before purchasing 
sufficient inventory.  
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 3. If you have Simply Accounting Premium or higher, and 
want to track inventory in multiple locations, choose 
Locations and select the Use Multiple Locations For 
Inventory Items box. Fill in the information in the other 
fields. 

 4. Click OK. 

 

 
Add Accounts to Keep Track of Inventory and 
Service Items 

 

You must set up accounts to track the goods and services that 
you buy and sell. Inventory items (physical goods) must be 
associated with an asset, a revenue, and a cost of goods sold 
account. Service items need a revenue and an expense account. 
These accounts are described below. 

You can use the same set of accounts for each item. However, we 
recommend that you create a set of accounts for each category of 
items. For example, if you own a grocery store, you might create 
a set of accounts for fruits and another for bakery items. 

Asset account (Inventory items only). This account records the 
value of the items you have in inventory.  

Revenue account.  Simply Accounting updates this account 
when you sell goods and services. For service items, this account 
is optional.  

Cost of Goods Sold (Expense) account.  Simply Accounting 
updates this account when you sell goods and services. For 
service items, this account is optional.  

Variance (Expense) account (Inventory items only).  If you 
allow inventory levels to go below zero, Simply Accounting uses 
the variance account to record any differences in cost of goods 
sold caused by negative inventory. If you do not want to keep 
track of this variance, you can select the same account that you 
used for Cost of Goods Sold.  

For information on adding accounts, see “Adding Accounts” in 
Chapter 2. 
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Simply Accounting 
Pro or higher 

If you use Simply Accounting Pro or higher, and have set up 
departments, you can select a department for each of the four 
accounts. However, do this only if you want transactions 
involving inventory to use specific accounts and departments, 
regardless of the vendor (or customer) department. For example, 
if you choose 5040-0100 as your C.O.G.S. account for an item, 
5040-0100 will always be used when you enter that item in the 
Sales, Orders and Quotes window, even if the customer’s 
department is 0200. 

If you do not choose a department for the Revenue and C.O.G.S. 
accounts, Simply Accounting automatically uses the vendor or 
customer department for those accounts. However, for 
Inventory Asset or Variance accounts, Simply Accounting does 
not use the vendor or customer department. 

For information about setting up departments, see “Accounting 
by Departments” in Chapter 2. 

Make a List of the Items and Services You Buy and 
Sell  

Once you decide how to organize your inventory list and have 
added the accounts you require, you can add your items to 
Simply Accounting. You can add the list all at once, or gradually, 
during day-to-day buying and selling. 

If you are using Simply Accounting Pro or higher, you can keep 
track of service activities and bill customers for them. See 
Chapter 18, “Keeping Track of Employee Time and Billing.”  

To add inventory items and services all at once: 

1. In the Home window, choose the Inventory and Services 
icon.  

2. On the File menu, choose Create. Then click the Units tab 
and fill in the information. 
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Select the type of item. 

Fill in the item number and 
description.  

These fields appear only for 
inventory items. If you buy or 
sell items in different units of 
measure, fill in this part of the 
tab. For more information, see 
“Working with Different Units of 
Measure,” later in this chapter. 

 

3. Click the Pricing tab and fill in the information. You can also 
add and edit prices using Update Price Lists. For more 
information, see the next section “Create and Maintain Price 
Lists.” 

Enter the prices you 
charge. You can leave 
any of them blank.   

To set up separate prices for 
each of the currencies you 
use, see “Set Up Foreign 
Currencies” in Chapter 10. 

 

Note:  The Pricing Method column appears if you choose a 
foreign currency. If you choose Exchange Rate, Simply 
Accounting will use the current price from that price lists 
and convert it using the most current exchange rate that you 
have entered. 

4. Click the Linked tab and select the accounts that you added 
for this item (as described in the previous section). 
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If you are adding a service 
item, neither the Asset nor 
the Variance fields appear, 
and The Cost of Goods Sold 
field is renamed Expense. 

 

5. If you are using Simply Accounting Pro or higher and this is 
an item that you assemble from components, add inventory 
records for all of the components, then click the Build tab 
and fill in the fields. Later, you can recall the information 
without having to enter each component individually, and 
record the assembly in the Bill of Materials and Item 
Assembly window.  

List the components that 
are needed to build this 
item.  

Enter any additional costs, 
such as labour and setup 
costs. 

 

6. For service items only, if the item is one for which you want 
to keep track of employee time so you can bill your clients, 
fill in the Time and Billing tab. If you need more details, 
refer to Chapter 18, “Keeping Track of Employee Time and 
Billing.”  

7. On the Taxes tab, check that the tax information is correct. If 
you have set up import duties, enter the rate for this item.  

8. If you want to keep additional information about the item, 
such as height or weight, fill in the fields on the Additional 
Info tab. If you need to change the names of these fields, 
choose Set Field Names on the File menu or toolbar.  

9. If you want to add a longer description or a picture to the 
item, click the Detailed Description tab and fill in the 
information. This information appears on custom reports. 
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Note:  You can associate pictures of inventory items with 
their inventory records. Pictures can be bitmap (*.BMP), 
JPEG (*.JPG, *.JPEG), or Graphics Interchange Format (*.GIF) 
files and should measure 120x120. 

The information on this tab appears in the Price List With 
Pictures report, one of the custom reports supplied with 
Simply Accounting. For more information on customizing 
reports, see the Advanced Topics manual. 

10. Fill in the information on the remaining tabs. The Statistics 
and History tabs are described under “Adding Inventory 
History” in Chapter 11. 

 11. Click the Create Another button. 

12. Repeat steps 2 through 10 for each item you want to add. 

13. Click the Save And Close button. 

To add inventory items “on the fly,” one at a time: 

1. When you enter a purchase or sale, click the List button in 
the Item column. 

 

If you want to search 
through the list of records 
manually, check the Bypass 
Search Field box and scroll 
through the list of records. 

 

2. Click Add. 

3. When you have entered all the information about the new 
item, choose Save from the File menu, then continue filling 
in the invoice. If you need help entering the item, refer to the 
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steps above under “To add inventory items and services all 
at once.” 

Working with Different Units of Measure 

You may want to buy or sell items using a different unit of 
measure than the one you use when stocking your items. For 
example, you might buy and stock potatoes by the kilogram but 
sell them in five-kilogram bags. You can set up this relationship 
so that when you sell a bag of potatoes, Simply Accounting 
knows that this represents five kilograms of your stock.  

 

To set up different units of measure for inventory items: 

1. In the Inventory and Services window, open the inventory 
item and click the Units tab. 

2. Type the unit of measure you use to stock the item. 

3. Uncheck the Same As Stocking Unit box for selling or 
buying units. 

4. Type the unit of measure that you use when selling or 
buying. 

5. Type the number of stocking units that make up a buying or 
selling unit, or vice versa. For example, if the stocking unit of 
measure is kilograms and the selling unit is grams, you 
would enter 1000 in the first box and select Grams per 
Kilogram in the second box: 
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Create and Maintain Price Lists 
Simply Accounting 
Pro or higher 

Price lists offer a convenient way of keeping track of your 
inventory and service item prices. If your business has different 
prices for different situations, you can create a price list for each 
of those situations. For example, if you have a retail business and 
you offer different prices to each of your best clients, you can set 
up one price list for each customer. You could set up price lists 
called Gold, Silver, Bronze, and Platinum, keeping all of the 
regular prices, and changing only the prices for the items that 
you discount for that specific customer. In the customer record, 
you would use the appropriate price list with each customer. 

Naming Price Lists 

1. In the Home Window from the Setup menu, choose System 
Settings, then Settings. 

2. Under Inventory and Services, choose Price List, and add or 
change the names of price lists. 

 

Select a price list to rename 
by clicking in the Description 
column.  You cannot change 
the Regular, Preferred, or 
Web price lists. 

Change the status to Inactive 
by clicking in the Status 
column, next to the name of 
the price list. 

 

3. Click OK. 
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Adding or Changing Prices on Your Price Lists 

Once you have set up the names of your price lists, you can add 
prices to new price lists (or change prices on existing price lists) 
in several ways: 

■ Add or modify price list prices individually on each 
inventory record (on an inventory or service item’s Pricing 
tab, as described in the previous section). 

■ Update prices for several items and price lists at one time by 
importing price list information on spreadsheet from an 
outside source (such as your company’s head office, or a 
supplier), or exporting an existing price list and modifying it 
on a spreadsheet.  

■ Refer to Chapter 3, “Importing and Exporting Data,” in 
Advanced Topics. (In the Home window on the Help menu, 
choose Simply Accounting Manuals, then Advanced Topics.) 

Simply Accounting 
Pro or higher 

If you use Simply Accounting Pro or higher, you can either add 
price list prices individually, or you can have Simply Accounting 
add prices by calculating new prices based on an existing price 
list. You can also use a combination of these two methods to 
change prices by calculating new prices and then fine-tuning by 
hand. 

 To manually change prices on new or existing price lists: 

1. In the Home Window on the Maintenance menu, choose 
Update Price Lists. 

2. Select the price list and the type of items you will be 
changing prices for, and then make manual price changes. 
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Select a price list to 
change. 

Select the type of items to 
show. 

You can make changes 
manually to item prices by 
clicking in the New Price 
column. 

When you have finished 
making manual changes, 
click Save Prices.  

3. After you have saved the new prices, click OK. 

To calculate new prices based on an existing price list: 

1. Select the price list and the type of items you will be 
changing prices for (as illustrated above), then choose the 
settings for the calculations. 

1. Choose the price list on which 
the new prices will be based. 
2. Choose whether to increase or 
decrease those prices.  
3. Choose a fixed amount or a 
percentage. 

1 

2 

3 

 

Tip:  To copy prices from one price list to another, select the 
new price list name, then choose the price list upon which to 
base the prices as shown in 1) in the diagram above. Finally, 
choose “percent” and zero as shown in 3) above. Then 
follow the rest of the steps below. This will copy all the 
prices from the original price list onto the new one. Don’t 
forget to click the Save Prices button to save the new prices. 
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2. Choose the currency, then select the items to change by 
placing a check mark next to them. 

Choose the currency to 
set the prices for. You 
can also choose All 
Currencies. 

Select the items to which 
you want to apply the 
new price calculations. 
You can select all of them 
by clicking the icon at the 
top of the column. 

Click the Calculate 
button to see the new 
prices. You can also edit 
them manually if they are 
not correct.  

3. Click Calculate. If you want to make any changes to the new 
prices, click in the New Price Column. 

4. When you have finished making changes to the price list, 
click Save Prices. 

5. Repeat steps 1 to 5 for as many price lists as you like. Click 
OK when you have finished making your changes to price 
lists. 

 
Assemble Items from Components 

If you assemble or build inventory items from components, 
Simply Accounting can keep track of both the components and 
the assembled items. For example, assume you keep a supply of 
hinges, wood, and glue, which are used to build doors. Each 
time you build a door, you can enter a transaction in the Item 
Assembly window to: 

■ Reduce your stock for the components used in 
manufacturing. 
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■ Account for additional costs, such as labour. 

■ Add the manufactured item to your stock. 

Tip:  If you are using Simply Accounting Pro or higher and plan 
to manufacture or assemble this item often, you should consider 
setting up a bill of materials. Both bill of materials and item 
assembly help you to automate the process of building or 
assembling items in Simply Accounting. Each feature is useful in 
different situations. Item Assembly may be more useful for items 
that you do not build on a regular basis, such as a special order. 
You should use bills of materials for items that you regularly 
build or assemble and then sell. By using a bill of materials, you 
save time when you next manufacture an item by recalling its 
entry with details already filled in. To set up a bill of materials, 
fill in the Build tab in the inventory record, as described under 
“Make a List of the Items and Services You Buy and Sell,” earlier 
in this chapter.  

Recording the Assembly of Items 

1. In the Home window on the Inventory and Services tab, 
choose Bill of Materials and Item Assembly. (If you are not 
using Simply Accounting Pro or higher, the icon is called 
Item Assembly.)  

2. If you are using Simply Accounting Pro or higher and want 
to use a list of components you have previously set up for an 
inventory item, select Build From Bill Of Materials in the 
first field.  
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Select Build from Bill of 
Materials.  

 If you are using Simply 
Accounting Premium or 
higher and multiple 
locations, choose the 
location at which the item 
will be assembled.  

 

3. Or, to enter each component separately, select Build From 
Item Assembly in the first field. (If you are not using Simply 
Accounting Pro or higher, this field does not appear.)  

 

Select the components 
you use to assemble the 
item.  

Enter any additional costs, 
such as labour and setup 
costs.  

Select the items you have 
assembled and are now 
adding to your stock.  

These totals must be equal. 

 

Note:  The Additional Costs field is available only if you 
have added an expense account for Transfer Costs, and set it 
up as an Inventory linked account. For more information on 
linked accounts, see “Set Up Linked Accounts” in Chapter 2. 
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4. Click Process. 

Where To Now? 
 To find out how to enter invoices and other transactions 

related to the inventory items and services you buy and sell, 
refer to Chapter 12, “Buying,” and Chapter 13, “Selling.”  

 Refer to Chapter 26, “Tracking Your Inventory,” for more 
information about inventory.  
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Chapter 10 
Doing Business outside the 
Country 
 

If you do business outside the country, you can set up Simply Accounting to 
handle foreign-currency transactions. The program will keep track of 
exchange rates and foreign selling prices for you. 

 

Keeping Records in Other Currencies .............................................. 10–1 
Keep Track of Exchange-Rate Differences and Rounding ............................. 10–2 

Exchange-Rate Differences .................................................... 10–2 
Differences Due to Rounding .................................................. 10–2 

Set Up Foreign Currencies......................................................... 10–4 
Adding or Changing an Exchange Rate ......................................... 10–5 
Setting the Exchange Rate “on the Fly” ......................................... 10–6 

Add Foreign-Currency Bank Accounts ............................................. 10–7 
Decide Which Type of Foreign Pricing to Use for Sales ............................... 10–8 
Add Foreign Prices for Inventory and Service Items ................................. 10–9 
Set Up Vendors and Customers to Use Foreign Currency............................ 10–10 
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What You Need to Do 
 Add an account to keep track of exchange-rate differences 

and rounding.  

 Set up the foreign currencies you want to use.  

 Add foreign-currency bank accounts. 

 Decide which type of foreign price to use for sales. 

 If necessary, add foreign prices for inventory and service 
items. 

 Set up the vendors and customers who will be using foreign 
currency. 

Keeping Records in Other Currencies  

 
If you do business with vendors or customers in another 
country, you can set up Simply Accounting to keep track of 
transactions in a foreign currency, such as the British pound. 

Simply Accounting 
Pro or higher 

If you are not using Simply Accounting Pro or higher, you can 
use one foreign currency. Simply Accounting Pro and higher 
versions allow you to use an unlimited number of currencies.  

You can also set up bank and cash accounts that use the foreign 
currency. This is useful if you have a bank account in the foreign 
country or a foreign-currency account at a local bank. 

You can set foreign prices for inventory and service items, or 
enter prices in your home currency and let the program calculate 
the foreign price based on the current exchange rate.  

The currency used in the country in which your business is 
located is called the home currency. On most reports, foreign 
balances are converted into home currency or are shown in 
addition to home-currency amounts.  
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Keep Track of Exchange-Rate Differences and 
Rounding 

Exchange-Rate Differences 

 

When you purchase or sell an item, payment is often made or 
received at some time in the future. If the item’s price is in a 
foreign currency, the exchange rate may change before payment. 
This means that the equivalent price in your home currency also 
changes. Sometimes this works in your favour, sometimes not.  

For example, you purchase an item from Britain for £100 
(100 British pounds). On the day of the purchase, the exchange  
rate is 1.45, so the price in dollars is $145. Some time later, when 
you are ready to pay the vendor’s invoice, the exchange rate has 
changed, and the pound is worth $1.40. You pay your vendor 
£100 (worth $140). You have gained $5.  

Simply Accounting keeps track of gains and losses caused by 
exchange-rate changes in the Currency Exchange and Rounding 
account. This is usually in the expense section of your chart of 
accounts, but your accountant may suggest a different 
classification. You can see these amounts on the Realized 
Exchange Gain/Loss report (on the Reports menu, under 
Financials). 

Differences Due to Rounding 

The final price of an item paid for in foreign currency may 
change due to rounding that occurs when the exchange rate is 
calculated.  

For example, if you purchase two items and pay in a foreign 
currency, the entries might appear as follows. The exchange rate 
in this example is 1.5997033. 

 Add exchange acct. 
 Set up currencies 
 Add bank accounts 
 Decide foreign pricing 
 Add foreign prices 

 Set vendors/customers 
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Account Foreign 
Currency 
Amount 

Debits Credits 

1540 Hardware 534.99 855.83  

1560 Lumber 35.00 55.99  

2220 Accounts 
Payable 569.99 ______ 911.81 

Total:  911.82 911.81 

Simply Accounting converts and then rounds each line 
individually. However, as shown in the example above, this can 
result in small differences in the totals. Such differences are 
recorded in the Currency Exchange and Rounding account, as 
shown below.  

Account Foreign 
Currency 
Amount 

Debits Credits 

1540 Hardware 534.99 855.83  

1560 Lumber 35.00 55.99  

2220 Accounts 
Payable 569.99  911.81 

5770 Currency 
Exchange and 
Rounding 

  

______ 

 

    0.01 

Total:  911.82 911.82 

To add an account to keep track of exchange-rate 
changes and differences due to rounding:  

1. In the Accounts window, create an expense account called 
Currency Exchange and Rounding. Select Loss as the 
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Account Class. (Your accountant may suggest a different 
classification.) 

For more information on adding accounts, see “Adding 
Accounts” in Chapter 2. 

Set Up Foreign Currencies 

 

You must add a Currency Exchange and Rounding account, as 
described in the previous section, before you set up a foreign 
currency.  

If you are not using Simply Accounting Pro or higher, note that 
the screens you see may be different from the examples below, 
because you can set up only one foreign currency. However, the 
fields are the same. 

1. In the Home window on the Setup menu, choose System 
Settings, then Currencies.  

2. Fill in the home-currency information: 

Select the currency used in 
the country in which your 
business is located, and 
define its format. 

 

Select the account you 
created to track differences 
due to exchange-rate 
changes over time.  

3. Fill in the foreign-currency information: 

   

Click the List button to 
see a list of currencies, or 
type a currency name. 

The currency code is an 
abbreviation of the 
currency name, such as 
EUR for the Euro. Enter the symbol, such as 

£, that you want to use for 
the foreign currency.  

 Add exchange acct. 

 Set up currencies 
 Add bank accounts 
 Decide foreign pricing 
 Add foreign prices 

 Set vendors/customers 
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Note:  You cannot make changes to this currency (such as 
changing the currency code or the number of decimal places) 
after you have processed transactions in this currency. Be 
sure to enter the correct information. 

4. In the Exchange Rate table, enter a date and an exchange 
rate. 

 
 
 
 

 

You can enter up to two years of 
dates and rates. If a transaction 
falls between two dates, the 
program uses the earlier rate. 

If you use an average 
exchange rate for a given 
period, such as a week, 
and want to be reminded 
to bring the rate up to 
date, check this box and 
enter a frequency. 
 

Fill in a Web site address so 
you can quickly look up 
exchange rates. Click the 
button to open the site, 
from this screen or from 
any transaction window 
(such as an invoice) that 
uses foreign currency.  

 

How does the 
exchange rate work?  

Note:  The program multiplies the foreign currency by the 
exchange rate to calculate its value in the home currency. For 
example, if you sell an item for £100, the program multiplies 
£100 by the current exchange rate, 1.807, to find a value of 
180.709 in the home currency. 

5. Click OK. 

Adding or Changing an Exchange Rate 

You should keep an eye on the exchange rate and enter any 
significant rate changes in Simply Accounting. That way, the 
program can make timely calculations and help you keep 
accurate records of your foreign purchases and sales.  
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Note that changing a rate in the exchange-rate table does not 
affect transactions that you have already entered. If you need to 
correct the exchange rate on a transaction, make a correction to 
the original transaction. To find original transactions, print 
vendor purchases and customer sales reports for your foreign 
vendors and customers for the range of dates that used the 
wrong exchange rate, then drill down to open and adjust the 
original invoices. 

To add or change an exchange rate:  

1. In the Home window on the Setup menu, choose System 
Settings, then Currencies. 

2. If you are using Simply Accounting Pro or higher, click the 
Exchange Rate tab and select the currency. 

3. In the Exchange Rate table, enter a date and exchange rate, 
or change one of the rates listed. If you have entered a name 
in the Currency Exchange Web Site field, click the button 
next to the field to quickly look up the new rate.  

4. Click OK. 

Setting the Exchange Rate “on the Fly” 

If you wish, you can enter a different exchange rate when you 
enter a transaction, without having to open the Currencies 
window. 

If you have set up Simply Accounting to use foreign currencies, 
an Exchange Rate field appears in transaction windows where 
foreign currency can be used. 

 

You can either enter a new rate in the field or click the button to 
open the exchange-rate table, then add or change rates as 
needed. 
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Add Foreign-Currency Bank Accounts 

 

We recommend that you set up at least one bank account to keep 
track of foreign-currency amounts. Although Simply Accounting 
lets you mix home-currency and foreign-currency amounts in the 
same account, you will probably find it easier to keep them in 
separate accounts. This could be an account at a bank in the 
foreign country you do business with or a foreign-currency 
account at a local bank. 

 

If you use Simply Accounting to reconcile your bank statements, 
note that foreign-currency bank accounts are reconciled in the 
foreign currency. This means that you are matching foreign 
amounts to foreign amounts and do not need to worry about 
exchange-rate differences. 

If you wish, you can set up a primary foreign bank account for 
Purchases or Sales. Simply Accounting then displays this 
account automatically when you enter a payment or receipt for a 
foreign vendor or customer, so you do not have to select the 
bank from a list every time. You can set up one account for 
purchases and one for sales for each currency you use. 

To add a foreign-currency bank account: 

1. In the Home window on the General tab, choose the 
Accounts icon. 

2. On the File menu, choose Create. 

3. Enter the information on the Account tab as you would for 
any other account. For more information on adding 
accounts, see “Adding Accounts” in Chapter 2.  

4. Click the Class Options tab, and enter the information: 

 

Change the account class 
to Bank, then fill in 
information about the 
bank. 

Be sure to change the 
currency of the account to 
the foreign currency. 

 

 Add exchange acct. 
 Set up currencies 

 Add bank accounts 
 Decide foreign pricing 
 Add foreign prices 

 Set vendors/customers 
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Save 5. On the File menu, choose Save. 

To set up an account as your primary foreign bank 
account: 

1. In the Home window, on the Setup menu, choose System 
Settings, then Linked Accounts. 

2. Choose either Vendors And Purchases or Customers And 
Sales. 

3. Select a primary foreign bank account for the foreign 
currency. If you are using Simply Accounting Pro or higher, 
you can select an account for every foreign currency you are 
using. 

 

Click the List button to 
display a list of 
accounts, then select an
account to link.  

 

4. Click OK.  

Decide Which Type of Foreign Pricing to Use for 
Sales 

 

When you enter a sales invoice, Simply Accounting can either 
use a fixed foreign price or calculate the foreign price based on 
the home-currency price and the exchange rate. Be sure you have 
chosen the method you want to use before you enter an invoice: 

1. In the Home window, on the Setup menu, choose System 
Settings, then Settings. 

2. Select Inventory and Services and click Options. Under 
Foreign Prices On Sales Invoices, select one of the following 
options: 

 Add exchange acct. 
 Set up currencies 
 Add bank accounts 

 Decide foreign pricing 
 Add foreign prices 

 Set vendors/customers 
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Calculated Using The Exchange Rate. The program will 
calculate the price on each invoice by dividing the price in 
the home currency by the current exchange rate. Choosing 
this option will disable the foreign price table in inventory 
records.  

Taken From The Foreign Price Listed In The Inventory 
And Services Record. Select this if you want to enter a 
specific foreign price in the item’s inventory or service 
record. 
 
Note: You can also choose to use the current exchange rate 
for a price from an inventory or service item's record. 
Choosing the second option, then, will allow you to decide 
on a per-item basis whether you want to use the exchange 
rate or a specific price. 

3. Click OK. 

4. If necessary, enter foreign prices for your inventory items 
and services, as described in the next section. 

Note:  You can change the price when you enter a 
transaction. 

Add Foreign Prices for Inventory and Service Items 

 

You can enter a foreign price for any inventory item or service 
(as opposed to calculating a foreign price based on the exchange 
rate) if you have set the pricing option as described in the 
previous section. 

1. In the Home window on the Inventory and Services tab, 
choose the Inventory and Services icon. 

2. For each inventory item or service, click the Pricing tab and 
enter the foreign prices. If you are using Simply Accounting 
Basic, the Pricing Method column doesn’t appear.  

 Add exchange acct. 
 Set up currencies 
 Add bank accounts 
 Decide foreign pricing 

 Add foreign prices 
 Set vendors/customers 



Part 1:  Setting Up 

10−10    Simply Accounting 

 
  

SIM2006 ENGL UG Part 1 (6-11) PRINT.doc, printed on 1/12/2006, at 11:03:07 AM. Last saved 
on 1/9/2006 10:36:00 AM. 

ACCPAC International, Inc. Confidential 

 

Choose the foreign 
currency. 

To calculate the price based 
on the exchange rate, click in 
the Pricing Method column 
and choose Exchange Rate. 
Or choose Fixed Price and 
type one in the Price per 
Selling Unit column. 

 

 
Save 3. On the File menu, choose Save. 

Set Up Vendors and Customers to Use Foreign 
Currency  

 

To enter foreign prices on purchase or sales invoices, you must 
first set up a vendor or customer as foreign. Simply Accounting 
uses the currency associated with the vendor or customer when 
you enter a transaction, such as a purchase or sale. You cannot 
enter transactions in different currencies for the same vendor or 
customer. 

Note that you cannot change the currency of an existing vendor 
or customer if they have transactions on file. However, you can 
clear the outstanding transactions, delete the vendor or 
customer, then add the same vendor or customer and select a 
foreign currency on the Options tab. 

For information on adding vendors and customers, see “Adding 
Vendors” in Chapter 12 and “Adding Customers” in Chapter 13. 

 

 Add exchange acct. 
 Set up currencies 
 Add bank accounts 
 Decide foreign pricing 
 Add foreign prices 

 Set vendors/customers 
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Chapter 11 
Adding Historical Information 
 

If your business is already running but you’re just starting out with Simply 
Accounting, it’s a good idea to record historical information about outstanding 
invoices, year-to-date sales, purchases, payments, payroll totals, and so on. This 
will help you avoid time-consuming manual calculations later and give you a 
more accurate picture of your business. 

 

What Is Historical Information?.................................................... 11–1 
Decide When You Want to Add Historical Information............................... 11–2 
Add History ..................................................................... 11–2 

Adding Account History ...................................................... 11–2 
Adding Vendors and Purchases History ........................................ 11–3 
Adding Customers and Sales History ........................................... 11–5 
Adding Payroll History ....................................................... 11–6 
Adding Inventory History ..................................................... 11–8 
Adding Project History........................................................ 11–9 

Finish Entering History .......................................................... 11–10 
 





Chapter 11:  Adding Historical Information 

User Guide    11−1 

 
  

SIM2006 ENGL UG Part 1 (6-11) PRINT.doc, printed on 1/12/2006, at 11:03:07 AM. Last saved 
on 1/9/2006 10:36:00 AM. 

ACCPAC International, Inc. Confidential 

What You Need to Do 
 Decide whether to add historical records all at once, or over 

a period of time.  

 Add accounts, vendors, customers, employees, inventory, 
and projects, and their historical records.  

 Finish entering history. 

What Is Historical Information? 
Historical information consists of all the transactions that you 
completed before you started to use Simply Accounting. These 
include account balances, vendor and customer invoice and 
payment information, employee year-to-date earnings, 
deductions, and expenses, and the quantity and value of 
inventory on hand.  

You should add this information so that your records provide an 
accurate picture of your business dealings and so that Simply 
Accounting can correctly calculate taxes, payroll, inventory 
value, and so on.  

 

 A History symbol beside an icon indicates that a window is able 
to accept historical transactions. 

Simply Accounting 
Pro or higher  

Note that historical information is not the same as financial 
history, the financial data that Simply Accounting Pro and higher 
accumulate over several years as your business operates. For 
more information on financial history, refer to “Keeping and 
Comparing Additional Years of Financial Information” in 
Chapter 2.  
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Decide When You Want to Add Historical 
Information 

 

Simply Accounting is set up to accept historical transactions and 
current day-to-day transactions concurrently; you do not have to 
enter all the historical information before entering new 
transactions.  

You can add all or most of your historical information before 
you start using Simply Accounting for normal business, or you 
can add it as time allows. You can add entire lists of vendors, 
customers, or employees, or add each of them “on the fly” as 
you happen to be entering a purchase, sale, or paycheque.  

After you finish entering historical information, you set up 
Simply Accounting to accept only new transactions, using the 
Finish Entering History command described at the end of this 
chapter. 

Add History 

 

Follow the steps in this section to add information about your 
accounts, vendors, customers, employees, inventory and service 
items, and projects, and any related transactions and balances. 

Remember to back up your data frequently! (Choose Backup on 
the File menu or toolbar.) In case of damage to your data, you 
can restore a backup. Refer to “Backing Up Your Company’s 
Information” in Chapter 19 for more about backing up and 
restoring data.  

Adding Account History 

Follow the steps below to add the opening balance for each 
account.  

1. Add account records, as described under “Add or Change 
Accounts” in Chapter 2.  

2. Open the account record, click the Account tab, and fill in 
the opening balance.  

 Decide when to add 
 Add history 
 Finish entering history 

 Decide when to add 

 Add history 
 Finish entering history 
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Fill in the opening balance. 

 

3. When you have finished, close the Accounts window. If the 
accounts are out of balance, Simply Accounting warns you, 
and asks you to select an account to record the difference.  

4. In the Home window, on the Reports menu, choose 
Financials, then Trial Balance. Print the report and check that 
you entered the balances correctly and that the accounts are 
in logical order and in balance.  

Adding Vendors and Purchases History 

You can enter information about the amounts you owe to each 
vendor, and any payments you have made against each invoice 
as of the earliest transaction date. If you do not enter this 
information, the program assumes that there are no unpaid 
purchase invoices.  

We recommend that you enter this information, to have a more 
accurate picture of your purchases. Follow the steps below for 
each vendor. 

1. Add vendor records, as described under “Adding Vendors” 
in Chapter 12.  

2. On the Statistics tab, add the purchases and payments totals 
for the current year and last year.  
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Fill in the totals for last year 
and the year to date. 

 

3. On the Historical Transactions tab, click the Invoices button 
to add outstanding (unpaid) invoices.  

 

Fill in the invoice number 
and date.  

Enter the full amount of the 
invoice, including tax and 
freight, even if you have 
already paid part of it. 
You’ll record any 
payments in the next step.   

4. In the Home window on the Reports menu, choose Vendors 
and Purchases, then Vendor Aged. Select Detail and print a 
report for all vendors. Check that you entered everything 
correctly. If you find any errors, correct them by entering a 
historical payment for the invoice (follow step 5), and then 
enter the invoice correctly 

5. On the Historical Transactions tab, click Payments to add 
information about paid invoices. 
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Enter a cheque number or 
credit-card name.  

Enter the amount paid, 
and the discount, if any.  

Simply Accounting 
automatically displays the 
invoices you entered in 
step 3. 

 

6. Print the Vendor Aged Detail report and keep a copy for 
your records. 

Adding Customers and Sales History 

You can enter information about the amounts each customer 
owes you, and any payments they make against each invoice as 
of the earliest transaction date. If you do not enter this 
information, the program assumes that there are no unpaid sales 
invoices.  

We recommend that you enter this information, to have a more 
accurate picture of your sales. Follow the steps below for each 
customer.  

1. Add customer records, as described under “Adding 
Customers” in Chapter 13.  

2. On the Statistics tab, add the sales totals for the current year 
and last year.  

 

Fill in the sales totals for last 
year and the year to date. 
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3. On the Historical Transactions tab, click the Invoices button 
to add outstanding (unpaid) invoices.  

 

Fill in the invoice number 
and date.  

Enter the full amount of the 
invoice, including tax and 
freight, even if the 
customer has already paid 
part of it. You’ll record any 
payments in the next step.   

4. In the Home window on the Reports menu, choose 
Customers and Sales, then Customer Aged. Select Detail and 
print a report for all customers. Check that you entered 
everything correctly. If you find any errors, correct them by 
entering a historical payment for the invoice (follow step 5), 
and then enter the invoice correctly. 

5. On the Historical Transactions tab, click Payments to add 
information about paid invoices.  

 

Enter a cheque number or 
credit-card name.  

Enter the amount paid, 
and the discount, if any.  

Simply Accounting 
automatically displays the 
invoices you entered in step 3. 

 

6. Print the Customer Aged Detail report and keep a copy for 
your records. 

Adding Payroll History 

If you issued any paycheques for the current calendar year 
before you started using Simply Accounting, you should record 
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the year-to-date earnings and deductions for each employee. If 
you do not, your year-end totals may be incorrect, and you or 
your employees might end up paying too much tax. Also, your 
Canadian T4 and Relevé 1 slips or U.S. W-2 forms will probably 
be wrong.  

Follow the steps below for each employee.  

1. Add employee records, as described under “Adding 
Employees” in Chapter 15.  

2. Record the employee’s historical information: 

On this tab:  If you are using the 
Canadian version of Simply 
Accounting: 

 If you are using the U.S. 
version of Simply Accounting: 

Income Fill in the regular income, 
benefits, vacation owed and paid, 
and advances for the historical 
and current calendar year. 

Fill in the regular income, 
benefits, vacation paid, and 
advances for each quarter in the 
current calendar year. 

Taxes Enter the employee’s year-to-date 
tax deductions. 

For historical amounts, use the 
Historical Tax Amount tab. 

Deductions Enter the employee’s historical 
and year-to-date deductions. 

Enter the employee’s year-to-date 
deductions for each quarter. 

Historical Tax 
Amount 

– Enter the employee’s tax 
deductions for each quarter. 

Historical 
Expense 
Amount 

– Enter the Medicare, Social 
Security, and other expenses for 
each quarter. 

 

3. In the Home window on the Reports menu, choose Payroll, 
then Employee. Select Summary, then Select All, then OK, to 
display a list of employees and their year-to-date earnings 
and deductions. Check that you entered everything 
correctly.  
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4. If you find any errors, correct them in the employee record, 
then print the Employee Summary report and keep a copy 
for your records.  

Adding Inventory History 

You can record the opening quantity and value of your 
inventory, and the quantity and amount sold in the year to date 
and last year for inventory and service items. If you do not enter 
this information, the program assumes that the quantities are 
zero. We recommend that you enter this information, to have a 
more accurate picture of your inventory history. Follow the steps 
below for each item. 

1. Add inventory records, as described under “Make a List of 
the Items and Services You Buy and Sell” in Chapter 9.  

2. For inventory items, click the History tab and fill in the 
information.  

 

Enter the quantity and 
value of the item, as of the 
day you began using 
Simply Accounting.  

 

3. For all items, click the Statistics tab and fill in the 
information.  

 

Fill in the information for the 
year to date and last year. 
(The Cost of Goods Sold 
fields do not appear for 
service items.) 

 

4. In the Home window on the Reports menu, choose 
Inventory and Services, then Quantity. 
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a) Under Select From, select Inventory By Item. 

b) Under Report Quantities In, select Stocking Units, and 
then click the Select All button. 

c) Click OK. Check that you entered the quantities and 
minimum levels correctly. 

5. In the Home window on the Reports menu, choose 
Inventory and Services, then Statistics.  

a) Under Select From, select All Items, then click the Select 
All button.  

b) Under Select Details to Report, check the boxes for the 
details you want to include.  

c) Click OK, then check that you entered the number of 
transactions, units sold, amount sold, cost of goods sold, 
and last sale date correctly. 

6. In the Home window on the Reports menu, choose 
Inventory and Services, then Synopsis.  

a) Under Select From, Select Inventory By Item. 

b) Under Report On, choose Item Synopsis, then click the 
Select All button. 

c) Click OK, then check that you have entered the units, 
price, cost, and total value correctly.  

7. If you find any errors, correct them in the inventory record.  

8. Print the inventory reports and keep a copy for your records. 

Adding Project History 

You use the Project window to list the projects you are working 
on and their start dates.  

Since the Project module does not have its own transaction 
window, it is not affected by the Finish Entering History 
command. However, it’s a good idea to enter the start dates and 
opening balances for any projects currently under way.  
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1. Add project records, as described under “Add a List of 
Projects” in Chapter 5. 

2. In the Project record, click the Project tab and fill in the 
information.  

 

Fill in the start date and the 
opening balances for 
revenue and expense.  

 

3. In the Home window on the Reports menu, choose Project, 
then Income. 

a) Under Select Projects, choose Select All.  

b) Under Select Accounts, choose Select All. 

c) Check the Balance Forward box.  

4. Click OK, then check that you entered the balances correctly. 

Finish Entering History 

 

Once you have added your records and historical information, 
and have set up the linked accounts for the modules you plan to 
use, you must tell Simply Accounting that you have finished 
entering history.  

All history should be entered by the end of the first fiscal year, 
before completing year-end procedures. (See ”End of a Fiscal 
Year” in Chapter 21 for more information about year-end.).  

After you select the Finish Entering History command, you cannot 
enter additional historical information. The program will record 
invoice and payment information only when you make an entry 
in a transaction window. However, you can still see the 
historical totals in the records windows. For example, you can no 

 Decide when to add 
 Add history 

 Finish entering history 
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longer change the year-to-date or last-year sales totals, but you 
can see the amounts on the Statistics tab in the customer record.  

Note that, if you have hidden some modules (using View, User 
Preferences, Modules in the Home window) before you follow 
these steps, the hidden modules will still be set to allow 
historical transactions if you display them later.  

Simply Accounting 
Pro or higher 

If you are using Simply Accounting Pro or higher, you must be 
logged in as the system administrator in single-user mode before 
you can follow these steps.  

1. Back up your data. (In the Home window on the File menu, 
choose Backup.) 

2. In the Home window on the History menu, choose Finish 
Entering History.  

3. If your data contains errors, Simply Accounting displays a 
detailed list telling you where the errors are. Print the list, 
correct the errors, then choose the Finish Entering History 
command again.  

Where To Now? 
 Refer to Parts 2 through 6 of this manual for more 

information about using Simply Accounting for day-to-day 
business. 
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Part 2 

Once you have finished setting up Simply Accounting to suit your 
company, you are ready to start using it for day-to-day transactions. 

 

Chapter 12 — Buying 

Chapter 13 — Selling 

Chapter 14 — Paying Bills 

Chapter 15 — Paying Employees 

Chapter 16 — Entering Other Types of Transactions 

Chapter 17 — Allocating Revenues and Expenses to Projects 

Chapter 18 — Keeping Track of Employee Time and Billing 

 

D
ay-To-D
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Chapter 12 
Buying 
 

Use Simply Accounting to record remittance payments, purchases, orders, and 
quotes. All of your accounts are automatically updated, allowing you to track 
the amount of inventory you have on hand and the amount that you owe to 
vendors. 

 

Setting Up Options for Vendors and Purchases ......................................12–1 
Adding Vendors ..................................................................12–1 

Map Payroll Authorities to Payroll Liability Accounts ............................12–4 
Entering a Purchase ...............................................................12–5 

Editing Taxes .................................................................12–7 
Ordering Goods and Services ......................................................12–8 
Getting a Quote from a Vendor.....................................................12–9 

Ordering Goods and Services Based on a Quote ..................................12–9 
Receiving Goods and Services .................................................12–10 

Paying for Goods and Services ....................................................12–11 
Prepaying Goods and Services.................................................12–12 
Applying a General Prepayment to a Payment ..................................12–12 

Remitting a Payment to a Payroll Authority ........................................12–13 
Correcting or Cancelling Purchases, Orders, and Quotes.............................12–15 

Changing or Cancelling a Purchase Invoice .....................................12–16 
Changing or Cancelling a Purchase Order or Quote .............................12–17 
Manually Correcting a Purchase Invoice........................................12–18 

Correcting or Cancelling Payments to Vendors .....................................12–18 
Automatically Correcting or Cancelling Payments to Vendors ....................12–19 
Manually Correcting or Cancelling Payments to Vendors ........................12–20 
Manually Correcting Payments to Payroll Authorities ...........................12–20 
Correcting or Cancelling Prepayments .........................................12–22 
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What You Need to Do 
 Set up options for your vendors and purchases. 

 Add vendors. 

 Enter quotes, orders, or purchases. 

 Pay for the purchase. 

Setting Up Options for Vendors and Purchases 

 

Make sure that you have set up your vendor and purchasing 
options properly before using Simply Accounting to record 
purchases. See “Enter Payment Options for Vendors and 
Customers,” in Chapter 3, for more information. 

 

 

 

 Set
 Ad
 Ent
 Pa s 

 
 
 
 

 up options 
d vendors 
er purchases 
y for purchase
Adding Vendors 

You can purchase goods and services without adding vendors to 
Simply Accounting; however, we highly recommend that you 
add them. If you wish to purchase something and pay for it later 
or enter a purchase order or quote, you must have a vendor on s 
Set up options 

Add vendors 
Enter purchases 
Pay for purchase
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file first. 

Simply Accounting uses the term “payroll authority” to identify 
vendors to whom you remit payments for tax and other payroll 
liabilities. When you match one or more payroll liability 
accounts to a payroll authority, Simply Accounting 
automatically keeps track of the total amount owed to the 
payroll authority.  

Adding vendors to Simply Accounting allows you to track 
purchases and debts to vendors easily. For example, Simply 
Accounting can remind you to pay bills and payroll remittances 
on time. You can also print reports that help you to analyze your 
purchases or to determine the amount to remit to a payroll 
authority. 
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You can add vendors using the Vendors window or you can add 
a vendor as you make the purchase. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Vendors icon. 

 
Create 2. On the File menu, choose Create and enter the Vendor’s 

name. 

3. Fill in the information on the Address tab. 

 Note:  The Canada Revenue Agency requires you to report a 
company’s business number or an individual’s Social 
Insurance Number for certain services. You can place this 
number in the Tax ID field.  

Simply Accounting 
Pro or higher 

Department field.  If you use Simply Accounting Pro or 
higher, and have set up departments, this field appears on 
the Address tab. The department entered in this field will be 
used automatically when you enter purchases or payments 
for this vendor. For example, if you set up account 2200 as 
your linked Accounts Payable account, and you assign 0100 
as the vendor’s department, then a purchase transaction for 
that vendor would update the account 2200-0100 Accounts 
Payable. 

For information about setting up departments, see 
“Accounting by Departments” in Chapter 2 of this guide. 

4. Click the Options tab and fill in the information:  

 

This box appears if you have 
set up a second currency. 

  If this vendor is a 
subcontractor who provides 
construction services, check 
this box. For more information 
about T5018 slips, see “End of 
a Contract Payment 
Reporting Period” in 
Chapter 21.   

Expense Account.  The account you select in this field will 
appear automatically in the Account field when you select 



Chapter 12:  Buying 

User Guide    12−3 

 
  

SIM2006 ENGL UG Part 2 (12-13) PRINT.doc, printed on 9/27/2005, at 10:26:38 AM. Last 
saved on 9/14/2005 9:15:00 AM. 

ACCPAC International, Inc. Confidential 

the vendor in the Purchases, Orders, and Quotes window, so 
you don’t have to select it every time. 

Charge Duty on Items Purchased.  This option appears 
only if you chose to track duty on imported items in the 
System Settings window. If you select this option, then the 
Duty % and Duty (Amount) fields will appear when you 
select the vendor in the Purchases, Orders, and Quotes 
window. 

Synchronize with Microsoft® Outlook®.  If you are using 
Simply Accounting Pro or higher, you can automatically 
update your vendor or customer contact information in 
Microsoft Outlook, so you don’t have to re-enter the 
information (See “Synchronizing Your Vendor and 
Customer Records with Microsoft Outlook” in Chapter 22.) 

Note:  If you are creating a vendor record for a payroll 
authority, you probably will not be purchasing goods or 
services from this vendor. If this is the case, the only fields 
that you need to complete on the Options tab are Conduct 
Business In and Currency (if you have set up another 
currency). Other fields on the Options tab, such as discount 
for early payment, do not apply to payments remitted to 
payroll authorities.  

5. On the Statistics tab, enter information about the purchases 
you made last year and this year.  

6. Fill in the information on the remaining tabs. 

Note:  For a payroll authority, be sure to set the Tax Exempt 
fields on the Taxes tab to Yes. Do not enter information in 
any of the other fields on the Taxes tab or on the 
Import/Export tab. These fields apply only to vendors from 
whom you purchase goods or services. 

If you will be remitting taxes on other payments to this 
vendor, be sure to check the Payroll Authority box. 
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For more 
information on: 

See: 

Taxes “Enter Tax Codes for Vendors and 
Customers” in Chapter 3. 

Statistics Chapter 11, “Adding Historical 
Information.” 

Memos “Adding Memos to the To-Do List” in 
Chapter 22. 

Importing and 
Exporting 

The Advanced Topics file. (In the Home 
window, from the Help menu, choose 
Simply Accounting Manuals, and then 
Advanced Topics.) 

Additional 
Information  

“Set Up Fields to Store Additional 
Information” in Chapter 3.  

Historical 
Transactions 

Chapter 11, “Adding Historical 
Information.”  
This tab appears only if you have not 
finished entering history. 

 
Save 7. Choose Save from the File menu. 

8. If you entered a vendor record for a payroll authority, map 
the payroll authority to the payroll liability accounts for 
which you will remit payments. See the next section for 
more information.  

Map Payroll Authorities to Payroll Liability Accounts 

After you have set up your payroll authorities, map each payroll 
liability account to its respective payroll authority so that Simply 
Accounting can track the amounts you owe the authority.  

To map liability accounts: 

1. In the Home window on the Setup menu, choose System 
Settings, then Settings, or select the Settings icon on the 
Payroll tab. 

2. Click Remittance. 
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Click to select a payroll 
authority to whom you 
will remit a payment for 
the payroll liability.   

 

3. Click OK. 

  Entering a Purchase 

 

Use the Purchases, Orders, and Quotes window to purchase 
goods and services. 

Entering purchases into Simply Accounting allows you to track 

 
 
 
 s 
Set up options 
Add vendors 

Enter purchases 
Pay for purchase
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not only your purchases, but also information on your inventory. 
You can analyze your costs and profits easily. Simply 
Accounting can also remind you to re-order items when stocks 
are getting low. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Purchases, Orders, and Quotes icon or the 
Invoices icon. 

2. In the Transaction field, select Invoice, and then select the 
method of payment. If the vendor will bill you later for this 
invoice, select Pay Later.  
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You can enter a new 
vendor, account, inventory 
item, or service “on the fly” 
by typing a new name. 

The payment method 
determines which fields 
appear on the screen. 

If you pay by cash or 
cheque, select the bank from 
which the funds will be 
withdrawn. 

If you buy from a foreign 
vendor, you can change 
the exchange rate. 

 

3. Select or enter the vendor. If you plan to do business with 
this vendor only once and do not want to add the name to 
Simply Accounting, type the name of the vendor, press the 
Tab key, and then click Continue. 

Note:  If the vendor is not listed in your Simply Accounting 
vendor records, you must pay the invoice immediately. 
Choose Cash, Cheque, or Credit Card in the Paid By field. 

4. After you have entered the date and other background 
information, fill in the goods and services that you are 
purchasing. 

If you select an item that is listed in your inventory records, 
the Account field is filled in automatically. If not, you must 
select an account in which you can record the value of the 
item. Usually, you select an asset account, in the 1000 range, 
for an inventory item, and an expense account, in the 
5000 range, for a service. 

5. Fill in the freight information, if necessary.  

Note:  If you are buying from a foreign vendor, you must 
enter the freight amount in the foreign currency. 

6. If you need to edit tax amounts, see the next section, 
“Editing Taxes.” 
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Track 
Shipments 

7. If you want to track the shipment of purchased goods, you 
can choose Track Shipments from the toolbar or Purchase 
menu and enter the shipper’s name and tracking number. 
You must set up shippers in Simply Accounting before you 
can track shipments. For more information, see “Set Up 
Shippers” in Chapter 3. 

 
Print 8. If you are paying for this purchase by cheque, you can 

choose Print from the File menu or toolbar to print a cheque. 

 
9. Click Process. 

Editing Taxes 

You can change the tax amount of an individual item, of a 
freight charge, or of the entire purchase transaction. 

To edit the tax amount of an item line or freight charge: 

1. Choose the item or freight charge. 

2. Choose Tax Summary for Line from the Purchase menu, or 
press Ctrl+Y.  

3. In the Line or Freight Tax Summary window, change the tax 
amounts as required. 

4. Click OK.  

To edit the total tax amounts of the purchase transaction:  

1. From the Purchase menu, choose Tax Summary. Or, click the 
List Button next to the Tax field. 

Note:  If two tax fields appear, click the List button beside 
the second tax field to edit both taxes. 

2. In the Total Tax Summary window, change the tax amounts 
as required. 

3. Click OK. 
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Ordering Goods and Services 
Enter a purchase order in Simply Accounting when you 
purchase goods or services that you have not yet received. 

If you receive only part of a shipment, you must enter the 
transaction as an order first. Then, you can record part of the 
order as received, and have a record of the items that you expect 
to receive later. For more information on receiving goods, see 
“Receiving Goods and Services” later in this chapter. 

If you have already entered a quote for the order, follow the 
instructions in “Ordering Goods and Services Based on a 
Quote,” later in this chapter. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Purchases icon or the Purchases, Orders, and 
Quotes icon. 

2. In the Transaction field, select Purchase Order. 

3. Fill out the order just as you would for a purchase. (For 
more information on purchases, see “Entering a Purchase,” 
earlier in this chapter.)  

 

Enter the date that the 
vendor has told you 
they will ship goods or 
provide services. 

You can e-mail the 
order to the vendor. 

You should allow Simply 
Accounting to 
automatically calculate 
the number of back-
ordered items. 
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4. Click Record. 

Note:  Simply Accounting updates your inventory records to 
record the pending order. No money has changed hands, so 
the account balances are not affected. 

Getting a Quote from a Vendor 
If your staff requires approval before entering orders or if you 
are getting several estimates for an item, you can use Simply 
Accounting to record a quote. You can then easily create an 
order or purchase based on that quote. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Quotes icon or the Purchases, Orders, and Quotes 
icon. 

2. In the Transaction field, select Quote. 

3. Fill out the quote just as you would for a purchase. (For 
more information on purchases, see “Entering Purchases,” 
earlier in this chapter.) 

You may want to type a ship date now, so that when you 
order this item, you can quickly change the quote to a 
purchase order or invoice. 

 
4. Click Record. 

Note:  Simply Accounting stores the quote until you remove 
it or you order or purchase the items. If you need to remove 
a quote, see “Changing or Cancelling a Purchase Order or 
Quote,” later in this chapter. 

Ordering Goods and Services Based on a Quote 

When you decide to order an item based on a quote, you can 
retrieve the quote and change it to an order. This allows you to 
send the order to the vendor, and updates the Pending Orders 
report. The report tracks all unfilled purchase orders. 
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1. In the Home window on the Vendors and Purchases tab, 
choose the Purchase Orders icon or the Purchases, Orders, 
and Quotes icon. 

2. In the Transaction field, select Purchase Order, and then 
select the vendor. 

3. In the Order Number field, select the quote number, and 
press the Tab key. 

4. If you want to print a copy of the purchase order, choose 
Print from the File menu or toolbar. 

 
5. Click Record. 

Receiving Goods and Services 

Once you receive goods or services based on a quote or an order, 
you must change the transaction to an invoice. When you 
process the transaction, Simply Accounting adjusts your 
accounts and inventory levels. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Purchases, Orders, and Quotes icon or the 
Invoices icon.  

2. In the Paid By field, select the method of payment. 

3. In the Transaction field, select Invoice, and then select the 
vendor. 

4. In the Order/Quote Number field, select the order or quote 
number, and press the Tab key. 

5. Enter an invoice number. 

 
Fill 
Backordered 
Quantities 

6. In the Quantity field for each item, enter the number of items 
that you have received. If you are working with an order 
(not a quote), you can click the Fill Backordered Quantities 
toolbar button to automatically fill the entire order. 

Note:  If you do not receive all items, Simply Accounting 
continues to store the quote or order. 
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Print 7. If you are paying for this purchase by cheque, you can 

choose Print from the File menu to print a cheque. 

 
8. Click Process. 

 
Paying for Goods and Services 

 

If your vendors bill you for purchases, you have probably 
recorded the invoice in Simply Accounting, but have not yet 
recorded payment. You can pay for all or part of any invoice. 

If
in

 
 
 
  
Set up options 
Add vendors 
Enter purchases 

Pay for purchases
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1. In the Home window on the Vendors and Purchases tab, 
choose Pay Vendor Invoices or the Payments icon. 

2. Select Pay Purchase Invoices in the first field, and select the 
way you want to pay the invoices. Then, select the vendor 
that you are paying. 

3. In the list of unpaid invoices, fill in the payment information: 

 you receive a discount, fill 
 this field first. 

 

If you are paying a foreign vendor, enter the exchange rate 
on the day of payment. 
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Print 4. If you are paying by cheque, you can print a cheque by 

choosing Print from the File menu. 

 
5. Click Process. 

Prepaying Goods and Services 

If a vendor requests that you prepay items on order or that you 
give them a deposit for a large purchase, you can enter the 
payment into Simply Accounting. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Pay Vendor Invoices or the Payments icon. 

 
Enter Vendor 
Prepayments 

2. Make sure that Pay Purchase Invoices is selected in the first 
field and that the Enter Vendor Prepayments button is 
selected. 

3. Select a vendor, and fill in the rest of the prepayment.  

■ Make payments or prepayments on specific invoices in 
the Payment Amount column. 

■ Enter general prepayments in the Prepayment Amount 
field.  

 
4. Click Process. 

Applying a General Prepayment to a Payment 

Simply Accounting displays any prepayment that has not been 
applied to a specific invoice in the Payments window in red: 

 

You can apply a general prepayment to a single invoice or a 
series of invoices: 

1. In the Home window on the Vendors and Purchases tab, 
choose Payments or the Pay Vendors Invoices icon. 
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2. Pay the invoices as you normally would (as described in the 
previous section, “Paying For Goods and Services”). 

3. To apply the prepayment to these invoices, click in the 
Payment Amount field beside the prepayment. Type the 
amount that you want to apply to the payment. You must 
type a positive number.  

 
Print 4. If you are paying for the remaining amount of the purchase 

by cheque, you can choose Print from the File menu to print 
a cheque. 

5. Click Process. 

 
Remitting a Payment to a Payroll Authority 

 

When you process payroll, tax and other deductions are 
withheld from employee paycheques. These payroll deductions, 
along with any employer contributions and expenses become 
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payables – amounts that you owe to payroll authorities.  

Each payroll authority will advise you of the reporting period 
for which amounts must be paid, and will advise you of the date 
and frequency of remittance payments. For example, a tax 
authority may require that you remit a payment on the 15th day 
of every month for payroll tax deductions accrued in the prior 
month. If you've mapped the payroll authority to the 
appropriate payroll payable account, then Simply Accounting 
keeps track of the amount owing so that you can remit a 
payment.  

1. In the Home window on the Vendors and Purchases tab, 
choose the Pay Remittance or Payments icon. 

2. Enter payment information:  
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Enter a cheque number. 

Select the bank account 
from which the payment 
will be made. 

Select the payroll authority. 

Select the date to print on 
the cheque. This is also the 
transaction date. 

Simply Accounting shows the 
payroll account balances as 
of the period ending date. 

Select the remittance 
period end date. The 
amount owing will be 
reported as of this date. 

Enter your business number, 
or an account number that 
identifies your company.  

 

3. In the End of Remitting Period field, change the date to the 
end date for the remittance reporting period. The payroll 
amounts you owe the payroll authority will be calculated 
and displayed as of this date. 

4. In the Payments window, choose Display Remittance Report 
from the Report menu to see a detailed listing of transactions 
for the remittance reporting period. 

5. Enter an adjustment if: 

■ You need to record a penalty or interest charge (for 
example, a penalty charged for late payment) that you 
will remit with the current payment 

■ You are correcting a previous remittance payment 
cheque. 

Simply Accounting will automatically increase or decrease 
the payment amount by the adjustment amount. 

6. If the payment amount for a payroll liability is not correct, 
enter the amount you wish to remit in the Payment Amount 
field. Simply Accounting automatically recalculates the 
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amount of the cheque and displays the total in the Total 
field. 

7. In the Reference No. field, enter your company’s business 
number for tax remittances, or an account number that 
identifies your company. 

8. If you want to, enter a comment in the Comment field. 

9. To preview the transaction, choose Display Payment 
Transaction Detail from the Report menu. 

 
Print 10. If you are paying by cheque, you can print a cheque by 

choosing Print from the File menu or toolbar. 

 
11. Click Process. 

Correcting or Cancelling Purchases, Orders, and 
Quotes 

You can cancel purchase invoices or correct any errors. Simply 
Accounting automatically adjusts all necessary accounts, 
including inventory levels or payments. 

 

 

You cannot correct invoices automatically if you have turned off 
the Store Invoice Lookup Details option, if you have cleared the 
invoice, or if it was processed in a previous fiscal year. In this 
case, you need to manually correct the transaction, as described 
in “Manually Correcting a Purchase Invoice” later in this 
chapter. You can always automatically correct quotes and orders. 
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Simply Accounting creates two transactions when you make a 
correction. First, it reverses the original transaction. Second, it 
adds the new transaction. Both appear in transaction reports. 

Changing or Cancelling a Purchase Invoice 

 

When you change a paid invoice, Simply Accounting 
automatically tracks payment details. Do not manually change 
the payment for the invoice you are correcting. 

1. In the Home window on the Vendors and Purchases tab, 
choose Purchases, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice. 

 
Adjust Invoice 3. On the toolbar, click the Adjust Invoice button, or from the 

Purchase menu, choose Adjust Invoice. 

 

If you are unsure of the 
invoice number that 
you want to change, 
select a vendor, and 
click Browse. 

 

4. Once you have selected the invoice, click OK. 

5. If you want to cancel the invoice, remove all the items from 
the invoice. To remove a line, click the item, and then choose 
Remove Line from the Edit menu. Otherwise, make the 
necessary changes. 

Note:  When you change a quantity or amount, type the 
new amount, not the difference between the original and the 
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new amount. For example, to change 100 to 80, type 80, 
not -20. 

 
Print 6. If you need to print a new cheque, you can choose Print from 

the File menu. 

 
7. Click Process. 

If the amount you owe increases after the correction, you will 
find the invoice in the Payments window, and you can pay that 
extra amount as described in “Paying for Goods and Services” 
earlier in this chapter. 

If the amount you owe decreases, Simply Accounting does one 
of two things. If you did not select Pay Later when entering the 
original invoice, Simply Accounting assumes that you received 
the necessary refund and increases your cash. If, on the other 
hand, you selected Pay Later when entering the original invoice, 
Simply Accounting issues a credit note, which can be found in 
the Payments window. 

Changing or Cancelling a Purchase Order or Quote 

1. In the Home window on the Vendors and Purchases tab, 
choose the Purchases, Orders, and Quotes or the Purchase 
Orders icon. 

2. In the Transaction field, select Purchase Order or Quote. 

3. Select the vendor, and then in the Order/Quote Number 
field, choose the order or quote number from the list and 
press the Tab key. 

4. If you want to cancel the order or quote, choose Remove 
Purchase Order or Remove Quote from the Purchase menu. 
If you want to change the order or quote, choose Adjust 
Purchase Order or Adjust Quote, and make the necessary 
changes. 

 
5. If you are changing the purchase order or quote, click 

Record. 
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Manually Correcting a Purchase Invoice 

You must manually correct a purchase invoice if you have 
turned off the Store Invoice Lookup Details option. You also 
need to do this if the transaction occurred in a previous fiscal 
year or if you cleared a transaction and can no longer look it up. 

1. In the Home window on the Vendors and Purchases tab, 
choose Purchases, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice. Then, select the 
vendor. 

3. In the Paid By field, select the original method of payment. If 
you are correcting an unpaid invoice, select Pay Later. 

4. Enter an invoice number, followed by the letters COR or 
ADJ. 

5. Fill in the invoice as on the original, but precede all amounts 
with minus signs.  

 
6. Click Process. 

7. If you are cancelling or correcting an unpaid invoice, open 
the Payments window and pay this negative invoice and the 
original invoice. 

For more information on paying invoices, see “Paying for 
Goods and Services” earlier in this chapter. 

8. Re-enter the correct invoice, if necessary. 

Correcting or Cancelling Payments to Vendors 
The way you correct or cancel a payment to a vendor depends 
on whether you have cleared the details for the original invoice. 
As long as you have not cleared the details, you can correct or 
cancel the payment automatically. Otherwise, you must make 
the correction manually. 
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To correct a payment remitted to a payroll authority “vendor,” 
follow the instructions in “Manually Correcting Payments to 
Payroll Authorities” later in this chapter. 

If you are cancelling a purchase along with the payment, follow 
the instructions in “Correcting or Cancelling Purchases, Orders, 
and Quotes” earlier in this chapter. 

Automatically Correcting or Cancelling Payments to Vendors 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or the Pay Vendor Invoices icon. 

 
Include Fully 
Paid Invoices/ 
Prepayments 

2. Make sure that the Include Fully Paid Invoices/Prepayments 
toolbar button is selected. 

 
Adjust 
Payment 

3. Choose Adjust Payment from the toolbar or Payment menu. 

 

If you are unsure of the 
transaction that you 
want to change, 
select a customer, and 
click Browse. 

 

4. Once you have selected the payment, click OK. 

5. If you want to cancel the payment, remove any amounts in 
the Payment Amount column. To correct a payment amount, 
click in the Payment Amount column and change it. 
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Note:  When you change an amount, type the new amount, 
not the difference between the original and the new amount. 
For example, to change $100 to $80, type 80, not -20. 

 
6. Click Process. 

Manually Correcting or Cancelling Payments to Vendors 

You must manually correct a payment if you have turned off the 
Store Invoice Lookup Details option. You also need to do this if 
the payment occurred in a previous fiscal year or if you cleared a 
transaction and can no longer look it up. 

1. In the Home window on the Vendors and Purchases tab, 
choose Purchases, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice. In the Paid By field, 
select Pay Later. 

3. Select the vendor, and then enter the original invoice 
number followed by the letters REV (for payment reversal) 
in the Invoice field. 

4. In the Amount field, enter the incorrect payment amount (as 
a positive number). 

5. In the Account field, enter the account from which the 
payment was made, most likely an asset account. 

6. Clear the payment terms for the invoice. The invoice total 
should equal the total of the original payment you are 
correcting or cancelling. 

 
7. Click Process. 

8. If this is a correction, enter the correct payment in the 
Payments window. 

Manually Correcting Payments to Payroll Authorities 

If you make an error and processed a payment for an incorrect 
amount, and you want to correct the error before the next 
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remittance due date, then reverse and void the original cheque 
and then issue a new cheque. 

To adjust a payment: 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or Pay Remittances icon. 

2. Select Pay Remittance in the first field. 

Determine the original 
payment amount 

3. From the Payment menu, choose Look up Payment.  

4. In the Vendor Name field, select the payroll authority, then 
click the Browse button to select the payment in question. 
Take note of the payment amounts allocated to each payroll 
liability account. 

5. Choose Create New Payment from the Edit menu. 

Enter a new payment 6. Select the payroll authority to whom the original cheque was 
made. 

7. Select the bank account on which the new cheque will be 
drawn. 

8. If you have not set the starting cheque number for the 
selected bank, then enter the number of the new cheque. 

9. Change the cheque date, if required. 

10. Select the remittance period end date. The payroll account 
balances (Amount Owing) are reported as of this date. 

11. For each payroll liability account that needs to be adjusted: 

a) In the Adjustment column for each payroll liability 
account, enter the amount of the original payment. 

b) In the Payment Amount field, enter the amount of the 
new payment plus the adjustment amount.  

12. Enter a payment reference number (your business number 
for tax payments, or an account number that identifies you 
to the payroll authority), and an optional comment. 
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13. Preview the transaction by selecting Display Payment 
Transaction Details from the Report menu. 

 
Print 14. Click the print icon from the toolbar, or choose Print from 

the File menu to print a new cheque. 

 
15. Click Process. 

Correcting or Cancelling Prepayments 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or Pay Vendor Invoices icon. 

 
Enter Vendor 
Prepayments 

2. Make sure the Enter Vendor Prepayments button is selected, 
and that you have selected Pay Purchase Invoices. 

 
Adjust 
Payment 

3. Click the Adjust Payment button on the toolbar, or from the 
Payments menu, choose Adjust Payment. 

 

If you are unsure of the 
payment number that 
you want to change, 
select a vendor, and 
click Browse. 

 

4. In the Prepayment Amount field, change or clear the 
amount. 

5. Click Process.
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Chapter 13 
Selling 
 

Use Simply Accounting to record sales, orders, and quotes. All of your accounts 
are automatically updated, allowing you to track the amount of inventory you 
have on hand and the amount that your customers owe you. 

 

Setting Up Options for Customers and Sales ........................................ 13–1 
Adding Customers ............................................................... 13–1 

Adding Basic Customer Information............................................ 13–2 
Entering a Sale ................................................................... 13–4 

Editing Taxes................................................................. 13–6 
Entering an Order from a Customer ................................................ 13–7 
Giving a Quote to a Customer ..................................................... 13–8 

Entering an Order for Goods and Services Based on a Quote ...................... 13–9 
Filling an Order or Quote..................................................... 13–10 

Receiving Payment for Goods and Services ........................................ 13–10 
Receiving a Payment on Unpaid Invoices ...................................... 13–11 
Receiving Deposits from Customers ........................................... 13–11 
Applying a General Deposit to a Customer Payment ............................ 13–12 

Correcting or Cancelling Sales, Orders, and Quotes ................................. 13–12 
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What You Need to Do 
 Set up your sales options. 

 Add customers. 

 Enter sales. 

 If you bill your customers, receive payment for the items 
you sold. 

Setting Up Options for Customers and Sales 

 

Make sure that you have set up your customer and sales options 
properly before adding sales to Simply Accounting. See “Enter 
Payment Options for Vendors and Customers” in Chapter 3 for 
more information. 
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Adding Customers 

You can sell goods and services without adding customers to 
Simply Accounting; however, we highly recommend that you 
add them. If you wish to sell something and receive payment for 
it later or enter a sales order or quote, you must add a customer  
Set up options 

Add customers 
Enter sales 
Receive payment
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first. 

Adding customers to Simply Accounting allows you to track 
sales and customer orders easily. For example, Simply 
Accounting can remind you when customer payments are 
overdue. You can also print reports on your sales to help analyze 
them. 

You can add customers using the Customers window or you can 
add a customer as you make a sale. 
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Adding Basic Customer Information 

1. In the Home window on the Customers and Sales tab, 
choose the Customers or Add Customer icon. 

 
Create 2. On the File menu, choose Create and enter the customer 

name. 

3. Fill in the details on the Address tab. 

Simply Accounting 
Pro or higher 

Department.  If you use Simply Accounting Pro or higher, 
and have set up departments, this field appears on the 
Address tab. The department entered in this field will be 
used automatically when you enter sales or receipts for this 
customer. For example, if you set up account 1200 as your 
linked Accounts Receivable account, and you assign 0100 as 
the customer’s department, then a sales transaction for that 
customer will update the 1200-0100 Accounts Receivable 
account. 

For information about setting up departments, see 
“Accounting by Departments” in Chapter 2 of this guide. 

Internal Customer.  If this “customer” is a department in 
your company (such as admin or professional development), 
check the Internal Customer box to be able to include it on 
Time and Billing reports (Pro and higher versions). You 
cannot select them when filling out sales invoices. 

4. Fill in the details on the Ship-to Address tab. If you ship 
items to the company’s main address, you can select Same 
As Mailing Address on the Ship-to Address tab. 

5. Click the Options tab and fill in the information: 

The customer’s terms 
override the discount terms 
you entered in the system 
settings. 

You can print or e-mail 
invoices, statements, and 
other forms to your customers.  

Choose a revenue account 
and price list for this customer. 
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Revenue Account.  The account entered in this field will 
appear automatically in the Account field when you select 
the customer in the Sales, Orders, and Quotes window, so 
you don’t have to select it every time. 

Price List.  Choose a price list to use for this customer. This 
will determine which prices appear in the Price field when 
you create invoices for this customer. For more information 
on creating and maintaining price lists, see Chapter 9, 
“Setting Up a List of Inventory and Service Items.” 

Synchronize with Microsoft® Outlook®.  If you are using 
Simply Accounting Pro or higher, you can automatically 
update your vendor or customer contact information in 
Microsoft Outlook, so you don’t have to re-enter the 
information (See “Synchronizing Your Vendor and 
Customer Records with Microsoft Outlook” in Chapter 22.) 

6. Fill in the information on the remaining tabs. 

For more 
information on 

See 

Taxes “Enter Tax Codes for Vendors and 
Customers” in Chapter 3. 

Statistics (to set 
credit limit) 

Chapter 11, “Adding Historical 
Information.” 

Memo “Adding Memos to the To-Do List” in 
Chapter 22.  

Importing and 
Exporting 

The Advanced Topics file. (In the Home 
window, on the Help menu, choose 
Simply Accounting Manuals, and then 
Advanced Topics.) 

Additional 
Information  

“Set Up Fields to Store Additional 
Information” in Chapter 3.  



Part 2:  Day-To-Day Business 

13

 
  

SIM2006 ENGL UG Part 2 (12-13) PRINT.doc, printed on 9/27/2005, at 10:26:38 AM. Last 
saved on 9/14/2005 9:15:00 AM. 

For more 
information on 

See 

Historical Invoices Chapter 11, “Adding Historical 
Information.” 
This tab appears only if you have not 
finished entering history, as described in 
Chapter 11. 

 
Save 7. Choose Save from the File menu. 

 

 
Entering a Sale 

 

Use the Sales, Orders, and Quotes window to sell goods and 
services. 

Entering sales into Simply Accounting allows you to track not 
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only your sales, but also information on your inventory. You can 
analyze your costs and margins easily. Simply Accounting can 
also remind you to re-order items when stocks are getting low. 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice, and then select the 
method of payment. If you will bill the customer later for 
this invoice, select Pay Later.  
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You can enter a new 
customer, account, 
inventory item, or service 
“on the fly” by typing a 
new name. 

The payment method 
determines which fields 
appear on the screen. 
If you receive cash or a 
cheque, select the bank 
where the funds will be 
deposited. 

Simply Accounting 
automatically displays the 
prices from the price list you 
chose for this customer. You 
can change prices by 
clicking the List button or by 
typing a new price. 

 
3. Select or enter the customer name. If you plan to do business 

with this customer only once and don’t want to add the 
name to Simply Accounting, type the name of the customer, 
press the Enter key, and then click Continue. 

Note:  If you use a customer who is not listed in your 
Simply Accounting records, you must receive payment for 
the invoice immediately. 

4. Once you have entered the date and other background 
information, fill in the goods and services that you are 
selling. 

If you select an inventory item or service that is already 
listed in Simply Accounting, the Account field is filled 
automatically. Otherwise, you must select the account that 
will record the item’s value. Usually, you select a revenue 
account in the 4000 range. 

5. Fill in the freight information, if necessary.  

Note:  If you are selling to a foreign customer, you must 
enter the freight amount in the foreign currency. 
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6. If you want to track orders according to salesperson, specify 

the salesperson for the order. If you click the Pushpin button 
beside this field, the next sales order you enter will be 
assigned to the same salesperson. 

7. If you need to edit tax amounts, see the next section, 
“Editing Taxes.” 

 
Track 
Shipments 

8. To track the shipment of goods click Track Shipments on the 
toolbar or Sales menu. Enter the shipper’s name and tracking 
number. You must set up shippers in Simply Accounting 
before you can track shipments. For more information, see 
“Set Up Shippers” in Chapter 3. 

 
Print 9. To print an invoice for your customer, choose Print from the 

File menu. 

 
10. Click Process. 

Editing Taxes 

You can edit the tax amount of an individual item, of a freight 
charge, or of the entire sales transaction. 

To edit the tax amounts of an item line or freight charge: 

1. Choose the item or freight charge. 

2. Choose Tax Summary for Line from the Sales menu, or press 
Ctrl+Y.  

3. In the Line or Freight Tax Summary window, change the tax 
amounts as required. 

4. Click OK.  

To edit the total tax amounts of the sales transaction:  

1. From the Sales menu, choose Tax Summary. Or, click the 
List button next to the Tax field: 

 



Chapter 13:  Selling 

User Guide    13−7 

 
  

SIM2006 ENGL UG Part 2 (12-13) PRINT.doc, printed on 9/27/2005, at 10:26:38 AM. Last 
saved on 9/14/2005 9:15:00 AM. 

ACCPAC International, Inc. Confidential 

Note:  If two tax fields appear, click the List button beside 
the second tax field to edit both taxes. 

2. In the Total Tax Summary window, change the tax amounts 
as required. 

3. Click OK. 

Entering an Order from a Customer 
Enter an order in Simply Accounting when you sell goods or 
services that you have not yet shipped.  

If you ship only part of an order, you must enter the transaction 
as an order first. Then, you can fill part of the order. For more 
information on filling orders, see “Filling an Order or Quote” 
later in this chapter. 

If you have already entered a quote for the order, follow the 
instructions in “Entering an Order for Goods and Services Based 
on a Quote” later in this chapter. 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or Sales Orders icon. 

2. In the Transaction field, select Sales Order. 

3. Fill out the order just as you would for a sale. (For more 
information on sales, see “Entering a Sale,” earlier in this 
chapter.)  



Part 2:  Day-To-Day Business 

13−8    Simply Accounting 

 
  

SIM2006 ENGL UG Part 2 (12-13) PRINT.doc, printed on 9/27/2005, at 10:26:38 AM. Last 
saved on 9/14/2005 9:15:00 AM. 

ACCPAC International, Inc. Confidential 

Enter the date that you 
expect to ship goods or 
provide services. 

You can confirm the 
order via e-mail. 

You should allow Simply 
Accounting to 
automatically calculate 
the backordered items. 

 

 
4. Click Record. 

Note:  Simply Accounting updates your inventory to record 
the pending order. No money has changed hands, so the 
account balances are not affected. 

Giving a Quote to a Customer 
If a customer requests a price quote, you can use Simply 
Accounting to quickly put one together and print or e-mail it. 
You can easily change that quote to an order or a sale if the 
customer decides to purchase the items. 

Simply Accounting 
Pro or higher 

Sometimes giving a quote is a way of attracting new clients, in 
which case you must be aware of your pricing. Consider which 
item prices are important in securing this client’s order. If you 
are using Simply Accounting Pro or higher, you might even 
consider setting up a separate price list for this client, to make it 
easy to view and change item prices before presenting the quote 
to the customer. 
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Quotes do not affect your inventory reports. Only orders and 
invoices update your inventory. 

1. In the Home window on the Customers and Sales tab, choose 
Sales, Orders, and Quotes or the Quotes icon. 

2. In the Transaction field, select Quote. 

3. Fill out the quote just as you would for a sale. (For more 
information on sales, see “Entering a Sale,” earlier in this 
chapter.) 

Tip:  You may wish to type a ship date now, so that when the 
customer orders this item, you can quickly change the quote 
to a sales order or invoice. 

4. If you would like to give the customer special pricing, you 
can override the prices that display in the Price column. 

 
5. Click Record. 

Note:  Simply Accounting stores the quote until you remove 
it or the customer orders or purchases the items. For more 
information on removing quotes, see “Changing or 
Cancelling a Sales Order or a Quote,” later in this chapter. 

Entering an Order for Goods and Services Based on a Quote 

When you fill an order based on a quote that you entered into 
Simply Accounting, you can retrieve the quote and change it to 
an order. 

1. In the Home window on the Customers and Sales tab, 
choose Sales, Orders, and Quotes or the Sales Orders icon. 

2. In the Transaction field, select Sales Order, and then select 
the customer. 

3. In the Order Number field, select the quote, and press the 
Tab key. 

4. If you want to print a copy of the sales order, choose Print 
from the File menu. 
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5. Click Record. 

Filling an Order or Quote 

Once you ship the goods or provide the services based on an 
order or quote that you entered, you must change the 
transaction to an invoice. When you process the transaction, 
Simply Accounting adjusts your accounts and inventory levels. 

1. In the Home window on the Customers and Sales tab, 
choose Sales, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice, and then select the 
customer. 

3. In the Order/Quote Number field, select the sales order or 
quote you wish to fill, and press the Tab key. 

4. In the Paid by field, select the method of payment. 

 
Fill 
Backordered 
Quantities 

5. In the Quantity field for each item, enter the number of items 
that you have shipped. If you are working with an order (not 
a quote), you can click the Fill Backordered Quantities 
toolbar button to automatically fill the entire order. 

Note:  If you do not ship all items, Simply Accounting 
continues to store the quote or order. 

 
6. Click Process. 

 
Receiving Payment for Goods and Services 

 

If you bill your customers as opposed to receiving payment 
immediately when filling in an invoice, you can use the Receipts 
window to enter customer payments. 
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Enter sales 
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Note:  If you receive an overpayment from a customer, you can 
either apply it to another unpaid invoice or record it as a deposit 
and refund the excess amount. 
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Receiving a Payment on Unpaid Invoices 

1. In the Home window on the Customers and Sales tab, 
choose Receipts. 

2. Select the customer and other details, then enter the 
payment in the Payment Amount field. 

 

The discount is calculated 
based on the customer’s 
payment terms. 

Click here to enter the full 
payment or discount. You 
can type over the amount 
for partial payments or 
discounts. 

You can receive 
payments by cash, 
cheque, or credit card. 

 

 
3. Click Process. 

Receiving Deposits from Customers 

1. In the Home window on the Customers and Sales tab, 
choose the Receipts icon. 

 
Enter Customer 
Deposits 

2. Ensure that the Enter Customer Deposits toolbar button is 
on, and then select a customer. 

3. Fill in the remaining parts of the receipt: 

■ Enter deposits or prepayments on specific invoices in the 
Payment Amount column. 

■ Enter general deposits in the Deposit Amount field.  

4. If you want to print or e-mail a receipt for the customer, 
choose Print or E-mail from the File menu. 
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5. Click Process. 

Applying a General Deposit to a Customer Payment 

Simply Accounting displays any deposit that has not been 
applied to a specific invoice in the Receipts window in red: 

 

You can apply a general deposit to a single invoice or a 
series of invoices: 

1. In the Home window on the Customers and Sales tab, 
choose Receipts. 

2. Receive payment for the invoices as you normally would (as 
described under “Receiving a Payment on Unpaid Invoices,” 
earlier in this chapter). 

3. To subtract all or part of a deposit from the payment 
amount, click in the Payment Amount field beside the 
deposit. Type the amount that you want to apply to the 
payment. You must type a positive number.  

4. If you want to print or e-mail a receipt for the customer, 
choose Print or E-mail from the File menu. 

 
5. Click Process. 

Correcting or Cancelling Sales, Orders, and Quotes 
You can cancel or fix errors on a sale automatically. Simply 
Accounting adjusts all necessary accounts, including inventory 
levels or receipts. 
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You cannot correct invoices automatically if you have turned off 
the Store Invoice Lookup Details option, if you have cleared the 
invoice, or if it was processed in a previous fiscal year. In this 
case, you need to manually correct the transaction, as described 
in “Manually Correcting a Sales Invoice” later in this chapter. 
You can always automatically correct quotes and orders. 

 

Simply Accounting creates two transactions when you make a 
correction. First, it reverses the original transaction. Second, it 
adds the new transaction. Both appear in transaction reports. 

Changing or Cancelling a Sales Invoice 

 

When you change a paid invoice, Simply Accounting 
automatically prompts you to issue a credit note for overpaid 
amounts or adds unpaid amounts to the customer record. Do not 
manually change a related receipt. 

1. In the Home window on the Customers and Sales tab, 
choose Sales, Orders, and Quotes, or the Invoices icon. 

2. In the Transaction field, select Invoice. 

 
Adjust Invoice 3. Click the Adjust button on the toolbar: 
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If you are unsure of the 
invoice number that you want 
to change, select a customer 
and click Browse. 

 

4. Once you have entered the invoice, click OK. 

5. If you want to cancel the invoice, remove all the items from 
the invoice. To remove a line, click the item, and then choose 
Remove Line from the Edit menu. Otherwise, make the 
necessary changes. 

Note:  When you change a quantity or amount, type the 
new amount, not the difference between the original and the 
new amount. For example, to change 100 to 80, type 80, not 
-20. 

6. If you need to print or e-mail a new invoice, you can choose 
Print or E-mail from the File menu. 

 
7. Click Process. 

If the amount the customer owes you increases after the 
correction, you will find the invoice in the Receipts window, and 
you can receive that extra amount as described in “Receiving a 
Payment on Unpaid Invoices” earlier in this chapter. 

If the amount the customer owes you decreases, Simply 
Accounting does one of two things. If you did not select Pay 
Later when entering the original invoice, Simply Accounting 
assumes that you gave the customer a refund. If, on the other 
hand, you selected Pay Later when entering the original invoice, 
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Simply Accounting issues a credit note, which can be found in 
the Receipts window. 

Changing or Cancelling a Sales Order or a Quote 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes icon or the Invoices 
icon. 

2. In the Transaction field, select sales order or quote, and then 
select the customer. 

 
Search  3. In the Quote/Order No. field, enter an order or quote 

number and press the Tab key. Or, click the Search button to 
view a list of orders and quotes, then select one. 

 
Adjust Sales 
Order or Quote 

4. If you want to change the order or quote, click the Adjust 
button on the toolbar, or from the Sales menu, choose Adjust 
Sales Order or Adjust Quote, and make the necessary 
changes. If you want to cancel the order or quote, choose 
Remove Quote or Remove Sales Order from the Sales menu. 

 
5. If you are changing the sales order or quote, click Record. 

Manually Correcting a Sales Invoice 

You must manually correct a sales invoice if you have turned off 
the Store Invoice Lookup Details option. You also need to do this 
if the transaction occurred in a previous fiscal year or if you 
cleared a transaction and can no longer look it up. 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice. Then, select the 
customer. 

3. In the Paid By field, select the original method of payment. If 
you are correcting an unpaid invoice, select Pay Later. 

4. Enter an invoice number, followed by the letters COR or 
ADJ. 
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5. Fill in the invoice as on the original, but precede all amounts 
with minus signs. 

 
6. Click Process. 

7. If you are correcting or cancelling an unpaid invoice, open 
the Receipts window and receive payment for this negative 
invoice and the original invoice. 

For more information on receiving payments, see “Receiving 
a Payment on Unpaid Invoices,” earlier in this chapter. 

8. Re-enter the correct invoice, if necessary. 

Correcting or Cancelling Payments From 
Customers 

The way you correct or cancel a payment from a customer 
depends on whether you have cleared the details for the original 
invoice. If you have not cleared details and you have turned on 
the Store Invoice Lookup Details option, you can correct or 
cancel the payment automatically. Otherwise, you must make 
the correction manually. 

If you are cancelling a purchase along with the payment, follow 
the instructions in “Correcting or Cancelling Sales, Orders, and 
Quotes” earlier in this chapter. 

Automatically Correcting or Cancelling Payments from Customers 

1. In the Home window on the Customers and Sales tab, 
choose the Receipts icon. 

 
Include Fully 
Paid Invoices/ 
Deposits 

2. Make sure that the Include Fully Paid Invoices/Deposits 
toolbar button is selected. 

  
Adjust Receipt 3. Choose Adjust Receipt from the toolbar or Receipts menu. 
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If you are unsure of the 
receipt number that 
you want to change, 
select a customer, and 
click Browse. 

 

4. Once you have selected the receipt, click OK. 

5. If you want to cancel the receipt, remove any amounts in the 
Payment Amount column. To correct a payment amount, 
click in the Payment Amount column and change it. 

Note:  When you change an amount, type the new amount, 
not the difference between the original and the new amount. 
For example, to change $100 to $80, type 80, not -20.  

 
6. Click Process. 

Manually Correcting or Cancelling Payments from Customers 

You must manually correct a payment if the transaction 
occurred in a previous fiscal year or if you cleared a transaction 
and can no longer look it up. 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes icon, or the Invoices 
icon. 

2. Select the customer, and then enter the original invoice 
number followed by the letters REV (for payment reversal) 
in the Invoice field. 
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3. In the Amount field, enter the incorrect payment amount, as 
a positive number. 

4. In the Account field, enter the account into which the 
payment was deposited. 

The invoice total should equal the total amount of the 
original payment you are correcting or cancelling.  

 
5. Click Process. 

If this is a correction, enter the correct payment in the 
Receipts window. 

Correcting or Cancelling Deposits 

1. In the Home window on the Customers and Sales tab, 
choose the Receipts icon. 

 
Enter Customer 
Deposits 

2. Make sure the Enter Customer Deposits button is selected. 

 
Adjust 
Payment 

3. Click the Adjust button on the toolbar, or from the Receipts 
menu, choose Adjust Receipts. 

 

If you are unsure of the 
receipt number that 
you want to change, 
select a customer, and 
click Browse. 

 

4. In the Deposit Amount field, change or clear the amount. 

5. Click Process. 
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Accepting a Customer Return 
When customers return goods that they have not paid for, you 
can cancel the sale as discussed in “Changing or Cancelling a 
Sales Invoice” earlier in this chapter. Make sure to indicate that 
the invoice represents a return: in the Invoice field, add the word 
Return to the number. 

When a customer returns an item that they have already paid 
for, you can either return their money or offer them a credit on 
future purchases. 

Offering a Customer a Refund 

Part 1: Cancel the original invoice and return goods to 
inventory 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or the Invoices icon. 

2. Choose Invoice, and then select the customer’s original 
method of payment. Then, select the customer. 

3. In the Invoice field, enter the original invoice number, 
followed by the letters RET (for return). 

4. If you are returning goods into stock or offering a refund for 
services rendered, fill in the invoice exactly as you did for 
the original, but use negative values for the quantities and 
amounts. 

If you are offering a refund for goods that cannot be sold 
again, enter a quantity preceded by a minus sign, enter a 
description for the item, and then add the taxes. Also, 
change the Account (Acct) to the expense account you use 
for write-offs. 

5. If the customer receives early-payment discounts, but did 
not receive a discount for this invoice, clear the Discount 
field. 
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6. Once you have filled in the remaining parts of the form, click 

Process. 

Note:  If you are offering a cash refund, you may wish to 
print the invoice. The customer can then sign the refund slip, 
and you can keep it for your records. 

Part 2:  If necessary, issue a cheque 

If you want to print a cheque for the customer, follow these 
steps.  

Note:  If you want to write out the cheque manually, you do not 
need to follow these steps. 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or Make Other Payment icon. In the 
first field, select Make Other Payment. 

2. In the By field, select Cheque, then the bank account from 
which funds are withdrawn. 

3. In the To The Order Of field, type the name of the customer 
and press the Tab key. 

4. In the Account field, enter the bank account from which you 
are withdrawing the funds. Then fill in a description and the 
amount of the cheque. 

5. Fill in the remaining parts of the screen. 

 
Print 6. Choose Print from the File menu. 

 
7. Once you have filled in the remaining parts of the form, click 

Process. 

 

When you complete this transaction, no accounts have been 
changed. The proper accounts were reversed when you cancelled 
the original invoice in the first part of these instructions. 

Issuing a Credit Note 

If you want to issue a credit for future purchases as opposed to 
refunding the customer’s money, you can follow the steps above 
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for cancelling the original invoice and returning goods to 
inventory. Then you can enter a deposit for the customer for the 
amount of the original invoice. For information on entering 
deposits, see “Receiving Deposits from Customers” earlier in 
this chapter. 

Customers Who Don’t Pay 
When customers pay late, you may want to charge them a 
penalty. If a customer refuses to pay and you are unable to 
collect, you may need to write off an invoice as a bad debt. 

Charging Interest on Overdue Invoices 

If you have customers who don’t pay their bills on time, you can 
charge interest on overdue invoices. For information on setting 
up interest charges, see “Enter Payment Options for Vendors 
and Customers” in Chapter 3. Sometimes, you will encounter 
customers who pay their overdue invoices, but refuse to pay the 
interest charge. For this reason, Simply Accounting does not 
automatically add interest payments to invoices when they 
become overdue. You must enter the interest payment as a 
separate transaction. 

Note:  Overdue interest charges appear only on customer 
statements. To print a customer statement, in the Home window, 
from the Reports menu, choose Customers and Sales, and then 
Customer Statements. 

To accept an interest payment for a paid overdue invoice: 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice, and in the Paid By 
field, select Pay Later. 

3. Select the customer to whom you are charging interest. 

4. In the Invoice field, type Int and then the original invoice 
number. 



Part 2:  Day-To-Day Business 

13−22    Simply Accounting 

 
  

SIM2006 ENGL UG Part 2 (12-13) PRINT.doc, printed on 9/27/2005, at 10:26:38 AM. Last 
saved on 9/14/2005 9:15:00 AM. 

ACCPAC International, Inc. Confidential 

5. Fill in the details of the invoice: 

a) In the Description field, type Interest on overdue 
invoice. 

b) For the amount, type the amount of interest collected. 

c) In the Account field, select the revenue account in which 
you record interest revenues. 

6. Clear the payment terms for the invoice. 

 
7. Click Process. 

8. Receive the payment as you would for any other invoice. For 
more information on receiving payments, see “Receiving a 
Payment on Unpaid Invoices” earlier in this chapter. 

Writing Off Bad Debts 

Once you have decided that a customer is not going to pay an 
invoice, you must write it off. 

You must ensure that you have set up an expense account 
(5000-5999) for Bad Debts. 

 In Canada, you must also have the following accounts: 
 

Account Type 

ITC (Input Tax Credit) 
Adjustments 

Liability (2000-2999); subgroup with 
other GST accounts 

 ITR (Input Tax 
Refund) Adjustments 

Liability (2000-2999); subgroup with 
other QST accounts 

1. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes or the Invoices icon. 

2. In the Transaction field, select Invoice. In the Paid By field, 
select Pay Later. 

3. Select the customer, and then enter the original invoice 
number followed by the letters BD (for bad debt) in the 
Invoice field. 
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4. In the Amount field, enter the amount of the debt with the 
taxes subtracted, preceded by a minus sign. 

5. Double-click the Account field, and select the Bad Debts 
account. 

6. On the next line, in the Amount field, enter the amount of 
sales tax, preceded by a minus sign. 

7. Double-click the Account field. If you are in Canada, select 
the ITC Adjustments account. If you are in the United States, 
select the SST Payable account. 

 8. If you charged PST or QST, enter the amount preceded by a 
minus sign on the next line. For PST, select the PST Payables 
account. For QST, select the ITR Adjustments account. 

 
9. Click Process. 

10. In the Home window, open the Receipts window, and enter 
a cash receipt for this negative invoice and the original 
invoice. The receipt total should be zero.  

For more information on receipts, see “Receiving a Payment 
on Unpaid Invoices” earlier in this chapter. 
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Chapter 14 
Paying Bills 
 

Your vendors are not your only creditors. You need to pay credit-card bills, rent, 
phone bills, and other expenses. 

 

Paying Credit-Card Bills .......................................................... 14–1 
Paying Other Bills ................................................................ 14–2 
Correcting or Cancelling Other Kinds of Payments .................................. 14–2 

Automatically Correcting or Cancelling Other Payments ......................... 14–3 
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Paying Credit-Card Bills  
Simply Accounting allows you to reconcile your credit-card 
statements and then pay your credit-card bill. 

For more information on reconciliation, see “Reconciling 
Statements from a Bank or Credit-Card Company” in 
Chapter 20. To pay your credit-card bill, follow the instructions 
below: 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or Pay Credit Card Bill icon. 

2. In the first field, select Pay Credit Card Bill, and then fill in 
the rest of the form.  

Enter the fees and interest 
payment from the statement. 

 

 
Print 3. If you are paying a credit-card bill by cheque, you can print a 

cheque by choosing Print from the File menu. 

 
4. Click Process. 
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Paying Other Bills 
You can use Simply Accounting to pay any bill, such as your 
rent or a phone bill. You do not need to enter an invoice for a bill. 

1. In the Home window on the Vendor and Purchases tab, 
choose the Payments or Make Other Payment icon. 

2. In the first field, select Make Other Payment. 

3. Enter the payment information for the cheque:  

Select the expense account 
against which the payment 
will be recorded. 

 

 
Print 4. If you are paying this bill by cheque, you can print a cheque 

by choosing Print from the File menu. 

 
5. Click Process. 

Correcting or Cancelling Other Kinds of Payments 
You can clear a miscellaneous payment only if you have not 
cleared details for “other payments” from Simply Accounting. If 
you have cleared the payment or you have turned off the Store 
Invoice Lookup Details option, you must manually cancel or 
correct it. You must also have made the payment in the current 
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fiscal year. See “Manually Correcting or Cancelling Payments to 
Vendors” in Chapter 12. 

Automatically Correcting or Cancelling Other Payments 

1. In the Home window on the Vendors and Purchases tab, 
choose the Payments or Make Other Payment icon. 

2. In the first field, select Make Other Payment. 

 
Adjust 
Payment 

3. From the Payment menu, choose Adjust Other Payment: 

 

If you are unsure of the 
cheque number that you 
want to change, select a 
vendor and click Browse. 

 

4. Once you have entered the correct payment, click OK. 

5. If you want to cancel the payment, remove all the items from 
the payment. To remove a line, click the item, and then 
choose Remove Line from the Edit menu. Otherwise, make 
the necessary changes. 

 
6. Click Process. 
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Chapter 15 
Paying Employees 
 

Whether you have one employee or thousands of them, Simply Accounting helps 
you track and pay employees. Overtime, taxes, holiday pay—they’re all 
automatically calculated. 

 

Checking Your Payroll Options .....................................................15–1 
Adding Employees ................................................................15–1 

Adding Basic Employee Information ............................................15–2 
Adding Income Information for an Employee ....................................15–4 
Adding Taxes and Deductions for an Employee ..................................15–5 
Adding Entitlements for an Employee ...........................................15–6 
Setting up for Direct Deposit....................................................15–7 
Recording T4 and Relevé 1 Slips Information .....................................15–8 
Recording GST and QST on Employee Benefits ...................................15–9 

Deducting GST or QST from Each Paycheque.................................15–9 
Recording the GST or QST as a Payroll Expense..............................15–10 

Paying Individual Employees......................................................15–11 
Paying a Group of Employees with a Payroll Cheque Run ............................15–14 
Paying Out Vacation Time.........................................................15–16 

Checking How Much Vacation Pay You Owe an Employee .......................15–17 
Looking Up Information on Old Paycheques ........................................15–17 
Correcting Errors on Paycheques...................................................15–18 

Automatically Correcting an Employee’s Most Recent Paycheque .................15–18 
Correcting an Older Paycheque ................................................15–18 

Keeping Your Tax Tables Up To Date...............................................15–21 
Direct Deposit....................................................................15–21 

Setting up for Direct Deposit...................................................15–22 
Processing Payroll ............................................................15–22 

Printing Direct Deposit Stubs...............................................15–22 
Submitting the Direct Deposit File..............................................15–23 

Printing a Direct Deposit Log ..............................................15–23 
Clearing Direct Deposit Data ...............................................15–24 
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 Set up your payroll options. 

 Add employees. 

 Process the paycheques, either individually or in a cheque 
run. 

Note:  In order to use the automatic payroll calculation 
features in Simply Accounting, you need to provide a client 
ID and a payroll ID. Messages in the program describe how 
to obtain these IDs, and how to enter them. You can also 
enter the payroll ID in the Home window by selecting 
Unlock Auto Payroll in the Help menu. You do not need any 
IDs to calculate payroll manually. 

Checking Your Payroll Options 

 

Make sure that you have set up your payroll options properly 
before adding employees to Simply Accounting. See “Set Up 
Payroll Options” in Chapter 3.  

If you are unfamiliar with government requirements, read 
Chapter 18 “Payroll Accounting” in the Accounting Manual. 

 
Adding Employees 

 You can add employees using the Employees window or you can 
add an employee when you create a paycheque. 

Adding employees to Simply Accounting lets you keep track of 
basic information, such as the employee’s hire date and the 
amount you have paid the employee over a year. You can then 
process paycheques, automatically deducting the appropriate 
amounts from your bank account. 

You can also print cheques automatically; however, if you 
prefer, you can create a transaction for your records and then 
write your cheques from your chequebook. 

 Check options 
 Add employees 
 Process cheques 

 Check options 

 Add employees 
 Process cheques 
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Adding Basic Employee Information 

1. In the Home window on the Payroll tab, click the Employees 
icon. 

 
Create 2. On the File menu, choose Create. 

3. Fill in the information on the Personal tab. 

Simply Accounting 
Pro or higher 

Department.  If you use Simply Accounting Pro or higher, 
and have set up departments, this field appears on the 
Personal tab. The department entered in this field will be 
used automatically when you enter paycheques for this 
employee. 

For example, if you linked account 5300 as your Regular 
Wage Expenses, and you assign 0100 as the employee’s 
department, then processing a paycheque for that employee 
would update the 5300-0100 Regular Wage Expenses 
account. 

For information about setting up departments, see 
“Accounting by Departments” in Chapter 2 of this guide. 

Simply Accounting 
Pro or higher 

Job Category.  You can assign a job category to each 
employee to help track revenues, or to identify the 
employees who are required to submit time slips in Simply 
Accounting Pro or higher. 

For example, if you create a Sales category and assign this 
category to all your salespeople, you can track their 
revenues on sales invoices. 

To set up job categories, in the Home window on the Setup 
menu, select System Settings, and then choose Settings. Click 
Payroll. Under Payroll, select Job Categories. To save time, 
you can use the Job Categories window to assign several 
employees to a category at one time. For more information 
on setting up Job Categories, refer to “Create Job Categories” 
in Chapter 3. 

To learn about tracking salespeople on invoices, refer to 
Chapter 13, “Selling.” 
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Accounting 
Premium or 
higher 

Expense Group.  If you use Simply Accounting Premium or 
higher, and have turned on the Payroll Expense Group 
setting, this field appears. Expense groups enable you to 
have more than one set of payroll linked accounts to 
accurately distribute and track payroll expenses. For more 
information about setting up expense groups, see “Setting 
Up a Payroll Expense Group“in Chapter 3. 

4. Click the Taxes, Income, and Deductions tabs and enter the 
information. For more information on these tabs, refer to the 
next two sections, “Adding Income Information for an 
Employee,” and “Adding Taxes and Deductions for an 
Employee.”  

5. If you wish to record information about the employee’s 
entitlements, complete the Entitlements tab. See the section 
“Adding Entitlements for an Employee,” later in this 
chapter. 

6. If you have set up user-defined expenses, complete the User-
Defined Expenses tab. In Canada, this information is entered 
using the WCB and Other Expenses tab. 

7. If you plan to directly deposit the employee’s paycheques 
into the employee’s bank account, fill in the information on 
the Direct Deposit tab, as described in the section “Setting 
up for Direct Deposit,” later in this chapter. 

8. If you have set up fields to contain additional information 
about employees, fill in the Additional Info tab.  

  9. If your company has records from the previous tax year, fill 
in the information on the T4 and RL-1 Reporting tab. 

 
Save 10. Choose Save from the File menu. 
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Adding Income Information for an Employee 

When adding or changing an employee, click the Income tab for 
the employee to enter their current pay.  

 

Add up the amount of 
taxable benefits that you 
pay on behalf of this 
employee, such as child 
care. 

Canadian employers need 
to track and retain 
vacation pay. 

 

 

Displays quarter-to-date 
amounts. 

 

Hours Per Period:  This field appears for an income that is an 
hourly rate or differential rate. Enter the number of hours 
normally worked for this type of income. 

 In the Canadian version, Hours Per Period also appears for an 
item defined as an “income” type whose Insurable Hours option 
has been selected (in System Settings, Settings, Payroll tab). For 
such an income, the Hours Per Period will be reported on 
paycheques as EI insurable hours. 

Benefits Per Period:  Remember that the amount you enter for 
Benefits Per Period is not added to an employee’s cheque. 
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prints the information on T4 and Relevé 1 slips or W-2 forms. 

 Wage Expenses:  You can link employees or groups of 
employees to different wage expense accounts. This is useful if, 
for example, you want to track the wages for a particular type of 
employee in one account, and others in different accounts. 

 GST/QST:  Do not enter the amount of GST or QST charged on 
the taxable benefits in the Benefits Per Period field. Instead, use a 
GST or QST Benefits field, as explained in “Recording GST and 
QST on Employee Benefits” later in this chapter. 

 Vacation Pay:  Whether you retain vacation pay or pay it out on 
every paycheque varies according to provincial legislation. If you 
retain vacation pay, you should read “Paying Out Vacation 
Time” later in this chapter. 

 Record Wage Expenses In:  If you want to track an employee’s 
wages in a different payroll expense account, click the second 
button and select an account from the list. In Canada, if you are 
using Simply Accounting Premium or higher, and if you have set 
up payroll expense groups, this field does not appear. 

Adding Taxes and Deductions for an Employee 

You are responsible for deducting taxes and various other 
amounts from employee paycheques. You can record these 
deductions for each employee. 

Tax and deduction information is found on the Taxes and 
Deductions tabs. You may wish to consult with the Canada 
Revenue Agency, U.S. Internal Revenue Service, and state tax 
authorities to find out more about deductions and claims. 
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The employee may 
request additional tax to 
be deducted to cover 
taxes on other income or 
capital gains. 

The province you select 
determines the amount of 
tax to deduct. 

 

The state you select 
determines which fields 
appear below. 

Enter the number of state 
withholding allowances 
the employee claims. 

 

You can deduct amounts based on a percentage or a fixed 
amount. You can specify which deductions are by percentage 
and which are by amount in the Settings window. For more 
information, see “Set Up Payroll Options” in Chapter 3.  

Adding Entitlements for an Employee 

You can track employee entitlements such as sick days or leaves 
of absence. 

The settings you specified on the Payroll Settings window 
appear in all employees’ records, but you can change them for 
each employee. 
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Enter the typical number 
of hours in a work day. 

For each entitlement that 
you use, enter the 
information. 

 

Setting up for Direct Deposit 

If you have registered for the Direct Deposit service, you can set 
up to have an employee’s paycheque directly deposited into the 
employee’s bank account. For detailed setup instructions, see the 
section “Direct Deposit” later in this chapter. 

Once you have registered, complete the information on the 
Direct Deposit tab of the Employees window: 

 

Click this box to be able 
to directly deposit the 
employee’s paycheques. 

Enter the employee’s 
bank account information 
and the amount or 
percentage of the 
employee’s paycheque 
to be deposited to the 
account. You can specify 
up to 12 bank accounts 
for each employee. 
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Click this box to be able 
to directly deposit the 
employee’s paycheques. 

Enter the employee’s 
bank account information 
and the amount or 
percentage of the 
employee’s paycheque 
to be deposited to the 
account. You can specify 
up to 12 bank accounts 
for each employee. 

 

Note:  When processing a paycheque, the program will first 
deposit the amounts you entered in the Amount column of the 
Direct Deposit tab. Then, for the remaining balance of the 
paycheque, the program will use the values entered in the 
Percentage column to calculate the amounts to be deposited. 

For example, for the employee record shown in the previous 
illustration, the program would distribute a paycheque of $200 
as follows: 

■ $100 is deposited to account number 33333, leaving a 
balance of $100. 

■ $25 ($100 x 25%) is deposited to account number 11111. 

■ $10 ($100 x 10%) is deposited to account number 22222. 

■ $65 ($100 x 65%) is deposited to account number 44444. 

 Recording T4 and Relevé 1 Slips Information 

If your company has records from the previous tax year, the T4 
and RL-1 Reporting tab in the employee record includes fields 
for the current and prior years. 

EI Insurable Earnings.  Enter the employee’s insurable income 
for the year. The Prior Year field shows previous EI insurable 
earnings, if any. 
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pensionable earnings for the year. This amount appears in 
Box 26 on T4s and Box G on Relevé 1 slips. You can customize 
your Employee report so that it includes Pensionable Earnings. 
The Prior Year field shows the previous year’s pensionable 
earnings, if any. 

RPP/DPSP Registration Number.  If the employee belongs to a 
Registered Pension Plan or a Deferred Profit Sharing Plan, enter 
the plan number that should be printed on employee T4 slips. 

Pension Adjustment.  If required, enter the pension adjustment 
amount that will print on the employee’s T4 slip. 

T4 Employee Code.  If applicable, select a code from this field. 
It will appear in Box 29 on the employee’s T4 slip. 

 Recording GST and QST on Employee Benefits 

When an employee receives benefits subject to GST or QST, the 
government normally requires that you pay the tax as you 
would for a sale. However, exceptions do exist. Contact the 
Canada Revenue Agency or the ministère du Revenu du Québec 
for more information. 

Deducting GST or QST from Each Paycheque 

To be able to deduct the GST or QST from each 
paycheque: 

1. Add a liability account called GST Payroll Deductions or 
QST Payroll Deductions. For more information on adding 
accounts, see “Add or Change Accounts” in Chapter 2.  

2. In the Home window on the Setup menu, choose System 
Settings, and then Names and Terminology. 

3. On the Payroll tab, change the name of one of the Deduction 
options (1 through 20) to GST/Benefits or QST/Benefits, and 
click OK. 

4. In the Home window on the Setup menu, choose System 
Settings, and then Settings. Under Payroll, click Deductions. 
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5. Beside GST/Benefits or QST/Benefits, check the box to 
indicate that it should be deducted after tax, and click OK. 

6. On the Setup menu, choose System Settings, then Linked 
Accounts. Click the Payroll Deductions tab. 

7. In the GST/Benefits or QST/Benefits box, select the payroll 
deductions account you created in step 1. 

8. Click OK. 

To deduct the GST or QST from each paycheque: 

1. On the paycheque, enter the taxable benefit in the Benefits 
field. 

2. In the GST/Benefits or QST/Benefits field, enter the amount 
of GST or QST the employee must pay. 

 

When you process the paycheque, the sales tax the employee 
owes the government is recorded in the payroll deductions 
account. 

Recording the GST or QST as a Payroll Expense 

If you prefer not to deduct sales tax from each paycheque, you 
can record the following transaction during the current calendar 
year or as a prior-year expense. 

To be able to record the GST or QST as an additional payroll 
expense: 

■ Add a liability account called GST Payroll Deductions or 
QST Payroll Deductions. For more information on adding 
accounts, see “Add or Change Accounts” in Chapter 2.  

■ Add an expense account called GST Paid On Benefits or QST 
Paid On Benefits. 

To record the GST or QST expense: 

1. In the Home window on the General tab, choose the 
Miscellaneous Transactions icon. 
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Paid On Benefits account. Enter the amount of the tax in the 
debit field. 

3. In the Account field, select the GST or QST Deductions 
account. Enter the amount of the tax in the credit field. 

4. Fill in the remaining parts of the screen, and click Process. 

 
 

Paying Individual Employees 
 If you have only a few employees and want to print one 

paycheque at a time, follow the steps in this section. To print 
several or all cheques at once, see the next section, “Paying a 
Group of Employees with a Payroll Cheque Run.” 

If you want to print a post-dated cheque, you must set up Simply 
Accounting to allow transactions in the future. Read the section 
on dates in “Enter Background Information about your 
Company” in Chapter 3.  

To pay an individual employee: 

1. In the Home window on the Payroll tab, choose the 
Paycheques icon. 

 
Calculate 
Taxes 
Automatically 

2. On the toolbar, make sure that the Calculate Taxes 
Automatically button is selected.  

3. In the To The Order Of field, select an employee. 

4. If you have set up the employee to have the paycheque 
directly deposited to the employee’s bank account, check the 
Direct Deposit This Paycheque box. 

5. Enter any additional income or deductions, such as overtime 
or a pay advance: 

 Check options 
 Add employees 

 Process cheques 
- individually 
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Enter additional benefits 
in this field, such as the 
cost of a company car. 

When the employee pays back the advance, enter a 
negative value in this field. The current balance that the 
employee owes the company is noted in the YTD field.  

 If you retain vacation pay, and the employee takes some 
time off, you can release that pay by entering the amount in the 
Vacation Paid field. Total vacation pay owed appears in the 
Vacation YTD field.  

6. If you track employee entitlements, enter the entitlement 
days earned or released on the Entitlements tab.  

 

Simply Accounting 
calculates the days 
earned based on this 
field. 

Enter the days earned 
or released. 

 

7. If you have set up additional expense accounts, verify the 
amounts on the User-Defined Expenses tab, and change 
them as needed. 
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departments 

8. If you are allocating payroll amounts to multiple 
departments: 

a) On the Paycheque menu, choose Allocate to 
Departments. 

b) In the Department column, double-click the line that 
contains the amount you want to allocate to multiple 
departments. 

c) Select the departments to which you want to allocate the 
amount. 

d) Enter the percentage in the % column. 

e) If you want to apply the same allocation to all of the 
employee’s accounts, check the Apply This Allocation To 
All Accounts By Percentage box. 

f) Click OK twice to return to the Paycheques window. 

 9. If you have chosen to track Quebec tips, you can also enter 
income received from tips: 

Sales the employee 
handled and the tips 
they collected on 
those sales. 

Automatically calculated at 8% of Tippable 
Sales, as required by the Quebec government. 

Amount of Columns C, D, 
and E on employee’s 
Register and Statement of 
Tips (form TP-1019.4.U-V).  

 
Preview 10. If you use a custom Simply Form for cheques or direct 

deposit stubs, you can preview the report by selecting the 
Preview Simply Form icon from the toolbar. 

 
Print 11. If you use Simply Accounting to print cheques or direct 

deposit stubs, choose Print from the File menu. 

 
12. Click Process. 
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Paying a Group of Employees with a Payroll 
Cheque Run 

 
 

Processing individual cheques using the Paycheques window 
can be overly time-consuming if you work with a relatively large 
business. You can pay many employees at once with a cheque 
run.  

Note:  With a cheque run, you can change the deductions, give 
advances, or pay out vacation time, just as you can do when 
issuing individual paycheques. 

To complete a payroll cheque run: 

1. In the Home window on the Payroll tab, choose Payroll 
Cheque Run. 

Simply Accounting 
Pro or higher 

2. If you use Simply Accounting Pro or higher and have set up 
departments, you can choose whether to use departments 
when updating the payroll-related accounts for all the 
employees that you process during this run. In the Dept. 
(Department) field, choose either: 

■ Employees’ Departments — Use the department from 
each employee’s record. 

■ No Departments — Use only the account number 
(without departments). 

3. Select the pay period frequency and enter the dates and 
starting cheque number for this run. Check marks appear in 
the first column, indicating employees who need to be paid 
for the period you selected: 

 Check options 
 Add employees 

 Process cheques 
- all at once 
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Select any employees 
who need to be paid for 
the selected pay period. 

Click in this column if you 
want to print a cheque or 
a direct deposit stub for 
the employee. 

This field appears if you 
use departments. 

  US companies 
need to specify the start 
date.

Click in this column to 
select employees whose 
cheques are to be 
directly deposited. 

Change income, deductions, taxes, 
user-defined expenses, or entitlements 
for this pay period, if required. 

 

Note:  You can click the Process or Print column heading to 
select all employees for the selected pay period. 

Allocating to multiple 
departments 

4. If you are allocating payroll amounts to multiple 
departments: 

a) On the Payroll menu, choose Allocate to Departments. 

b) In the Department column, double-click the line that 
contains the amount you want to allocate to multiple 
departments. 

c) Select the departments to which you want to allocate the 
amount. 

d) Enter the percentage in the % column. 

e) If you want to apply the same allocation to all of the 
employee’s accounts, check the Apply This Allocation To 
All Accounts By Percentage box. 

f) Click OK twice to return to the Payroll Cheque Run 
window. 

5. From the Report menu, choose Print Payroll Cheque Run 
Summary (and Print Direct Deposit Stub Summary if you 
use direct deposit) to print a report showing the amounts 
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that will appear on employees’ cheque stubs (or direct 
deposit stubs). Keep this summary for your records. 

6. If you want to see the actual transactions that will be made 
to your payroll accounts as a result of this cheque run, 
choose Display Payroll Run Transaction Detail from the 
Report menu. 

 
Print 7. If you are printing cheques, choose the Print icon on the 

toolbar, or choose Print from the File menu. 

 
Print Direct 
Deposit Stubs 

8. If you are printing direct deposit stubs, choose Print Direct 
Deposit Stubs from the File menu or the icon in the upper 
right corner. 

 
9. Click Process. 

 Paying Out Vacation Time 
If you retain vacation pay for employees rather than paying it 
out on every cheque, you need to release their vacation pay 
when they take time off. 

To pay out vacation time: 

1. In the Home window on the Payroll tab, choose Paycheques. 

2. Select the employee. 

3. On the Income Tab, in the Vac. Paid field, enter the amount 
of vacation to be paid out. 

Note:  Total vacation pay accrued for the period is indicated 
in the Vacation amount field. The Vac. Accrued YTD field 
shows the total amount of vacation pay owed to the 
employee. This figure includes any vacation pay earned for 
the current payroll period. 

 
4. Click Process. 

Note:  If the employee’s paycheque is part of a cheque run, then 
you can pay out the vacation from the Payroll Cheque Run 
window. 
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 Checking How Much Vacation Pay You Owe an Employee 

If you choose to retain vacation pay, you can easily find out how 
much vacation pay you owe an employee. 

To check how much vacation pay you owe an employee: 

1. In the Home window on the Reports menu, choose Payroll, 
and select Employee. 

2. Under Report Type, click Summary. 

3. Select the name of the employee and click OK. 

The vacation pay owed is the amount under Vacation Owed. 

Looking Up Information on Old Paycheques 
To review the details of existing cheques: 

1. In the Home window on the Reports menu, select Payroll, 
and then Employee. 

2. Select the employees for whom you need information. If the 
employees belong to a single job category, then select the job 
category to quickly filter the list of employees. 

3. Select Detail, then the range of dates. 

4. To limit the report to only those details you want, click 
Customize. 

5. On the Customize Report Columns tab, select Custom 
Report Column Settings. 

6. Select only those fields that you want to include on the 
report. 

7. Click OK to save your customization settings. 

8. Click OK to view the report 
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Correcting Errors on Paycheques 
As long as you catch an error before issuing the employee’s next 
paycheque, you can correct it automatically. Just reverse and 
void the original cheque and then issue a new one. 

If, on the other hand, several pay periods have passed, you will 
need to manually reverse and void the cheque and then issue a 
new one. You need to do this to avoid any miscalculation of the 
employee’s taxes. 

 

If you have made out a new cheque, make sure to void the old 
one before completing these corrections. Otherwise, both the old 
cheque and the new one could be cashed. 

Automatically Correcting an Employee’s Most Recent Paycheque 

To automatically correct an employee’s latest paycheque: 

 
Adjust Cheque 1. In the Home window on the Payroll tab, select the 

Paycheques icon, and choose Adjust Cheque from the 
Paycheque menu. 

2. Select the paycheque you wish to adjust. 

3. Make changes to the cheque. If you just want to cancel an 
employee’s cheque without issuing a new one, delete the 
amounts on every tab. 

 
Recalculate 
Taxes 

4. If you are re-issuing a cheque, choose Recalculate Taxes from 
the Paycheque menu to update tax deductions. 

 
Print 5. If you want to print a new cheque, choose Print from the File 

menu. 

 
6. Click Process. 

Correcting an Older Paycheque 

If you are correcting a cheque from an earlier pay period and tax 
rates have changed, you need to restore the old tax rates. 
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paycheque properly. 

Part 1:  If necessary, restore old tax rates 

1. In the Home window on the Setup menu, choose System 
Settings, and then Settings. Click Payroll, and then Income. 

2. Write down the tax rates currently on the screen, then enter 
the rates in effect when you issued the original cheque, and 
click OK. 

 3. In Canada, reset the tax, WCB, or CSST rates: 

a) In the Home window on the Payroll tab, click the 
Employees icon and then open the record for the 
employee whose cheque you are reversing. 

b) Click the WCB and Other Expenses tab. Write down the 
current WCB rate (or CSST, in Quebec) and then enter 
the rate in effect for this employee when the original 
cheque was issued. 

 
Save c) Choose Save from the File menu or toolbar. 

Part 2:  Correct the paycheque manually 

1. In the Home window on the Payroll tab, click the 
Paycheques icon and then select the employee whose cheque 
you are correcting. 

 
Enter Taxes 
Manually 

2. Click the Enter Taxes Manually toolbar button. 

3. Enter a cheque number, and all amounts from the incorrect 
cheque preceded by a minus sign. 
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Enter the values from the 
original cheque with a 
minus sign. 

Enter the original cheque 
number, followed by the 
letters COR or ADJ. 

Make sure that this 
button is selected. 

 

 
4. Click Process. 

Note:  By processing this transaction, you reverse the 
incorrect paycheque. A record of both the original incorrect 
transaction and the reversing transaction appear in the 
Payroll Transactions report. 

5. If you want to re-issue a corrected cheque, do so now. For 
more information, see “Paying Individual Employees” 
earlier in this chapter. 

Part 3:  If you changed the tax rates, restore the new rates 

1. In the Home window on the Setup menu, choose System 
Settings, and then Settings. Click Payroll, and then Income. 

2. Restore any rates that you changed in Part 1 to the correct 
rates for the current period. 

 3. If you are working with a Canadian company, in the Home 
window on the Payroll tab, click the Employees icon and 
then open the employee record. Restore the workers’ 
compensation rates for the current period. 
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To ensure that the correct amount of tax is deducted from each 
cheque, you should make sure that your Simply Accounting tax 
tables are up to date. Otherwise, you have to manually calculate 
all taxes for each paycheque you issue. If you subscribe to 
SimplyCARE with Payroll or SimplyCARE with Payroll and 
Support, you can have Simply Accounting automatically check 
for and install payroll tax updates whenever you are connected 
to the Internet, as follows: 

1. In the Home window on the File menu, choose Automatic 
Updates.  

2. Select the Require Client ID To Download box if you want 
Simply Accounting to ask you to enter your client ID before 
downloading any updates. This can work as a password in 
case you don’t want other people downloading updates. 

3. Select the box to allow Simply Accounting to check for 
payroll updates at start up. Simply Accounting will attempt 
to connect to the Internet to check for updates when you 
open the program.  

4. You can click the Check Now button if you would like to 
check for updates right away. 

5. Click OK.  

Direct Deposit 
The direct deposit feature allows you to deposit paycheques 
directly (electronically) into your employees’ bank accounts. 

To use this feature, you must first register for this service. Then, 
in Simply Accounting, set up information about your employees. 
Every time you process direct deposit paycheques, Simply 
Accounting stores the paycheque information. You then submit 
(upload) this information to a service provider, which then 
deposits the paycheques to the employee’s bank accounts. 



Part 2: Day-to-Day Business 

15−22    Simply Accounting 

 
  

SIM2006 ENGL UG Part 2 (15-17) PRINT.doc, printed on 1/12/2006, at 11:05:49 AM. Last 
saved on 1/9/2006 10:37:00 AM. 

ACCPAC International, Inc. Confidential 

Setting up for Direct Deposit 

Before using direct deposit, follow these steps. 

1. You must register with a service provider. In the Home 
window, open the Business Services menu, then choose 
Direct Deposit. Then follow the instructions on the screen. 

2. Set up direct deposit information for your employees. 
Complete the information on the Direct Deposit tab of the 
Employee Records window. 

3. Set up printer settings for direct deposit stubs. From the 
Setup menu, choose Reports and Forms, then click Direct 
Deposit Stubs. 

Processing Payroll 

Process your payroll, using the Paycheques or the Payroll 
Cheque Run window, as described in the previous sections of 
this chapter.  

In the Paycheques window, select the Direct deposit this 
paycheque box to deposit the paycheque directly. Similarly, in 
the Payroll Cheque Run window, select the Direct Deposit 
column of the paycheque(s) to be deposited directly. 

Printing Direct Deposit Stubs 

Simply Accounting will print “Non-Negotiable” on the direct 
deposit stubs of employees who have been set up for direct 
deposit. 

 
Print icon To print the direct deposit stub when using the Paycheques 

window, select the Direct Deposit This Paycheque box and click 
the Print icon on the upper right corner of the window (or choose 
Print from the File menu). 

 
Print Direct 
Deposit Stubs 
icon 

To print direct deposit stubs when using the Payroll Cheque Run 
window, click the Print Direct Deposit Stubs icon on the upper 
right corner of the window. 
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information on batch printing, see Chapter 22 “Increasing 
Efficiency” in the User Guide). 

Submitting the Direct Deposit File 

When you are ready to submit (upload) the direct deposit file to 
the service provider for processing, follow these steps: 

Upload Direct 
Deposit File 

1. In the Home window, click the Upload Direct Deposit File 
toolbar button. Or, from the File menu, choose 
Import/Export, then Upload Direct Deposit File. This opens 
the Direct Deposit window. 

2. Enter display criteria: 

a) In the Status field, choose whether to display all direct 
deposit cheques, or only those that that have been 
generated previously, or only those that have never been 
generated. 

b) Choose the date of the direct deposit cheques to display. 

c) Click the Display button to list the cheques. 

3. Select the cheques to be included in the direct deposit 
upload file by clicking in the checkmark column. 

4. Click Upload. 

5. Enter the information in the service provider’s 
authentication window, and click Upload. 

A message then informs you that Simply Accounting has 
uploaded a direct deposit file to your service provider. In the 
message box, you can click on the hyperlink to log on to the 
service provider’s web site to review your uploaded files. 

Printing a Direct Deposit Log 

To see a report of direct deposit cheques that have been sent or 
will be sent: From the Reports menu, choose Banking and then 
Direct Deposit Log. 
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Clearing Direct Deposit Data 

As with other Simply Accounting data, you can periodically 
clear the direct deposit data. In the Home window from the 
Maintenance menu, choose Clear Data, then Clear Direct Deposit 
Data. 
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Chapter 16 
Entering Other Types of Transactions 
 

Sometimes you need to complete transactions that aren’t suitable to the other 
Simply Accounting windows. This can include transferring funds from one bank 
account to another, or entering year-end adjusting entries.  

 

Entering a Daily Bank Deposit ......................................................16–1 
Recording a Miscellaneous Transaction ..............................................16–3 

Transferring Funds from One Account to Another ................................16–3 
Entering Sales Taxes Information................................................16–4 

Changing or Cancelling a Miscellaneous Transaction..................................16–5 
Manually Correcting a Miscellaneous Transaction ................................16–6 
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Entering a Daily Bank Deposit 
When you receive payment for goods or services, you should 
make a deposit to your bank account at the end of the day. If you 
enter the deposit slip details into Simply Accounting, you can 
automate your account reconciliation process at month-end. 

If you are using Simply Pro or higher, you can save partially 
completed deposit slips and return to work on them later. 

1. In the Home window on the General tab, click Reconciliation 
and Deposits or Deposit Slip icon. 

2. Select Deposit Slip from the Transaction list. 

3. Select the account for which you have a deposit slip. 

 

If you have entered the account details in the account record, 
Simply Accounting will automatically display them. 

4. If you have set up the account to assign deposit slip 
numbers, the next number will appear in the number field. If 
not, enter the date and amount of the deposit as a number. 

5. Verify or change the date and add a comment, if you wish. 

6. Add cheques to the deposit: click the Select button in the 
Cheques area. If there are no cheques to deposit, go to step 7 
to add cash to the deposit slip. 
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A new window appears: 

Select the account you 
deposited the cheque into 
in the Receipts window. 

Select the cheque(s) you 
are adding to this deposit 
and then click Add. 

Review the list. If you want 
to make any changes, click 
the Remove button to 
remove a cheque from the 
list. 

Click OK. 
 

7. To add cash to the deposit: 

a) Click the Select button in the Cash area. 

b) Select the account you deposited the cash into in the 
Receipts window, and then select a currency. 

c) Enter the number of bills you have of each denomination 
in the Count column.  

d) Enter the total value of all coins you have received in the 
Amount column. 

e) Click the Apply to Deposit Slip button. 

f) Click OK. 

8. Check the details of the deposit slip and then click Process. 
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Recording a Miscellaneous Transaction 

Use the Miscellaneous Transactions window for all transactions 
that cannot be completed in other windows.  

Generally, your accountant will use this window to make 
adjusting entries at the end of the year; however, you can also 
use it to transfer funds from one account to another. 

 

You cannot make entries that affect “control” accounts, such as 
Accounts Payable, Accounts Receivable, and Inventory. 

 

Transferring Funds from One Account to Another 

1. In the Home window on the General tab, choose the 
Miscellaneous Transactions icon. 

2. On the first line in the Account field, select the bank account 
that you would like to increase. Then, in the Debits field, 
enter the amount. 

3. On the next line in the Account field, select the bank account 
from which you would like to withdraw funds. Then, in the 
Credits field, enter the amount. 

4. Fill in the remaining parts of the form: 
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These two values must be 
equal. 

This option appears if you 
have set up another currency. 

This comment is for the 
account (line) only. 

This comment is for the entire 
transaction. 

 

Tip:  To hide the Comments column, choose the View menu, 
then Customize Transaction Window. On the Miscellaneous 
Transactions tab, in the Do Not Show section, select the 
Comment box; then click OK. 

 
5. Click Process. 

Entering Sales Taxes Information 

We recommend that only experienced accountants use this 
procedure. 

Even if you have set up asset or liability accounts to keep track 
of all of your taxes, you should still use this procedure to enter 
the appropriate tax codes for a miscellaneous transaction. If you 
fail to do so, your tax reports will be incorrect. 

1. In the Miscellaneous Transactions window, enter at least one 
account that is linked to a sales tax. This makes the Sales 
Taxes button available to you. 

2. Click the Sales Taxes button. This opens the Sales Taxes –
Miscellaneous Transactions window, which displays the tax 
accounts:  
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3. Select the Transaction Type (purchase or sale). 

4. Enter the Tax field and Tax Code field, and move to the next 
field. 

5. The Amount Subject to Tax and the Other Taxes Paid fields 
are automatically calculated. Adjust them if required. 

6. Click OK to accept the data and return to the Miscellaneous 
Transactions window. 

7. Click Process. 

The tax information you entered will appear on the tax report (in 
the Home window choose the Reports menu, then Tax). 

Changing or Cancelling a Miscellaneous 
Transaction 

If you have entered an incorrect miscellaneous transaction, as 
long as you have not cleared the transaction, you can 
automatically change or cancel it. You must also change or 
cancel the transaction manually if it occurred in a previous fiscal 
year or if you have turned off the Store Invoice Lookup Details 
option. See the next section for more information. 

1. In the Home window on the General tab, choose the 
Miscellaneous Transactions icon. 

 
Adjust 
Transaction 

2. From the Entry menu, choose Adjust Transaction. 
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3. Select the transaction you want to change or cancel, and click 
Select. 

4. If you want to cancel the transaction, delete all the detail 
lines. Select a detail line, and then choose Remove Line from 
the Edit menu. Otherwise, make the necessary changes. 

 
5. Click Process. 

Manually Correcting a Miscellaneous Transaction 

You must correct a miscellaneous transaction manually if it 
occurred in a previous fiscal year. You also need to do this if you 
cleared a transaction and can no longer look it up or you have 
turned off the Store Invoice Lookup Details option. 

1. In the Home window on the General tab, choose the 
Miscellaneous Transactions icon. 

2. Enter the source number of the original transaction followed 
by the letters COR or ADJ. 

3. Enter the same account numbers and amounts as in the 
original transaction, but enter the debit amount in the credit 
field and vice versa. 

4. If you allocated revenues or expenses to a project, you must 
reverse these allocations as well. For more information on 
projects, see Chapter 5 “Setting Up Projects.” 

 
5. Complete the remaining parts of the form, and click Process. 
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Chapter 17 
Allocating Revenues and Expenses 
to Projects 
 

Allocating amounts to projects allows you to track revenues and expenses for 
particular activities. You can then set goals (with a budget) for individual projects. 

 

Allocating Project Revenues and Costs...............................................17–1 
Allocating an Amount to a Project ...............................................17–1 
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Allocating Project Revenues and Costs 
Once you have set up project allocation, as discussed in 
Chapter 5, “Setting Up Projects,” you can allocate amounts to 
projects, either line by line, or for an entire transaction. 

You can allocate amounts to projects from the following 
transaction windows: 

■ Inventory Adjustments. 

■ Miscellaneous Transactions. 

■ Paycheques. 

■ Payroll Cheque Run. 

■ Purchases, Orders, and Quotes. 

■ Sales, Orders, and Quotes. 

■ Time Slips (Simply Accounting Pro or higher). 

Allocating an Amount to a Project 

1. In the Home window, choose the transaction window you 
need, and enter the transaction as you normally would. 

 
Allocate 2. Click the Allocate toolbar button, or double-click in the 

Allocate column on a specific item line. 

Note:  Each item to be allocated must be associated with a 
revenue or expense account. Paycheques are always 
associated with an expense account. 

3. Indicate whether you want to allocate the amount of the 
entire transaction and then select the associated projects: 
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Enter an amount or 
percentage, depending 
on the allocation method 
you chose on the Project 
tab in System Settings. 

Click the Search button to 
display a list of projects, 
and then select one. You 
can also add projects "on 
the fly" 

 

4. Click OK. 

5. Process your transaction. 
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Chapter 18 
Keeping Track of Time and Billing 
 

You can keep track of the time you and your employees spend on different 
activities, and then use the information to bill your clients. 

 

Create a Service Item for Each Activity ............................................. 18–1 
Record the Time Spent ............................................................ 18–2 
Invoice the Customer ............................................................. 18–5 
Pay Employees................................................................... 18–7 
Look Up Time Slips............................................................... 18–8 
Adjust Time Slips ................................................................ 18–9 
Time-Slips Reports .............................................................. 18–11 
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What You Need to Do 
If you are using Simply Accounting Pro or higher, you can keep 
track of the time you and your employees spend on various 
tasks or activities, and can create sales invoices based on the time 
spent. To do this, you will:  

 Create a service activity item for each activity you want to 
track.  

 Record the time spent. 

 Invoice the customer.  

Create a Service Item for Each Activity 
1. On the Inventory and Services tab, add a record for each 

activity you want to track. Be sure to:  

a) Choose Service as the item type, and check the Activity 
(Time and Billing) box. 

If this is an activity that is performed by or for a 
department within your company (such as 
administration or professional development) and you do 
not invoice customers for it but want to keep track of it, 
check the Internal Service Activity box. Simply 
Accounting will keep track of the activity and include it 
on Time and Billing reports, but it cannot be selected 
when filling out sales invoices.  

b) On the Time and Billing tab, if the unit is not hours or 
minutes but can be measured in hours or minutes, check 
the Unit Is Related To Time box, then fill in the 
information about the item.  

If you choose to charge a flat fee for an item, note that 
Simply Accounting calculates the flat fee by multiplying 
a number of units by the price of the item. If you have 
entered the flat rate as the price on the Pricing tab, you 
must still enter a number in the Flat Fee field on the 
Time and Billing tab to have the amount recorded 
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correctly on the time slip. Be sure you have entered a 
price on the Pricing tab, and that the number in the Flat 
Fee field multiplied by the price will calculate the flat 
amount you want to use.  

In the Default Payroll Income field of the Time and 
Billing tab, you can choose a value from the list. The 
value entered will automatically appear in the Payroll 
Income field of the Time Slips window, so you don’t 
have to select it every time. 

c) Fill in the information on the other tabs.  

2. Save your entries and close the window.  

Record the Time Spent 
1. In the Home window on the Time and Billing tab, select the 

Time Slips icon. 

 

Click the Pushpin button to 
use the same employee 
for the next time slip. 

  

2. Select an employee. Only employees assigned a Job 
Category that displays in time slips will appear in the 
drop-down list. You can assign an employee to a job 
category on the Personal tab of an employee’s record. 

3. Select a customer.  
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4. In the Item column, select the service activity.  

Notice that values from the service item’s inventory record 
(such as description and billing status, and billable amount if 
you charge a flat fee) automatically appear. Also notice that 
the item is automatically selected (checked), indicating that 
the item will have time applied to it if you click Apply Time.  

5. In the Actual Time field, enter the time spent on the activity, 
in hh:mm:ss (hours, minutes, and seconds). For example, 
enter 2 hours as 2:00:00 or 20000. 

Using the timer If employees enter their time into the Time Slips window, 
they may wish to use the Time Slips timer to simplify the 
process. You can use the time slips timer in several ways: 
 
■ Employees may have the time slip open on their 

computer when they begin a job, and then click the Start 
button. Simply Accounting starts a timer, which the 
employee can stop with the stop button. Then, the 
employee can add that time to one or more items on the 
time slip. 

■ Employees can also use the timer to add time to several 
items on a single slip rather than entering the time 
manually for each item. 

Note that there must be a check mark in the timer column in 
order for time to be applied to an item this way; once you 
have applied the time, the check mark disappears 

Billable time The billable time is the time associated with the billing status 
listed (Billable, Non-billable, No Charge, or In Progress). If  
the billing status is No Charge, the item appears on the 
invoice, but the amount charged is blank.  

6. To record time to be paid to the employee, enter the 
following: 

Payroll Time.  The time to be paid.  

Payroll Income.  The type of income to be paid (related to 
the payroll time). This field displays the value you entered in 
the Default Payroll Income field (Time and Billing tab) in the 
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item’s Inventory and Services Records window. You can 
enter a different value. The choices are Non-Payroll (that is, 
do not pay for the payroll time), or any income that you 
defined as an hourly rate or differential rate. 

The Payroll Status indicates whether the payroll time has 
been paid or not. If the Payroll Income field is Non-Payroll, 
then the Payroll Status displays a hyphen.  

 
Allocate time 7. If you want to allocate any part of this employee’s time to a 

specific project, double-click in the Allocate field for a 
specific activity line, or click the Allocate button on the 
toolbar. 

 

This allocation choice 
determines which field in 
the grid you can modify. 

Select this box to apply 
same allocation to all lines 
in the time slip you are 
working on. 

 

8. Enter the allocation amount in the active field (based on the 
method of allocation). The remaining fields are 
automatically calculated. 

9. Repeat steps 3 through 8 for any other activities you want to 
add for this employee. 

10. If you want to print the time slip, choose Print from the File 
menu or toolbar. Before printing, you can choose one of two 
versions of the time slip as follows: 

a) In the Home window on the Setup menu, select Reports 
and Forms. 

b) Select Time Slips and click in the Form Type field to 
select Custom Simply Form or Custom Reports Form.  

c) In the Description field, choose one of the following: 
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Timeslip.sfm — shows both billable and payroll 
information 

or 

Timeslip.rpt — shows the billable information. 

or 

Timeslip_prl.rpt — shows the payroll information. 

d) Click OK. 

11. Click Record, and close the Time Slips window. 

This information is now available when you enter a sales invoice 
or pay employees. For more information about customizing or 
creating new Simply forms, see “Customizing Forms and 
Management Reports” in Advanced Topics. 

Invoice the Customer 
1. Print a Time and Billing report by customer to identify the 

customers who have time slip activities to be invoiced.  

2. In the Sales, Orders, and Quotes window, select the 
customer you want to invoice.  

 
Add Time Slips 
Activities 

3. Select Add Time Slip Activities button or from the Sales 
menu. 
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Select the options for the 
activities you want to 
include on the invoice.  

Click in the Add To Invoice 
column to identify the 
activities to include.  

Click the Add button to 
add all selected items to 
the invoice.  

 

4. Check that the information is correct.  

The program sorts the items 
according to the options 
you selected — in this 
case, by date and activity. 
If you chose to consolidate 
the entries, items are 
summarized. 

 

5. Click Process. 
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Pay Employees 
1. Print the Time Sheet Summary report. (In the Home window 

on the Reports menu, choose Time and Billing, then Payroll, 
and then Time Sheet.) 

You can use this report to identify employees who need 
adjustments to their hours and amounts to be paid. For 
example, an employee may have recorded 45 hours of 
regular pay on their time slips, but should be paid 40 hours 
of regular pay and 5 hours of overtime instead. Use this 
report to make the adjustments later in step 8. 

2. In the Home window on the Payroll tab, select Paycheques 
or the Payroll Cheque Run icon. 

3. Select the employee(s) to be paid. 

 
Add Time From 
Time Slips 

4. Select Add Time From Time Slips on the toolbar or 
Paycheque menu (Payroll menu if using the Payroll Cheque 
Run window). 

The Payroll Hour Selection window appears, similar to the 
following: 

 

5. Select the date range of the time slips to add to the 
paycheque. 

6. Click OK. 

7. If the total hours of a payroll income (such as regular income) 
from the selected time slips are fewer than the income’s 
hours specified in the employee’s record, a message asks if 
you wish to increase the hours from the time slip(s) to match 
at least those in the employee’s record: 

■ If you choose No, the hours from the selected time slips 
will be used. 
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■ If you choose Yes, the hours from the employee’s record 
will be used.  

For example, assume that the regular hours shown on an 
employee’s record are 30. Assume you choose to pay three of 
the employee’s time slips, which recorded regular hours of 
10, 8, and 11 respectively (a total of 29). Since the 29 regular 
hours are fewer than 30, the message would appear. 

8. The Paycheques (or Payroll Cheque Run) window then 
shows the hours and amount to be paid. 

For any employees you identified in step 1, adjust their 
hours and amounts to be paid. 

 
Allocate 9. If you want to allocate this employee’s hours to a specific 

project, click the Allocate toolbar button. 

Note:  If a time slip already contains project allocations for 
activities, they are carried through to the paycheque only if 
the payroll amount is distributed by hours. Otherwise, you 
must allocate time slip activity in the Paycheques (or Payroll 
Cheque Run) window. 

10. Click Process. 

Look Up Time Slips 
You can look up an individual time slip in the Time Slips 
window. 

 
Look Up 1. In the Time Slips window on the Time Slip menu or toolbar, 

choose Look Up Time Slip. 

2. Choose a range of dates and the employee name and time 
slip number, if known. Click the Browse button and select 
the time slip you want to view. 
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Adjust Time Slips 
You can change the billable information on a time slip in the 
Time Slips window if you have not yet invoiced it. You can also 
change the information while entering or adjusting a sales 
invoice. If you change time-slip information on the entry lines of 
a sales invoice (instead of in the Service Activities Selection 
window that you display from the Sales, Orders, and Quotes 
window), Simply Accounting changes the Time and Billing 
reports to include the new information, and changes the written 
up/down sections of the report.  

To change a time slip in the Time Slips window:  

 
Adjust Time Slip 1. In the Time Slips window on the Time Slip menu or toolbar, 

choose Adjust Time Slip. 

2. Once you have selected the time slip, click OK. 

3. Make the changes you need, then click Record. 

To change a time slip while entering a sales invoice:  

1. In the Sales, Orders, and Quotes window on the Sales menu 
or toolbar, choose Add Time Slip Activities.  

 
Add 2. In the Service Activities Selection window, click the button at 

the top of the Add Activity column to include or remove all 
activities on the invoice, or place a check mark in the Add 
Activity column to select or remove the activities you want. 

Deciding where to 
enter changes 

■ Generally, you should use this window to make minor 
changes to activities before invoicing them. Changes you 
make here will be recorded on the time slip, just as if 
you had made the change in the Time Slips window.  

■ If you change an activity’s price, quantity, or amount on 
the invoice (in the Sales, Orders, and Quotes window), 
the time slip shows the original values, and the 
differences appear on the Time and Billing reports as 
written up/down amounts and percentages. (These 
reports are described in more detail in the Advanced 
Topics manual.) 
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3. When you have made the changes you want, click the Add 
button to include the information on the invoice. If you 
make a mistake, choose Add Time Slip Activities again, 
correct any errors, and then click the Update button to 
update the invoice.  

4. Click Process when the invoice is completed.  

To change activities that have already been invoiced:  

 
Adjust Invoice 1. In the Home window on the Customers and Sales tab, choose 

Invoices or the Sales, Orders, and Quotes icon. Choose 
Adjust Invoice from the Sales menu or toolbar, then select 
the invoice you want to change.  

2. On the Sales menu or toolbar, choose Add Time Slip 
Activities.  

3. In the Service Activities Selection window, remove or 
change the activities as needed.  

■ To remove activities from the invoice, change the status 
from Invoiced to Billable or No Charge.  

■ To add or change activities, click in the Add To Invoice 
check mark column and make any changes needed.  

Consolidated 
activities 

To change an invoice that contains consolidated 
(summarized) service activities, you should use this window, 
not in the invoice window. This ensures that the Time and 
Billing reports are correct. Change the status of the items 
you are adjusting from Invoiced to Billable, then check the 
Consolidate Onto Invoice box and click Update to update 
the invoice.  

If you want to invoice 
an item later 

Note:  If you change or remove a line from an invoice and 
want to bill for it later, you must change the activity in this 
window, not in the Time Slips window. 
You cannot use the Time Slips window to adjust activities 
that have been invoiced; you must adjust them in the Service 
Activities Selection window for the invoice that you are 
adjusting.  

For example: If you have invoiced several activities, and 
then want to remove one of them and bill for it later, you 
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would choose Adjust Invoice in the Sales window, then 
choose Add Time Slip Activities. In the Service Activities 
Selection window, change the status of the item to be 
invoiced later to Billable, then click the Update button. 
Simply Accounting will display the invoice without the 
activity you just changed to Billable. Later, you can select the 
activity in the Service Activities Selection window and click 
Add to include it on the new invoice.  

4. Click the Update button to include the changes on the 
invoice.  

5. If you want to print the invoice, choose Print from the File 
menu or toolbar.  

6. Click Process.  

Time-Slips Reports 
You can print reports that show time-slips information by 
customer, employee, or activity. 

To print time-slips reports:  

1. In the Home window on the Reports menu, select Time and 
Billing, then Billing or Payroll. 

2. Select the report you want. 

3. Select the options you want. Note that some options may not 
be available, depending on your selections in the Report 
Type, Select Categories To Report, and Select Activities To 
Report fields.  

4. Click OK. 

Choose Print from the toolbar or File menu.  
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Part 3 

Regular maintenance ensures that your business runs smoothly. Some 
of these tasks are mandatory for your company, such as filling out 
your tax return at the end of the year. Others are optional and help 
your business to perform better, such as maintaining a budget. 

 

Chapter 19 — Protecting Your Data 
Chapter 20 — Daily and Monthly 
Chapter 21 — End of Year and Tax Period 
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Chapter 19 
Protecting Your Data 
 

You’ll probably spend years accumulating valuable business data with Simply 
Accounting. You should protect that knowledge by keeping your data safe. 

 

Checking Data Integrity ............................................................ 19–1 
What to Do If You Have Errors in Your Data ..................................... 19–1 

Backing Up Your Company’s Information ........................................... 19–2 
Backing Up Your Data ......................................................... 19–2 
Changing the Backup Frequency ................................................ 19–3 
Other Uses for Old Backups .................................................... 19–3 

Restoring a Backup ................................................................ 19–4 
Saving a Copy of Your Data as You Work............................................ 19–4 
Troubleshooting................................................................... 19–5 

Starting Simply Accounting..................................................... 19–5 
Dimmed Options .............................................................. 19–5 
Printing....................................................................... 19–5 
Adding Vendors and Customers ................................................ 19–6 
Paying Employees ............................................................. 19–6 
Customizing Reports........................................................... 19–7 
Graphing ..................................................................... 19–7 
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Checking Data Integrity 
Periodically, you should check your data’s integrity to ensure 
that all of your accounts are balanced. 

You can also use this feature to ensure that your files have not 
become damaged. Any number of things can cause data 
corruption, such as a power failure or a computer crash. 

1. In the Home window on the Maintenance menu, choose 
Check Data Integrity. 

 

A message tells you whether 
your data is out of balance 
or damaged. 

An asterisk 
shows where 
your data is out 
of balance. 

Amounts may be different 
from your trial balance if you 
have negative-valued assets, 
liabilities, revenues, or 
expenses. 

 

2. Click OK. If Simply Accounting finds any problems, read the 
next section, “What to Do If You Have Errors in Your Data.” 

What to Do If You Have Errors in Your Data 

1. Be sure you have a backup of your data. See “Backing Up 
Your Data” in the next section. Then, in the Home window 
on the Maintenance menu, choose Database Utilities, and 
then Compact Database. 

2. Check your data integrity again. If you still find errors, you 
may need to restore your most recent backup and re-enter 
any transactions that were entered after you made that 
backup.  
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Backing Up Your Company’s Information 
Imagine you turn on your computer and nothing happens. Or 
worse, you arrive at work to find that your computer has been 
stolen. The most important thing you can do every week, if not 
every day, is back up your company’s information. 

Although you can back up onto any media, including another 
hard drive, we recommend you use a tape backup or a CD 
writer. Floppy disks, while cheap, are prone to failure. (A 
backup on floppy disks is, however, better than no backup 
at all.) 

You should store your backup in a safe place. Store some 
backups at a different location, because fire or theft can destroy 
both your computer and your backup. 

Backing Up Your Data 

1. In the Home window on the Maintenance menu, choose 
Check Data Integrity. If Simply Accounting reports that your 
data is OK, proceed with the backup. If not, refer to “What 
to Do If You Have Errors in Your Data,” earlier in this 
chapter. 

 
Backup 2. In the Home window on the File menu, choose Backup. 

 

Click Browse to select the 
folder where you want to back 
up your data. 

Change the filename to 
ensure that you don’t 
overwrite old backups. 

 

3. Fill in the fields and click OK. 
 
Note:  If you are backing up to a recordable CD, you may 
want to back up to a folder on your hard drive, and then 
copy the file to the CD using the CD writer’s software. 
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Changing the Backup Frequency 

Simply Accounting reminds you to back up your data when you 
complete various tasks. It will also remind you to back up after a 
certain time, such as every day or week. You can change the 
frequency at which Simply Accounting reminds you to back up: 

1. In the Home window on the Setup menu, choose System 
Settings, and then Settings. 

2. Click Company, and then System. 

You can set up daily, 
weekly, semi-monthly, 
monthly, or custom 
reminders. 

Select the backup 
options you want. 

 

3. Click OK. 

Other Uses for Old Backups 

While data loss is your primary concern, you can use old copies 
of your company’s financial data for other reasons. 

■ Print a report from a previous year. 

■ Check details that you cleared. 

■ Restore files that are accidentally deleted. 

■ For internal control. You can see if someone else alters your 
files after the fact. 

■ Easily move your company data from one location to 
another. 
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Restoring a Backup 
You need to restore a backup if your company’s data is lost or 
damaged. You may also want to restore your files so that you 
can check information from a previous year. In any case, make 
sure to restore your backup files under a different name. You do 
not want to overwrite your current company data as you may 
need to restore past backups. 

1. In the Home window on the File menu, choose Restore. 

2. Follow the instructions in the wizard. Make sure to restore 
the file under a different name. If you use the same name, 
you will overwrite your current data. 

Saving a Copy of Your Data as You Work 
To save a quick copy of your company data to your hard drive 
while you work on the company, you can use Save As or Save A 
Copy from the File menu in the Home window. You are then 
prompted to choose where to save the data and what name to 
give it. 

Unlike the Backup feature, you do not need to restore the data to 
open the saved company. You cannot use Save As or Save A 
Copy to store data on diskettes or CD. 

The Save As feature saves a copy of your current company data, 
but then opens your saved company. For example, when you 
save Company 1 as Company 2, Simply Accounting opens 
Company 2 after the copy is made. 

The Save a Copy feature saves a copy of your current company 
data, and keeps the current company open. For example, when 
you save Company 1 as Company 2, Simply Accounting opens 
Company 1 after the copy is made. 

If you are using Simply Accounting Pro or higher, you can use 
the Backup, Save As, and Save A Copy features only when in 
single-user mode. 
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Troubleshooting 
Do you have the 
latest version? 

If something isn’t working as expected, visit the Simply 
Accounting Web site at www.simplyaccounting.com, and 
download the latest service pack for this version of Simply 
Accounting. If you do not have Internet access, call Customer 
Service and have them send you a disk. 

Starting Simply Accounting 

I get an error message when trying to convert my old data. 

■ Turn off your anti-virus software, and try the conversion 
again. 

Dimmed Options 

The option that I want to use is dimmed. 

■ Close all windows other than the Home window. 

■ If you are using Simply Accounting Pro or higher, switch to 
single-user mode. In the Home window on the File menu, 
choose Switch To Single-user Mode. 

Printing 

I can’t print properly. 

■ Try printing another report using different settings: 

− Make sure that the proper paper size is selected.  

■ In the Home window on the Setup menu, choose Reports 
And Forms, and try the following: 

− Set the report’s margins to zero. 

− Click the Default button in the Report Sections. 

■ Visit your printer manufacturer’s Web site to download and 
install the latest printer driver. 
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Simply Accounting crashes when I try to print. 

■ Rename the Simply.ini file, found in the Windows folder, to 
Simply.ini.BAK and try again. 

The custom Crystal Reports print in 300 dpi, even though my 
printer is capable of printing at a finer resolution. 

■ Make sure that your printer settings have been set to print 
higher than 300 dpi. Refer to your printer manual for more 
information. 

■ Open the report in Crystal Reports, and choose Printer Setup 
from the File menu. Check the Default Properties box, and 
click OK. 

Adding Vendors and Customers 

I can’t fill in the year-to-date purchases or last year’s 
information. 

■ Once you have finished entering history, you cannot fill in 
this information. For more information on history, see 
Chapter 11, “Adding Historical Information.” 

Paying Employees 

The employee that I want to pay doesn’t appear on the list. 

■ You may have set the employee’s status to inactive. For 
information on inactive records, refer to “Keeping Inactive 
Parts of your Business Out of the Way” in Chapter 23. 

Simply Accounting won’t let me enter Quebec tips for an 
employee. 

■ The tax table for an employee must be set to Quebec. Refer 
to “Adding Taxes and Deductions for an Employee” in 
Chapter 15. 
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Customizing Reports 

When I click the Customize button, Simply Accounting says 
that I cannot edit the report because Crystal Reports has 
not been installed. 

■ If you have not installed Crystal Reports, insert the Crystal 
Reports CD into your drive. This CD is included with 
Simply Accounting Premium or higher. 

■ If you have installed Crystal Reports and you still see this 
error message, open Windows Explorer, find the folder that 
contains the report you want to customize, and double-click 
the file. Doing this resets a registry entry that Simply 
Accounting requires in order to find Crystal Reports. 

Graphing 

When I open a bar graph, all of the bars on the graph are 
quite short, leaving a lot of open space. 

■ Delete any files with the extension .CH# (where # is a 
number or letter) in the folder where your company’s data is 
located. This will reset the graph settings. 
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Enhancing Database Performance 
When you change or remove records, your data can become 
fragmented. You can save disk space and enhance performance 
by compacting the database periodically (such as at the end of 
the week or the month). 

Before compacting the database, you should back up your data. 
For more information on backing up, see “Backing Up Your 
Data” in Chapter 19. 

To compact the database: 

1. In the Home window on the Maintenance menu, choose 
Database Utilities and then Compact Database. 

2. Click Yes. 

Maintaining Records 
Addresses change, prices rise and fall, and employees receive 
raises. Simply Accounting allows you to easily change or remove 
most information stored in your company data. 

Restrictions to Changing Records 

Once you have finished entering history, as described in 
Chapter 11, “Adding Historical Information,” you cannot change 
the following information. These amounts change automatically 
whenever you enter transactions. 

For: You can’t change: 

Vendors Year-to-date and last year’s totals. 

Customers Year-to-date and last year’s totals. 

Employees Year-to-date and last year’s totals. 

Inventory Quantity on hand and total value. 



Part 3:  Company Maintenance 

20−2    Simply Accounting 

 
  

SIM2006 ENGL UG Part 3 (19-21) Recovered.doc, printed on 1/12/2006, at 11:07:38 AM. Last 
saved on 1/9/2006 10:39:00 AM. 

ACCPAC International, Inc. Confidential 

Simply Accounting also prevents you from changing certain 
account information (except in Simply Accounting Accountants’ 
Edition): 

■ You cannot change an account number once a transaction 
has been processed against it and it has a balance. However, 
once you clear transaction details, you can change the 
number. 

■ If you change the number of a linked account that has no 
associated transactions, the new number must be within the 
same section of the chart of accounts (for example, asset 
accounts must be within the 1000 to 1999 range). 

■ To change a subgroup or group account to a group heading, 
subgroup total, or group total, you must delete the account, 
then re-enter it with the new account type. 

Changing Records 

You can change information within a record with certain 
exceptions. See the previous section for more information. 

Note:  If you are changing accounts, you can use the Modify 
Accounts wizard to automate this process. From the Setup 
menu, choose Wizards, and then Modify Accounts. 

1. In the Home window, click the icon for the window in which 
you want to change information. 

2. Open the record you want to change, and make any changes. 

 
Save 3. Choose Save from the File menu. 

4. Print a report for your records. For example, if you changed 
a customer, print a Customer List. 

Restrictions to Removing Records 

If you stop doing business with a vendor, you may want to 
remove it from your records. However, Simply Accounting 
prevents you from removing information that would affect your 
accounting. Refer to the following table for information on when 
you can remove records. 



Chapter 20:  Daily and Monthly 

User Guide    20−3 

 
  

SIM2006 ENGL UG Part 3 (19-21) Recovered.doc, printed on 1/12/2006, at 11:07:38 AM. Last 
saved on 1/9/2006 10:39:00 AM. 

ACCPAC International, Inc. Confidential 

Note:  If you don’t want to remove a record permanently but 
don’t need it anymore, you can change its status to Inactive. For 
more information, see “Keeping Inactive Parts of your Business 
out of the Way” in Chapter 23. 

Simply Accounting  
Pro or higher 

If you are using Simply Accounting in multi-user mode, you 
cannot remove accounts. Log into Simply Accounting as the 
administrator in single-user mode to remove accounts. 

 

Before deleting: Be sure: 

Accounts ■ The account has a zero balance. 
■ The account has no transactions processed against it for this 

year or last. If it does, you can make the account inactive 
and then remove it after the next year. 

■ The account is not used as a linked account. 
■ If you are using Simply Accounting Pro or higher and want 

to keep financial history for more than two years, you have 
made a note of the account name and number.  
If you need to delete an account, we recommend that you 
renumber it, rename it “Deleted Account,” and check the 
Omit From Financial Statements If Balance Is Zero box in 
the account record. This will maintain the relationship 
between past and current charts of accounts and ensure that 
the multi-period reports balance. 

■   If you file your tax return electronically, do not remove 
Group or Subgroup Total accounts. They balance the GIFI 
report, as required by the Canada Revenue Agency 
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Before deleting: Be sure: 

Vendors and 
Customers 

■ The account has a zero balance. 
■ All transactions have been cleared. For more information on 

clearing data, see “Clearing Old Information from Simply 
Accounting” in Chapter 23.  

■ There are no outstanding orders or quotes. 
■   For vendors, you have printed the T5018 slips for the 

end of the reporting period.  
■   For vendors, you have printed the 1099 Miscellaneous 

Income forms at the end of the calendar year. 
■ For payroll authorities, the authority is not mapped to any 

payroll liability accounts. 

Employees ■ The employee has repaid any advances. 
■ You have printed the Employee Summary and Detail 

reports at the end of the calendar year. 
■ You have paid the employee’s entitlements. 
■   You have paid the employee’s vacation pay. 
■   You have printed a T4 slip and a Relevé 1 slip (Quebec 

only) for the employee. 
■   You have printed the T4 Summary form and Relevé 1 

Summary (Quebec only) at the end of the calendar year. 
■   You have printed the W-2 forms, and the 940 and 

941 Summaries at the end of the calendar year. 

Inventory and Service 
Items 

■ The quantity on hand is zero (this does not apply to 
services). 

■ You have no outstanding purchase or sales orders for the 
item. 

■ All transactions that refer to this item have been cleared. 
For more information on clearing data, see “Clearing Old 
Information from Simply Accounting” in Chapter 23.  
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Before deleting: Be sure: 

Projects ■ You have printed all reports that contain information about 
the project: 

− All Project reports. 

− Transaction detail reports for Miscellaneous 
Transactions, Purchases, Sales, Payroll, and 
Adjustments. 

Note:  Any transactions allocated to the removed project are 
listed as allocated to “Unknown Project” on reports. 

Removing Records 

Removing records is not the same as clearing data. Removing a 
record clears very little disk space and memory. For more 
information on clearing data, see “Clearing Old Information 
from Simply Accounting” in Chapter 23.  

Note:  If you are removing accounts, you can use the Modify 
Accounts wizard to simplify this process. From the Setup menu, 
choose Wizards, and then Modify Accounts. 

1. Print a report for your records. For example, if you removed 
a customer, print a Customer List. 

2. In the Home window, click the icon for the window in which 
you want to remove a record. 

3. Open the record you want to remove. 

 
Remove 4. Choose Remove from the File menu. 

 

 Automatically Updating Personal Tax Credits Subject to 
Indexing 

Simply Accounting allows you to automatically update the 
personal tax credit amounts that are subject to indexing for your 
employees. You can update all of your employee records at once. 
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Note:  This feature will update only the Federal and Provincial 
Claim Subject To Indexing fields whose balance is not zero. 

1. In the Home window on the Maintenance menu, choose 
Update Employee Claims. 

2. Check a box and enter either a factor or amount for the 
federal and provincial claims that you want to increase or 
decrease, as indicated by the government. 

 

Use these fields to update 
employee federal claims. 

Use these fields to update 
employee provincial claims. 

 

3. Click OK. 

Receiving Money from Credit-Card Sales 
Once you receive a merchant statement for a credit card, you 
need to record the amount that the bank or credit-card company 
transferred to you. 

1. In the Home window on the General tab, choose the 
Miscellaneous Transactions icon. 

2. In the Source field, type the merchant statement’s number. 

3. On the first line in the Account field, select the account into 
which the bank or credit-card company deposited what it 
owed you. Then, in the Debits field, enter the amount on the 
statement. 
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4. On the next line in the Account field, select the credit card 
“receivable” account. Then, in the Credits field, enter the 
amount deposited into your bank account, as indicated on 
the statement. 

5. If you have not set up Simply Accounting to automatically 
deduct credit-card charges, on the next line in the Account 
field, select the credit-card expense account for service 
charges. Then, in the Debits field, enter the service charge 
amount from the statement. 

For information on setting up credit cards, see Chapter 4, 
“Making and Accepting Credit-Card Payments.” 

6. Fill in the remaining parts of the form:  

 

These two values must be 
equal. 

This option appears if you 
have set up another currency. 

This line is only necessary if 
you have not set up Simply 
Accounting to automatically 
deduct credit-card charges. 

 

 
7. Click Process. 
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Reconciling Statements from a Bank or 
Credit-Card Company 

When you receive statements from your bank for your bank or 
credit card account, you should always match each transaction 
on your statement with the corresponding transaction in Simply 
Accounting to check for errors. 

Simply Accounting automates this process for all accounts that 
you have set up for reconciliation. See “Set Up Accounts for 
Reconciliation” in Chapter 2.  

Automatically Reconciling Using Online Services 

If your bank offers online services, you can import your 
statement directly into Simply Accounting. Then, the program 
reconciles most of the statement automatically. All that remains 
for you to do is to correct any discrepancies. 

Note:  The institution must support the Open Financial 
Exchange (OFX) data format. Contact your bank for more 
information. 

 

Before importing transactions, you must set the bank or credit-
card account to accept imported transactions. Open the account, 
click the Class Options tab, and check the Use This Account For 
Online Banking box. 

1. Depending on which window you have open in Simply 
Accounting, do one of the following to import an online 
statement: 

■ In the Home window on the File menu, choose 
Import/Export and then Import Online Statements. 

 
Import Online 
Statements 

■ In the Reconciliation and Deposits window, choose 
Account Reconciliation in the Transaction field. Select 
the account you wish to reconcile, then choose Import 
Online Statements from the Reconciliation menu. 

2. Follow the instructions in the wizard. When complete, a 
report summarizes the imported transactions and their 
reconciliation status. 
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Print 3. From the File menu, choose Print. You will need this report 

later. Once you have printed the report, close the window. 

4. In the Home window on the General tab, choose the 
Reconciliation and Deposits or Account Reconciliation icon. 

5. Select Account Reconciliation in the Transaction field. 

6. Select the bank account for which you have imported the 
statement. 

7. You will need to account for any discrepancies, such as 
interest and service charges. Go to “Accounting for Interest 
and Service Charges,” later in this chapter.  

Manually Reconciling Your Statement 

Reconciliation is a three-step process: 

 Compare the bank or credit card statement to account 
records. 

 Enter interest, service charges, and other miscellaneous 
items. 

 Correct any discrepancies between the statement and your 
Simply Accounting data. 

Note:  If you have imported your transactions from the bank’s 
Web site, you can skip to “Accounting for Interest and Service 
Charges,” later in this chapter.  

Comparing the Statement to Your Account Records 

 

1. In the Home window on the General tab, choose the 
Reconciliation and Deposits or Account Reconciliation icon. 

2. Select Account Reconciliation in the Transaction field. 

3. Select the account you want to reconcile, and enter the 
statement end date and the date of reconciliation. 

4. In the End Balance field, enter the closing balance that 
appears on your statement. You can also add a comment. 

 Compare 
transactions 

 Enter interest and 
service charges 

 Fix discrepancies 
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5. On the Transactions tab, choose an order in which to view 
the transactions and compare each transaction on your 
statement with the list of transactions on the screen. 

 
 6. Click in the Cleared column for each transaction that you 

match. A check mark appears, and the status changes to 
Cleared. 

7. Click in the Cleared column for each transaction that was an 
adjustment or correction. 

This date is usually the 
same as the End Date. 

If you have correctly 
reconciled your account, 
this amount will be zero. 

Simply Accounting 
automatically displays the 
deposit number of cheques 
and cash you deposited 
into the account.  

You can choose to show 
deposit slip details or to 
filter the corrections you 
have made to items. 

 

8. After you finish comparing transactions, continue with the 
steps in the next section. 

Accounting for Interest and Service Charges 

 

The Income and Expense tabs on the Reconciliation and Deposits 
window allow you to account for interest, service charges, and 
other income or expenses that appear on your statement. 

When you enter income and expenses, all of the related accounts 
are updated. 

1. On the income tab, a type of income, or change the name, 
and enter the source, department, comment, account, 
amount, and a comment, if needed. 

 Compare 
transactions  

 Enter interest and    
service charges 

 Fix discrepancies 
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The account in which this 
amount will be recorded. 

You set up these income 
types when setting up this 
account for reconciliation. 

 

2. On the Expense tab, enter any expenses such as service 
charges in the same way. 

3. If the unresolved amount is zero, click Process to complete 
the reconciliation. Otherwise, continue to the next section. 

Correcting Discrepancies between the Statement and Your Simply Accounting 
Data 

 

If the reconciliation reveals errors on your statement, either you 
or the bank is at fault. If the error is yours, you will need to add 
missing transactions in Simply Accounting or correct existing 
ones. 

■ You will need to make adjustments to existing transactions if, 
for example: 

− The bank withdrew or deposited the wrong amount. 

− The bank didn’t deposit a cheque because it bounced. 

− You processed a cheque that you had voided. 

■ You will need to add transactions if the statement shows, for 
example: 

− You did not enter a cheque that you deposited. 

− You printed a cheque without processing the transaction. 

 Compare 
transactions  

 Enter interest and 
service charges 

 Fix discrepancies 
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Bring Home 
Window to 
Front 

1. In the Reconciliation and Deposits window, choose Bring 
Home Window To Front from the toolbar or View menu. 

2. Make the necessary additions or corrections using the Simply 
Accounting transaction windows. 

 3. Once you have finished all of your corrections, return to the 
Reconciliation and Deposits window. Any transactions that 
you have added or corrected appear automatically. 

Note:  If you have put a check mark in the Do Not Show 
Corrections box, you will not see the original and adjusting 
transactions. 

4. Put a checkmark in the Do Not Show Corrections box. When 
you clear the corrected entry, Simply Accounting will 
automatically clear the original and adjusting entries. 

5. Clear any transactions that you have added.  

 
6. If the unresolved amount is equal to zero, click Process to 

complete the reconciliation. Otherwise, see the next section. 

What To Do with an Unresolved Amount 

If, after following the above steps, you still can’t get the 
unresolved amount to equal zero, you should do the following: 

1. Print the Transactions By Account report for the month of 
the reconciliation: 

a) In the Home window on the Reports menu, choose 
Financials, and then Transactions By Account. 

b) Type a start date that is a few weeks before the earliest 
transaction on your statement. For the end date, type the 
statement’s date. 

c) Click the Select All button, and then click OK. 

d) From the File menu, choose Print. 

2. Next, complete the following checks: 
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■ Make sure the amounts on your source documents — 
such as cancelled cheques, cheque stubs, and so on — 
match the amounts on the bank statement. Then match 
these to the transactions on the report that you just 
printed. 

■ Make sure that you did not receive someone else’s 
source documents, and that you received all of yours. 

■ Make sure you entered the correct closing bank balance 
from the bank statement. 

■ Make sure you have adjusted everything that needed to 
be adjusted. 

■ Make sure every item on the bank or credit-card 
statement has been accounted for. 

■ Make sure the status of each transaction is correct in the 
Reconciliation and Deposits window. 

■ If the difference is divisible by nine, look for a 
transposition error in your work or on the statement. For 
example, you might have typed 87 instead of 78. 

3. If you still cannot find the unresolved amount, you can still 
process the reconciliation, though if the amount is more than 
a few dollars, we strongly discourage this. 

The unresolved amount will appear in the Reconciliation 
and Deposits Adjustments account. 

 
 

Adjusting Inventory Levels 

Inventory items can break, spoil, or be stolen. Or you could 
receive additional stock, such as a free shipment. For this reason, 
you may need to change your inventory records to match actual 
quantities.  

1. In the Home window on the Inventory and Services tab, 
choose the Inventory Adjustments icon. 
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2. Enter a number in the source field. 

3. Select the item and enter the quantity of inventory that you 
are adjusting. If you are decreasing stock, type a negative 
number. If you are increasing stock, type a positive number. 

If you have set up a linked 
account for write-offs, it 
appears automatically. 
Otherwise, you must select 
the account you use for 
write-offs. 

The unit cost is calculated 
based on the average 
purchase price. Enter a value 
in the Amount field if you 
need to change it. 

 

 
3. Fill in the remaining parts of the screen, and click Process. 

Note:  If you are writing off inventory from a customer 
return, let Simply Accounting calculate the unit cost and 
amount. Do not enter the selling price in the Amount field. 

Correcting Inventory Adjustments 

If you have processed an incorrect adjustment, you need to make 
an entry to reverse the error. 

1. In the Home window on the Inventory and Services tab, 
choose the Inventory Adjustments icon. 

2. Fill in the first part of the screen. For the source number, you 
may want to use the original transaction number followed 
by the letters COR (for correction). 

3. Enter the inventory item number with the same quantity as 
the incorrect transaction but with the opposite sign. For 
instance, if the original entry was -15, then type 15. 
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4. Ensure that the account displayed is the same as on the 
incorrect transaction. If the original transaction included 
allocations, be sure to enter those as well. 

 
5. Fill in the remaining parts of the screen, and click Process. 

Checking Your Budget 
Ensure that your company is meeting or exceeding its budget 
goals by analyzing various reports and graphs. 

For more information on setting up budgets, see Chapter 6, 
“Setting Up a Budget.” 

Getting the Facts 

Two reports help you compare budget numbers to what your 
company is actually making: the Project Budget report and a 
comparative income statement. 

Project Budget report.  Allows you to compare actual revenues 
and expenses for one or more projects to the original budget. 

■ In the Home window on the Reports menu, choose Project, 
and then Budget. Select Actual Versus Budget. 

Comparative Income Statement.  Allows you to compare 
actual versus budgeted revenue, expenses, and net income for 
the specified period. 

■ In the Home window on the Reports menu, choose 
Financials, and then Income Statement. In the Report Type 
field, make sure to select a report that compares actual 
figures to budgeted ones. 

Using Graphs 

You may want to print graphs to include in a presentation on the 
company’s budget. You can also copy a graph into a bitmap file 
and then paste it into your presentation. For more information 
on graphs, see Chapter 27, “Using Graphs.” 
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Sales versus Budget graph.  Shows actual and budgeted sales 
for all selected revenue accounts for each month in the current or 
previous fiscal year. 

■ In the Home window on the Graphs menu, choose Sales 
Versus Budget. 

Expenses versus Budget graph.  Shows actual and budgeted 
expenses for all selected accounts for each month in the current 
or previous fiscal year. 

■ In the Home window on the Graphs menu, choose Expenses 
Versus Budget. 

Quickly Updating Your Budget 

At any time, you can change your budget expectations for a 
particular account or project. However, sometimes you may 
want to increase or decrease your entire budget by a certain 
percentage. For example, you may want to account for inflation. 

1. In the Home window on the Maintenance menu, choose 
Update Budget Amounts. 

2. Enter the percentages by which you want to increase or 
decrease the budget, and click Update. 

Daily and Monthly Checklists 
It helps to have a daily and monthly routine to make sure that 
your company runs smoothly. This makes your accounting less 
onerous, as the tasks that you need to complete don’t pile up. 

The following lists are only recommendations, and you may 
want to add or remove tasks. You’ll also find these tasks in the 
built-in checklists, which you can change according to your 
needs. For more information on these checklists, see “Using 
Checklists” in Chapter 22.  
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At the End of the Day 

  Enter a bank deposit.  If you use Simply Accounting to 
reconcile your accounts and have made a bank deposit, you 
may want to enter your deposit slip information in the 
Reconciliation and Deposits window. For more information, 
see “Entering a Daily Bank Deposit” in Chapter 16.  

 Check data integrity and back up your data.  For more 
information, see Chapter 19, “Protecting Your Data.” 

  Print a list of the day’s transactions.  In the Home window 
on the Reports menu, choose Transaction Details, and then 
All. 

 Print a list of changes to all records.  In the Home window 
on the Reports menu, choose List and then the module for 
which you have made changes. 

At the End of the Month 

  Check your budget.  If you work with monthly budgets, 
you should check to see that your actual figures match the 
budgeted ones. For more information, see “Checking Your 
Budget,” earlier in this chapter. 

 Reconcile your bank and credit-card statements.  You 
may wish to reconcile your accounts at the end of the month 
as opposed to when you receive your statement. For more 
information, see “Reconciling Statements from a Bank or 
Credit-Card Company,” earlier in this chapter. 

 Check data integrity and back up your data.  For more 
information, see Chapter 19, “Protecting Your Data.” 

 Compact the database.  For more information, see 
“Enhancing Database Performance,” earlier in this chapter. 

  Print monthly reports.  Make sure to print these reports 
before adding entries in the next month. For a list of reports 
to print, see “Printing Audit Trail Reports” in Chapter 21.  
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 At the End of the Quarter 

When you enter a session date for a new quarter, Simply 
Accounting zeroes the current quarter’s payroll earnings, 
deductions, and expenses (although it keeps the cumulative 
year-to-date information) so that it can begin to accumulate the 
new quarter’s information. 

  Check data integrity and back up your data.  For more 
information, see Chapter 19, “Protecting Your Data.” 

  Print payroll reports.  Print all the reports described in 
“Printing Audit Trail Reports” in Chapter 21.  
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Chapter 21 
End of Year and Tax Period 
 

The year can end at the end of the calendar year, tax period and fiscal year. You 
must complete certain tasks at the end of each. To complete your year-end tasks 
quickly, use Simply Accounting to electronically file some government forms. 

 

End of a Provincial or State Tax Period ..............................................21–1 
End of a GST, HST, or QST Period...................................................21–1 

Printing Reports at the End of a Tax Period.......................................21–1 
Adjusting the Sales Tax Reports .................................................21–2 
Backing Up Your Data Before Filling Out the Sales Tax Return .....................21–3 
Filling Out the Sales Tax Return .................................................21–3 

GST/HST Return ..........................................................21–3 
QST Return................................................................21–4 

Paying the Government What You Owe or Receiving a Refund.....................21–4 
Paying the Government ....................................................21–5 
Receiving a Refund from the Government ....................................21–6 

End of a Contract Payment Reporting Period.........................................21–7 
End of a Calendar Year.............................................................21–8 
End of a Fiscal Year................................................................21–8 

Checking Your Data and Backing It Up ..........................................21–9 
Reconciling the Statements for Your Bank and Credit-Card Accounts ...............21–9 
Exporting GIFI Data ..........................................................21–10 
Printing Year-End Reports.....................................................21–10 
Adjusting Entries in the Previous Year ..........................................21–11 

Creating a Copy of Your Data to Send to Your Accountant ....................21–11 
Cancelling an Accountant’s Copy...........................................21–13 
Importing Entries From Your Accountant ...................................21–13 

Printing Audit Trail Reports .......................................................21–13 
Electronic Filing ..................................................................21–15 

Before You Start ..............................................................21–15 
Filing Original T4 Slips ........................................................21–18 
Filing Amended T4 Slips ......................................................21–22 
Filing Relevé 1 Slips ..........................................................21–22 
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End of a Provincial or State Tax Period 
The number of times per year that you pay your provincial or 
state government taxes varies by jurisdiction. Contact the 
government department to which you remit taxes if you need 
more information. 

The account in which you record tax payments varies according 
to the situation. You should ask your accountant for information 
on how to record provincial or state taxes. 

At the end of the tax period, print a Tax report to see the 
information you need to report.  

 End of a GST, HST, or QST Period 
You must report GST, HST, or QST at the end of a month, 
quarter, or year. Contact the Canada Revenue Agency or the 
Ministère du Revenu du Québec to find out the length of your 
reporting period. 

When the tax period ends, you need to complete the following: 

 Print a balance sheet and the Tax report in detail and 
summary form for the last day of the tax period. 

 Make manual adjustments to the tax report. 

 Back up your company’s data. 

 Fill out the sales tax return. 

 Pay the government what you owe, or receive a refund. 

Printing Reports at the End of a Tax Period 

You should print the following reports for your records before 
filling out your tax return: 

■ In the Home window on the Reports menu, choose 
Financials, and then Balance Sheet. 
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■ In the Home window on the Reports menu, choose Tax, then 
select the taxes to report. Make sure to print two copies of 
each report: one as a summary and one with details. 

Adjusting the Sales Tax Reports 

The sales tax reports for Simply Accounting may not include all 
sales taxes that you have collected. For example, employee 
income that includes GST, HST, or QST-taxable benefits is not 
included. You may need to add these amounts to your sales tax 
report. 

Using the reports that you just printed, compare the GST, HST, 
or QST amounts on your summary tax report to the GST, HST, 
or QST account total on the balance sheet. 

Note:  Ignore the negative sign when you are comparing the 
numbers.  

If the two totals are not the same, you must adjust the totals on 
the summary report, as follows: 

1. On the summary report, cross out the totals for the tax paid 
and charged. Write down the totals from the balance sheet 
(as positive numbers). 

Next, you need to calculate the taxable purchases and sales. 

2. In the Home window on the Reports menu, choose 
Financials and then Transactions By Account. 

3. Select the GST Paid On Purchases, HST Paid On Purchases, 
or Refundable QST Paid account. Select the beginning and 
ending dates for the tax period, and click OK. Print the 
report. 

4. Check to make sure that all the transactions on this report 
appear on the detailed tax report that you printed earlier. 
Mark the entries that don’t appear on the detailed tax report. 

5. Using those marked transactions, determine what your 
actual GST paid on purchases should be. 

6. Repeat steps 2 through 5, calculating GST charged on sales 
instead of purchases. 
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Backing Up Your Data Before Filling Out the Sales Tax Return 

Before completing the tax return, you should back up your data. 
Label this backup to indicate that you are passing from one tax 
period to another. For more information on backing up, see 
“Backing up Your Company’s Information” in Chapter 19. 

You can use this backup if you need to look up information 
specific to this tax period. 

Filling Out the Sales Tax Return 

Once you have the correct amounts on the summary tax report, 
you can fill out the sales tax return. You will need the corrected 
summary tax report as well as your balance sheet, both of which 
you printed earlier in this process. 

The information you require depends on whether you are filling 
out a GST/HST or QST return. 

GST/HST Return 

Using the corrected Tax report for GST/HST, copy the following 
information to your sales tax return. 

Copy this total: To this section: 

Taxable Sales Excluding Taxes Total Taxable Supplies 

Then, from the balance sheet, copy the following to the sales tax 
return. 



Part 3:  Company Maintenance 

21−4    Simply Accounting 

 
  

SIM2006 ENGL UG Part 3 (19-21) Recovered.doc, printed on 1/12/2006, at 11:07:38 AM. Last 
saved on 1/9/2006 10:39:00 AM. 

ACCPAC International, Inc. Confidential 

Copy this total: To this section: 

GST/HST Charged On Sales 
and GST/HST Payroll 
Deductions (if any) 

GST Collectible 

GST/HST Adjustments GST/HST Adjustments 

GST/HST Paid On Purchases Input Tax Credit 

ITC Adjustments ITC Adjustments 

QST Return 

Using the corrected Tax report for QST, copy the following to the 
sales tax return. 

Copy this total: To this section: 

Taxable Sales Excluding Taxes Total Supplies 

Then, from your balance sheet, copy the following to the sales 
tax return. 

Copy this total: To this section: 

QST Charged and QST 
Adjustments Deductions (if 
any) 

QST Collectible and 
Adjustments 

Refundable QST Paid and ITR 
Adjustments 

ITRs and Adjustments 

Paying the Government What You Owe or Receiving a Refund 

If you owe the government money, you must not only issue a 
cheque to the government, but also clear the tax accounts. If you 
are eligible for a refund, once you receive money from the 
government, you must also enter a receipt into Simply 
Accounting that clears the tax accounts, as described below. 
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Paying the Government 

1. If this is your first sales tax payment, you must add a vendor 
record for either the Receiver General of Canada or the 
Ministère du Revenu du Québec. Since you will be remitting 
payments to these government agencies for payroll 
liabilities, in the vendor record, check the payroll authority 
box, and be sure to set the Tax Exempt field to Yes on the 
Taxes tab. For more information on adding vendors, see 
“Adding Vendors” in Chapter 12. 

 

Note:  You must not write a cheque to a one-time vendor 
under the government body’s name. If you do, your tax 
reports will be inaccurate for the next period. 

2. In the Home window on the Vendors and Purchases tab, 
choose the Purchases, Orders, and Quotes icon or the 
Invoices icon. 

3. In the Transaction field, choose Invoice. If you are going to 
issue a cheque immediately, select Cheque in the Paid By 
field. Otherwise, select Pay Later. 

4. Select the “vendor” (the government department), and for 
the invoice number, enter the payment information, such as 
Q3 GST (for a third-quarter GST payment). 

5. On the first line of the invoice, in the Description field, type 
GST charged on sales or QST charged on sales. Type the 
amount as found on the summary tax report, and then 
double-click the Account field and select either GST Charged 
On Sales or QST Charged at Rate 1. 

6. On the next line, repeat step 5 using GST Paid On Purchases 
or Refundable QST Paid. Enter the amount as a negative 
number. 

7. If you have used other sales tax accounts, such as QST 
Charged at Rate 2, any tax adjustment accounts, or a sales 
tax payroll-deduction account, enter the amounts from the 
summary tax report and select the corresponding account. 

The invoice total should equal the amount that you owe the 
government.  
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Print 8. If you are issuing a cheque, choose Print from the File menu. 

 
9. Click Process. 

If you are issuing the cheque later, do so in the Payments 
window. Select the tax authority, and then make the payment as 
you normally would for any other invoice. For more information 
on paying invoices, see “Paying for Goods and Services” in 
Chapter 12.  

Receiving a Refund from the Government 

1. If this is your first sales tax refund, you must add a customer 
record for either the Receiver General of Canada or the 
Ministère du Revenu du Québec. You must set the Tax 
Exempt field to Yes on the Taxes tab for this “customer.” For 
more information on adding customers, see “Adding 
Customers” in Chapter 13.  

Note:  You must not accept a payment from a one-time 
customer under the government body’s name. If you do, 
your tax reports will be inaccurate for the next period.  

2. In the Home window on the Customers and Sales tab, 
choose the Sales, Orders, and Quotes icon or the Invoices 
icon. 

3. In the Transaction field, choose Invoice. In the Paid By field, 
select Pay Later. (If you have already received the refund, 
select Cheque). 

4. Select the tax authority, and for the invoice number, enter 
the refund information, such as Q3 GST (for a third-quarter 
GST refund). 

5. On the first line of the invoice, in the Description field, type 
GST paid on purchases or Refundable QST paid. Type the 
amount as found on the summary tax report, and then 
double-click the Account field and select either GST Paid On 
Purchases or Refundable QST Paid. 

6. On the next line, repeat step 5 using GST Charged On Sales 
or QST Charged On Sales. Enter the amount as a negative 
number. 
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7. If you have used other sales tax accounts, such as QST 
Charged At Rate 2, any tax adjustment accounts, or a sales 
tax payroll-deduction account, enter the amounts from the 
summary tax report and select the corresponding account. 
Make sure the discount rate is set to zero.  

The invoice total should equal the amount the government 
owes you.  

 
8. Click Process. 

If you will receive the refund later, use the Receipts window to 
record receipt of the payment when it arrives. Select the tax 
authority, and then enter the receipt as you normally would for 
any invoice. For more information on receiving a cheque for an 
invoice, see “Receiving Payment for Goods and Services” in 
Chapter 13.  

 End of a Contract Payment Reporting Period 
In Canada, if your company’s primary activity is construction, 
you must file a T5018 form to report amounts paid to 
subcontractors for construction services. You can use Simply 
Accounting to print the information needed for this form.  

You must file the report within six months of the end of your 
reporting period, which can be a calendar year or a fiscal year. 
For more information about the T5018 form, contact the Canada 
Revenue Agency.  

To print T5018 forms: 

1. In the vendor record, in the Tax ID field, enter the 
subcontractor’s Business Number or Social Insurance 
Number. Simply Accounting will print this number on the 
T5018 form.  

2. In the Home window on the Reports menu, choose Vendors 
and Purchases, then Print T5018 Slips.  

3. Select the vendors and the year you want. 
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4. Select T5018 Summary, T5018 Statements, or both. You must 
submit both when you file your report with the Canada 
Revenue Agency.  

End of a Calendar Year 
Moving from an old calendar year to a new one (from 
December 31 to January 1) affects only payroll. Simply 
Accounting moves all amounts from the current year to the 
previous year except for pay advances and vacation time. These 
amounts represent continuing assets and liabilities. However, if 
your fiscal year coincides with a calendar year, be sure to read 
the next section for important information about fiscal year-end. 

Before you begin a new calendar year, you should do the 
following: 

 Check your data’s integrity and back up your data. See 
Chapter 19, “Protecting Your Data.” 

 Print your payroll reports. See “Printing Audit Trail 
Reports,” at the end of this chapter, for more information. 

 In Canada, you may also need to update the personal tax credit 
amounts that are subject to indexing for your employees. See 
“Automatically Updating Personal Tax Credits Subject to 
Indexing” in Chapter 20.  

End of a Fiscal Year 
The end of the fiscal year may or may not occur at the same time 
as the end of the calendar year. It depends on how you have set 
up your business. 

Nonetheless, the end of the fiscal year is a critical time for your 
business and its financial statements. 

Before you move into a new fiscal year, you should do the 
following: 
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 Check data integrity and back up your data. 

 Reconcile the statements for your bank and credit-card 
accounts. 

   If filing taxes electronically, export GIFI data. 

 Print year-end and budget reports. 

 Make year-end adjustments as recommended by your 
accountant. 

 

Simply Accounting automatically enters the balances from all 
revenue and expense accounts into the Retained Earnings 
account for the new year. It also accumulates balance-forward 
amounts for projects and moves these balances to the Project 
report. 

Checking Your Data and Backing It Up 

You should never start a new fiscal year with damaged or 
incorrect data, so make sure to check your data’s integrity before 
proceeding. See “Checking Data Integrity” in Chapter 19. 

Once you have ensured that your data is intact, you should back 
it up. This way, you can be sure that you have a copy of the old 
year’s data in case you need to look something up or restore 
your data. See “Backing up Your Company’s Information” in 
Chapter 19. 

Reconciling the Statements for Your Bank and Credit-Card Accounts 

Usually, you reconcile your accounts when your statements 
arrive; however, if you have fallen behind on your reconciliation, 
you should reconcile all of your statements before moving to the 
new year. 

Reconciling your accounts will help to catch any errors. 

See “Reconciling Statements from a Bank or Credit-Card 
Company” in Chapter 20.  
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 Exporting GIFI Data 

If you file your corporate tax returns (T2) electronically, you 
must use the General Index of Financial Information (GIFI) codes 
that correspond to your chart of accounts. You can use Simply 
Accounting to export these codes and other information to a file 
that can be used when you submit your tax return. 

Two files are created when you export. The first is the GIFI 
export file, GIFInnnn.GFI, where nnnn is the fiscal year you are 
reporting. The second is the GIFI chart of accounts file, 
GIFICHRT.CSV, which contains a list of your accounts, GIFI 
codes, and account balances. Simply Accounting uses this 
second file to create the GIFI file. 

You only need the GIFInnnn.GFI file, which contains the 
information required by your corporation income tax return 
software. 

1. In the Home window on the File menu, choose 
Import/Export. Select Electronic Filing, and then Export 
GIFI. 

2. Select the year for which you want to export, and click OK. 

3. Save the GIFI file to any location. You can then copy that file 
to a floppy disk so that you can send it to the Canada 
Revenue Agency. You should also keep a copy of the file for 
your records. 

Printing Year-End Reports 

You should print and store the year-end reports for your 
records. These reports will provide an audit trail for your 
accountant. 

See “Printing Audit Trail Reports,” at the end of this chapter, for 
a list of reports that you should print. 

If you have a consolidated company, there are specific 
consolidated company reports you can print on a monthly, 
quarterly, or yearly basis, depending on your company’s 
reporting requirements. For more information about generating 



Chapter 21:  End of Year and Tax Period 

User Guide    21−11 

 
  

SIM2006 ENGL UG Part 3 (19-21) Recovered.doc, printed on 1/12/2006, at 11:07:38 AM. Last 
saved on 1/9/2006 10:39:00 AM. 

ACCPAC International, Inc. Confidential 

P
ro

tectin
g

 
Y

o
u

r D
ata 

consolidated company reports, refer to the section, “Working 
with a Consolidated Company,” in Chapter 24. 

Adjusting Entries in the Previous Year 

There are two reasons why you might need to enter transactions 
in the previous year. First, you might find an error in an old 
transaction that must be fixed. Second, your accountant may 
send you a set of “adjusting entries” that will allow you to more 
accurately report your financial position. You might receive 
these entries well into the new year. 

For more information on period-end adjustments, see Chapter 11 
in the Accounting Manual. 

Any transactions that you must enter as adjustments occur in the 
previous year. Because you cannot start Simply Accounting with 
a session date in the previous year, you must ensure that Simply 
Accounting is set to allow you to enter transactions in the 
previous year: 

1. In the Home window on the Setup menu, choose System 
Settings and then Settings. 

2. Click Company and then System, and enter a new date from 
the previous year in the field next to Do Not Allow 
Transactions Before. 

3. Click OK. 

4. Make the adjusting entries (dated in the previous year). 

   Creating a Copy of Your Data to Send to Your Accountant 

If your accountant is using the Accountant’s Edition of Simply 
Accounting, you can create an electronic copy of your Simply 
Accounting data and give it to your accountant to make the 
adjustments. 

You can continue to work with your original company data 
while your accountant makes the adjusting entries.  

When your accountant finishes working with the copy, they will 
send you a file that you import into Simply Accounting. For 
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more information about importing data from your accountant, 
see “Importing Entries From Your Accountant” later in this 
section. 

While your accountant has a copy of your company data, there 
are no restrictions on what you can do, but we strongly 
recommend that you do not: 

■ Delete or renumber any accounts. 

■ Delete or rename any projects. 

■ Delete or renumber any departments. 

■ Delete or renumber any tax codes. 

Performing any of the above actions may prevent some of your 
accountant's entries from importing into your company data. 

If you are running Simply Accounting on a network, you must 
be in single-user mode to create an accountant's copy. If you are 
in multi-user mode, the Accountant's Copy menu option will be 
dimmed. Unless you create a user profile with limited access 
rights, your accountant will have view access to the same 
information as the sysadmin. 

 

You can only have one accountant's copy at any given time. If 
you create another accountant's copy, the existing copy will be 
cancelled. If you cancel an accountant's copy that your 
accountant is working on, you will not be able to import any 
entries made by your accountant using that copy. 

1. Back up your company data. 

2. In the Home window, in the File menu, choose Accountant's 
Copy, and Create Accountant's Copy. 

3. Make changes to the file name if you want. For example, you 
might want to add the date or the name of your accountant 
to the file. 

4. If you want to change where the accountant's copy will be 
saved, enter the new location or click Browse to choose one. 

5. Click OK. 
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   Cancelling an Accountant’s Copy 

Note:  If you cancel the current accountant's copy, you will not 
be able to import entries made by your accountant for this copy. 

1. In the Home window on the File menu, choose Accountant's 
Copy, and Cancel Accountant's Copy. 

2. Click Yes to confirm that you want to cancel the current 
accountant's copy. 

   Importing Entries From Your Accountant 

1. In the Home window on the File menu, choose Accountant's 
Copy, and Import Entries From Accountant. 

2. Follow the Import Entries from Accountant Wizard. If you 
want a list of the entries added to your company data, click 
Print in the Import Records Summary dialog. 

3. Click Finish to close the wizard. 

Printing Audit Trail Reports 

 
Report 

Month 
End 

Calendar 
Qtr. End 

 

Calendar 
Year End 

Fiscal
Year End

Income Statement     
Month-to-date     
Year-to-date     

Balance Sheet     

Transactions By Account (past month)     
All Transactions (past month)     

Chart of Accounts     
Cheque Log (for purchases and payroll)     
Direct Deposit Log     
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Report 

Month 
End 

Calendar 
Qtr. End 

 

Calendar 
Year End 

Fiscal 
Year End

Vendors and Purchases     
Purchase Transaction Details     
Payment Transaction Details     
Vendor Aged (summary and detail)     

Customers and Sales     
Sales Transaction Details     
Receipts Transaction Details     
Customer Aged (summary and detail)     

Payroll     
Payroll Transaction Details (past month)     
Remittance report for the amounts owed 
to payroll authorities 

At the end of the remittance reporting 
period. 

  Employee Quarter-to-Date Summary     
Employee Year-to-Date Summary     
Employee Detail     

  T-4 slips and Summary     
  Relevé 1 slips and Summary     

  W-2 Forms     
  SUTA Summary     
  940 Summary     
  941 Summary     

Inventory and Services     
Inventory (Quantity and Synopsis)     
Item Assembly Transactions (past 
month) 

    

Adjustment Transactions (past month)     

Project     

Tax reports for the taxes you need to report At the end of the tax reporting period. 
Account Reconciliation (summary and 
detail) 

During and after reconciliation. 
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 Electronic Filing 
Use Simply Accounting to print your employee T4 and Relevé 1 
slips (RL-1), and to electronically file (e-file) these slips via the 
Internet or on magnetic media according to government 
specifications. Electronic filing speeds processing, so you can 
complete year-end tasks quickly. 

The Canada Revenue Agency and the Ministere du Revenu du 
Quebec require that you file your payroll tax forms and 
employee T4 and RL-1 slips by the last day of February (or the 
next business day, if the this day falls on a Saturday or Sunday ) 
of the calendar year following the year to which they pertain. 
You must also remit copies of T4 and RL-1 slips to your 
employees by this same date. 

When you use Simply Accounting to file your T4 slips (either via 
the Internet or on magnetic media), you are actually filing your 
T4 Information Return. Your return includes your employee 
T4 slips, and the related T4 Summary form.  

Although Simply Accounting does not submit the Summary of 
Source Deductions and Employer Contributions with you RL-1 
slip submission, you can print reports to gather the information 
you need to prepare and file this form. 

Before You Start 

Before you print or file T4 and RL-1 slips: 

1. Ensure that you have made all required adjustments to 
employee paycheques for the payroll calendar year. 

2. Ensure that your company’s business number is entered 
correctly on the Company Information window. 

3. Ensure that employee information is correct and up-to-date. 
For example, each employee record must contain the 
employee’s first name and surname, a valid social insurance 
number, and the province of employment (2-character 
province code). 

In addition, update the following information on employee 
records, if required: 
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a) RPP/DPSP Reg. Number.  If the employee is part of a 
Registered Pension Plan or Deferred Profit Sharing Plan, 
enter the plan registration number on the employee 
record.  

b) Pension Adjustment.  Refer to government legislation 
to determine whether to report a pension adjustment 
amount on the employee T4. Enter only a dollar amount. 

c) T4 Employment Code.  This code is reported on Box 29 
on the T4 slip. Select the appropriate code on the 
employee record if one of the following situations 
applies. Otherwise, leave the field blank. 

■ 11 — Placement Agency (self-employed) 

■ 12 — Driver of taxi or other passenger-carrying 
vehicle 

■ 13 — Barber or hairdresser 

■ 14 — Withdrawal from a prescribed salary deferral 
arrangement plan. 

■ 15 — Seasonal Agricultural Workers Program 

■ 16 — Detached employee - social security 
agreement.  

Refer to your government-supplied documentation for 
information on completing T4 slips for employees that 
fall into one of the aforementioned employment 
categories. 
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d) EI Insurable Earnings.  EI insurable earnings is a year-
to-date total based on taxable earnings. If you entered 
payroll taxes manually when you processed an 
employee’s paycheque or paycheque adjustment, then 
the calculated EI insurable earnings may differ slightly 
from the taxable earnings. Remember to adjust the 
calculated amount on the T4 and RL-1 Reporting tab of 
the employee record so that the correct amount is 
printed on the employee’s T4. 

e) Pensionable Earnings.  Pensionable earnings is a year-
to-date total based on taxable earnings. If you entered 
CPP/QPP manually when you processed an employee’s 
paycheque or paycheque adjustment, the calculated 
pensionable earnings may differ slightly from the 
taxable earnings. Remember to adjust the calculated 
amount on the T4 and RL-1 Reporting tab of the 
employee record so that the correct amount is printed on 
the employee’s T4. 

To file T4 slips electronically: 

You must be registered for the Canada Revenue Agency's e-file 
service. When you register, you will receive one or both of the 
following: 

■ A Web Access Code (WAC) for Internet filing.  This 
six-character code (two letters and four numbers) is 
pre-printed on the top of the personalized T4 Summary 
form you received from the CRA.  

If you have not received a WAC, contact the CRA to 
confirm your eligibility and to obtain a code for Internet 
filing. 

■ A magnetic media transmitter number.  The number 
format is "MM" and six digits (for example, MM999999).  

Note:  If you did not receive a magnetic media 
transmitter number when you registered for the e-file 
service and you wish to transmit original or amended 
T4 slips on magnetic media, then contact the CRA. 
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To file RL-1 slips electronically: 

To file electronically, contact the Groupe de promotion de l’EDI 
et d’acquisition de données électroniques. You will be assigned 
the following:  

■ Transmitter number.  This number is composed of two 
letters (NP) followed by six digits, and identifies you as the 
file submitter. If you do not have such a number, contact the 
Groupe de promotion de l’EDI et d’acquisition de données 
électroniques. 

■ User Code and Password.  A user code and password to 
access the Web site of the Ministère. 

■ RL-1 Slip Number.  This number will be used to calculate 
each employee’s 9-digit E-file slip number. 

Filing Original T4 Slips 

For the year you select, Simply Accounting will generate T4 slips 
and the T4 Summary report to a file in Extensible Markup 
Language (XML) format, as required by the Canada Revenue 
Agency. You can transfer this file over the Internet if you 
generated no more than 499 T4 slips and the file size does not 
exceed 610 KB. If you need to submit slips for more than 
499 employees, submit the file on magnetic media (diskette or 
CD-ROM only). 

For information on how to file amended T4 slips, see the next 
section entitled, “Filing Amended T4 Slips.” 

Note:  If your data exceeds 1.35MB, copy it to media with more 
storage space than a floppy diskette. 

To file T4 slips (original submission): 

1. In the Home window on the File menu, choose 
Import/Export. Select Electronic Filing, and then Export T4's 
(Internet File Transfer). 

2. If you have payroll data for more than one year, select the 
payroll year to which the T4 slips apply. 
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3. Select the employees for whom you wish to file T4 slips. 

4. Using publications from the Canada Revenue Agency to 
guide you, complete the information on all tabs of the form. 

 

Select the employees for 
whom you wish to submit 
T4 slips. 

Click to include inactive 
employees in the 
employee selection list. 

Select the payroll year. 

 

Transmission Information Tab 

■ Transmission Method.  Select the Internet File Transfer 
option to submit up to 499 T4 slips over the Internet. If 
you select more than 499 employees, Simply Accounting 
will automatically select the Magnetic Media option. 
Select the Magnetic Media option to file an original or 
amended slip transmission on diskette or CD-ROM. 

■ Report Type Code.  If you select the Internet File 
Transfer transmission method, Original is automatically 
selected, as you can only submit original T4 slips via the 
Internet. If you select the Magnetic Media option, then 
select Original to submit your original T4 slips, or 
Amended if you are making changes to an original or 
previously amended slip transmission.  

■ Transmitter Number.  If you select the magnetic media 
transmission method, then enter the 6-digit transmitter 
number assigned to you by the CRA. This number 
begins with the letters “MM.”  
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■ Submission Reference ID.  Simply Accounting displays 
a default number, which is the count of the number of 
transmissions you’ve made. You can accept this number, 
or enter a unique number to identify the current file 
submission. For example, to identify an original file 
submission, enter 001. To identify a resubmission of 
amended slips, enter 002, and so forth. 

■ File Sequence Number.  You are required to track the 
sequence of filings submitted when you file 
electronically. This number appears at the end of the 
electronic file name. Simply Accounting automatically 
displays the last number in the submission series. You 
can accept this number or enter another number. 

Business Information Tab 

■ Click the Business Information tab, and select your 
business type. Depending on your selection, you may 
have to enter the social insurance number (SIN) of one 
or two of the primary business owners. 

Business Type  Information Required 

Sole Proprietorship Enter the SIN of the owner. 

Partnership Enter the SIN of the two main 
owners or partners. 

Canadian Controlled 
Private Corporation 

Enter the SIN of one or more 
owners or partners. 

Other No information is required. 

Contact Information Tab 

■ Enter your company contact's information and language 
preference. 

5. Click OK. 

6. On the T4 Box Options window, assign income and 
deductions to the correct T4 slip box numbers. Click OK 
when complete. 
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Simply Accounting validates company and employee 
information before creating the file for transmission and 
advises you if errors are found. 

7. If the validation process is successful, then the T4 slip 
information is exported to a file. Select a location on your 
hard drive where the file will be created.  

Note:  Simply Accounting will use the default file name 
T4EFILE001XML. This file name format is <name>nnn.xml, 
where name is any combination of number or letters that 
you’ll use to identify the file, and nnn corresponds to the 
submission sequence number. For example, if this is your 
second submission, then modify the default file name to 
T4EFILE002.XML. 

8. Click the Print button on the Simply Accounting — Export 
Records Summary window to print the transmission details 
for your records.  

9. If you are filing original slips over the Internet: 

a) Click the link on the bottom left of the window to access 
the CRA's secure Web site, where you can enter your 
web access code and transmit the generated file. 

b) When you’ve completed this process click the OK button 
to close the Export Records Summary window. 

10. If you are filing on magnetic media: 

a) Click the OK button to close the Export Records 
Summary window. 

b) Copy the file to diskette or write it to CD. Consult your 
CD writer’s software manual for instructions on 
finalizing the disk using ISO 9660 encoding. 

c) Refer to CRA publications for additional filing 
directions.  

11. For each employee for whom a T4 slip was generated, 
Simply Accounting will update the E-file Information 
section on the Taxes tab of the employee record (the E-file 
Submission ID and the Date of Transmission fields). 
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Filing Amended T4 Slips 

The Canada Revenue Agency permits you to file amended 
T4 slips (to correct information on a previously filed slip) in 
electronic (XML) format on magnetic media only. T4 Internet 
filing is not supported for amended T4 slips.  

To file amended T4 Slips: 

Follow the steps for filing original T4 slips, as outlined in the 
previous section. Note the following: 

1. Ensure that you only select the employees for whom you’ve 
already filed T4 slip information, and whose T4 slip 
information you want to correct.  

2. On the Transmission Information tab: 

a) Select the Magnetic Media transmission method. 

b) Select the Amended option as the Report Type. 

c) Enter your magnetic media transmitter number. 

d) Use the Submission Reference ID that Simply 
Accounting generates or enter your own unique 
reference number. 

Note:  To reprint amended T4 slips for affected employees, 
follow the directions for printing T4 slips in Chapter 1, “List 
of Reports” in the Advanced Topics file. Remember to print 
the word “amended” on the top of each amended T4 slip, 
and distribute the slips to affected employees as soon as 
possible. 

Filing Relevé 1 Slips 

For the year you select, Simply Accounting will generate 
Relevé 1 slips to a file in the format required by the Ministère du 
Revenu du Québec. You can access the Ministère’s Web site to 
transmit the file over the Internet if you generated no more than 
10 RL-1 slips. If you need to submit slips for more than 
10 employees, then submit the file on magnetic media, such as 
diskette or CD-ROM. 
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Simply Accounting currently supports filing original, 
replacement, and test RL-1 slips via the Internet or on magnetic 
media. If your data exceeds 1.35MB, copy it to media with more 
storage space than a floppy diskette. 

If you file using magnetic media, you will need to have the 
Simply Accounting magnetic media filing authorization number. 
This number changes annually and is available on our Web site: 
www.simplyaccounting.com/ce/rq/. 

Note:  You must be registered with Clic Revenu to file RL-1 slips 
over the Internet. Visit the Revenu Quebec Web site for more 
information about registration. 

To file RL-1 slips: 

1. In the Home window on the File menu, choose 
Import/Export. Select Electronic Filing, and then Export 
RL-1’s (Slip Transmission Service). 

2. If you have payroll data for more than one year, then select 
the payroll year to which the RL-1 slips apply. 

3. Select the employees for whom you wish to file RL-1 slips. 

4. Using publications from the Ministère du Revenu du Québec 
to guide you, complete the information on all tabs of the 
form. 
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Select the employees for 
whom you wish to submit 
RL-1 slips. 

Click to include inactive 
employees in the 
employee selection list. 

 

Transmission Tab 

■ Transmission Method.  Select the Internet File Transfer 
option to submit up to 10 RL-1 slips over the Internet. If 
you select more than 10 employees, Simply Accounting 
will automatically select the Magnetic Media option. 
Select the Magnetic Media option to file RL-1 slip data 
on diskette or CD-ROM. 

■ Package Type.  Select one of the following: 

− 1 — Original File, if you are submitting an original 
file. 

− 2 — Replacement of Original File, if you are sending 
a file in replacement of an original file at the request 
of the Ministère. 

−  3 — Test File, if you are sending a test file or a file in 
replacement of a test file. 

Note:  Although, you are not required to submit a test 
file before filing “live” data, the Ministère du Revenu du 
Québec recommends that you submit a test file if this is 
the first time you are filing RL-slip data on magnetic 
media or via the Internet. 
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■ Transmitter Type.  Select the option that describes for 
whom you are filing RL-1 slips.  

■ Source of RL slips.  Select the option that describes 
where you obtained your RL-1 slips. 

■ Transmitter Number.  Enter the transmitter number 
assigned (6-digit number, prefixed with the letters 
“NP”) to you by the Groupe de promotion de l’EDI et 
d’acquisition de données électroniques. 

■ RL-1 Slip Number.  Enter the 8-digit number that you 
received from the Ministère du Revenu du Québec for 
electronic filing. This number will be used to calculate 
each employee’s 9-digit E-file slip number. 

■ File Sequence Number.  You are required to track the 
sequence of filings submitted when you file 
electronically. This number appears at the end of the 
electronic file name. Simply Accounting automatically 
displays the last number in the submission series. You 
can accept this number or enter another number. 

Business Information Tab 

Enter the following information: 

■ Quebec Enterprise Number.  Enter the 10--digit 
Québec Enterprise Number (NEQ) assigned to you by 
the Inspector General of Financial Institutions, the clerk 
of the Superior Court, or the Ministère du Revenu. If you 
do not have a number, then leave the field blank. 

■ Employer ID Number.  Enter the 10-digit employer 
identification number assigned to you by the Ministère 
du Revenu. 

■ Employer File Number.  Enter the 4-digit employer file 
number assigned to you by the Ministère du Revenu. 
This number is always preceded by the letters RS.  

Note:  Your employer identification and file numbers are 
pre-printed on the personalized Summary of Source 
Deductions and Employer Contributions form you received 
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from the Ministère du Revenu. For example, if the number is 
1009551815RS0001, then the first ten digits correspond to the 
identification number, and the last four digits correspond to 
the file number. 

Contact Information Tab 

■ Enter the name and basic contact information of the 
accounting and technical resource persons the 
government can contact if additional information is 
required. 

5. Click OK. 

6. Simply Accounting validates company and employee 
information before creating the file for transmission and 
advises you if errors are found. 

7. If the validation process is successful, then the RL-1 slip 
information is exported to a file. Select a location on your 
hard drive where the file will be created.  

Note:  For magnetic media, Simply Accounting 
automatically creates and names the file MRQREL01.BBB, 
where BBB corresponds to the sequence number of the 
magnetic medium. If you submit a single CD-ROM, the file 
name would be MRQREL01.001.  

8. If you are filing over the Internet: 

a) Click the Print button on the Simply Accounting — 
Export Records Summary window to print the 
transmission details for your records.  

b) Click the link on the bottom left of the window to access 
the Québec government’s secure Web site, where you 
can transmit the generated file. 

c) When you’ve completed this process click the OK button 
on the Export Records Summary window to close the 
window. 
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9. If you are filing on magnetic media: 

a) Click the Print button on the Simply Accounting — 
Export Records Summary window to print the 
transmission details for your records. 

b) Click the OK button to close the window. 

c) Copy the file to diskette or supported tape format, or 
write it to CD. Consult your CD writer’s software 
manual for instructions on finalizing the disk using 
ISO 9660 encoding. 

d) Complete form OPR-400-V, Description of the RL-Slip 
Data File, available from the Revenu Québec Web site.  

Note:  When completing the form, enter 550 for the 
logical record length. 

e) Refer to Revenu Québec publications for additional 
filing directions.  

10.  For each employee for whom an RL-1 slip was generated, 
Simply Accounting will update the E-file Information 
section on the Taxes tab of the employee record (the E-file 
RL-1 Slip Number and the Date of Transmission fields). The 
9-digit RL-1 slip number must be printed in the upper 
right-hand corner of each slip, in the space above the 
pre-printed (or Simply Accounting generated) slip number. 

Note:  Remember to file your Summary of Source 
Deductions and Employer Contributions form under 
separate cover. If you’re registered for the Clic Revenu 
service, then you can complete this form online. 
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Part 4 

Once you become familiar with the basics, you can start to 
streamline the way you use Simply Accounting. You can tailor Simply 
Accounting by re-arranging screens and creating checklists for 
yourself. You can also use recurring transactions to save time on 
tasks that you complete every week or month, like paying rent. These 
and many other time-saving features are described in this section. 

 

Chapter 22 — Increasing Efficiency 
Chapter 23 — Reducing Clutter 
 

Tim
e-Savers 
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Chapter 22 
Increasing Efficiency 
 

These tips will save you time and help you remember important tasks. 

 

Centralize Tasks in the Daily Business Manager ..................................... 22–1 
Displaying the Daily Business Manager Automatically ........................... 22–1 
Batch Process and Print Transactions ........................................... 22–2 
Attach Notes to the Business Calendar .......................................... 22–3 

Filtering Out Events ....................................................... 22–3 
Clearing Notes............................................................ 22–4 

Use To-Do Lists as Reminders of Tasks to Be Completed.......................... 22–4 
What’s on the To-Do Lists?................................................. 22–5 
Displaying To-Do Lists .................................................... 22–5 
Using To-Do Lists......................................................... 22–6 
Adding Memos to the To-Do List ........................................... 22–6 
Using a Recurring Transaction in the To-Do List ............................. 22–6 

Business Performance Measurements ........................................... 22–7 
Selecting Business Performance Measurements .............................. 22–8 

Print Forms in Batches ............................................................ 22–8 
Set the Batch Printing Option .................................................. 22–9 
Print the Batch................................................................ 22–9 

Viewing Reports in Batches....................................................... 22–10 
Using Checklists................................................................. 22–11 

Displaying Checklists ........................................................ 22–12 
Using an Existing Checklist ................................................... 22–12 
Creating or Changing Checklists .............................................. 22–12 

Looking Up Information ......................................................... 22–13 
Looking Up a Transaction .................................................... 22–13 
Searching for Records or Transactions ......................................... 22–14 
Getting More Details from Reports ............................................ 22–16 
Tracking Shipments.......................................................... 22–18 
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Adding Records “on the Fly” ..................................................... 22–18 
Entering Transactions that Occur on a Regular Basis ................................ 22–19 
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Centralize Tasks in the Daily Business Manager 

 

The Daily Business Manager centralizes some of the most 
common daily tasks in a single handy location. Use it to:  

■ Process multiple transactions at once using the batch-
processing feature.  

■ Attach notes and reminders to the business calendar and 
print notes for a range of dates.  

■ View totals and graphs of current business performance 
measurements. 

■ See reminders in the to-do lists and take care of tasks that 
need attention, such as shipping orders and paying vendors 
on time.  

Displaying the Daily Business Manager Automatically 

When you first install Simply Accounting, the Daily Business 
Manager is set to display automatically when you start the 
program and when you change the session date. If you wish, 
you can turn off this option.  
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To turn the automatic display on or off: 

1. In the Home window on the Setup menu, choose User 
Preferences, then the View tab.  

2. Under Daily Business Manager, click At Startup or After 
Changing Session Date to add or remove the check mark 
that indicates when the Daily Business Manager will be 
displayed.  

3. Click OK. 

Batch Process and Print Transactions 

You can process payments due and recurring sales invoices in 
batches rather than one at a time. The program can also print the 
related invoices or cheques at the same time.  

Note that you can also print other forms in batches, after you 
have processed them. See “Print Forms in Batches” later in this 
chapter.  

To process transactions in batches:  

 
Daily Business 
Manager 

1. Open the Daily Business Manager: 

■ In the Home window on the Business Assistant menu or 
toolbar, choose Daily Business Manager. 

Or, 

■ In a transaction window, choose Daily Business 
Manager from the toolbar or View menu.  

2. Click the tab for the type of transaction you want to process: 
Recurring for sales invoices, or Payments Due for payment 
cheques.  



Chapter 22:  Increasing Efficiency 

User Guide    22−3 

 
  

SIM2006 ENGL UG Part 4 (22-23) PRINT.doc, printed on 9/27/2005, at 10:46:52 AM. Last 
saved on 9/27/2005 9:32:00 AM. 

ACCPAC International, Inc. Confidential 

In
crease 

E
fficien

cy 

 

Click in the Process 
column beside the 
transactions you want to 
process. 

Click in the Print column 
beside the transactions 
you want to print. 

 

3. If you selected any transactions for printing, choose Print 
Selected Transactions from the File menu. 

4. Click the Process button to process the selected transactions.  

Attach Notes to the Business Calendar 

Use the Business Calendar to create and store notes and 
reminders. To change the date of the notes displayed, left-click 
on the date you want. To change the transaction date, right-click 
on the date you want. This changes the to-do list display but 
does not change the session date once you close the window.  

 

The transaction date is 
highlighted in red. The 
date of the displayed 
note, which is also the 
date used to select the 
transactions displayed on 
the to-do lists at the 
bottom of the screen, is 
highlighted in blue. Dates 
that include notes and 
dates that appear in the 
to-do lists are bold.  

Click Print Notes to print 
notes, selected by date.  

Click Clear Notes to clear 
the notes displayed.  

 

Filtering Out Events 

If you have many notes or to-do list items and many of the dates 
are bold, you can filter out events you don’t want to highlight.  

1. Open the Daily Business Manager. 
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2. On the View menu, choose Options.  

3. Check the boxes for the items you want to include, or 
uncheck to exclude them.  

If you uncheck an item, 
note that its tab will 
disappear from the to-do 
list as well. You can restore 
it by checking the box. 

 

Clearing Notes 

You can clear notes you no longer need, in any of the following 
ways:  

■ Click the Clear Notes button in the Daily Business Manager 
to clear the notes currently displayed.  

■ In the Home window on the Maintenance menu, choose 
Clear Data, then Clear Notes, and select a date. The program 
will clear all notes on or before that date.  

■ In the Home window on the Maintenance menu, choose 
Clear Data, then Automatically Clear Data. Check the box 
beside Clear All Notes Over [     ] Months Old, then enter a 
number of months.  

Use To-Do Lists as Reminders of Tasks to Be Completed 

To-do lists help you remember to complete important tasks, such 
as paying bills or calling a customer. They also help you save 
time, as you can double-click an item on the list to automatically 
open the related window and complete the task. 

To-do lists help you to:  

■ Pay vendors before early-payment discounts expire. 
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■ Keep track of remittance due dates for tax and other payroll 
liabilities. 

■ Ship orders as they become due. 

■ Invoice customers when you fill an order. 

■ Process recurring transactions such as rent, insurance 
payments, and paycheques. 

■ Follow up on business relating to customers, vendors, or 
employees. 

What’s on the To-Do Lists? 

For the most part, Simply Accounting controls what appears on 
the list. For example, you make a purchase on February 1 and 
according to the payment terms that you entered, it’s due in 
60 days. Simply Accounting calculates the due date and adds a 
reminder to the to-do list.  

The only to-do item that works slightly differently is the Memo 
tab. The Memo tab contains notes that you have added to 
particular vendors, customers, or employees. You might remind 
yourself to call a customer to make sure they’ve received an 
important order or to pay an employee a bonus for making a 
special effort. See “Adding Memos to the To-Do Lists” later in 
this section, for more information. 

Displaying To-Do Lists 

 
To-Do Lists To-do lists appear automatically whenever you display the Daily 

Business Manager. If you prefer not to see them, you can hide 
them. 

To show or hide the to-do lists: 

1. In the Daily Business Manager, on the View menu or toolbar, 
click To-Do Lists. A check mark on the menu or an indented 
button indicates that the lists are displayed.  
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Using To-Do Lists 

1. In the Daily Business Manager, click the appropriate to-do-
list tab to find the reminder that you need. 

2. To display to-do lists for a different date, change the date in 
the business calendar at the top of the screen. 

Adding Memos to the To-Do List 

1. In the Home window, choose either the Vendors, 
Customers, or Employees icon. 

2. Open the record to which you want to attach a memo, and 
click the Memo tab. 

3. Type the information in the Memo area. 

4. In the To-Do Date field, type a date. If you leave this field 
blank, the memo will always appear.  

5. Check the Display This Memo In The Daily Business 
Manager box.  

 
Save 6. When you have finished, choose Save from the File menu. 

Using a Recurring Transaction in the To-Do List 

Simply Accounting allows you to store recurring transactions so 
that you can recall and process them when you need to. 

For more information about recurring transactions, see “Entering 
Transactions that Occur on a Regular Basis,” later in this chapter. 

1.  In the Daily Business Manager, click the Recurring tab. 

2. Double-click the recurring transaction. 

3. Make any changes needed, and click Process. 

Note:  To print a list of recurring transactions due on or before 
the date specified in the Daily Business Manager, click the Print 
List button on the Recurring tab. 
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Business Performance Measurements 

 

The Business Performance Measurements section of the Daily 
Business Manager displays financial information that helps you 
understand how your business is performing. For example, the 
Revenues (Past 7 Days) value tells you how much money has 
come into your business over the past seven days; the graph 
displayed shows you the amount for that week and compares it 
to values from the past 12 weeks or 8 months. 

Business Performance Measurements include Inventory 
Turnover, Gross Margin/Profit, Expenses, among others. 

By default, the Daily Business Manager displays your Cash 
Balance, your Current Ratio, and your Quick Ratio. You can 
select any combination of business performance measurements 
by selecting Options from the View menu and then selecting the 
Business Performance Measurements tab. For more information, 
see the section, Selecting Business Performance Measurements. 
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Selecting Business Performance Measurements 

To select the Business Performance Measurements to be 
shown in the Daily Business Manager: 

1. To open the Daily Business Manager, click Daily Business 
Manager on the Business Assistant menu or the toolbar in 
the Home window. 

2. In the Display field, select Business Performance. 

3. On the View menu, select Options. 

4. Click the Business Performance tab. 

To add a measurement to the list: 

■ Select one or more measurements from the Performance 
Not Shown In The Daily Business Manager box and click 
Select. Or, if you wish to include all measurements, click 
Select All. 

To remove a measurement from the list: 

■ Select one or more measurements from the Performance 
Shown In The Daily Business Manager box and click 
Remove. To start a new list, click Remove All and then 
select the measurements to add to the list. 

Note:  We recommend that you limit the number of business 
performance measurements to six or less. 

5. Click OK. 

Print Forms in Batches 
You can print most forms (such as invoices and cheques) in 
batches. Batch printing is easier and faster than printing one 
form at a time.  

You can still select the Print command in a transaction window 
to print an individual form. However, in most cases you may 
prefer to use the Print Batches command on the Reports menu to 
print several or many forms at once.  
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Note that batch printing is not the same as the batch processing 
and printing feature described under “Batch Process and Print 
Transactions” earlier in this chapter. That feature allows batch 
printing only from the Daily Business Manager, only for 
recurring sales invoices and recurring payments due, and only at 
the same time as you process the items.  

Set the Batch Printing Option 

When you first install Simply Accounting, the batch printing 
option is turned off.  

1. In the Home window on the Setup menu, choose System 
Settings, then Settings. Select Company, and click Forms. 

2. Check the Print In Batches box for each type of form you 
want to be able to print in batches. Checking the box to print 
cheques in batches will automatically choose direct deposit 
stubs as well. 

3. Click OK.  

Print the Batch  

Before you can print batches, you must process the transactions 
to be printed. You can then print batches from either the Home 
window or a transaction window.  

1. Process the transactions you want to print.  

2. Open the Print Batches window: 

■ In the Home window on the Reports menu, choose Print 
Batches, then the transaction type.  

Or, 

 
Print Batches ■ In a transaction window, choose Print Batches from the 

toolbar or File menu. 
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Select the options you 
want, then click Print. 

If you want to print another 
batch, select the options 
for the new batch, then 
click Display and check 
that these are the 
transactions you want. 

 

3. When you have selected the options you want, click Print to 
print the batch. You can then select different options to print 
other batches if needed. 

Viewing Reports in Batches 
Use the My Reports feature to view group reports for batch 
processing. My Reports allows you to group several reports, 
such as, daily, weekly, or monthly reports, to display them all at 
once. 

Grouping reports is a three-step process. First, you save 
customized reports as templates, then you create your report 
groups, and then you assign the templates to a report group. 

To set up report groups: 

1. In the Home window on the Reports menu, choose My 
Reports, or click the My Reports icon on the My Business tab 
in the Home window. 

2. Click Set Up Report Groups. 

3. Click on a new line to add one or more report group 
name(s). 
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4. Click OK. 

To assign templates to a report group: 

1. In the Home window on the Reports menu, choose My 
Reports, or click the My Reports icon on the My Business tab 
in the Home window. 

2. Click Set Up Report Groups. 

3. In the Report Lists tab, select your report group in the 
Groups field. Any new templates should automatically 
appear in the Reports That Do Not Belong To This Group 
column. 

4. Select the new template and click Select to add the template 
to the report group. 

5. Click OK. 

To batch-generate a report group: 

1. In the Home window on the Reports menu, choose My 
Reports, or click the My Reports icon on the My Business tab 
in the Home window. 

2. Select the report group you wish to generate and then click 
Select All to display all report groups. 

3. Click Display. 

4. When you have reviewed each report, you can click the print 
icon on the toolbar to print a copy. 

5. Click Close to close the My Reports window. 

Using Checklists 
Checklists help keep track of tasks that involve a number of 
steps, such as year-end procedures. You can use the program’s 
built-in checklists or you can add your own. 

Simply Accounting comes with these checklists, which you can 
change according to your needs: 
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■ Calendar Year-End Procedures 

■ Fiscal Year-End Procedures 

■ Month-End Procedures 

■ Day-End Procedures 

Displaying Checklists 

 
Checklists You can have checklists appear automatically whenever you start 

Simply Accounting or change the session date. You can also 
choose Checklists from the Business Assistant menu. 

If you prefer not to display the checklists automatically: 

1. In the Home window on the Setup menu, choose User 
Preferences and then View. 

2. In the Checklists section, click an item to add or remove the 
check mark.  

3. Click OK. 

Using an Existing Checklist 

1. To display a checklist, in the Home window, choose 
Checklists from the Business Assistant menu or toolbar. 

2. In the Checklists window, double-click the checklist you 
want to use. 

3. Click in the Done column beside each task as it is completed. 
A check mark appears, to indicate that you have finished the 
task. 

4. Once you have finished all of the tasks, you can click the 
Checklist Completed button to reset the list. 

Creating or Changing Checklists 

You may want to customize the checklists that come with Simply 
Accounting by adding new lists or changing existing ones. 
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1. To display a checklist, in the Home window, choose 
Checklists from the Business Assistant menu or toolbar. 

2. If you want to edit an existing checklist, double-click it. If 
you want to add a new one, click the Add button. 

3. In the Checklist field, type the name of the checklist, and 
then edit the checklist. To add a line, select an empty line 
and then type the task. To edit a line, double-click it. 

Select a task, and click 
these buttons to move it 
up or down the list. 

Select a task, and click 
these buttons to delete or 
add a blank line above it. 

 

4. Click Save. 

Looking Up Information 
When customers and vendors ask questions about their business 
with you, Simply Accounting provides a quick and efficient way 
of looking up the information. 

Looking Up a Transaction 

Sometimes a customer may ask a question about a particular 
invoice, and you want to see it for reference. Or perhaps you 
want to review a quotation you received from a vendor, or check 
an old deposit slip.  
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You can look up invoices, orders, quotes, payments, receipts, 
and deposit slips. 

 
Look Up 
Invoices, 
Payments, 
Receipts, or 
Deposit Slips 

To look up a specific invoice, payment, receipt, or deposit slip, 
click the Look Up button on the toolbar in the transaction 
window. 

 

Select a customer, or 
select <Search All 
Customers>. 

If you don’t know the 
name, invoice number, or 
transactions number, click 
Browse and select the 
item you want. Click OK 
to display the transaction. 

 

 To look up an order or a quote in a transaction window, use the 
List button in the Order or Quote Number field, and select a 
transaction from a list. Click Select. 

Searching for Records or Transactions 

In the Home window, Simply Accounting provides both basic 
and advanced search tools. 

The basic search helps you find records and transactions using a 
name or number. 

Simply Accounting 
Pro or higher 

If you are using Simply Accounting Pro or higher, an advanced 
search helps you find records or transactions containing specific 
field details or values. You can also use the Quick Search feature 
to create a report that lists all records and transactions that 
contain data matching the search request. 
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To perform a basic search: 

 
Search 1. In the Home window, click Search on the toolbar or Edit 

menu. 

2. In the Search window, select the type of record or transaction 
you want to find. 

3. Type the name or number of the record, account, or 
transaction you want to find. 

Note:  If you want to search for a record manually, check the 
Bypass Search Field box and scroll through the list of 
records. The Bypass Search field does not appear when 
searching for transactions. 

4. When the record is highlighted in the list below the Search 
field, click OK or double-click the record to view it. 

 

Simply Accounting 
Pro or higher 

To perform an advanced search: 

 
Search 1. In the Home window, click the Search on the toolbar or Edit 

menu. 

2. On the Advanced tab, choose the type of record or 
transaction you want to find. 

Note:  If you are working with a consolidated company, you 
can only look up account records and miscellaneous 
transactions. 



Part 4:  Time-Savers 

22−16    Simply Accounting 

 
  

SIM2006 ENGL UG Part 4 (22-23) PRINT.doc, printed on 9/27/2005, at 10:46:52 AM. Last 
saved on 9/27/2005 9:32:00 AM. 

ACCPAC International, Inc. Confidential 

 

Choose the matching 
criteria Simply Accounting 
should use when it 
searches (for example, 
Starts With). 

Enter the characters or 
amount to Search for. 

Use the And/Or buttons to 
make your search more 
specific. 

 

3. To customize the arrangement of your search results, 
click Customize. 

4. Click OK. 

Simply Accounting 
Pro or higher 

To perform a quick search: 

 1. In the Home window, on the toolbar next to the Search 
button, enter text in the Search field. 

2. Click the Quick Search button to list all records and 
transactions that contain matching text. 

Getting More Details from Reports 

You might be looking at a financial statement, such as an income 
statement, and want to know more specific details about one of 
the accounts. In the report window, you can double-click any 
item on the report to see these details. 

 Drilldown When you place the mouse pointer over an item on which you 
can see more details, the pointer changes to a magnifying glass. 
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Details for an 
account 

 

 
Redo Report You can change the report options (for example, to view details 

for another year, or to select a different sort option) without 
closing the window. Click the Redo Report button on the toolbar 
(or from the Options menu, click Redo Report) and choose new 
options. 

Double-click to 
open details on 
an account. 
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Tracking Shipments 

If you need to track a shipment and you have included the 
shipper’s name and tracking number on the invoice, you can 
trace the shipment automatically via the shipper’s Web site. 

You must set up shippers in Simply Accounting before you can 
track shipments. For more information, see “Set Up Shippers” in 
Chapter 3. 

To track a shipment: 

1. Open the window where you created the invoice for the 
merchandise you want to trace. 

 
Look Up 
Invoice 

2. From the Purchase or Sales menu or the toolbar, choose Look 
Up Invoice, and select the invoice. 

 
Track 
Shipments 

3. From the Purchase or Sales menu, choose Track Shipments. 

 
Web 4. Click the Web button to open the shipper’s Web site. 

5. Follow the instructions on the Web site to retrieve 
information about your shipment. 

Adding Records “on the Fly” 
If you are just starting to use Simply Accounting and want to get 
started quickly, you might not want to enter all of your 
information right away. 

For example, you might want to add customers only when they 
buy something, rather than entering your entire customer list at 
once. In the Sales, Orders, and Quotes window, you can type the 
new customer’s name. Simply Accounting recognizes that this 
customer doesn’t exist and asks you what you would like to do: 
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Read the instructions on the screen to see which option you want 
to select. 

You can add the following records on the fly: 

■ Accounts 
■ Vendors 
■ Customers 
■ Employees 
■ Inventory and service items 
■ Projects  

Entering Transactions that Occur on a Regular Basis 
Entering the same transaction every month, such as paying rent, 
can be cumbersome. Simply Accounting allows you to store 
recurring transactions so that you can recall and process them 
when you need to. 

You can use recurring transactions in the following windows: 

■ Purchases, Orders, and Quotes 
■ Sales, Orders, and Quotes 
■ Payments (when making miscellaneous payments) 
■ Paycheques 
■ Item Assembly 
■ Inventory Adjustments 
■ Miscellaneous Transactions 
■ Time Slips (Simply Accounting Pro or higher) 
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Storing a Recurring Transaction 

When you store a transaction, Simply Accounting does not 
update any accounts. It saves the details so that you can process 
them later. 

1. In the Home window, open the window in which you want 
to create the entry. 

2. Enter the transaction as you normally would, but do not 
process it. 

 
Store As 
Recurring 
Transaction 

3. Click Store As Recurring Transaction on the toolbar, and fill 
in the information about the transaction. 

4. Click OK. 

Using a Recurring Transaction 

1. In the Home window, open the window in which you stored 
the recurring transaction. 

 
Recall 
Recurring 
Transaction 

2. On the toolbar, click Recall Recurring Transaction. 

The due date is determined 
according to the last date on 
which you processed the 
transaction, and the 
frequency. 

 

You can choose to view recurring transactions by Due Date, 
Date Last Processed, Frequency, or Transaction Name. 

3. Select a transaction from the list and click Select. The next 
due date automatically appears in the Date field. 

4. Make any changes needed, and click Process. 
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Changing a Recurring Transaction 

 
Recall 
Recurring 
Transaction 

1. In the Home window, open the window in which you stored 
the recurring transaction, and then click Recall Recurring 
Transaction on the toolbar. 

2. Select the transaction you would like to change. To remove 
the recurring transaction, click Remove; otherwise, click 
Select. 

 
Store As 
Recurring 
Transaction 

3. If you are changing this transaction, make the necessary 
changes. Click Store As Recurring Transaction on the toolbar 
to save the changes. 

4. If necessary, change the frequency of the transaction, and 
click OK. 

Note:  If you change the name of the transaction, Simply 
Accounting adds a new recurring transaction under that 
name and does not replace the old one. 

Set Up Bills of Material for Inventory Items 
Simply Accounting  
Pro or higher 

In Simply Accounting Pro or higher, if you assemble items from 
components, you can set up a bill of materials, a list of the 
components and quantities needed to build an item. Later, you 
can quickly record the assembly of the item without having to 
enter each component individually. 
 
If you are creating a sales invoice for an assembled item that 
does not have sufficient stock on hand, Simply Accounting alerts 
you and asks if you want to build it.  

To set up a bill of materials:  

1. In the Inventory and Services window, add the item and fill 
in the Build tab.  
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List the components that 
are needed to build this 
item.  

Enter any additional costs, 
such as labour and 
overhead costs. 

 

Using a Pop-Up Calendar in Date Fields 

 
Date fields include a button that you can click to display a 
calendar and select a date. Use the mouse to select the month and 
day you want, or use the following keys: 

Arrow keys:  Moves the highlight to a different date.  

Enter:  Selects the highlighted date.  

Escape:  Closes the calendar. 

Page Up:  Displays the previous month. 

Page Down:  Displays the next month. 

Home:  Displays the first day of the month. 

End:  Displays the last day of the month.  

Click the month to select from a list of months. 

Click the year to select a year. 

Synchronizing Your Vendor and Customer Records 
with Microsoft® Outlook® 
Simply Accounting 
Pro or higher 

You can configure Simply Accounting and Microsoft Outlook to 
automatically maintain the same information in your vendor and 
customer records. 
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Synchronizing your vendor or customer contact list is a two-step 
process. First, prepare the vendor or customer records you 
would like to add to Outlook. Then, in Outlook, synchronize 
your records. Any time you add, change, or delete records in 
Simply Accounting, you can click the Synchronize button in 
Outlook to update its records. 

Set Up Your Vendor and Customer Records 

1. In the vendor or customer list, open the first record you 
want to add to Microsoft Outlook. 

2. On the Options tab, select the Synchronize With Microsoft 
Outlook box. 

3. Click the Next arrow to open the next record. Repeat for all 
vendors or customers you want to include in your Outlook 
synchronization. 

Synchronize Your Records for the First Time 

1. Close Simply Accounting. 

2. Open Microsoft Outlook. 

3. On the Simply toolbar, select the database you have 
prepared for synchronization. 

Note:  When you installed Simply Accounting, a new 
Synchronization toolbar was added to Outlook. If this 
toolbar is not visible when you open Outlook, right-click the 
main toolbar and choose Simply. 

4. Click the Sync button. When Outlook has finished updating, 
you can re-open Simply Accounting. 

Add Simply Accounting Vendor or Customer Records in Outlook 

After you have synchronized your records at least once, you can 
create new vendor or customer records from within Outlook. 

1. In the Contacts window in Outlook, enter the customer or 
vendor details and then click Categories. 
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2. In the list of categories, select the box for the Simply Vendor 
or Customer and company combination you want to use, 
and then click OK. 

3. Click Save and Close. 

4. Click the Synchronize button. 
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Chapter 23 
Reducing Clutter 
 

Once you’ve been using Simply Accounting for a while, you may want to 
streamline it to hide or remove things that you don’t use. 

 

Keeping Inactive Parts of Your Business out of the Way .............................. 23–1 
Customizing Windows To Show What You Need.................................... 23–1 

Customizing Sales Invoices .................................................... 23–2 
Hiding Unused Parts of Simply Accounting......................................... 23–3 

Automatic Advice ............................................................ 23–3 
Sections of the Home Window ................................................. 23–3 
Account Numbers on Reports.................................................. 23–4 
Comments Column in Miscellaneous Transactions ............................... 23–5 
Hide Specific Window Features ................................................ 23–5 
Icon Windows ................................................................ 23–6 

Clearing Old Information from Simply Accounting .................................. 23–7 
Clearing Data Automatically.................................................. 23–10 
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Keeping Inactive Parts of Your Business out of the 
Way 

An employee decides to quit, but you need to keep their records 
on file. Or perhaps you stop selling a particular item, but still 
need to track how much of it you have sold for the year. You can 
set the record’s status to Inactive. This way, the record won’t 
appear on lists or reports, yet any transactions remain. 

Note:  You can set inactive records to appear on reports when 
you open the report. 

In the bottom left corner of any account, customer, vendor, 
inventory item, employee, or project record, you can check the 
Inactive box. 

 

Check this box to set this 
employee’s status to 
inactive. 

 

Customizing Windows To Show What You Need 
Hiding fields that you never use leaves more room for the ones 
that you need. For example, if you do not plan to keep track of 
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projects for your company, you can remove the Allocation 
column from the Sales and Purchases screens. 

1. Depending on which window you have open in Simply 
Accounting, do one of the following: 

■ In the Home window from the View menu, choose 
Customize Transaction Windows. Click the tab for the 
window you want to change. 

 
Customize 
Transaction 
Window 

■ In a transaction window (such as the Sales, Orders, and 
Quotes window), choose Customize Transaction 
Window from the View menu. 

2. Check the boxes for the fields you want to hide. 

3. Click OK. 

Customizing Sales Invoices 

Simply Accounting 
Pro or higher 

For sales invoices, you can choose a different invoice style to suit 
your business, and can change the style if you want to. 

`

Choose a style from the 
list. 
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To customize the settings for each invoice style: 

1. In the Home window on the View menu, click Customize 
Transaction Window. 

2. On the Customer Invoices tab, select the style you want to 
change. 

3. Check the boxes and read the instructions on the screen. 
Note that these settings are for display only; to change your 
printed invoices, click Form Options. 

4. Click OK. 

Hiding Unused Parts of Simply Accounting 
You can hide various parts of Simply Accounting that you don’t 
plan to use. 

Automatic Advice 

Simply Accounting offers advice automatically as you conduct 
your daily business. For example, if you are about to make a sale 
to a customer whose credit is overextended, the program will 
ask whether you are sure you want to sell more to this customer.  

To turn advice on or off: 

1. In the Home window on the Setup menu, choose User 
Preferences, and then the View tab. 

2. Check or uncheck the Automatic Advice button. 

3. Click OK. 

Sections of the Home Window 

The Simply Accounting Home window is divided into groups of 
icons called modules. You can hide individual modules that you 
do not use. For example, you may not want to use the Project or 
Time and Billing features. 



Part 4:  Time-Savers 

23-4    Simply Accounting 

 
  

SIM2006 ENGL UG Part 4 (22-23) PRINT.doc, printed on 9/27/2005, at 10:46:52 AM. Last 
saved on 9/27/2005 9:32:00 AM. 

ACCPAC International, Inc. Confidential 

 

Simply Accounting still records information that affects the 
hidden sections, and you can bring them back into view at any 
time. 

To hide a module: 

1. In the Home window from the Setup menu, choose User 
Preferences, and then the View tab. Uncheck the modules 
you do not want to display. 

2. Click OK. 

To display a hidden module: 

1. In the Home window from the Setup menu, choose User 
Preferences, and then the View tab. Check the modules you 
want to display. 

2. Click OK. 

Account Numbers on Reports 

Account numbers appear in transaction detail lists and reports. If 
you don’t need to show the account numbers, you can display 
only the account names. 
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1. In the Home window from the Setup menu, choose System 
Settings, and then Settings. 

2. Click General (Accounts) and then Numbering.  

3. To display or hide account numbers, check or uncheck the 
boxes. 

4. Click OK. 

If two or more accounts use the same name, these commands are 
dimmed because the account number is the only way to 
distinguish the accounts. 

Comments Column in Miscellaneous Transactions  

A column for comments appears in the Miscellaneous 
Transactions window. If you wish to hide the Comments 
column: 

1. In the Miscellaneous Transactions window, on the View 
menu, choose Customize Transaction Window.  

2. On the Miscellaneous Transactions tab, in the Do Not Show 
section, check the Comment box. 

3. Click OK. 

Hide Specific Window Features 

If you do not use specific features within a module, you can turn 
them off so they do not appear in transaction windows or lists. 
You can easily turn any of these options back on again. 

To show or hide features in a transaction window: 

1. In the Home window on the Setup menu, choose System 
Settings, and then Settings.  

2. Click Features. 
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If you clear the options My 
Company Uses Orders and 
My Company Uses Quotes, 
associated toolbar buttons 
and fields are hidden in 
related transaction 
windows. 

Leave this checked if 
your company uses 
projects. 

 

3. Click OK. 

Icon Windows 

The icon window is a list of records that displays a small icon 
with each name. It helps you find records quickly and easily 

 

You can display icon windows for accounts, vendors, customers, 
employees, inventory and services, and projects. 
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You may prefer to skip the icon window and open the first 
record instead. You can then find other records using the 
navigation tools built into the record window: 

You can select any 
record from this list. 

Use these buttons to 
browse through the 
records one by one. 

 

To show or hide an icon window: 

1. In the Home window on the Setup menu, choose User 
Preferences, and then click the View tab.  

2. Uncheck the icon windows you do not wish to display. 

3. Click OK. 

Clearing Old Information from Simply Accounting 
Every time you enter a transaction, Simply Accounting records 
its details. This information is essential for creating accurate 
reports. 

Paycheque details are automatically cleared after one year. 
However, most other data is stored until you specifically clear it 
out.  
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Simply Accounting 
Pro or higher 

If you are using Simply Accounting Pro or higher, you can keep 
monthly account balances and include them on  multi-period 
reports for up to 100 years. This lets you: 

■ Create historical reports for any date or period. 

■ Compare your current year’s transactions to those of 
previous years, to have a better idea of how your business is 
doing. 

■ Print historical financial statements easily, without having to 
restore a backup file.  

The program adds to your financial history when you start a 
new fiscal year.  

Saving disk space The more transactions you store, the more hard-disk space they 
take up and the longer some actions take to complete. For this 
reason, you should clear details that are no longer needed. 

The best time to clear transaction data is at the beginning of the 
fiscal year. As long as you back up your data, you can always 
restore old company details so that you can look them up. For 
more information on backing up and restoring company data, 
see “Backing up Your Company’s Information” in Chapter 19. 

You can also save disk space and enhance performance by 
compacting the database. For more information, see “Enhancing 
Database Performance” in Chapter 20. 

 

Note:  You cannot look up or automatically adjust transactions 
that you have cleared. 

To clear transactions: 

1. In the Home window on the Maintenance menu, you can 
choose Clear Data and then any of the following commands: 

Clear: What this clears More information 

Paid Transactions Invoices from customers or 
vendors that have been fully paid. 
This includes payments made in 
the Payments window with the 
Make Other Payments option. 

You can clear paid 
invoices automatically for 
each vendor or customer. 
See “Adding Vendors” in 
Chapter 12 and “Adding 
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Customers” in 
Chapter 13.  

Tax Report Details of all or selected sales 
taxes. 

We recommend that you 
keep tax data for at least 
12 months. 

Account 
Reconciliation 

Details of account reconciliations. We recommend that you 
keep account 
reconciliation information 
for at least 6 months. 

Imported Online 
Statements (under 
Account 
Reconciliation) 

Account information downloaded 
from your bank. 

We recommend that you 
keep account 
reconciliation information 
for at least 6 months. 

Inventory Tracking 
Data 

Information on inventory 
turnover. The program also clears 
the details of associated invoices. 

We recommend you keep 
inventory tracking data 
for at least 24 months. 

 Lookup Data Results of searches using Lookup. We recommend that you 
keep lookup data for at 
least 24 months. 

Lookup Data for 
Other Payments 
(under Lookup 
Data) 

The line-by-line details of 
payments made using the Make 
Other Payments option. 

We recommend that you 
keep lookup data for 
other payments for at 
least 24 months. 

Lookup Data for 
Remittances (under 
Lookup Data) 

The line-by-line details of 
payments made to payroll 
authorities using the Pay 
Remittance option. 

We recommend that you 
keep lookup data for 
remittance payments for 
at least 24 months. 

Lookup Data for 
Time Slips (under 
Lookup Data) 

The line-by-line details of time 
slips.  

We recommend that you 
keep time slips details for 
at least 12 months. 

Notes The notes entered in the Daily 
Business Manager. 

We recommend that you 
keep notes for at least 
6 months.  

Paycheque Details The income, tax, and deduction 
totals for all employees. 

We recommend that you 
allow Simply Accounting 
to clear employee data 
automatically after 
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2 years. 

Financial History In Simply Accounting Pro or 
higher, these are the monthly 
account balances up to 100 years. 

Simply Accounting Pro 
(or higher) adds to your 
financial history every 
time you start a new fiscal 
year.  

Direct Deposit 
Data 

The details related to the direct 
deposits made for employees. 

We recommend that you 
allow Simply Accounting 
to clear direct deposit 
data automatically after 
2 years. 

Clearing Data Automatically 

If you always clear data after a certain time, you can set Simply 
Accounting to do so automatically. 

1. In the Home window on the Maintenance menu, choose 
Clear Data and then Automatically Clear Data. 

2. Check the boxes and type the number of months to indicate 
the data you want to clear automatically. 

3. To clear direct deposit data, check the box and type the 
number of months. 

4. Click OK. 
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Part 5 

Simply Accounting doesn’t just efficiently store all your company’s 
transactions. It can also help you run your business more effectively 
and more profitably. 

 

Chapter 24 — Maintaining a Healthy Business 

Chapter 25 — Developing Customer and Vendor Relations  

Chapter 26 — Tracking Your Inventory  

Chapter 27 — Using Graphs 

Chapter 28 — Working Away from the Office 

 
 

D
eveloping Your Business 
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Chapter 24 
Maintaining a Healthy Business 
 

One of the most important questions that Simply Accounting can answer is 
whether you are making money. It can also help you to increase your profitability 
and ensure that your bank accounts never dip below zero. 

 

Exploring Your Financial Position.................................................. 24–1 
Income Statement............................................................. 24–1 

Revenue ................................................................. 24–2 
Expenses ................................................................. 24–2 
Net Income............................................................... 24–3 

Balance Sheet................................................................. 24–3 
Assets.................................................................... 24–4 
Liabilities ................................................................ 24–5 
Equity ................................................................... 24–6 

Graphing Revenues and Expenses.............................................. 24–7 
Understanding Your Cash Flow.................................................... 24–8 

Cash-Flow Projection.......................................................... 24–8 
Statement of Cash Flows...................................................... 24–10 

Operating Activities...................................................... 24–11 
Investing Activities....................................................... 24–12 
Financing Activities ...................................................... 24–12 
Cash and Cash Equivalents ............................................... 24–12 

Consolidating Multiple Companies................................................ 24–13 
Create a Consolidated Company .............................................. 24–13 

Before You Start ......................................................... 24–14 
Working with a Consolidated Company ....................................... 24–18 

Modify Company Accounts ............................................... 24–18 
Update Consolidated Companies .......................................... 24–19 
Print Consolidated Company Reports...................................... 24–19 
Enter Miscellaneous Transactions.......................................... 24–20 
Other Activities .......................................................... 24–20 
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Exploring Your Financial Position 
Understanding whether your company is making money is 
probably your first priority. Two basic financial statements 
immediately describe your company’s financial position — the 
income statement and the balance sheet. 

Income Statement 

An income statement allows you to see the amount you have 
earned (revenues), the amount you have spent (expenses), and 
most important, your total profit or loss. Using Simply 
Accounting’s different income statement report options allows 
you to compare this year’s statement with your budget to see if 
you’re meeting your goals. You can also compare this year’s 
income with last year’s. 

The income statement comparing actual figures to your budget 
is discussed briefly in “Getting the Facts” in Chapter 20. Let’s 
examine a comparative income statement. 

To print an income statement: 

1. In the Home window from the Reports menu, choose 
Financials, and then Income Statement. 

The sample income statement in this chapter was created 
using these options:  
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Revenue 

The first section of your income statement shows revenues: 

A revenue account with 
a negative value is 
actually an expense. 
Accountants sometimes 
group a closely related 
expense in with revenues 
as a “contra account”. 
Notice that this expense 
increased, hence 
decreasing the revenue. 

Actual 
Jul 01, 2015 to 
Jun 30, 2016 

Actual 
Jul 01, 2014 to 
Jun 30, 2015 

 

You may wish to examine those accounts that have increased 
and decreased the most from the last period. With this 
information, you can determine where your growth is 
greatest — and smallest — and adjust your sales strategies 
accordingly.  

 Drilldown For an even closer look at your records, you may wish to double-
click some of the amounts so that you can get a transaction-by-
transaction breakdown of each revenue account. For more 
information on drilling down, see “Getting More Details from 
Reports” in Chapter 22.  

Expenses 

Expenses appear next on the income statement: 
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EXPENSE

DIRECT COSTS
Material: Drywall 47,797.86 57,181.17 -16.41
Material: Hardware 90,729.94 105,966.83 -14.38
Material: Lumber 717,557.96 436,882.49 64.25
Material: Roofing 455,140.07 246,127.08 84.92
Materials: Net 1,311,225.83 846,157.57 54.96
Purchase Discounts -11,537.10 -16,900.51 -31.74
Equipment Rentals 106,050.00 183,431.00 -42.19
Wages 86,195.20 187,696.40 -54.08
EI Expense 3,161.33 3,517.76 -10.13
CPP Expense 2,580.35 3,635.55 -29.02
WCB Expense 2,048.31 315.79 548.63
QPP Expense 0.00 0.00 0.00
QHSF Expense 153.36 204.48 -25.00
Burden: Net 94,138.55 195,369.98 -51.82
Subcontractors 56,400.00 239,800.00 -76.48
Union 0.00 0.00 0.00
Freight Expense 23,335.00 22,335.00 4.48
Transfer Costs -0.30 0.00 0.00
Adjustment Write-off 107.50 206.86 -48.03

TOTAL DIRECT COSTS 1,579,719.48 1,470,399.90 7.43

GENERAL AND ADMINISTRATION
Accounting And Legal Fees 0.00 5,000.00 -100.00
Advertising And Promotion 112,957.62 113,350.00 -0.35
Bad Debts 0.00 0.00 0.00
Bank Charges 14,850.00 2,850.00 421.05
Bank Rec. Adjustments 0.00 0.00 0.00
Amortization 16,800.00 36,300.00 -53.72
Insurance 24,000.00 30,000.00 -20.00
Office Rent 16,000.00 22,000.00 -27.27
Telephone 8,000.00 9,000.00 -11.11
Utilities 8,000.00 2,000.00 300.00
AMEX Charges 6,089.23 0.00 0.00
MasterCard Charges 2,942.21 0.00 0.00
VISA Charges 2,248.86 0.00 0.00
Credit Card Charges: Net 11,280.30 0.00 0.00
Currency Exchange & Rounding 0.00 0.00 0.00

TOTAL GENERAL & ADMIN 211,887.92 220,500.00 -3.91

TOTAL EXPENSE 1,791,607.40 1,690,899.90 5.96  

Compare administrative 
expenses to those 
directly incurred in 
making the inventory 
item or service. 

 

Examine where your expenses have increased and decreased the 
most over the period just as you did with your revenues. 

Net Income 

Net income is the figure that should concern you the most. This 
figure tells you how profitable the company is. In the example 
below, the company was almost 75 percent less profitable than 
last year. 

 

If your net income is up or down significantly, you may wish to 
look back on your revenues and expenses. Has your net income 
changed because you are selling more or because it costs more to 
sell those items? You need to answer these kinds of questions 
before you can decide what changes you need to make to your 
business. 

Balance Sheet 

The balance sheet shows what your company owns (assets), 
what it owes (liabilities), and the net worth of your company 
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(equity). The balance sheet can be summarized in the following 
formula: 

Assets = Liabilities + Equity 

This formula is commonly re-arranged to look like the following: 

Equity = Assets - Liabilities 

Unlike the income statement, which looks at profitability, the 
balance sheet gives you a snapshot of your company’s resources 
on a particular day. 

You can compare balance sheets from the previous and current 
year, just as you can with income statements. 

To print a balance sheet: 

1. In the Home window on the Reports menu, choose 
Financials, and then Balance Sheet. 

The sample balance sheet was created using these options: 

 

Assets 

Looking at your assets — the things you own — can help you to 
determine how liquid your company is. Do you have too much 
or too little inventory on hand? How about cash? Are most of 
your assets located in long-term items, like vehicles or buildings, 
meaning that you can’t readily convert your assets into cash? 
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You might want to pay special attention to your receivable 
accounts, which indicate how much money you are owed. 

 

Accounts on the 
balance sheet are 
usually listed from most 
liquid to least. The 
greater the subtotals at 
the top of the balance 
sheet, the more easily 
you can get at your 
cash, if you need it. 

As at Jul 01, 2015                                 As at Aug 01, 2015                                    Percent

 

Liabilities 

Liabilities — the money that you owe to others — are usually 
categorized as short-term and long-term. How much do you owe 
to your creditors? How much of it will you need to pay in a short 
time? 

Other reports will help you further evaluate these figures, 
including cash-flow reports and vendor aged reports. Cash flow 
is discussed later in this chapter, in “Understanding Your Cash 
Flow.” For more information on vendor aged reports, refer to 
“Finding Out When Payments Will Come Due” in Chapter 25. 
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LIABILITIES

CURRENT LIABILITIES
Accounts Payable 110,328.39 585,244.75 -81.15
Amex Payable 15,115.64 0.00 0.00
MasterCard Payable 3,364.06 0.00 0.00
VISA Payable 18,951.57 0.00 0.00
Credit Card Payable: Net 37,431.27 0.00 0.00
Vacation Payable 6,363.04 9,797.84 -35.06
EI Payable 12,169.45 6,750.03 80.29
CPP Payable 12,487.40 7,326.70 70.44
Income Tax Payable 89,805.56 67,097.13 33.84
Receiver General Payable 114,462.41 81,173.86 41.01
WCB Payable 2,364.10 315.79 648.63
QPP Payable 212.48 212.48 0.00
Quebec Tax Payable 3,019.71 2,360.80 27.91
QHSF Payable 664.56 511.20 30.00
Quebec Minister of Finance 3,896.75 3,084.48 26.33
RRSP Payable 4,187.58 1,506.56 177.96
Union Payable -832.40 -1,225.16 -32.06
Medical Payable 26.80 -126.00 -121.27
Misc A 0.00 0.00 0.00
Misc B 0.00 0.00 0.00
PST Payable 19,711.25 70,357.97 -71.98
GST Paid On Purchases -264,349.42 -153,354.32 72.38
GST Charged On Sales 206,275.52 113,684.52 81.45
GST Payroll Deductions 0.00 0.00 0.00
GST Adjustments 0.00 0.00 0.00
ITC Adjustments 0.00 0.00 0.00
Net GST Owing/Refund -58,073.90 -39,669.80 46.39
Import Duty Clearing 0.00 0.00 0.00

TOTAL CURRENT LIABILITIES 239,865.29 710,460.29 -66.24

LONG TERM LIABILITIES  
Bank Loan 46,000.00 46,000.00 0.00
Mortgage Payable 100,000.00 100,000.00 0.00
Shareholders' Loan 17,300.00 17,300.00 0.00

TOTAL LONG TERM LIABILITIES 163,300.00 163,300.00 0.00

TOTAL LIABILITIES 403,165.29 873,760.29 -53.86  

Compare liabilities that 
are due relatively soon 
(short-term) and those 
that are long-term 
debts to be paid over 
several years. 

 

You should also compare short-term (current) assets to short-
term liabilities and long-term assets (like capital assets) to long-
term liabilities. If, for example, you hold a lot of short-term debts 
relative to short-term assets, you may be unable to fulfill your 
financial obligations. 

Equity 

The equity section represents the net worth of the company. 
Often, for small-business owners, the equity section includes 
both the owner’s investment and the accumulated net worth of 
the company. For larger companies, this section can also include 
other amounts, such as those received from stock offerings. 

Examining the equity in your company gives you an idea of 
what the company is worth. Creditors are also interested in what 
proportion of your assets is furnished by liabilities and what 
proportion by equity. 
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EQUITY

PAID IN CAPITAL
Class A Common 50,000.00 50,000.00 0.00
Class B Common 30,000.00 30,000.00 0.00

TOTAL PAID IN CAPITAL 80,000.00 80,000.00 0.00

RETAINED EARNINGS
Retained Earnings - Previous Year 1,344,506.70 517,926.95 159.59
Current Earnings 463,843.73 826,579.75 -43.88

TOTAL RETAINED EARNINGS 1,808,350.43 1,344,506.70 34.50

TOTAL EQUITY 1,888,350.43 1,424,506.70 32.56  

Graphing Revenues and Expenses 

You might want to use one of the following graphs to represent 
some aspects of financial statements. 

You can find all of these graphs on the Graphs menu in the 
Home window. 

Revenues by Account.  This pie chart shows each revenue 
account that you select as a percentage of your total revenue.  

This graph can tell you which revenue accounts are contributing 
the most to your profitability. 

Expenses by Account.  This pie chart shows each selected 
expense account as a percentage of your total expenses. 

This graph can tell you which expense accounts are highest in 
relation to the others. 

Expenses and Net Profit as a Percentage of Revenue.  This 
pie chart divides your total revenue into expenses and net profit. 
Each account you select will have its own slice. All expense 
accounts that you do not select are grouped into the category 
Other Expenses. 
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This graph is a useful visual clue as to your profitability. The 
larger the Net Profit slice of the pie, the better. 

Understanding Your Cash Flow 
If you don’t have enough money in the bank on the day that a 
bill becomes due, you may be in trouble. Making sales and 
receiving payment for those sales often happen at different 
times, and it’s easy to be caught short of cash. This regular 
movement of cash in and out of your business is known as cash 
flow. 

Simply Accounting can help you to manage and analyze your 
cash flow. You can examine where your revenues and expenses 
are coming from, and you can even project future cash flow. 

Cash-Flow Projection 

A cash-flow projection can be extremely useful for managing 
your business and ensuring that you have enough money to 
cover future bills. This report summarizes the bills that will be 
coming due in the future as well as money you should be 
receiving from customers and other sources. 
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To print a cash-flow projection: 

1. In the Home window on the Reports menu, choose 
Financials, and then Cash Flow Projection. 

The example cash-flow projection was created using these 
options: 

 

 

03/15/2015 

If projecting for a bank 
account, make sure 
that the lowest balance 
is not below zero. 

03/15/2015 TO 04/14/2015 
03/15/2015 TO 04/14/2015 

 

Pay particular attention to the lowest balance in the account over 
the period that you select. If this number is a negative number, 
you could potentially overdraw your account. You can print a 
detailed report to see when you are forecast to go below zero. 
You might then want to delay payment of some of your bills. 

You might also want to ensure that your customers are paying 
their bills on time to help improve your cash flow. For more 



Part 5:  Developing Your Business 

24−10    Simply Accounting 

 
  

SIM2006 ENGL UG Part 5 (24-27) PRINT.doc, printed on 1/16/2006, at 11:51:12 AM. Last 
saved on 1/16/2006 11:50:00 AM. 

ACCPAC International, Inc. Confidential 

information about reports on overdue payments, refer to 
“Dealing with Overdue Sales Invoices” in Chapter 25. 

Note:  The further in the future you analyze, the less accurate 
the cash-flow projection. 

Statement of Cash Flows 

The Statement of Cash Flows describes where your money came 
from and where it went over a certain period in the past. This 
report helps you to examine your ability to generate cash and 
how you use it. It also breaks down your cash flow into three 
categories for easier analysis: 

■ Operating. 

■ Investing. 

■ Financing. 

In essence, this report shows the changes to various accounts 
over a period that you select. You could get similar information 
by comparing two balance sheets, one from the day before the 
beginning of the period and one for the end. 

A Statement of Cash Flow can be created only within a fiscal 
year (either this year or last). 

Note:  Make sure that all of your accounts have been assigned a 
proper account class before creating this report. For more 
information on account classes, see “Assign Account Classes” in 
Chapter 2.  

To print a statement of cash flows: 

1. In the Home window on the Reports menu, choose 
Financials, and then Statement of Cash Flows. 
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2. Select options for the report and click OK. 

Operating Activities 

Operating activities are the principal revenue-producing 
activities of your business. Cash flow from these activities 
consists of cash transactions that contribute to net income, such 
as the sale or purchase of goods and services. 

Looking at this section of the report can help you to determine 
the business’s ability to generate cash from day-to-day 
operations. This cash is used to maintain your business, repay 
loans, make new investments, and pay owners. 

 

The first figure shows the 
amount of money your 
company has made or 
lost over the period. 

Depreciation of items 
such as equipment is 
added to net income in 
this section of the report 
to reflect cash provided 
by operations.  
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Investing Activities 

Any time you acquire or dispose of long-term assets, like a 
vehicle or equipment, cash flows from investing activities are 
affected. 

Cash Flows from (used in) Investing Activities
Decrease in Fixed Asset

Equipment 2,140.00
(Increase) in Fixed Asset

Equipment -2,140.00
Increase in Accum. Amort. & Depreciation

Accum Amort: Buildings 8,000.00
Accum Amort: Equipment 8,000.00
Accum Amort: Vehicles 800.00

(Amortization and Depreciation already recognized) -16,800.00
Net Cash provided by (used in) Investing Activities 0.00  

Depreciation already 
appears in the Operating 
Activities section. These 
amounts outline changes 
in accumulated 
amortization and 
depreciation accounts.  

 

Financing Activities 

Cash flows from financing activities consist of transactions that 
affect the company’s debts and capital, such as receiving or 
paying a long-term loan, shares, or owner investments or 
withdrawals. You should compare the amount of cash created 
by financing to that created by operations.  

Cash Flows from (used in) Financing Activities
Increase in Credit Card Payable

Amex Payable 131,554.72
MasterCard Payable 222,934.16
VISA Payable 298,236.56

(Decrease) in Credit Card Payable
Amex Payable -116,439.08
MasterCard Payable -219,570.10
VISA Payable -279,284.99

Net Cash provided by (used in) Financing Activities 37,431.27  

Credit-card purchases 
are categorized as 
financing because you 
are borrowing money 
from the credit-card 
company.  

Cash and Cash Equivalents 

Cash equivalents are short-term (3 months or less), easy-to-sell, 
low-risk investments held to meet short-term cash commitments 
rather than for investing or other purposes. For this report, 
Simply Accounting considers payments received by credit card 
as cash. 

This section shows your total increase or decrease in cash over 
the period. 

Increase (Decrease) in Cash and Cash Equivalents 126,747.79

Cash and Cash Equivalents at Beginning of Period 152,678.45

Cash and Cash Equivalents at End of Period 279,426.24
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   Consolidating Multiple Companies 
Simply Accounting 
Premium or higher 

If you use Simply Accounting Premium or higher, and manage 
the accounts for several companies (subsidiary companies) 
owned by a single head office (parent company), you can 
consolidate your companies to generate an overall view of 
company operations and finances. 
 
When a company owns or is owned by another, generally 
accepted accounting principles (GAAP) require that their 
financial records be merged or “consolidated” into a single 
statement for reporting purposes, usually at the end of each 
fiscal year. Simply Accounting Premium or higher lets you 
consolidate a number of companies (up to 2 GB of data) into a 
single consolidated parent company. You can consolidate data 
from companies created in any edition of Simply Accounting 
(Basic, Pro, Premium, or Accountants’), but the data must be 
from the same Simply Accounting version (year). For example, 
you can consolidate data created in Simply Accounting 2006 
Basic with data from Simply Accounting 2006 Pro. 

When should I 
consolidate? 

To ensure that you generate the most accurate consolidated 
reports, you should consolidate your companies at year-end. If  
you require reports on a monthly or quarterly basis, talk to your 
financial advisor about consolidating more frequently. 

Consolidated 
company reports 

Comparative subsidiary reports (Balance Sheet, Income 
Statement, Trial Balance) and the Transactions By Account report 
provide financial details about the parent company and about 
each subsidiary company in relation to the consolidated parent 
company. The Transaction Details report provides financial 
details on all company transactions, or transactions for the parent 
company, a subsidiary company, or the consolidated parent. 
 
Note:  Because the consolidated company does not recognize 
departments in subsidiary companies, there is no Department 
option on reports. 

Create a Consolidated Company 

The Consolidation wizard walks you through the process of 
creating a consolidated company in a few simple steps. When 
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you run the wizard, it creates a chart of accounts for the 
consolidated parent based on the parent company’s chart of 
accounts. The Consolidation wizard helps you map subsidiary 
company accounts to the consolidated parent’s chart of accounts. 

Before You Start 

Before you can consolidate, be sure to complete the following 
checklist: 

 Identify the parent company. 

 Identify one or more subsidiary companies. 

 Ensure that each company has a unique company name and 
file name, uses the same accounting method, and is running 
in the same fiscal year. 

 Ensure that the parent company is in single-user mode, and 
the subsidiary companies are closed.  

 Review the charts of accounts to identify discrepancies in 
accounts between the parent and each subsidiary company. 

Each subsidiary company’s accounts should be mapped to 
the parent company’s accounts. If any account numbers 
differ, the consolidation process automatically maps 
accounts according to these conditions: 

■ If the subsidiary company has fewer digits in its asset 
account numbers than the consolidated parent, Simply 
Accounting adds additional zeroes to the end of each 
subsidiary company’s asset accounts.  

For example, if the parent asset account is 168000, then 
the subsidiary asset account 1680 becomes 168000. 

■ If the subsidiary company has more digits in its asset 
account numbers than the consolidated parent, Simply 
Accounting truncates each subsidiary asset account 
number to match the length of the consolidated parent 
company’s asset account.  

For example, if the parent asset account is 1680, then the 
subsidiary asset account 1680911 becomes 1680. 
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■ If a subsidiary company account cannot be matched, you 
must map account numbers manually (you can do this 
quickly and easily while running the Consolidation 
wizard).  

Note:  During account mapping, Simply Accounting does 
not recognize departments. 

When you are ready to consolidate, complete the following 
steps. 

To consolidate your company: 

1. Open a subsidiary or parent company in Simply Accounting 
Premium or higher. If you use security, enter the password 
for the sysadmin user. 

Note:  Users and their passwords used by the parent 
company are copied to the consolidated parent company 
(users and passwords from subsidiary companies are not 
copied to the consolidated parent company). 

2. In the Home window on the File menu, select Consolidate 
Company. 

3. Click Next to start the wizard. Identify whether the current 
company is the parent company or a subsidiary company. 

 

Specify whether the 
current company is the 
parent or a subsidiary 
company. 
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4. Enter a consolidated company filename. The wizard will 
create a new data file (.CDB) for the consolidated company.  

 

Enter a file name for 
the consolidated 
parent company. 

You can store the 
consolidated parent 
data file in the same 
location as your 
subsidiary company 
data.  

 

5. Click Add to identify one or more subsidiary companies, 
then click Next to continue. 

On the Related Accounts page, the Consolidation wizard 
automatically maps account numbers from the parent 
company to each subsidiary company (according to the 
conditions described at the beginning of this section). If no 
checkmark appears beside a company name in the Related 
Accounts column, one or more accounts need to be mapped. 

6. Select the company and then click Relate to manually map 
accounts. 

Note:  To ensure accurate financial reporting, you should 
map all subsidiary accounts to a consolidated parent 
account: However, the Consolidation wizard lets you 
consolidate a company even if some accounts are not 
mapped. You will be reminded to map outstanding accounts 
when you try to create a report. 

 7. Choose to show all unmatched accounts. Beside each 
unmatched subsidiary account, click the List button in the 
Consolidated Parent Accounts column to identify a 
matching parent account.  
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8. When all accounts are matched, click OK.  

9. Repeat steps 6 through 8 for each subsidiary company that 
requires account matching. 

10. Click Next and then finish the wizard. The Consolidation 
wizard retrieves opening balances and transactions for the 
current fiscal year from the subsidiary companies into the 
consolidated parent. It also identifies opening balances and 
adds them to the consolidated parent. 

All transactions for the current year are retrieved, up to the 
latest transaction date.  

Updating 
consolidated 
company data 

Transaction data is current as of the consolidation date. 
However, you can update the consolidation and reporting 
process for your companies as part of your year-end procedures 
(or more frequently, as required). For more information, see 
“Update Consolidated Companies” later in this chapter. 
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Working with a Consolidated Company 

When you open a consolidated company, a different Home 
window appears. It identifies the activities you can perform in 
your consolidated company: 

 

Modify Company Accounts 

You can add, remove, or modify accounts in your consolidated 
company.  

■ Add accounts if they are required by the consolidated parent 
company. For more information on adding accounts, refer to 
the section “Add or Change Accounts” in Chapter 2, and 
“Maintaining Records” in Chapter 20.  

If you add an account in your consolidated parent company, 
review the account mapping in your subsidiary company to 
ensure no other account modification is required in the 
subsidiary company. See the next section, “Other Activities,” 
to find out how to review account mapping between 
consolidated companies. 

■ Remove accounts if you want to limit the amount of report 
details.  



Chapter 24:  Maintaining a Healthy Business 

User Guide    24−19 

 
  

SIM2006 ENGL UG Part 5 (24-27) PRINT.doc, printed on 1/16/2006, at 11:51:12 AM. Last 
saved on 1/16/2006 11:50:00 AM. 

ACCPAC International, Inc. Confidential 

If you delete an account in your consolidated parent 
company, be sure to reassign the account mapping in the 
subsidiary accounts. See the next section, “Other Activities,” 
for instructions on mapping outstanding accounts. 

■ Modify accounts if you need to change the grouping or a 
GIFI code.  

Review the account mapping in the subsidiary companies to 
ensure the accounts are matched correctly. 

Update Consolidated Companies 

You can update a consolidated company with new transactions 
from the parent and subsidiary companies. 

To update a consolidated company: 

1. In the Home window of the consolidated parent company, 
on the File menu, choose Consolidated Company. 

2. Select Update, and specify the companies you want to 
update. 

3. Click Next and follow the steps in the Consolidation wizard. 

Print Consolidated Company Reports 

Print a list of comparative financial reports or consolidated 
company reports as frequently as specified in your company’s 
reporting requirements: 

■ Comparative Subsidiary Balance Sheet.   
■ Comparative Subsidiary Income Statement.   
■ Comparative Subsidiary Trial Balance.   
■ Transactions By Account.   

For complete descriptions of these reports, refer to Chapter 1 in 
the Advanced Topics manual (In the Home window on the Help 
menu, select Simply Accounting Manuals, and then Advanced 
Topics). 
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Note:  If you did not map all accounts during the Consolidation 
wizard, when you try to generate a report a warning pops up 
telling you to map all accounts.  

Enter Miscellaneous Transactions 

You may need to process adjustments to handle asset-value 
discrepancies, or to account for new amortization rates. Note 
that you cannot adjust transactions recorded in the parent or 
subsidiary companies from the consolidated parent, but you can 
adjust transactions processed for the consolidated parent 
company using the Miscellaneous Transactions window. 

Refer to Chapter 16 “Entering Other Types of Transactions,” for 
more information about miscellaneous transactions. 

Other Activities 

After you consolidate a company, you can add or delete 
subsidiary companies from the consolidated company, and 
update or make changes to account mapping. 

To add or delete a subsidiary company: 

1. In the Home window of the consolidated parent company, 
on the File menu, choose Consolidated Company. 

2. Complete the Consolidation wizard to add or delete 
subsidiary companies. There must be at least one remaining 
subsidiary company.  

To modify account mapping: 

1. In the Home window on the Setup menu, choose System 
Settings, then Account Mapping.  

2. Select the subsidiary company. 

3. Choose to view only unmatched accounts. 

4. Match subsidiary company accounts in the Consolidated 
Parent Accounts column. 

5. When mapping is complete, click OK. 
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Chapter 25 
Developing Customer and Vendor 
Relations 
 

Who are your best customers and vendors? Who are the worst? Based on this 
basic information, you may wish to reward some and penalize others. 

 

Evaluating Your Customers ....................................................... 25–1 
Getting a General Report on Customers ......................................... 25–1 
Analyzing and Ranking Sales Data ............................................. 25–3 
Identifying Customers with Increased Monthly Sales............................. 25–4 
Identifying Customers With Decreased Sales .................................... 25–5 
Dealing with Overdue Sales Invoices ........................................... 25–5 

Graphing Overdue Invoices on Sales........................................ 25–6 
Evaluating Your Vendors ......................................................... 25–7 

Getting a General Report on Vendors ........................................... 25–7 
Finding Out When Payments Will Come Due.................................... 25–8 
Printing a Report Showing Overdue Payments Owed to Vendors.................. 25–9 
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Evaluating Your Customers 
You identify your best customers in a number of different ways. 
For example, you may care more about prompt payments than 
the number or size of orders. Or, you may be concerned with the 
number of orders that each customer makes as an indication of 
whether they are a regular customer. 

Whatever method you use to evaluate the importance of your 
customers, Simply Accounting reports can help. 

Note:  You may want to offer your best customers preferred 
pricing. For more information on preferred pricing, see “Make a 
List of the Items and Services You Buy and Sell” in Chapter 9 
and “Adding Customers” in Chapter 13.  

Getting a General Report on Customers 

Customers who make large purchases — and pay for them on 
time — are customers you may want to make a special effort to 
please. 

The most useful report for evaluating your overall sales is the 
Customer Sales Report. On this report, you can find: 

■ Sales to a customer. 

■ Costs involved in making sales. 

■ Profit amount and margin on sales. 

■ A breakdown of each item purchased. 

A summary report of all items that you sell might be of the most 
use. To print this report: 

1. From the Reports menu in the Home window, choose 
Customers And Sales and then Customer Sales. 

2. Select Detail, then All Items. The screen should look 
something like the following: 
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These options affect only 
the unit name used on 
the report but not the 
quantities. 

If you check either box, 
the report will not show 
subtotals for Cost of 
Goods Sold and Profit 
columns. 

 

Note:  Be sure to click the Select All buttons under the 
customers and items lists. Uncheck the Freight Amounts and 
Other Amounts options. 

3. Select the starting and ending dates for the period you want 
to analyze. 

 
Print 4. To print the report, choose Print from the File menu. 

This report allows you to analyze different parts of your 
relationship with your customer. You can see the total amount 
that you sold to a customer and which items were the most 
profitable (and the least). 

Here is a copy of a section of the report for one customer. Notice 
that not every item sold to this customer made a profit, nor does 
it have to. For example, you might match a competitor’s prices 
on a few popular items to ensure that your customer continues 
to purchase the more profitable items from you. However, you 
should be careful about which items you sell as loss leaders: 
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UNIVERSAL CONSTRUCTION
Customer Sales Detail Report 03/15/2000 to 03/15/2001 Page 1

Date Item Source Quantity Revenue C.O.G.S. Profit Margin %

Ashburton Reinforcing

03/28/1999 L1030 17607 J228 2,000.0000 Sheet 36,000.00 32,099.99 3,900.01 10.83
04/28/1999 L1030 17613 J270 2,000.0000 Sheet 36,000.00 32,099.99 3,900.01 10.83
05/28/1999 L1030 17627 J327 2,000.0000 Sheet 36,000.00 32,099.99 3,900.01 10.83
06/28/1999 L1030 17634 J364 2,000.0000 Sheet 36,000.00 32,100.00 3,900.00 10.83
10/19/1999 H2510 17662 J136 100.0000 Pound 272.00 218.88 53.12 19.53
03/28/1999 L2001 17607 J228 2,000.0000 Board 1,520.00 1,498.00 22.00 1.45
04/28/1999 L2001 17613 J270 2,000.0000 Board 1,520.00 1,498.00 22.00 1.45
10/19/1999 H2520 17662 J136 100.0000 Pound 179.00 157.18 21.82 12.19
05/28/1999 L2001 17627 J327 500.0000 Board 380.00 374.50 5.50 1.45
03/28/1999 L1020 17607 J228 2,000.0000 Sheet 24,000.00 25,677.83 -1,677.83 -6.99
04/28/1999 L1020 17613 J270 2,000.0000 Sheet 24,000.00 25,678.58 -1,678.58 -6.99
05/28/1999 L1020 17627 J327 2,000.0000 Sheet 24,000.00 25,678.58 -1,678.58 -6.99
06/28/1999 L1020 17634 J364 2,000.0000 Sheet 24,000.00 25,679.04 -1,679.04 -7.00

243,871.00 234,860.56 9,010.44

Profits and profit margins can change on each 
transaction as your costs change with the 
purchase of materials. 

 

You can also scan through this report to determine which 
customers earn you the most total profit. 

Analyzing and Ranking Sales Data 

 Simply 
Accounting 
Premium or 
higher 

If you are using Simply Accounting Premium or higher, you can 
print the Customer Analysis report weekly or monthly to review 
which customers represent your best sales and which customer 
relationships could be further developed. 

The Customer Analysis report is similar to the Customer Sales 
report. However, it adds a ranking structure to your customer 
sales (top or bottom percentage of customers), and also adds two 
more types of information: the average inventory value of the 
item sold and the return on investment (expressed as a 
percentage) for the specific sale. 

To print a Customer Analysis report: 

1. In the Home window, on the Reports menu, choose Forecast 
and Analysis, then Analysis, and then Customer Analysis. 

2. Choose to display either a Summary or Detail report. 

3. Enter a start and a finish date for the report. 

4. Choose how you want to rank your customers. You can list 
them by revenue amount, quantity of units sold, profit, or 
return on investment. 
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5. Decide what percentage of your customers the report should 
display. If you want to display less than 100%, you can 
choose to view the top or bottom group of customers, based 
on sales. If you would like to include customers who have 
not made a purchase within the period you specified in step 
3 above, put a check mark in the Include Customers With No 
Transactions box. 

6. Choose which sales items to base the report on. Select 
Inventory and Service Items, Other Items, or both.  

Note:  Other items are items that you have entered 
manually on an invoice, but have never entered into your 
inventory records. 

7. If you chose to view Inventory and Service Item sales, select 
the items you want to view. Check the Include Inactive 
Items box if you want them listed in the report. 

8. Click OK. 

9. To print the report, from the File menu, choose Print. 

Note:  You may want to select a narrower font or smaller point 
size to ensure that the entire report fits on the page. To change 
the font or size, on the Setup menu, choose Reports And Forms, 
then click Reports and enter the new settings. 

Identifying Customers with Increased Monthly Sales 

If your customers tend to buy goods or services on a regular 
basis, a monthly analysis of which customers have increased 
sales over the month from the previous year can be valuable. 
You might want to offer them preferred pricing so that they will 
continue to buy goods and services from you. 

For more information on preferred pricing, see “Make a List of 
the Items and Services You Buy and Sell” in Chapter 9 and 
“Adding Customers” in Chapter 13. 

To find which customers have increased sales: 

1. In the Home window on the Reports menu, choose 
Management Reports, and then Customers And Sales. 
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2. Select Customers With Increased Monthly Sales, and click 
OK. 

Simply Accounting displays a list of customers whose average 
sales have increased. It also shows the customers’ phone 
numbers. 

Identifying Customers With Decreased Sales 

If sales to certain customers are decreasing, you may want to 
contact them to see why. Perhaps they are dissatisfied with your 
service or have found a better price somewhere else. 

To find which customers have decreased sales: 

1. In the Home window on the Reports menu, choose 
Management Reports, and then Customers And Sales. 

2. Select Customers With Decreased Monthly Sales, and click 
OK. 

Simply Accounting displays a list of customers whose average 
sales have decreased. It also shows the customers’ phone 
numbers. 

Dealing with Overdue Sales Invoices 

Overdue invoices are one of your greatest concerns. The Aged 
Overdue report helps you to see not only the invoices that are 
unpaid, but also those that are overdue. It will also characterize 
those overdue invoices into different “aging periods,” helping 
you to sort through which overdue payments are only a little 
late and which are seriously in arrears. 

To print an aged overdue report: 

1. In the Home window on the Reports menu, choose 
Customers And Sales, then choose Aged Overdue Sales 
Invoices. 

2. Select the customers to include, then click OK.  

3. Choose Print from the File menu. 
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Aged Overdue Sales Invoices Summary Age as of 03/15/2001

Total Total Total 1 to 30 31 to 60 61+
Due Current Overdue Overdue Overdue Overdue

Ashburton Reinforcing -750.00 -750.00 - - - -
Askew Shopping Centre 3,061.36 -500.00 3,561.36 - - 3,561.36
Cavendish, Peter S. 26,750.00 - 26,750.00 - - 26,750.00
Construction Concrete Corp 43,656.00 43,656.00 - - - -
Garry High School Board 50,000.00 50,000.00 - - - -
Kent Industries Inc. 29,768.46 29,768.46 - - - -
Lowland Brewery Inc. 45,115.94 45,115.94 - - - -
Mainline Rail Ltd. 68,916.93 68,916.93 - - - -
South Flats Drainage Board 107,930.90 107,930.90 - - - -
Village Realty 85,600.00 85,600.00 - - - -
West Coast Development 10,700.00 - 10,700.00 - 10,700.00 -

470,749.59 429,738.23 41,011.36 - 10,700.00 30,311.36

Total Current includes invoices 
that are due, but not overdue. 

Negative amounts represent 
deposits, credits, or overpayments. 

 

Tip:  If you have a lot of customers, you can sort and filter the 
report to focus on the largest outstanding amounts. For more 
information on sorting and filtering, see the Advanced Topics file. 
(In the Home window choose Help, then Simply Accounting 
Manuals.)  

Make sure to contact any customers with overdue invoices and 
remind them that they must make payment. 

Any payments that are overdue by more than 60 days (amounts 
in the last column) should receive your immediate attention. Try 
calling the customer to arrange for at least partial payment. 
Otherwise, you may need to write off the sale. For more 
information on write-offs, refer to “Writing Off Bad Debts” in 
Chapter 13.  

You might consider lowering the credit limit of customers with 
late payments. You may also want to refuse to do business with 
customers who are perpetually late with payments.  

Graphing Overdue Invoices on Sales 

You can see a graphical representation of sales invoices. The 
Unpaid Sales by Aging Period graph shows invoices that are 
both due and overdue. 
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To create a graph of unpaid and overdue invoices: 

1. In the Home window on the Graphs menu, choose Unpaid 
Sales by Aging Period. 

Current

31 to 60

61 to 90

91+

Unpaid Sales by Aging Period as at 03/12001 Unpaid Sales by Aging Period as at 03/15/2001 
Generated on/16/2001Generated on 03/15/2001

Current sales are not 
overdue. The larger this 
portion of the pie, the better. 

 

Evaluating Your Vendors 
Good relations with your vendors are just as important as your 
relationships with your customers. You may receive special 
discounts or other benefits if you develop close relationships 
with your vendors. 

If your vendors are offering you discounts for paying your bills 
within a certain time (payment terms), you should try to take 
advantage of those discounts. Consider that 1 percent on $10,000 
of purchases is $100. However, you should only take advantage 
of early-payment terms if you have enough cash on hand. Don’t 
borrow money at a higher rate of interest to take advantage of 
early-payment terms. 

Getting a General Report on Vendors 

You can use the Vendor Purchases report to see a list of your 
purchases from each vendor that you select. This can help you 
identify vendors who might agree to give you a volume 
discount. 
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To print a Vendor Purchases report: 

1. From the Reports menu in the Home window, choose 
Vendors And Purchases and then Vendor Purchases. 

2. Select Detail, then All Items, and select the vendors and 
accounts you want to include. The options window should 
look something like the following: 

 

These options affect only 
the unit name used on 
the report, not the 
quantities. 

 

Note:  Be sure to click the Select All buttons under the 
customers and items lists. 

3. Select the starting and ending dates for the period you want 
to analyze. 

 
Print 4. To print the report, choose Print from the File menu. 

You can also use this report to find out which vendor is giving 
you the best price on an item. To do this, select a single item for 
all vendors, then compare prices.  

Finding Out When Payments Will Come Due 

Missing payments you owe to vendors can cost you money. 
Missing an early payment means a higher cost on the items you 
purchase. Making a late payment can incur penalties as well as 
affect any favourable payment terms you might have. 
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You can use the Aged Overdue Purchase Invoices report to see 
the total amount of payments that you owe, as well as those that 
might be overdue. 

To print an aged overdue report: 

1. In the Home window from the Reports menu, choose 
Vendors And Purchases, then choose Aged Overdue 
Purchase Invoices. 

 
 

Aged Overdue Purchase Invoices Summary Age as of 03/25/2001

Total Total Total 1 to 30 31 to 60 61+
Due Current Overdue Overdue Overdue Overdue

Abercrombie Hardware Inc. 1,247.64 1,247.64 - - - -
Catanach, Douglas -500.00 -500.00 - - - -
Harry's Lumber 94,136.80 12,377.04 81,759.76 - 81,759.76 -
Inglewood Drafting Service 7,490.00 - 7,490.00 7,490.00 - -
Jackson Construction Ltd. 7,953.95 - 7,953.95 - 7,953.95 -

110,328.39 13,124.68 97,203.71 7,490.00 89,713.71 -

“Total Current” includes invoices 
that are due, but not overdue. 

Negative amounts represent prepayments, 
overpayments, and credits.  

Any payments that are more than 60 days overdue (found in the 
last column) are a serious concern. Your vendor may refuse to 
send you more goods or offer further services until you make a 
payment. 

You might also find the cash-flow projection reports useful to 
find out whether you can make your payments on time. For 
more information on cash flow, see “Understanding Your Cash 
Flow” in Chapter 24. 

Printing a Report Showing Overdue Payments Owed to Vendors 

To find out exactly which payments are overdue, you can use 
the management report Overdue Amounts Owed to Vendors. 

 

This report will show only amounts that are overdue past the 
second aging period (over 60 days, in the examples above). 

For more information on setting the aging periods for Simply 
Accounting, see “Enter Payment Options for Vendors and 
Customers” in Chapter 3. 
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To Print an Overdue Amounts Owed To Vendors report: 

1. In the Home window on the Reports menu, choose 
Management Reports and then Vendors And Purchases. 

2. Select Overdue Amounts Owed To Vendors, enter the date 
for which you want the report, and then click OK. 
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Chapter 26 
Tracking Your Inventory 
 

If you sell goods, Simply Accounting provides a number of reports to help you 
make sure that you are selling them at the right price and that you have enough 
on hand to keep your customers happy. 

 

Identifying the Items That Make the Most Money.................................... 26–1 
Knowing When To Re-order....................................................... 26–3 
Understanding the Value of What You Have On Hand ............................... 26–5 

 





Chapter 26:  Tracking Your Inventory 

User Guide    26−1 

 
  

SIM2006 ENGL UG Part 5 (24-27) PRINT.doc, printed on 1/16/2006, at 11:51:12 AM. Last 
saved on 1/16/2006 11:50:00 AM. 

ACCPAC International, Inc. Confidential 

Identifying the Items That Make the Most Money 
You can get a general idea of the goods and services that are 
making you the most money when you look at your income 
statement. Items, after all, are associated with specific revenue 
and expense accounts. 

The problem with this is that many items can be associated with 
a single account. For example, you might have a revenue 
account for computer hardware. Any purchases of monitors, 
hard drives, or processors would all be grouped into that one 
account. 

You need to find out which items are selling well and which are 
not. The Inventory Sales report can help you identify the top 
sellers. If you haven’t sold an item for a while, you might 
consider eliminating it as a stocked item. 

To print an Inventory Sales report: 

1. In the Home window on the Reports menu, choose 
Inventory And Services, and then Sales. 

The following Inventory Sales report example was created 
using these options: 
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Pay particular attention to the profit you make on each item. Of 
course, you may sell some items below cost to attract other 
business. However, you should be careful to retain the right mix 
of profitable sales and unprofitable ones if you use this strategy. 

Remember that a healthy margin varies with the industry and 
the perceived value of the item that you are selling. For instance, 
if you are in the computer industry, a margin of 10 percent can 
be quite healthy. If, however, you are in the fashion industry, 
10 percent can be quite low. 

To print a Product Analysis report: 

 Simply 
Accounting 
Premium or 
higher 

If you are using Simply Accounting Premium or higher, you can 
print the Product Analysis report weekly or monthly to identify 
which inventory or service items are the top (or bottom) 
performers. 

1. In the Home window on the Reports menu, choose Forecast 
and Analysis, then Analysis, and then Product Analysis. 
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2. Choose a Report Type: Summary or Detail. 

3. Enter a start and a finish date for the report. 

4. Choose how you want to rank the products: by revenue, 
quantity, profit, or return on investment. 

5. Decide what percentage of your products the report should 
display. If you want to display less than 100%, you can 
choose to view the top or bottom products, based on your 
ranking choice. If you would like to include items that have 
not been sold within the period you specified in step 3 
above, put a check mark in the Include Items With No 
Transactions box. 

6. Choose which type of customer to include: those on your 
customer list, one-time customers, or both. 

7. If you selected customers from the customer list, select the 
customers to display. 

8. If you want to include inactive customers, check the Include 
Inactive Customers box. 

9. Click OK. 

10. To print the report, from the File menu, choose Print. 

Knowing When To Re-order 
When you first set up your inventory items, you can enter a 
minimum level. When the quantity falls below the minimum 
level due to an order or sale, Simply Accounting reminds you to 
re-order the item. 

If you are about to place an order with a vendor to re-order an 
item, you might want to check to see if other items are close to 
their minimum level. To do this, you can print an Inventory 
Quantity report. 
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To print an Inventory Quantity report: 

1. In the Home window from the Reports menu, choose 
Inventory And Services, and then Quantity. 

The sample inventory quantity report was created using 
these options: 

 

 

Compare the quantity on hand in the Quantity column with the 
minimum amount you want to have on hand in the next column. 
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You can see if you are close to the minimum and order more 
items. 

Pay particular attention to the To Order column. The number in 
this field represents the minimum amount you must order so 
that you can fill existing orders and have your inventory at the 
minimum level. 

Understanding the Value of What You Have On 
Hand 

Seeing a synopsis of your inventory helps you to analyze what 
you have on hand. You can quickly see selling prices, quantity 
on hand, and the cost of producing or purchasing those items. 

The Inventory Synopsis report allows you to check the value of 
all goods that you have on hand. This can be particularly useful 
if you are adjusting your prices and want to compare cost with 
margin. 

To print an Inventory Synopsis report: 

1. In the Home window on the Reports menu, choose 
Inventory And Services, and then Synopsis. 

The sample Inventory Synopsis report was created using 
these options: 
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This report, like the Inventory Quantity report discussed earlier 
in this chapter, shows you the profit margin on all of your stock. 

You can also report your markup as opposed to your margin. 
For information on the difference between markup and margin 
as well as how to set up inventory options, see “Select Inventory 
Options” in Chapter 9. 
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Chapter 27 
Using Graphs 
 

Graphs give you a useful visual representation of your company’s progress. You 
may want to use them for presentations to clients. 

 

Customizing Graphs.............................................................. 27–1 
Changing the Colour.......................................................... 27–2 
Displaying the Detail for a Part of the Graph .................................... 27–3 
Changing the Legend ......................................................... 27–3 

Fixing the Legend’s Position ............................................... 27–3 
Creating an Exploding Pie Chart ............................................... 27–4 

Pasting a Graph into a Presentation ................................................ 27–5 
Adjusting the Background Colour .............................................. 27–5 
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 Simply Accounting includes several graphs that help you to 
visualize the performance of your company. You can use these 
graphs within Simply Accounting to gather information quickly, 
or you can paste them into other documents for a presentation or 
report. 

In the Home window on the Graphs menu, you can select from a 
list of graphs. 

Customizing Graphs 
Once you select a graph from the Graphs menu, you can edit 
several features of the graph, including its size and colour. 

Simply Accounting automatically saves any changes you have 
made when you close the graph window. 

This button: Does this: 

 
Import.  Opens a graph you have exported with the Export 
button. 

 
Export.  Saves the graph to a file. 

 
Copy to the Clipboard as a bitmap.  Once you click this 
button, you can paste the complete graph into another 
program, such as a word processor. 

 
Copy to the Clipboard as text.  Once you click this button, 
you can paste the data associated with the graph into another 
program, such as a word processor. 

 
Print.  Prints the graph. You can change the printer or the 
margin settings in the Home window. On the Setup menu, 
choose Reports And Forms, then click the Graphs tab. 

 
3D or 2D.  Displays the graph in two or three dimensions.  

 
Rotate.  Changes the angle of the vertical and horizontal axes 
of the graph. 
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This button: Does this: 

 
Zoom.  Enlarges any area of a graph. This is useful, for 
example, if you have a pie with many small slices. Click the 
Zoom button, then position the pointer anywhere outside the 
graph area. Hold down the left mouse button and drag a 
rectangle over the part of the graph you want to enlarge. To 
return the graph to its original size, click the Zoom button 
again. 

 
Show or hide the legend.  Shows or hides the legend that 
explains the colours in the graph.  

 
Show or hide the series legend (bar graph only).  Show or 
hide the legend that explains the coordinates along the 
bottom of the graph. 

 
Vertical grid (bar graph only).  Display the graph with a 
background of vertical lines. 

 
Horizontal grid (bar graph only).  Display the graph with a 
background of horizontal lines. 

 
Edit titles.  Change the text at the top, bottom, left, or right of 
the graph. 

 
Change text fonts.  Change the fonts displayed on the 
screen. 

Changing the Colour 

You can change the colour of any aspect of the graph, including 
any segment (one of the pie slices or a series of bars) or the 
background for the graph. 

 Change colour 1. Drag a colour from the row at the top of the graph to the part 
you want to change. 

Once you let go of the mouse button, the new colour 
appears.  
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Displaying the Detail for a Part of the Graph 

To see the exact values for a pie slice or a graph bar, double-click 
the segment. 

Note:  The value does not appear when you print or copy this 
graph. 

 

Changing the Legend 

The legend identifies the various bars or pie segments in your 
graph. To display or hide a legend, click the Show Or Hide The 
Legend button for the type of legend you want to display. For 
more information on these toolbar buttons, refer to the table 
earlier in this chapter. 

Once you can see the legend, you can right-click it to bring up a 
menu that allows you to change various options, described 
below. 

Fixing the Legend’s Position 

When you first open a graph, the legend is contained within its 
own window. If you want the legend to appear when you print 
or copy it, you must fix it into position. You can do this in one of 
two ways: 
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■ Resize the legend as you would any window and place it 
where you would like it to appear. Then, right-click the 
legend, and choose Fixed. 

■ Right-click the legend, and then select either Left, Right, 
Top, or Bottom. 

 

If you right-click the legend and select Options, you can change 
the following: 

Draw Border.  Draw a line around the legend. 

Draw Splitter.  If you have placed the legend along an edge of 
the graph, the program draws a single line separating the legend 
from the graph. 

3D Frame.  Display the legend in a three-dimensional box. 

Skip Empty.  This option is used for line graphs, which Simply 
Accounting does not use. Leave this box unchecked. 

MultiLine.  Allow the lines in the legend to wrap to the next line. 

Creating an Exploding Pie Chart 

You can separate any slice of a pie chart. Drag the slice you want 
to move with the mouse pointer: 
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Pasting a Graph into a Presentation 
Pasting a graph into either a spreadsheet, a word-processing file, 
or a Microsoft PowerPoint presentation is as easy as preparing 
your graph, clicking the Copy button, and then pasting the 
graph into the document. 

Adjusting the Background Colour 

If you want to copy a graph to a presentation, it will look better 
if you colour the background for the graph the same colour as 
your presentation background. If you are pasting this graph into 
a word processor, consider changing the background colour to 
white. 

If you cannot find the colour that you need in the row of colours 
at the top of the graph, you can double-click any colour to 
change it to what you need. 

To change a colour: 

1. Double-click any colour on the row at the top of the graph. 
The colour that you double-click will be replaced by the new 
one that you create. 

2. Click Define Custom Colors. You can then select any colour. 

 

If you want an exact 
match, you may want to 
type in the RGB values. 

 

3. Click OK, and then drag the new colour to your graph’s 
background. 
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For more information on changing colours, see “Changing the 
Colour,” earlier in this chapter.  
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Chapter 28  
Working Away from the Office 
 

Simply Accounting . . .  To Go! If you are using Simply Accounting Pro or higher, 
you can use Simply Accounting Mobile to enter sales orders, invoices, customers, 
and time slips using a handheld device.   
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Taking Simply Accounting With You 

 

If you often work off-site, you can take Simply Accounting with 
you using a handheld device loaded with Simply Accounting 
Mobile. You can use Simply Accounting Mobile to enter new 
sales orders and invoices, update customer information, and 
keep track of your time.  
 
Later when you are back in your office, connect your handheld 
device to your desktop computer to quickly and easily transfer 
the new data to Simply Accounting. At the same time, you can 
update your handheld device with any changes to customers, 
employees, inventory and related sales and order information 
entered on the desktop. 

Simply Accounting Mobile is most beneficial for salespeople who 
want to enter new orders and sales while working offsite, service 
providers who want to record time spent on service calls, and 
marketing executives who want to keep their customer 
information up to date. 

Before You Start 

 

 
Requirements 

Review the following list to ensure you meet the installation 
requirements: 

■ A handheld device running Pocket PC 2002 or 2003: 

− 1.55MB (ROM) on Pocket PC 2002 

− 1.35MB (ROM) on Windows Mobile for Pocket PC 2003 
or Windows CE .NET Devices 

■ 200MB of hard disk space. 

■ Internet Explorer 5.5 SP2 or higher 
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Switching between 
companies 

If you will be working with more than one company’s data while 
you are out of the office, you must store each company’s data in 
a separate file location to prevent synchronization errors. 

Each time you synchronize with a different company, be sure to 
check the location of your data. See the section “Transfer Data to 
Simply Accounting” for more information. 

Multicurrency  If you use multicurrency accounting, note that you can only enter 
transactions in Simply Accounting Mobile using your home 
currency.  

 

Setting Up Simply Accounting Mobile 
Simply Accounting Mobile is included on the Simply 
Accounting installation CD and can be installed on one or more 
handheld devices. You can install Simply Accounting Mobile on 
your handheld device when you install Simply Accounting, or at 
another time. 

Step 1:  Install Simply Accounting Mobile 

If you installed Simply Accounting Mobile on your desktop 
computer when you installed Simply Accounting, follow the 
instructions under “To install Simply Accounting Mobile on a 
handheld device,” later in this step.  

If you chose not to install Simply Accounting Mobile when you 
installed Simply Accounting, you must install it on your desktop 
computer and then on your handheld devices.   

To install Simply Accounting Mobile on your desktop 
computer after you have installed Simply Accounting: 

1. Close Simply Accounting.  

2. From the Windows Start menu, choose Settings, then 
Control Panel, and then Add Or Remove Programs.  

3. Under Simply Accounting, click Change. 
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4. On the Simply Accounting Setup screen, choose 
Add/Remove Program Components. 

5. In the list of features, check Synchronize With Handheld 
Device and Simply Accounting Mobile Install. 

6. Click Next and complete the process. 

To install Simply Accounting Mobile on a handheld device: 

1. Connect the handheld device to the computer where you 
store your Simply Accounting company data.  

2. From the Windows Start menu, select Programs, then 
Simply Accounting, and then Install Simply Accounting 
Mobile. 

3. Click Yes to install (or re-install) Microsoft SQLCE 2.0. This 
program is usually already running on Pocket PC devices. It 
is required for Simply Accounting Mobile. 

4. If a compatibility error appears, click Yes to continue.  

5. Click Yes to install (or re-install) Microsoft.NET Compact 
Framework. This program is usually already running on 
Pocket PC devices. It is required for Simply Accounting 
Mobile.  

6. If the Select Destination Media window appears, choose a 
location for the files that has enough space to store Simply 
Accounting Mobile data (approximately 200MB).  

Step 2:  Set Up Synchronization Settings and Options 

What is 
synchronization?  

When you synchronize, information at two different locations is 
matched and made the same. During synchronization, records 
that have changed in Simply Accounting since the last time you 
synchronized are updated on your handheld device. At the same 
time, new orders, invoices, and time slips, and changes to 
customer records stored in the handheld device, are updated in 
Simply Accounting. 

After you install Simply Accounting Mobile, you must identify 
the company data file that you will use to synchronize with your 
handheld device. Then you will choose the data you want 
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transferred to your handheld device during synchronization: 
customers, inventory and service items, price lists, and 
employees. 

To set up your Synchronization settings: 

1. Connect the handheld device to the computer where you 
store your Simply Accounting data.  

Is Simply Accounting 
in multi-user mode? 

2. Ensure that Simply Accounting is running in multi-user 
mode, or exit the program.  

Exit Simply 
Accounting 
Mobile 

3. If Simply Accounting Mobile is running on your handheld 
device, exit the program. 

4. On the desktop Windows Start menu, select Simply 
Accounting, and then Synchronize With Handheld Device. 

5. Select your language preference and if you want to display 
the Synchronization window each time a handheld device is 
connected to your computer, then click Next to complete the 
initial synchronization. 

Note:  If your Simply Accounting company uses security, 
you must enter your User ID and password before activating 
synchronization. 

 

Choose a language to use 
for screen display. 

Choose to display the 
Synchronization window 
automatically the next time a 
handheld device is 
connected to your 
computer. 

 

6. Click Next. 
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Enter a name to identify your 
handheld device. 

Enter the location of your 
Simply Accounting desktop 
data. 

 

7. Enter a description of your handheld device and the location 
of the Simply Accounting company data you plan to use 
remotely, then click Next. The default location of your 
company data is: C:\Program Files\Winsim\Data. 

8. Choose the company data you want to synchronize with 
your handheld device. If you want to keep the size of the 
data on your handheld device to a minimum, choose to 
transfer only the information that you need. You can easily 
transfer additional information later.  

For example, if you are going to be working with one 
customer, synchronize one customer record and their 
assigned price list.  

Note:  You must have valid security rights to access the 
records you want to synchronize. Security access is defined 
in Simply Accounting. 
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If you choose Sales Orders 
and Invoices you can 
choose the items you want 
to transfer onto your 
handheld device.  
 
If you choose Time Slips you 
can choose the employees 
you want to transfer onto 
your handheld device. 

 

Note:  All tax codes are synchronized automatically. 

9. Complete the Setup Wizard to synchronize the information. 
Simply Accounting Mobile remembers these settings each 
time you synchronize. You can change your synchronization 
options after each synchronization. 

Step 3:  Set Up Simply Accounting Mobile  

The first time you start Simply Accounting Mobile, your 
handheld device displays the Settings window. Use the Settings 
window to set up the screen display language, to specify the 
types of transactions you want to record, and set prefix and next 
number settings for invoices and time slips. You can change 
your settings at any time. 

1. In the Home window tap Programs, and then Simply 
Accounting Mobile. 
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Choose your preferred 
display language. 

Check the type of 
transactions to record. 

If you record invoices and 
time slips, enter identifying 
text and sequence numbers. 

 

2. Choose a screen display language. 

3. Choose the types of transactions you want to record on your 
handheld device.  

4. Enter a prefix and next number for invoices and time slips. If 
you do not assign a prefix or number, you must enter one 
manually. 

For example, enter a salesperson’s initials to use as the prefix 
for all invoices entered on this handheld device, and then 
look up an imported sales invoice in Simply Accounting 
according to salesperson.  

5. Tap Save. 

If you want to change your settings later, tap the Setup tab in 
the Simply Accounting Mobile Home window, and then 
choose Settings. 

Entering Information on a Handheld Device 
Use your handheld device to enter orders, invoices, and time slip 
information for safe storage until you return to the office and 
synchronize.  

Note:  These steps are available in the on-line help for the 
handheld device. 
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Entering Sales Orders and Invoices 

Enter a sales order or invoice on your handheld device when 
you sell goods or services while working off-site. 

Note:  Simply Accounting Mobile provides fields for basic order 
information. When you return to the office you can modify the 
order to enter the salesperson responsible for the order (unless 
you entered a prefix that identifies the salesperson), shipping 
information, customer early payment terms, and project 
allocations. 

To enter a sales order or invoice on your handheld device: 

1. Tap the Sales Orders or Invoices icon. 

2. Fill out the form just as you would for any sales order or 
invoice (enter the date, customer name, order number, and 
ship date). Note that the date of the order must fall within 
the current year specified in your Simply Accounting data. 

Note:  You can add a new customer while entering an 
invoice if you select <Add New Customer> in the Customer 
field. 

3. Tap the Details tab to display a detail screen, then tap Add. 

4. Tap in the Item field and select an item from the inventory 
item list. 

5. Enter a quantity (The unit of measure and the price appear, 
and the total amount is calculated automatically). 

6. Assign a tax code, if applicable. 

7. Tap Finish and then tap Add if you want to enter another 
inventory item, or tap Save to finish entering the order or 
invoice.  

8. Tap the Info tab to enter another order, or tap Close. 

After you synchronize, you can open the order in Simply 
Accounting and add freight information, early payment terms, 
identify the salesperson, and allocate the order to a project. 
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Note:  You can use the look up feature to review entered orders 
and invoices. Transactions are stored on your handheld device 
until the next synchronization. 

Entering Time Slips 

Time slips entered on your handheld device appear in the Time 
Slips window in Simply Accounting.  

1. Tap the Time Slips icon. 

2. Enter the date, select an employee, and enter a new time slip 
number. 

3. Tap Details, then tap Add. 

4. Select the customer name, service activity, and the time 
spent on the activity. 

5. Tap Finish to save the entry. 

6. Tap Add to enter a new activity line, or tap Save to finish 
entering the time slip. 

After you synchronize, you can open the time slip in Simply 
Accounting to enter billing and project allocation information. 

Adding Customers 

New customers entered in Simply Accounting Mobile are added 
to Simply Accounting the next time you synchronize.  

Foreign customers Note:  You can only add customers to your handheld device that 
can complete transactions in your home currency. Simply 
Accounting Mobile does not support multicurrency transactions. 

 

1. Tap Customers. 

2. Tap the Tools tab in the bottom left corner of the screen, and 
then tap Add Customer. 

3. Enter or modify details in each field. 

4. Tap Save. 
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Looking Up Orders, Invoices, and Time Slips 
You can use the lookup feature in Simply Accounting Mobile to 
review and adjust orders, invoices, and time slips entered on the 
handheld device after the last synchronization Simply 
Accounting Mobile does not store transactions on your handheld 
device after synchronizing. 

1. Tap the Sales Orders, Invoices, or Time Slips icon. 

2. Tap the Lookup button. 

3. Highlight the order or time slip you want to review, then tap 
Select to open the transaction. 

4. To modify the transaction, tap Details, then tap Modify and 
make your changes.  

5. To add a new detail line, tap Details and then tap Add. 

6. To save your changes, tap Finish, then Adjust, and then OK, 
or tap Close to exit without saving. 

Deleting Transactions and Customer Records 
Sales orders, invoices, 
and time slips 

If you do not want a sales order, invoice, or time slip entered on 
your handheld device, delete it before synchronizing. 

1. Tap Sales Orders, Invoices, or Time Slips. 

2. Tap Lookup and select the transaction you want to delete. 

3. Tap Remove. 

4. Tap Yes to confirm deletion of the entry. 

Customers You can delete a new customer entered on your handheld device 
before synchronizing to prevent it from appearing in Simply 
Accounting. However, if you delete an existing customer in  
Simply Accounting Mobile and then synchronize, the customer 
is not deleted in Simply Accounting. You must modify your 
synchronization settings if you do not want a deleted customer 
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to reappear on your handheld device the next time you 
synchronize. 

1. Tap Customers. 

2. Tap Tools and then tap Remove Customer. 

3. Tap Yes to confirm deletion of the customer. 

Transfer Data to Simply Accounting 
When you return to the office you can quickly and easily transfer 
any new transactions or updated customer information stored 
on your handheld device to Simply Accounting using the 
Synchronization With Handheld Device feature. 

During synchronization, new items, customers, and employees 
that were added to Simply Accounting since the last 
synchronization are transferred to your handheld device, as well 
as any new price lists and tax codes. Note that transaction 
records (sales orders, invoices, and time slips) entered in Simply 
Accounting are not transferred to Simply Accounting Mobile. 

Is Simply Accounting 
in multi-user mode?  

1. Ensure Simply Accounting is in multi-user mode. 

Exit Simply 
Accounting Mobile 

2. If you are running Simply Accounting Mobile on your 
handheld device, exit the program. 

3. Connect your handheld device to the desktop. 

4. If the Synchronize window does not appear automatically, 
open the desktop Start menu, select Simply Accounting, and 
then Synchronize With Handheld Device. 

5. If you store data for multiple companies on one handheld 
device, make sure the correct data path is identified. 

6. Click Next to start synchronizing. Review the status report 
for errors. The handheld device also provides you with a 
status report. If any errors appear, refer to the next section 
for tips on fixing errors. 

7. When synchronization is finished, click Next.  
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8. Click Yes if you want to change your synchronization 
settings, or click No to complete the synchronization. 

If you need help modifying your synchronization settings, 
click the Synchronization Wizard’s Help button. 

Fixing Synchronization Errors 
If an error appears on the synchronization report, make the 
required changes to your Simply Accounting Mobile 
transactions and/or records before completing synchronization. 

Transactions that contain errors are not synchronized; they are 
stored on the handheld device until you adjust and synchronize 
them successfully.  

If you see this error: Do this: 

Waiting for response. Check that your handheld device is 
connected to your desktop 
computer. 

No data to synchronize Check that you have completed the 
initial synchronization to install data 
on your handheld device. 

Cannot open your Simply 
Accounting data. 

Ensure that Simply Accounting is 
not running on your desktop. If it is 
running, set it to run in multi-user 
mode. 

Error reading the 
company file. 

Ensure Simply Accounting Mobile is 
not running on your handheld 
device. Check that you have entered 
the correct data path in the 
Synchronization wizard. 

Invalid date. 
 

Ensure that all transaction dates fall 
within the current fiscal year as 
specified in your Simply Accounting 
data. 
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for exchange-rate differences, 10–2 
Account classes 

assigning, 2–13 
overview, 2–12 

Account history, 2–17 
adding, 11–2 

Account mapping, 24–14, 24–20 
 See also:  Consolidated companies 
Account names and numbers 

keeping track of changes, 2–17 
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Adding (continued) 
payroll history, 11–6 
prices to price lists, 9–10 
principal foreign-currency bank account, 

10–7 
project history, 11–9 
projects, 5–4 
users, 3–39 
vendors, 12–1 to 12–5 

Adding or changing a system administrator’s 
password, 3–38 

Additional Costs field 
in item assembly, 9–14 

Additional Info fields, 3–23 
for transactions, 3–25 

Additional information 
accounts, 2–10 
inventory items, 9–6 
projects, 5–4 

Adjusting 
inventory levels, 20–13 
payments to payroll authorities, 12–20 
prepayments, 12–22 
time slips, 18–11 
See also:  Changing 

Adjusting entries in previous year, 21–11 
Adjustments, 20–13 
Advanced topics.  In the Home window on the 

Help menu, choose Simply Accounting 
Manuals, then Advanced Topics 

Advances. See:  Pay advances 
Advice 

hiding, 23–3 
Aging periods (customers), 3–18 
Aging periods (vendors), 3–18 
Allocate button, in budgeting, 6–3 
Allocating to multiple departments, 15–13, 
 15–15 
Allocating to projects, 17–1 to 17–2 

by percentage, amount, or hours, 5–3 
time slips, 18–6 
See also:  Projects 

Allow Inventory Levels To Go Below Zero 
option, 9–2 

Allow transactions in previous year, 3–2 
Allow transactions in the future, 3–2 
American version of Simply Accounting, 1–1 

Analysis reports 
customer sales, 25–3 
inventory and services, 26–2 

Assembly 
of inventory from other items, 9–6, 9–12 
See also:  Item assembly 

Assigning account numbers, 2–4 
Audit trail 

reports, 21–13 
Automatically downloading tax tables, 15–21 
Automatically Refresh List option, 3–30 
Automatically Save Changes option, 3–30 
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Back orders 
on purchases, 12–8 
on sales, 13–7 

Backdating entries, 3–2 
Background colours on screens 

customizing, 3–29 
Backing up, 19–2 to 19–4 

reminders, 19–3 
restoring a backup, 19–4 

Bad debts, 13–22 
Balance sheet, 24–3 to 24–6 
Bank account, 2–13 
Bank account, foreign 

adding, 10–7 
Bank accounts 

for direct deposits, 15–7 
transferring funds, 16–3 

Bank deposits, 16–1 
Basic information 

entering (overview), 3–1 
Batch printing, 22–8 

turning on the option, 3–20 
Batch processing and printing, 22–2 
Batches 

viewing reports in, 22–10 
Benefits on paycheques, 15–4 

vacation, 15–16 
Benefits per period, 15–4 

deducting GST or QST, 15–9 
Bill of materials, 9–6, 9–12, 9–13 
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Bill of materials (continued) 
setting up, 22–21 

Billable time, 18–5 
Bills 

credit card, 14–1 
miscellaneous, 14–2 

Bitmaps 
adding to inventory records, 9–6 

Budget period 
annual, 6–3 
projects, 6–4 

Budgeted profit 
for projects, 6–4 

Budgeting tip, 6–2 
Budgets 

adding information to the accounts, 6–2 
checking, 20–15 
Comparative Income Statement report,  
 20–15 
distributing total evenly to all periods, 6–3 
for projects, setting up, 6–4 
modifying, 6–2 
Project Budget report, 20–15 
setting up, 6–1 
turning off, 6–1 
updating, 20–16 

Building inventory from other items, 9–6, 9–12 
Business calendar, 22–3 
Business Number, 3–3 
Business performance, measuring, 22–7 
Buttons 

graphs toolbar, 27–1 
See also:  back cover of the User Guide 

Buying. See:  Purchases 

C 

Calculating amounts using the exchange rate, 
10–5 

Calculating foreign prices on invoices, 10–9 
Calendar 

in the Daily Business Manager, 22–3 
Calendar  

pop-up, in date fields, 22–22 
Calendar year-end, 21–8 

Canadian version, 1–1 
Cancelling. See also:  Changing 

accountant's copy, 21–13 
customer deposits, 13–18 
employee paycheques, 15–18 
miscellaneous transactions, 16–5 
miscellaneous transactions manually, 16–6 
other payments, 14–3 
payments from customers, 13–16 
payments from customers manually,13–17 
payments to vendors, 12–19 
payments to vendors manually, 12–20 
prepayments, 12–22 
purchase invoices, 12–16 
purchase invoices manually, 12–18 
purchase orders or quotes, 12–17 
sales invoices, 13–13 
sales invoices manually, 13–15 
sales orders or quotes, 13–15 

Cash flow projection, 24–8 
Changing 

a system administrator’s password, 3–38 
account names and numbers over several 

years, 2–17 
customer deposits, 13–18 
employee paycheques, 15–18 
exchange rate, 10–5 
inventory levels, 20–13 
miscellaneous transactions, 16–5 
miscellaneous transactions manually, 16–6 
other payments, 14–3 
payments from customers, 13–16 
payments from customers manually,13–17 
payments to payroll authorities, 12–20 
payments to vendors, 12–19 
payments to vendors manually, 12–20 
prepayments, 12–22 
prices on price lists, 9–10 
purchase invoices, 12–16 
purchase invoices manually, 12–18 
purchase orders or quotes, 12–17 
records, 20–1 
sales invoices, 13–13 
sales invoices manually, 13–15 
sales orders or quotes, 13–15 
time slips, 18–11 
user password, 3–41 
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Changing (continued) 
user’s rights to use Simply Accounting 

data, 3–42 
Charge duty on items purchased (vendors), 

12–3 
Chart of accounts. See:  Accounts 
Check. See:  Cheque 
Check for duplicate invoices or receipts, 3–21 
Checking data integrity. See:  Data integrity 
Checklists, 20–16, 22–6 to 22–13 

creating or changing, 22–12 
displaying, 22–12 
displaying automatically, 22–12 

Cheque numbers 
renumbering, 3–21 

Class Options tab, in account records, 2–13 
 See also:  Account classes 
Clearing, 23–7 to 23–10 

account reconciliation, 23–9 
automatically, 23–10 
direct deposit data, 15–24, 23–10 
employee details, 23–9 
imported online statements, 23–9 
inventory tracking, 23–9 
invoice lookup data, 23–9 
lookup data for remittance payments, 23–9 
lookup data for time slips, 23–9 
notes, 23–9 
tax details, 23–9 

Closing records 
reminder to save, 3–30 

Codes for sales taxes, 3–6 
 See also:  Tax codes 
Colours 

customizing on reports, 3–28 
screen display, 3–29 

Comments 
hiding in Miscellaneous Transactions 

window, 23–5 
on printed forms, 3–21 

Compact database, 20–1 
Company Information screen, 3–3 
Company name, on reports, 3–3, 3–4 
Company type 

choosing, 3–3 
what is, 3–2 

 

Consolidated companies 
add or delete a subsidiary, 24–20 
miscellaneous transactions, 24–20 
modify account mapping, 24–20 
modifying accounts, 24–18 
reports, 24–19 
types of reports, 24–19 
updating, 24–19 
working with, 24–18 
year-end reports, 21–10 

Consolidating 
about, 24–13 
account mapping, 24–14 
and departments, 24–13 
before you start, 24–14 
reports, 24–13 
steps, 24–15 

Converting data 
troubleshooting, 19–5 

Correcting 
customer deposits, 13–18 
inventory levels, 20–13 
payments from customers, 13–16 
payments from customers manually,13–17 
payments to payroll authorities, 12–20 
payments to vendors, 12–19 
payments to vendors manually, 12–20 
prepayments, 12–22 
purchase invoices, 12–16 
purchase invoices manually, 12–18 
purchase orders or quotes, 12–17 
sales invoices, 13–13 
sales invoices manually, 13–15 
sales orders or quotes, 13–15 
time slips, 18–11 
See also:  Changing 

Cost centres. See:  Projects 
Cost of Goods Sold account, 9–3 
Cost of inventory, 9–2 
Courier. See:  Shipments 
Creating 

price lists, 9–9 
Credit cards 

adding information about, 4–2 
checking statements, 2–22 
fees charged, 4–2 
paying bills, 14–1 
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Credit cards(continued) 
receiving money from sales, 20–6 
reconciling, 2–22 
setting up, 4–1 to 4–3 

Credit note 
issuing, 13–20 

Credit-card accounts 
adding, 4–1 

Current Earnings account 
defined, 2–4 

Customer statements 
e-mailing to customers, 3–22 

Customers 
adding, 13–1 to 13–4 
adding on the fly, 22–18 
adding sales and receipts history, 11–5 
analysis report, 25–3 
changing, 20–1 
deposits, 13–11 
entering historical balances, invoices, and 

payments, 11–5 
entering on a handheld device, 28–9 
evaluating, 25–1 
exemptions from sales taxes, 3–8 
internal, 13–2 
memos, 22–6 
removing, 20–2 
returns, 13–19 to 13–21 
setting up to use foreign currency, 10–10 
tax codes, 3–8 

Customizing 
colours and fonts on reports, 3–28 
display settings, 3–29 
graphs, 27–1 to 27–6 
sales invoices, 23–2 
the Home Window, 23–5 
transaction windows, 23–1 

D 

Daily Business Manager, 22–1 
batch processing and printing, 22–2 
calendar, 22–3 
displaying automatically, 22–1 
to-do lists, 22–4 

Data 
backing up, 19–2 
enhancing performance, 20–1 
saving, 19–4 
using in other programs, 3–38 

Data folder 
for Simply Accounting, 7–1 

Data integrity 
checking, 19–1 
correcting errors, 19–1 

Date fields, 3–3 
pop-up calendar, 22–22 
unavailable if finished entering history, 
 3–3, 3–4 

Dates, 3–2 
changing format, 3–32 
Daily Business Manager, 22–3 
long and short format, 3–32 

Deductions. See:  Payroll deductions 
Deductions from paycheques, 15–5 

GST or QST on benefits, 15–9 
Deleting 

accounts, 20–3 
employees, 20–4 
inventory and service items, 20–4 
projects, 20–5 
records, 20–5 
transactions or customer records in Simply 

Accounting Mobile, 28–10 
vendors or customers, 20–4 
See also:  Removing 

Departmental accounting, 2–6 
Departments 

allocating to, 15–13, 15–15 
changing, 2–9 
changing names, 2–8 
creating, 2–7 
for customers, 2–8, 13–2 
for employees, 2–8, 15–2 
for inventory and services, 9–4 
for vendors, 2–8, 12–2 
removing, 2–8 

Deposit slip, 16–1 
Deposit slip numbers 

Bank account, 2–13 
Deposits 

bank, 16–1 
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Deposits (continued) 
deposit slip, 16–1 
See also:  Prepayments 

Deposits from customers, 13–11 
cancelling, 13–18 
changing, 13–18 

Detailed Description tab in inventory records, 
9–6 

Differential rate, 3–12, 3–13 
Dimmed options, 19–5 
Direct deposit, 15–21 

adding bank accounts for, 15–7 
and processing paycheques, 15–22 
clearing direct deposit data, 15–24 
printing direct deposit stubs, 15–22 
printing the direct deposit log, 15–23 
processing, 15–22 
setting up for, 15–22 
submitting the direct deposit file, 15–23 

Discounts on purchases, 3–18 
Discounts on sales, 3–18 
Display preferences, 3–29 
Drilldown, 22–16 
Dual currency. See:  Multiple currencies 
Duplicate invoices and receipts, 3–21 
Duties. See:  Import duties 
Duty on purchases, 12–3 

E 

Earliest transaction date, 3–2 
Early-payment terms 

for customers, 13–2 
for vendors, 12–2 

e-file. See:  Electronic filing 
EI. See:  Employment Insurance 
EI insurable earnings, 21–17 
EI insurable hours, 3–11 
Electronic filing, 21–15 

Relevé 1 slips, 21–18, 21–22 
T4 slips, 21–17, 21–18 

E-mail options 
setting up, 3–20 to 3–23 

E-mailing to vendors and customers, 3–22 
 

Employee options 
job categories, 3–26 

Employees 
adding, 15–1 to 15–11 
adding direct deposit bank accounts, 15–7 
adding on the fly, 22–18 
benefits, 15–4 
benefits per period, 15–4 
changing, 20–1 
deductions, 15–5 
entering historical balances, income, and 

deductions, 11–6 
entitlements, 15–6 
GST on benefits, 15–9 
income tab, 15–4 
linking to a single wage expense account, 

15–5 
memos, 22–6 
paying, 15–11, 15–14 
removing, 20–2 
taxes, 15–5 
time slips, 18–9 

Employees options 
job categories, 15–2 

Employer Health Tax, 3–11 
Employment Insurance, 3–11 
Enhancing performance, 20–1 
Entering 

customers in Simply Accounting Mobile, 
28–9 

miscellaneous transactions, 16–3 
purchases, 12–5 
sales, 13–4 
sales orders and invoices in Simply 

Accounting Mobile, 28–8 
time slips, 18–4 
time slips in Simply Accounting Mobile, 

28–9 
Entering history 

troubleshooting, 19–6 
Entitlements 

for employees, 15–6 
Exchange rate 

adding, 10–5 
adding on the fly, 10–6 
changing, 10–5 
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Exchange rate (continued) 
how the program uses it in calculations, 

10–5 
looking up on a Web site, 10–5, 10–6 
reminder to update, 10–5 
setting up, 10–5 

Exchange-rate differences 
adding an account for, 10–2 

Exemptions from sales taxes, 3–9 
company, 3–5 
inventory items, 3–9 
vendors and customers, 3–8 

Expense groups 
employees, 3–16, 15–3 
set up, 3–16 

Expenses 
allocating to projects, 17–1 to 17–2 
graphs, 24–7 

F 

Federal ID Number, 3–4 
Federal Unemployment Tax Act, 3–13 
Filing 

Relevé 1 slips, 21–15 
T4 slips, 21–15 

Financial history, 2–17 
dates available, 3–3 

Financial statements 
formatting, 2–3 

Finish entering history, 11–10 
Finish Entering History command, 11–2 
Fiscal year-end, 21–8 
Flags, 1–1 
Flat fee for service activities, 18–3 
Fonts 

customizing on reports, 3–28 
Foreign currency, 10–1 

bank account 
adding, 10–7 

exchange-rate differences, 10–2 
for vendors, 12–2 
reconciling accounts, 10–7 
setting up, 10–4 

 

Foreign currency (continued) 
setting up vendors and customers to use, 

10–10 
using the exchange rate with, 10–5  
See also:  Multiple currencies 

Foreign prices, 10–9 
setting up vendors and customers to use, 

10–10 
Foreign prices on invoices 

deciding which to use, 10–8 
Foreign transactions 

rounding differences, 10–2 
Forms 

automatic numbering, 3–21 
printing (testing), 8–2 
setting up options, 3–20 
warning before processing, 3–21 
See also:  Invoices, names of individual 

forms 
Full accounting rights, 3–36, 3–37 
FUTA. See:  Federal Unemployment Tax Act 

G 

General Index of Financial Information (GIFI), 
2–11 

GIFI codes, 2–11 
GIFI export data, 21–10 
Goods and services. See:  Inventory and service 

items 
Graphs 

colour, 27–2, 27–5 
customizing, 27–1 to 27–6 
Expenses Vs Budget, 20–16 
exploding pie chart, 27–4 
legend, 27–3 
revenues and expenses, 24–7 
Sales Vs Budget, 20–16 
toolbar buttons, 27–1 

Group accounts, to format financial statements, 
2–4 

Group heading, to format financial statements, 
2–3 

Group total, to format financial statements, 2–4 
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GST 
on employee benefits, 15–9 
period-end, 21–1 to 21–7 

H 

Handheld device. See:  Simply Accounting 
Mobile 

Hiding 
account numbers on reports, 23–4 
automatic advice, 23–3 
comments column in Miscellaneous 

Transactions, 23–5 
icon windows, 23–6 
modules, 23–3 
parts of a window, 23–1 
records, 23–1 
sections of the Home window, 23–3 
specific window features, 23–5 

Hiding transaction windows 
Customers & Sales, 3–18 
Vendors & Purchases, 3–18 

Historical account names and numbers, 2–17 
Historical accounts 

deleting, 2–18 
Historical financial year dates, 3–3, 3–4 
Historical information, 11–1 

adding, 11–2 
Customers and Sales module, 11–5 
defined, 11–1 
finish entering, 11–10 
Inventory and Services module, 11–8 
keeping financial history, 2–17 
Payroll module, 11–6 
Project module, 11–9 
Vendors and Purchases module, 11–3 
when to add, 11–2 

History 
keeping for 100 years, 23–8 

History symbol, 11–1 
Home currency, 10–4 

defined, 10–1 
Home window 

display hidden sections, 23–4 
hiding sections, 23–3 

Home window (continued) 
See also:  Quick Start manual 

Home-currency amount 
calculating using the exchange rate, 10–5 

Hours per period, 15–4 
Hours, insurable for EI, 3–11 
HST 

period-end, 21–1 to 21–7 
See:  Harmonized Sales Tax 

I 

Icon windows 
hiding, 23–6 
See also:  Quick Start manual 

Importing 
Simply Accounting Mobile data. See:  

Synchronizing 
Inactive records, 23–1 
Income 

employees, 15–4 
taxable, 3–11, 3–13 
types, 3–11, 3–13 

Income statement, 24–1 to 24–3 
comparative, 20–15 

Installing 
Simply Accounting Mobile, 28–2 

Installing Simply Accounting. See:  Quick Start 
manual 

Insurable hours, 3–11 
Interest charges on sales invoices, 3–18 
Internal customer, 13–2 
Internal service activity, 18–3 
International coverage, 1–1 
Internet 

importing online statements, 20–8 
looking up exchange rates, 10–6 

Internet 
tracking shipments, 3–19, 22–18 

Inventory 
adjusting levels, 20–13 
allow negative quantities, 9–2 
assembly, from other items, 9–6, 9–12 
cost calculation, 9–2 
multiple locations, 9–3 
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Inventory (continued) 
negative quantities, 9–3 
profit-evaluation method, 9–2 
setting up, 9–1 
units of measure, 9–5, 9–8 

Inventory and service items 
adding accounts for, 9–3 
adding historical balances, 11–8 
adding longer descriptions and pictures, 

9–6 
adding on the fly, 22–18 
adding service activities, 18–3 
additional information, 9–6 
changing, 20–1 
item assembly, 9–6, 9–12 
linked accounts, 9–6 
removing, 20–2 

Inventory and services list 
sorting by item number or description, 9–2 

Inventory asset account, 9–3 
Inventory items 

bills of materials, 22–21 
exempt from sales taxes, 3–9 
sales taxes, 3–9 

Inventory transfers. See:  Item assembly 
Invoices 

duplicate, 3–21 
entering on a handheld device, 28–8 
for service activities(time and billing),18–7 
foreign prices on, 10–8 
looking up details, 22–13 

Invoices, historical 
adding to Customers and Sales module, 

11–5 
adding to Vendors and Purchases module, 

11–3 
Item assembly, 9–12 

bill of materials, 9–6, 9–13, 22–21 
processing transactions, 9–6, 9–12 

J 

Job categories, 15–2 
setting up, 3–26 

Job costing. See:  Projects 

K 

Keyboard shortcuts. See:  Quick Start manual 

L 

Language 
customer preference, 3–33 
switching to another, 3–33 
user preference, 3–33 

Language preference 
for handheld device, 28–4 

Latest transaction date, 3–2 
Legend for graphs, 27–3 
Linked accounts 

inventory, 9–6 
overview, 2–14 
payroll, 3–14 
removing, 2–15 
setting up, 2–14 to 2–15 
wage expense account, 15–5 

Linked Accounts wizard, 2–14 
List button, 3–30 
Location 

inventory, 9–3 
Looking up 

deposit slips, 22–13 
invoices, orders, or quotes, 22–13 
paycheques, 15–17 
payments and receipts, 22–13 
time slips, 18–10 

Looking up transactions or records in Simply 
Accounting Mobile, 28–10 

M 

Manuals, online. See:  Quick Start manual 
Manufacturing inventory from other items, 
 9–6, 9–12 
Mapping. See:  Account mapping 
Margin (profit-evaluation method for 

inventory), 9–2 
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Margins (printer settings) 
lining up, 8–3 
negative, 8–4 

Markup, 9–2 
Measuring business performance, 22–7 
Memo tab, 22–6 
Microsoft Outlook, synchronizing with Simply 

Accounting, 22–22, 22–23 
Miscellaneous transactions, 16–3 

changing or cancelling, 16–5 
changing or cancelling manually, 16–6 
entering, 16–3 

Modify Accounts wizard, 2–3 
Modules 

hiding, 23–3 
Multi-period reports, 23–8 
Multi-user mode, 7–3 

N 

Negative inventory levels, 9–2, 9–3 
Negative margins (printer settings), 8–4 
Network 

number of users, 7–1 
setting up Simply Accounting on, 7–1 
using Simply Accounting on, 7–1 

New Business Guide. See:  Quick Start manual 
Next cheque number, 3–21 
Next deposit slip number 

setting for Bank account, 2–13 
No-entry symbol, 3–37 
Non-accounting terms, 3–30 
Notes 

adding to the business calendar, 22–3 
Numbering on forms, 3–21 

O 

One-time customer 
on sales, 13–5 

One-time vendor 
on purchases, 12–6 

Online documentation. See:  Quick Start manual 

Opening balances for projects, 11–10 
Opening quantity and value for inventory,11–8 
Orders. See:  Purchase orders; Sales orders 

P 

Passwords, 3–31 to 3–45 
access rights to different parts of the 

program, 3–35 
access rights to time slips, 3–35 
adding a user, 3–39 
adding or changing a system 

administrator’s password, 3–38 
case-sensitive, 3–39 
changing for a user, 3–41 
numbers and letters, 3–39 
removing a user’s, 3–43 
removing system administrator’s, 3–39, 
 3–45 
restoring system administrator’s, 3–45 
system administrator's rights, 3–37 
using Simply Accounting with other 

products, 3–38 
See also:  User 

Pay advances, 15–11 
end of calendar year, 21–8 

Paycheques 
adding time slips, 18–9 
changing or cancelling, 15–18 
looking up, 15–17 
printing in a run, 15–14 
printing individually, 15–11 

Paying 
credit-card bills, 14–1 
other bills, 14–2 

Paying employees 
by direct deposit, 15–11, 15–14 
from time slips, 18–9 
in a run, 15–14 
individually, 15–11 
troubleshooting, 19–6 

Payment options 
overview, 3–17 

Payment terms on purchase invoices, 3–18 
Payment terms on sales invoices, 3–18 



 

User Guide    Index–11 

 

SIM2006 ENGL Index.DOC, printed on 1/10/2006, at 11:30:49 AM. Last saved on 1/10/2006 
11:30:00 AM. 

CA Confidential 

Payments 
for goods and services, 12–11 
from customers, cancelling, 13–16, 13–17 
looking up, 22–13 
prepaying, 12–12 
receiving on sales, 13–11 
to payroll authorities, 12–13 
to vendors, cancelling, 12–19, 12–20 

Payments, miscellaneous 
correcting or cancelling, 14–2 

Payroll 
allocating to multiple departments, 15–13, 

15–15 
expense groups, 3–16, 15–3 
income, benefits, and reimbursements, 
 3–11 
linked accounts, 3–14 
payroll ID, 15–1 
unlocking Auto Payroll, 15–1 

Payroll authority 
adding, 12–1 
adjusting payments to, 12–20 

Payroll deductions 
calculated before or after tax, 3–14 
flat amount or percentage, 3–12, 3–14 

Payroll options 
change income and deduction names,3–10 
enter Canadian information, 3–11 
enter U.S. information, 3–13 
setting up, 3–10 to 3–14 

Payroll records, historical 
adding, 11–6 

Pensionable earnings, 21–17 
Period-end 

GST, HST, QST, 21–1 to 21–7 
Personal tax credits subject to indexing 

updating, 20–5 
Pictures 

adding to inventory records, 9–6 
Pie chart, 27–4 
Pop-up calendar, in date fields, 22–22 
Prepaying goods and services, 12–12 
Prepayments 

adjusting, 12–22 
See also:  Deposits 

Preprinted forms 
setting up options for, 3–20 

Price lists, 9–9 
and quotes, 13–8 
importing and exporting, 9–10 
naming, 9–9 

Prices on invoices, 10–8 
Prices, foreign, 10–9 
Prices, in inventory and service records, 9–5 
Principal bank account, foreign 

adding, 10–7 
Printers 

fitting print on page, 8–3, 8–4 
lining up margins, 8–3 
negative margins, 8–4 
recurring transactions, 22–6 
selecting for reports, 3–29 
setting up, 8–1 
troubleshooting, 19–5 

Printing 
batch-processed transactions, 22–2 
direct deposit log, 15–23 
direct deposit stubs, 15–22 
in batches, 22–8 
paycheques in a run, 15–14 
paycheques individually, 15–11 

Printing in batches 
turning on the option, 3–20 
See also:  Batch printing 

Printing options 
setting up, 3–20 to 3–23 

Processing 
direct deposit, 15–22 
in batches, 22–2 

Product Analysis report, 26–2 
Production of inventory from other items, 9–6, 

9–12 
Profit 

budgeted for projects, 6–4 
Profit centres. See:  Projects 
Profit-evaluation method 

inventory, 9–2 
Project allocation option 

turning on, 5–2 
Project budgets 

setting up, 6–4 
Project module 

renaming, 5–2 
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Project records, historical 
adding, 11–9 

Projections 
cash flow, 24–8 

Projects 
adding, 5–4 
adding on the fly, 22–18 
allocating revenues and expenses, 17–1 to 

17–2 
budget period, 6–4 
budgeted profit, 6–4 
entering historical balances, 11–9 
opening balances, 11–10 
setting up, 5–1 to 5–4 
warning if full amount not allocated, 5–3 

Purchase invoice confirmations 
e-mailing to vendors, 3–22 

Purchase invoices 
payment terms, 3–18 

Purchase orders, 12–8 
based on a quote, 12–9 
cancelling, 12–17 
e-mailing to vendors, 3–22 
looking up, 22–13 
receiving items, 12–10 
turning off option to use, 3–19 

Purchase quotes, 12–9 
cancelling, 12–17 
looking up, 22–13 
order items, 12–9 
receiving items, 12–10 
turning off option to use, 3–19 

Purchases, 12–5 to 12–22 
back orders, 12–8 
cancelling, 12–16, 12–17 
entering, 12–5 
looking up, 22–13 
ordering, 12–8 
ordering based on a quote, 12–9 
paying for, 12–11 
prepaying, 12–12 
quotes, 12–9 

Purchases and payments history 
adding to Vendors and Purchases module, 

11–3 

Q 

QST 
on employee benefits, 15–9 
period-end, 21–1 to 21–7 

Quebec Health Services Fund factor, 3–11 
Quick Start manual.  In the Home window on 

the Help menu, choose Simply Accounting 
Manuals, then Quick Start 

Quotes 
and price lists, 13–8 
See:  Purchase quotes; Sales quotes 

R 

Receipts, 13–10 
adjusting, 12–19, 13–16, 13–18 
duplicate, 3–21 
looking up, 22–13 

Receiving 
items from purchase order or quote, 12–10 
money from credit-card sales, 20–6 
payments from customers, 13–11 

Reconciliation. See:  Account reconciliation 
Reconciling accounts. See:  Account 

reconciliation 
Re-consolidating. See:  Consolidated companies 
Record of Employment form (Canada). See:  

ROE 
Records 

adding on the fly, 22–18 
deleting in Simply Accounting Mobile, 
 28–10 
setting to inactive, 23–1 

Recurring transactions, 22–19 to 22–22 
changing, 22–21 
in the To-Do List, 22–6 
storing, 22–20 
using, 22–20 

Refunds, 13–19. See also:  Returns 
Related historical accounts, 2–17 
Relevé 1 slips 

electronic filing, 21–18, 21–22 
filing, 21–15 
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Relevé 1 slips (continued) 
filing originals, 21–22 

Reminder message 
project allocation, 5–3 
updating exchange rates, 10–5 
when closing a record without saving,  
 3–30 

Reminders 
backing up, 19–3 
See also:  To-Do Lists; Checklists 

Remittances 
adjusting, 12–20 

Removing 
accounts, 2–18 
linked accounts, 2–15 
records, 20–2 
security, 3–44 
user, 3–44 
user password, 3–43 

Renumbering cheques, 3–21 
Repair Security command, 3–45 
Report groups 

assign templates to, 22–11 
setting up, 22–10 

Reports 
comparative income statement, 20–15 
consolidated companies, 24–19 
Customers Analysis, 25–3 
customizing colours and fonts, 3–28 
for audit trail, 21–13 
getting details, 22–16 
multi-period, 23–8 
printing (testing), 8–1 
Product Analysis, 26–2 
Project Budget, 20–15 
resetting options, 22–17 
sales taxes, 21–1 
setting up groups, 22–10 
time slip, 18–13 
viewing in batches, 22–10 
See also:  Advanced Topics manual 

Requirements 
Simply Accounting Mobile, 28–1 

Restoring 
a backup, 19–4 
a damaged security file, 3–45 
system administrator’s password, 3–45 

Returns, 13–19 to 13–21 
as a credit note, 13–20 
as a refund, 13–19 

Revenue account, 9–3 
Revenues 

allocating to projects, 17–1 to 17–2 
graphs, 24–7 

Reversing. See:  Cancelling 
Rights. See:  Passwords 
Rights to use data 

changing, 3–42 
Rights to use Simply Accounting data in other 

programs, 3–38 
RL-1 slips. See:  Relevé 1 slips 
Rounding differences on foreign transactions, 

10–2 

S 

Sales, 13–4 to 13–10 
cancelling, 13–13, 13–15 
deposits, 13–11 
looking up, 22–13 
orders, 13–7 
quotes, 13–8 
receiving payment, 13–11 

Sales and receipts history 
adding to Customers and Sales module, 

11–5 
Sales invoices 

adding comments, 3–21 
adding time slips, 18–7 
customizing, 23–2 
e-mailing to customers, 3–22 
job categories, 3–26 
payment terms, 3–18 

Sales order confirmations 
adding comments, 3–21 
e-mailing to customers, 3–22 

Sales orders, 13–7 
cancelling, 13–15 
completing, 13–10 
entering on a handheld device, 28–8 
looking up, 22–13 
 



 

Index–14    Simply Accounting 

 

SIM2006 ENGL Index.DOC, printed on 1/10/2006, at 11:30:49 AM. Last saved on 1/10/2006 
11:30:00 AM. 

CA Confidential 

Sales orders (continued) 
turning off option to use, 3–19 

Sales quotes, 13–8 
adding comments, 3–21 
e-mailing to customers, 3–22 
looking up, 22–13 
turning off option to use, 3–19 

Sales receipts 
e-mailing to customers, 3–22 

Sales taxes 
entering for inventory items, 9–6 
exempt items, 3–9 
exempt vendors and customers, 3–8, 3–9 
inventory items, 3–9 
refund, 21–6 
reports, 21–1 
setting up, 3–4 
See also:  Tax codes 

Save a Copy, 19–4 
Save As, 19–4 
Saving records 

reminder when closing, 3–30 
Screen display 

customizing, 3–29 
See also:  Display 

SDI. See:  State Disability Insurance 
Search 

advanced, 22–15 
basic, 22–15 
Quick Search, 22–16 

Section heading, to format financial statements, 
2–3 

Section total, to format financial statements,2–4 
Security 

access to time slips, 3–35 
removing, 3–44 
See also:  Passwords 

Security file, damaged 
restoring, 3–45 

Selling. See:  Sales 
Service activities 

adding records, 18–3 
flat fee, 18–3 

Services. See:  Inventory and services 
Session date, 3–2 
Setting up 

accounts, 2–1 to 2–22 

Setting up (continued) 
accounts (overview), 2–1 
bills of material, 22–21 
budgets, 6–1 
credit cards, 4–1 to 4–3 
direct deposit, 15–22 
employee direct deposit bank accounts, 

15–7 
exchange rate, 10–5 
foreign currency, 10–4 
inventory, 9–1 
linked accounts. See:  Linked 

accounts:setting up 
passwords, 3–31 to 3–45 
payroll options, 3–10 to 3–14 
price lists, 9–9 
printers, 8–1 
project budgets, 6–4 
projects, 5–1 to 5–4 
sales taxes, 3–4 
shippers, 3–19 

Setting Up 
Simply Accounting Mobile, 28–6 

Setting up Simply Accounting 
adding basic information, 3–1 
on a network, 7–1 
overview, 1–1 

Settings 
negative printer margins, 8–4 

Shipments 
tracking, 22–18 

Shippers 
setting up, 3–19 

Simply Accounting 
Canadian and U.S. versions described in 

one manual, 1–1 
installing. See:  Quick Start manual 
learning how to use. See:  Quick Start 

manual 
new features. See:  What’s New in Simply 

Accounting manual 
setting up (overview), 1–1 
setting up on a network, 7–1 
starting. See:  Quick Start manual 
updating from an older version. See:  

Quick Start manual 
using on a network, 7–1 
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Simply Accounting data 
folder, 7–1 
rights to use in other programs, 3–38 

Simply Accounting Mobile 
about, 28–1 
adding customers, 28–9 
deleting transactions or customer records, 

28–10 
entering sales orders and invoices, 28–8 
entering time slips, 28–9 
handheld device settings, 28–6 
installing, 28–2 
language preference, 28–4 
look up function, 28–10 
requirements, 28–1 
synchronization, 28–3 
synchronization errors, 28–12 
synchronization settings, 28–3 
transferring data to Simply Accounting, 

28–11 
Simply.ini file, 7–1 
Single-user mode, 7–3 
Spoilage, 20–13 
State Disability Insurance, 3–13 
State Unemployment Tax Act, 3–13 
Statement of Cash Flows, 24–10 

importance of account classes, 2–12 
Statements. See:  Customer statements 
Statistics tab 

customer records, 11–5 
inventory and services records, 11–8 
vendor records, 11–3 

Status bar. See:  Quick Start manual 
Subgroup accounts, to format financial 

statements, 2–3 
Subgroup total accounts, to format financial 

statements, 2–4 
Submitting 

a direct deposit data file, 15–23 
Subsidiary company. See:  Consolidated 

companies 
SUTA. See:  State Unemployment Tax Act 
Symbols 

history, 11–1 
no entry, 3–37 
view only, 3–37 

Synchronization, defined, 28–3 

Synchronizing 
resolving errors, 28–12 
steps, 28–11 
with Microsoft Outlook, 22–22, 22–23 

Sysadmin. See:  Passwords 
System administrator 

access rights, 3–37 
what is, 3–35 
See also:  Passwords 

System administrator’s password 
adding or changing, 3–38 
restoring if security file is damaged, 3–45 

T 

T4 slips 
electronic filing, 21–17, 21–18 
filing, 21–15 
filing changes, 21–22 
filing originals, 21–18 

T5018 forms (Canada), 21–7 
T518 forms (Canada), 12–2 
Tax. See also:  Sales taxes 
Tax codes, 3–6 

for new vendors and customers, 3–8 
for vendors and existing customers, 3–8 
See also:  Sales taxes 

Tax exemptions, 3–8 
Tax tables, 15–21 
Taxation 

end of GST, HST, QST period, 21–1 to 21–7 
paycheques, 15–5 
tax tables, 15–21 
updating personal tax credits subject to 

indexing, 20–5 
Taxes 

changing in purchases, 12–7 
changing in sales, 13–6 
payroll, 15–5 
sales tax refund, 21–6 

Templates, 2–1 
Terminology 

modifying names, 3–31 
use non-accounting terms, 3–30 
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Testing 
forms printing, 8–2 
pagination in printing, 8–2 
report printing, 8–1 

Third-party products, 3–38 
Time slip entry user, 3–35 
Time slips 

access rights, 3–35 
adjusting, 18–11 
allocating to a project, 18–6 
custom forms, 18–6 
entering, 18–4 
entering on a handheld device, 28–9 
job categories, 3–26 
looking up, 18–10 
on invoices, 18–7 
on paycheques, 18–9 
reports, 18–13 
timer, 18–5 
See also:  Time and billing 

Time, entering, 18–5 
Timer, 18–5 
To-do lists, 22–4 

displaying, 22–5 
Memo tab, 22–6 

Toolbar 
graphs, 27–1 

Tracking shipments, 22–18 
setting up, 3–19 

Transaction date, 3–2 
Transaction windows 

changing terminology, 3–31 
hiding, 3–18 

Transactions 
item assembly, 9–6, 9–12 
miscellaneous, 16–3 
payments, 14–1 
purchases, 12–5 
receipts, 13–10 
recurring, 22–19 to 22–22 
sales, 13–4 

Transferring 
Simply Accounting Mobile data to Simply 

Accounting, 28–11 
Transferring funds between accounts, 16–3 
Troubleshooting, 19–5 
Turning off the budget option, 6–1 

Typical set of accounts, 2–1 

U 

U.S. version of Simply Accounting, 1–1 
Units of measure for inventory, 9–5, 9–8 
Unlocking Auto Payroll, 15–1 
Update price lists, 9–10 
Updating 

budgets, 20–16 
personal tax credits subject to indexing, 

20–5 
price lists, 9–9 
to the latest version, 19–5 

Updating exchange rates 
displaying a reminder, 10–5 

Updating from an older version of Simply 
Accounting. See:  Quick Start manual 

User 
adding, 3–39 
changing password, 3–41 
changing rights, 3–42 
names and passwords, 3–39 
removing, 3–44 
removing password, 3–43 
required if running on a network, 7–2 
See also:  Passwords 

Using Simply Accounting data in other 
programs 
security settings, 3–38 

Using Simply Accounting on a network 
setting user preferences, 3–29 

V 

Vacation pay 
checking what is owed, 15–17 
paying out, 15–16 
setting for the employee, 15–4 

Variance account, 9–3 
Vendors 

adding, 12–1 to 12–5 
adding on the fly, 22–18 
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Vendors (continued) 
adding payroll authority, 12–1 
adding purchases and payments history, 

11–3 
changing, 20–1 
early-payment terms, 12–2 
evaluating, 25–7 
exemptions from sales taxes, 3–8 
historical balances, invoices, and 

payments, 11–3 
memos, 22–6 
Options tab, 12–2 
prepayments to, 12–12 
removing, 20–2 
setting up to use foreign currency, 10–10 
tax codes, 3–8 

Viewing reports in batches, 22–10 
View-only symbol, 3–37 

W 

Wage expense account, 15–5 
WCB. See: Workers’ Compensation Board 
Web site. See also: Internet 
Weighted-moving-average, in inventory cost, 

9–2 
What’s New in Simply Accounting manual. In the 

Home window on the Help menu, choose 
Simply Accounting Manuals, then What’s 
New 

Windows 
hiding features, 23–5 

Windows used in Simply Accounting. See:  
Quick Start manual 

Wizards 
Linked Accounts, 2–14 
Modify Accounts, 2–3 

Workbook. In the Home window on the Help 
menu, choose Simply Accounting 
Manuals, then Workbook 

Working remotely. See:  Simply Accounting 
Mobile 

Writing off 
bad debts, 13–22 
inventory, 20–13 
returned goods, 13–19 

Y 

Year-end 
calendar, 21–8 
clearing old information, 23–7 to 23–10 
creating accountant's copy, 21–11 
fiscal, 21–8 
reports, 21–10 
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